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Consolidation
Purpose
This application component features consolidation functions you can use for external (statutory)
rendering of accounts as well as internal (management) reporting.

To do this, this component offers different consolidation types [Ext.] that are based on user-
definable organizational units. Specifically, you can perform consolidation for companies,
divisions, business areas or profit centers.

In the component, the consolidation types are represented by dimensions. For example, you can
define one dimension for company consolidations and, at the same time, another dimension for
profit center consolidations. Each dimension lets you process flexible and, when needed, parallel
hierarchies of consolidation units and consolidation groups:

•  Flexible hierarchies means that you can use any number of hierarchy levels, define these
hierarchies in variable depths, and maintain these hierarchies easily and clearly.

•  Parallel hierarchies means that you use different criteria for structuring the consolidation units
of each type of consolidation (e.g., business area consolidation). For example, one hierarchy
could have a structure of consolidation units as companies, another hierarchy could have a
structure with business segments.

The component features the ability to use different consolidation charts of accounts [Ext.]. For
example, this lets you generate consolidated statements for both German HGB requirements as
well as US GAAP – in parallel.

You can use consolidation versions [Ext.] to maintain different categories of data, such as actual
data, prognostic data or budget data.

Integration
The application features integration functions with different SAP transaction modules that provide
data for consolidation; this is available for the consolidation types company consolidation,
business area consolidation and profit center consolidation. The integration functions enable the
following:

•  Generation of the organizational units of consolidation, based on the units in the transaction
system.

 There must be a clearly defined relationship between the organizational units of the
transaction system and those of the consolidation system before an automatic transfer of
data can take place.

•  Automated collection of transaction data.

Several data transfer methods are available. A prerequisite for the collection of
transaction data is that the data carried in local charts of accounts be converted for the
aggregated chart of accounts in Consolidation. In some consolidation scenarios the
transaction data can even be collected into different consolidation charts of accounts.

Features
•  Different methods are available for transferring the transaction data to the Consolidation

system. Which method you use depends on your consolidation scenario.



Consolidation (EC-CS)  SAP AG

Consolidation

12 April 2001

•  You can post manual entries, for example to standardize the reported data to the group's
methods of balance sheet valuations.

•  You can use validations to check the consistency of the reported or standardized financial
data.

•  You can translate the reported financial data into the currency of the consolidation group.

•  You can automatically execute the following consolidation tasks:

− interunit eliminations (elimination of payables and receivables, elimination of revenue
and expense, elimination of investment income)

− elimination of interunit profit/loss in transferred inventory

− consolidation of investments

− reclassifications

The automated postings are controlled by the task settings you previously define in
Customizing.

The logic of the consolidation tasks remains the same for all types of consolidation. For
example, the system uses the same logic when executing interunit eliminations for either
company consolidations or business area consolidations.

•  You can generate reports using the standard tools in drilldown reporting, and the Report
Painter or Report Writer of R/3. There are also existing reports for listing master data,
additional financial data and the control parameters.

The entire consolidation process can be broken down into two areas:  a) the collection and
preparation of reported financial data, and b) the consolidation of the financial data. Both of these
areas have their respective monitor, which you can use to maintain and execute all of the
individual tasks.

Constraints
The automated execution of the elimination of IU profit/loss in transferred assets is not available
in this release.
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Execution of a Consolidation
Purpose
The "Consolidation using SAP Consolidation" scenario can be applied to various consolidation
types [Ext.]. The objective of a consolidation depends on the type of consolidation.

•  A statutory (or legal) consolidation (such as company consolidation and business area
consolidation) requires that the reported data of the group's consolidation units be
aggregated into consolidated financial statements. This requires that:

− the reported financial data be adjusted to meet the group's balance sheet valuations

− the reported financial data be translated into the currency of the consolidation group

− the data be purged of transactions arising from the delivery of goods and services
between two consolidation units, as well as any investments in units of the same group

•  Internal or managerial consolidations (such as profit center consolidation) are used for
controlling areas of corporate enterprises. The main focus of the consolidation tasks is on the
elimination of the effects of the delivery of goods and services within such enterprise areas.
Let's take the "elimination of interunit sales of merchandise" as an example.

Prerequisites
The consolidation units must report their financial data [Ext.] so that it can be collected in the
Consolidation system. There are different methods for transferring financial data into the
Consolidation totals database. The method you choose depends on the organization of your
corporate group and the systems it uses. The data can be:

•  collected from SAP transaction-processing components using the integration feature

•  entered off-line (decentralized) and transferred to Consolidation as a data file

•  entered on-line directly in the Consolidation system

Note the following important prerequisites needed for error-free data collection.

Mapping
The financial data of the consolidation units is organized in operational organizational units and
operational charts of accounts. When this data is transferred, these operational account
assignments must be mapped to the account assignments used in the Consolidation system.

Subassignments
The Consolidation system needs account assignments, such as partner units, transaction types,
transaction currencies and so on, in order to perform the consolidation tasks. For example,
automated elimination of IU revenue and expense is only possible if the system knows which
partner units caused the revenues and expenses.

You can define which subassignments each financial statement item needs in the item's master
data. These subassignments must be included in the reported financial data.
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Creating an Initial Data Set
When implementing SAP Consolidation, data concerning your consolidation units usually already
exists.

In online and offline data entry, there is basically no difference between transferring historical
data and the data of the current period. During data entry in SAP Consolidation, you enter the
cumulative value for the historical data.

However, to transfer financial data using integration you first need to create an initial data set.
This is because integrated data collection updates the consolidation processing ledger or the
consolidation staging ledger with operational (transaction-system) data. Before one of these
ledgers is initially updated, you need to create an initial data set in that ledger with the account
assignments relevant to consolidation. If the relevant historical documents are still in the system,
you can subsequently post these in a separate journal entry.

Preparations for consolidation are needed to establish the requirements mentioned.
For more information see the following chapters in the Implementation Guide for SAP
Consolidation:

− Data Collection [Ext.]

− Integration: Preparation for Consolidation [Ext.]

Process Flow
A) Customizing
You use the Implementation Guide for Consolidation to customize the component to meet your
individual requirements.

The standard SAP system includes default settings for most of the Customizing activities. Check
each activity and decide whether you want to use the default settings. In particular, see if you can
adopt the predefined dimensions [Ext.] and consolidation charts of accounts [Ext.]. Many
Customizing settings rely on these objects. Thus, if you use your own dimensions or
consolidation charts of accounts, you need to adjust all of the dependent settings accordingly.
There are copy functions to assist you.

Note that master data for the organizational units can be maintained in the Implementation Guide
as well as the application menu.

B) Collection and Standardization of Reported Financial Data
You execute the activities for collecting and standardizing the financial data reported by
subsidiaries in the Data Monitor [Page 20] in the Consolidation application menu.

Basic Sequence of Activities in the Data Monitor:
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Rollup to consolidation groups

Preparation for consolidation group changes

3. Validation of reported financial data

 4. Contra items/retained earnings

 1. Carrying forward of balances

 2. Data collection

5. Standardization of financial data

6. Currency translation

7. Validation of standardized financial data

The tasks with gray backgrounds are additional tasks that are used in more complex
consolidation processes.

1. You carry forward the prior year data into the current fiscal year.

This task is only needed if prior year data already exists in the totals database.

2. You transfer the reported financial data of the consolidation units.

The system writes the reported financial data in the consolidation totals database.

The system also requires additional financial data for the consolidation tasks "Elimination
of Interunit Profit/Loss" and "Consolidation of Investments". Additional financial data
contains information on:

a) group-internal deliveries and inventories of assets (needed for the elimination of interunit
profit/loss)

b) investments in and equity of the consolidation units (needed for the consolidation of
investments)

The system writes additional financial data in separate database tables – not in the totals
database. You collect the additional financial data (as with reported financial data) using
the data collection task. In some situations you also have the option to read the values
from the execution of the consolidation of investments directly from the totals database.

In some cases, you may want to collect the additional financial data at a later point in
time, namely shortly prior to executing the elimination of interunit profit/loss and/or the
consolidation of investments. Although this is possible, you should keep in mind that if
this done, the status management function resets the task for validating standardized
financial data along with all subsequent tasks. Therefore, SAP recommends that you
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collect the additional financial data immediately after you collect the reported financial
data.

3. You validate the reported financial data.

At this point it is not yet necessary to validate the reported financial data. The last task in
the data monitor is the validation of standardized financial data in group currency. This
last task is mandatory, meaning that the system ensures that this task is successfully
executed prior to allowing tasks in the consolidation monitor to be executed (see below).

Nevertheless, it is useful to validate the reported data at this point if no consistency
check has yet taken place in some other fashion.

4. If you used the integrated data transfer methods "realtime update" or "rollup" to collect
reported data, you need to process the contra items and retained earnings.

a) If the balance of any items turned from a debit to a credit balance, or vice versa, this
balance must be transferred to the assigned contra item.

b) Retained earnings (if the statement of retained earnings appears after the income
statement) or annual net income (if retained earnings are stated in the balance sheet)
must be calculated and posted to the selected items provided.

5. You post standardizing entries to the reported financial data, if needed. These entries can be
posted manually or automatically (using "reclassifications").

 
An alternative is to also execute this task after currency translation.

6. If the reported financial data is valued in different currencies, you translate the data into the
currency of the consolidation group.

In company consolidation, this is usually the currency of the parent company.

Sometimes it is helpful to translate the reported financial data at an earlier point for pre-
reconciliations and the like. For example, you may want to pre-maturely execute interunit
elimination in test mode to clean up any mismatches between the disclosed receivables
and payables, etc. before the consolidation tasks are executed. To do a test run, the
financial data must be translated, even if the data of some of the consolidation units has
not yet been collected. In this situation, a test run of currency translation is insufficient
because a test run of interunit elimination needs the group currency values in the totals
database.

To enable this requirement, status management in the data monitor allows the execution
of currency translation prior to the completion of data collection or other preceding tasks.
Note that the system views such a premature currency translation as a preliminary
currency translation. This means that another currency translation must take at the
correct task sequence.

7. You validate the standardized financial data.

This task must be executed successfully before running any tasks in the consolidation
monitor.

Parallel Activities:
Parallel activities may be helpful or even required at various stages in the data collection
process:
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• If consolidation of investments processes consolidation group changes, for example, you can
prepare the data for such activities using automatic postings.

Consolidation group changes result from acquisitions or divestitures of consolidation
units. The automatic preparatory postings adjust the financial data as follows:

− The values of the balance sheet items of the acquired or divested consolidation units are
broken down by subitems and transferred to the subitem "Acquisition to Consolidation
Group" or "Divestiture from Consolidation Group".

− When dealing with acquisitions of consolidation units, the system takes the income
statement items and transfers the portion for the periods prior to the acquisition to the
item "Retained Earnings Prior to First Consolidation".

• You carry out a rollup to the consolidation groups, if needed.

To increase system performance, you may want to use the rollup feature to summarize
consolidation unit data for the consolidation groups or consolidation group hierarchies.
This can speed up reporting that uses the Report Writer. Rollups also speed up interunit
eliminations.

At which point you do this depends on which data is accessed in the Report Writer
reports. To speed up interunit eliminations, you need to do a rollup at the end of the data
processing, for example, prior to the validation of the standardized financial data.

C) Consolidation of the Financial Data
You remaining activities are executed in the Consolidation Monitor [Page 32].

Which tasks you run in the consolidation monitor depends on the type of consolidation involved
and the resulting requirements (see also section "Purpose").

Example of the Activities in the Consolidation Monitor:

3. Preparation for consolidation group changes

4. Consolidation of investments

 1. Interunit elimination

 2. Elimination of IU profit and loss in transferred inventory

5. Reclassification

6. Manual posting (if needed)

7. Validation of consolidated financial data

8. Rollup to consolidation groups
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The tasks with gray backgrounds are additional tasks that are used in more complex
consolidation processes.

1. Interunit Elimination

This task eliminates group-internal receivables and payables, and group-internal
revenues and expenses.

2. Elimination of Interunit Profit/Loss in Transferred Inventory

This task eliminates group-internal profit and loss. The elimination entries involved
require additional financial data that provides information on group-internal goods
deliveries and inventories. See section "B) Collection and Standardization of Reported
Financial Data", Step 2.

3. Preparation for Consolidation Group Changes

If you run consolidation of investments that, for example, processes consolidation group
changes, you prepare the consolidated data for such activities. See also section "B.
Collection and Standardization of Reported Financial Data".

4. Consolidation of Investments

This task eliminates ownership relationships within the group. This task is needed
particularly for the disclosure of consolidated financial statements that must meet
statutory requirements.

The elimination entries involved require additional financial data that provides information
on investments in and equities of consolidation units. See section "B) Collection and
Standardization of Reported Financial Data", Step 2.

5. Reclassification

This task lets you reclassify data that has been consolidated.

Frequently, consolidated financial statements of a corporate group need to state the
retained earnings of the parent unit within the group. You can use reclassifications to
reclassify the retained earnings of subsidiaries as appropriations.

6. Manual Postings (if needed)

In exceptional cases it may become necessary to post manual entries to adjust the
consolidated financial data.

7. Validation of the Consolidated Financial Data

After executing the consolidation tasks, you validate the consolidated data.

8. Rollup to Consolidation Groups

See also section "B. Collection and Standardization of Reported Financial Data".

Result
You can generate reports on the consolidated data and transfer the data for further processing
elsewhere. In the SAP System, you can forward the data to the Executive Information System
(EC-EIS) using the integration feature.
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Data Monitor
Use
You use the data monitor to run the activities for collecting and preparing the financial data
reported by your consolidation units. In Consolidation, these activities are called tasks.

The system manages the status of the tasks and, thus, ensures a logical sequence and
consistent data.

Prerequisites
In Customizing , you have defined a task group along with its tasks for the data monitor, and you
have assigned the task group to the dimension (global task group).

In addition you have assigned one task group to one consolidation group or to several
consolidation groups of the dimension, which includes a partial quantity of task groups.  When
you enter the consolidation group in the global parameters [Ext.], then the data monitor only
shows the organizational units of this group and the tasks of the consolidation group dependent
task group.

See also: Data Monitor [Ext.] in the Implementation Guide for Consolidation

Features
Monitor Layout
•  The monitor displays the hierarchy of organizational units vertically.

•  The monitor displays the overall status and the tasks horizontally.

•  In the resulting table, each organizational unit is shown with its overall status and the status
of each related task.
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•  The legend (found in the menu of the monitor) explains the meaning of the colors and

icons/texts. 

Hierarchy
Cons group

--

Cons unit

Cons unit
Cons unit

++

-- Cons group

--

--

--

++ Cons group

++ Cons group

Hierarchy of Org Units Tasks

Data Monitor

 

Status Display

Collection Valid. RFD Translation Valid. SFDOverall stat.

Legend of Colors/Icons

Organizational Units
The data monitor displays the hierarchy of organizational units all the way down to the level of
the consolidation units. This means that you can run the tasks for the consolidation groups as
well as the consolidation units (also see the section running the tasks).

When you enter a consolidation group in the global parameters, then the monitor
only displays the organizational units of this group as a hierarchy (as with the focus,
see below). When you also enter a consolidation unit of this group in the global
parameters, then the monitor displays the detail overview of tasks for this unit.

For a better overview of the organizational units to be processed, the menu contains the following
functions:

•  You can search the organizational units in the hierarchy.

•  You can set the focus on a hierarchy, a group, or a consolidation unit, allowing you to only
see these organizational units with their lower-level units.

By double-clicking on the hierarchy column heading, you can reset the focus (or via the
menu).

•  When you position the cursor on an organizational unit, then you can

− double-click on it to go to its master record.

This can be very useful, when you want to look at the unit's assignments concerning
the data transfer method, validations, currency translation method, and so on.

− right-click to call up the detail overview of the status for the selected organizational unit
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Tasks
The monitor shows all of the tasks you defined in Customizing and assigned to the task group.
The following is important when processing the tasks:

•  All tasks in the task group must generally be run for each and every consolidation unit.

An exception is made for the tasks:

− data collection tasks

− manual posting tasks

− tasks that are not relevant to a given consolidation unit (see later)

In Customizing of the task group, specify which task should be the last task to be
executed. When you include the task for validating the standardized financial data in the
task group, then the system considers this task as the last task; in this case you cannot
tag another task as the last task.

•  There is a mandatory sequence of certain tasks. This ensures that these tasks are run in
the correct sequence as required by the system.

For example, the collection of reported financial data must be complete before the
data is validated, that is, the data's consistency is checked.

However, this mandatory sequence is only very broad. The details of the mandatory
sequence depends on your specific requirements. Therefore, Customizing lets you
further narrow down the mandatory sequence.

If you want to standardize the reported financial data to meet your corporate
requirements, you can decide if this task is to be run prior to and after currency
translation.
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•  The following tasks may be irrelevant for individual consolidation units:

− Carrying forward of balances

This task is irrelevant for a consolidation unit if the database does not contain data
for the prior fiscal year.

− Currency translation

This task is irrelevant for a consolidation unit if the unit's local currency is the same
as the group currency, or if the unit's data is entered in group currency.

The status of such consolidation units shows if the task is irrelevant and is therefore
skipped.

•  In Customizing you can determine certain tasks as milestones. In the monitor, these tasks
are tagged with  in the column heading.

Milestones are used when tasks are run as a bundle. The system stops at each
milestone, thus allowing the user to control further processing at that point. However you
can run a task successively for the milestones (see also section Executing Tasks).

For further information on these Customizing activities, see the Implementation Guide of
Consolidation at: Define Task Group [Ext.]

Layout Design
Depending on your group's structure and your consolidation requirements, the matrix in the
monitor can become very large and somewhat unwieldy. In this case, you can use the following
functions to modify the layout of the monitor:

• In the hierarchy of the organizational units you can:

− set the focus (see also the section monitor layout / organizational units)

− hide the names of the organizational units, and thus only show the IDs.

− hide blank lines

• You can manipulate the task columns as follows:

− scroll horizontally to hide the completed tasks and only show the incomplete tasks

− hide columns to only show the overall task for the organizational units.

− set the width, by moving the edges of the column with the cursor

• You can manipulate the status display as follows:

− set a filter to only show certain statuses – e.g., only show all tasks with errors or with the
overall status of incomplete

− choose between icons and text

− align the icons on the left or centrally

• You can save your user layout (see menu Layout or Icons). Then your layout settings are
retained even when you exit the monitor and are available the next time you call up the
monitor.

This concerns the following settings in particular:
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− Focus

− Expand hierarchy

− Status display

− Task display

Some of the saved settings are cross-dimensional, they are icons/text, show/hide blank
lines, icon alignment, reveal/hide tasks.

Running the Tasks
Selection of the Organizational Units
In the data monitor, you can run the tasks for each individual consolidation unit.

If you want to be able to run the tasks for the lower level consolidation units of an entire
consolidation group, the system must be able to automatically execute the tasks of the lower-
level consolidation units. Automatic execution is not possible for:

•  the data transfer method online data entry in the SAP System

•  the task manual adjustment

When you position the cursor on a task and right click with the mouse, then you
receive a context menu. This menu is dependent on the status of the task. For
example, when the task is blocked, then you receive the functions Unblock and if
required Last log as the context menu .

•  

Start Mode
You can run the tasks in the following modes:

• Test mode

You can execute test runs regardless of a task's status at any time.

• Update mode

You can run a task in update mode if the task has been opened and the preceding task
is blocked (see Status Management).

• Update mode with pendent tasks

When you start a task in update mode and the preceding task is not yet blocked, then the
system executes the pendent task (see Status Management).

• Initial Screen Start

You receive the initial screen start for the tasks in this mode, so that you can enter the
selection conditions, the technical settings (test mode or update mode) etc.

• Run successive tasks

A consolidation run automatically triggers multiple executable tasks as a bundle. This
feature speeds up the creation of your consolidated statements. The automatic
processing stops at the next milestone.
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The status bar of the SAP screen shows which task is being processed.

• Run successive tasks without stopping

The system does not stop before the milestone in this mode. Instead it closes the
milestone task and moves on to the next task.

For tasks where the system generates a log (for example currency translation), you
can call up the last log, by positioning the cursor on the organizational unit and right
clicking the mouse.

Opening and Closing Periods
You can open and close periods of a fiscal year, to be precise always for a selected consolidation
unit (with subordinated organizational units) or a consolidation unit.

Periods are generally kept open. The following table shows, which actions you can execute in the
data monitor or in the consolidation monitor, so that according to the initial situation, you can
close or open the period again.

Action ResultInitial situation

in data monitor in cons monitor

Period open - Close period Period closed in
data monitor and
cons monitor

Period open Close data monitor - Period closed in
data monitor, open
in cons monitor

Period closed Open period - Period open in data
monitor and in cons
monitor

Period closed - Open cons monitor Period closed in
data monitor, open
in cons monitor

An authorization object exists for opening and closing periods, enabling you to assign the
authorization to a specific circle of co-workers.

Further functions

•  You can go to the monitor in the database listing in order to check the totals record (menu Go
To).

•  You can go to the data monitor to the consolidation monitor and vice versa (menu Go To).
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Status Management
Overall Status
The monitor displays the overall status for each organizational unit. The overall status is
portrayed using an initial stage icon and three traffic light icons, as illustrated here:

Overall status: Initial stage

Overall status: Incomplete

Overall status: Errors

Overall status: Complete

Task Status
As with the overall status, the monitor also displays the status of each task for each
organizational unit. Tasks have the following statuses:

Status: Task is unblocked

Status: Task is blocked

Status: Task with errors

Status: Task incomplete

Status: Task without errors

Status: Task is irrelevant

Status: Task in initial stage

You can double-click a status to see more detail. This includes the user name, date and time of
the last change.

Status Updating

•  At the beginning of processing in the data monitor the status of all tasks are set to initial
stage or irrelevant. When you run a task in update mode, the status is updated for the
relevant organizational unit.

•  When you run a task in update mode and the preceding tasks are not yet blocked, then the
system sets the status pendent task. This means that you have to run the task again if you
have blocked the preceding tasks.

•  A task can only be blocked (see menu) if it was run without any errors and not pendent.
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An exception is made for the tasks data collection and manual standardizing entries.
These can be blocked without having been run.

In Customizing, any task can be set to be automatically blocked after being run without
errors. For example, this is useful for the task validation.

•  A task must be unblocked before it can be rerun after being blocked. Note that this also
automatically unblocks all "downstream" tasks. For example, if you unblock the task data
collection, the tasks validation, currency translation, and so on are also unblocked.

•  The system uses the same update logic for higher-level and lower-level organizational units,
and for the overall status. This is illustrated below as follows:

•  In certain situations you can reset the status to initial stage (in the menu). The system then
also resets the statuses of the organizational units for the selected task as follows:

− the status of the selected consolidation unit or group

− the statuses of the lower-level consolidation units and groups

− the statuses of the higher-level consolidation groups

• Another function for certain situations is the function for deactivating status management.
This function is described in Customizing step  Check Global System Settings.

• When the status management is deactivated, you will receive a system message on activities
in the monitor. You find this function in the step Check Global System Settings  [Ext.]in the
Implementation Guide. When the status management is deactivated then you get a system
message with activities in the monitor. You can activate the status management from the
monitor (menu Environment).

Example
The following graphics illustrate simple examples of status updating: Say, a user at the subgroup
Acme Pharmaceuticals runs the tasks for the lower-level consolidation units. Note that some
interim steps have been left out below.

The first graphic shows all tasks at the initial stage before any processing occurs.

--

Pharma-1

Pharma-2

Pharma-3

Segments
++ Consumer, Non-food

-- Pharma

--

--

--

++ Electronics

++ Other

 Collection Valid. RFDOverall ...

The next graphic shows that the user executed the data collection task for two consolidation
units. Note that the status of the subgroup Pharma is still incomplete because the task has not
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been executed for all consolidation units that belong to the group. The traffic light is yellow. Both
of these statuses are reflected at the higher-level organizational unit Segments.

--

Pharma-1

Pharma-2

Pharma-3

Segments
++ Consumer, Non-food

-- Pharma

--

--

--

++ Electronics

++ Other

 Collection Valid. RFDOverall ...

The next graphic shows that the user blocked the data collection task for both consolidation units
and executed the task for validating the reported financial data.

--

Pharma-1

Pharma-2

Pharma-3

Segments
++ Consumer, Non-food

-- Pharma

--

--

--

++ Elektronics

++ Other

 Collection Valid. RFDOverall ...

The next graphic shows that the validation for unit Pharma 1 contained errors. This status is also
reflected at the higher-level organizational units.
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--

Pharma-1

Pharma-2

Pharma-3

Segments
++ Consumer, Non-food

-- Pharma

--

--

--

++ Electronics

++ Other

 Collection Valid. RFDOverall ...

The next graphic shows that the user unblocked the data collection task in order to correct the
reported financial data. Afterwards, the user must block the task again and rerun the validation
task.

--

Pharma-1

Pharma-2

Pharma-3

Segments
++ Consumer, Non-food

-- Pharma

--

--

--

++ Electronics

++ Others

 Collection Valid. RFDOverall ...

The next graphic shows that all tasks for the group Pharma ran without errors and have been
blocked, which is reflected by the green traffic light.
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--

Pharma-1

Pharma-2

Pharma-3

Segments
++ Consumer, Non-food

-- Pharma

--

--

--

++ Electronics

++ Other

 Collection Valid. RFDOverall ...

...

...

...

...
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Executing Tasks in the Data Monitor
Procedure
All tasks start out in the "initial stage" status. Execute the tasks in the following order:

1. Place the cursor on the "initial stage" status that intersects between the desired
organizational unit and the first task displayed.

2. Choose either the start mode (test run, update run, run successive tasks, run successive
tasks without stopping or initial screen start). The following describes the update run mode.

 The system carries out the task and displays an audit trail depending on which task is
run.

3. Block the task after it is successfully executed.

4. Execute the next task, for example, online data entry of reported financial data and additional
financial data.

5. Block the task and run the next one.

6. If a task, such as "validation", produces errors, you must correct the errors before attempting
to block the task.

 For example, you may have to unblock the data collection task. This will also unblock all
of the "downstream" tasks.

7. Execute all of the tasks, including the task for validating the standardized financial data.

Result
After the task for validating the standardized financial data is executed and blocked, you can then
execute further tasks in the consolidation monitor.
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Consolidation Monitor
Use
You use the consolidation monitor to run the activities for consolidating financial statement data.

Prerequisites
In the Implementation Guide, you have defined the task group along with its tasks for the
consolidation monitor, and you have assigned the task group to the dimension.

In addition you have assigned one task group to one consolidation group or to several
consolidation groups of the dimension, which includes a partial quantity of task groups.  When
you enter the consolidation group in the global parameters [Ext.] then the consolidation monitor
only shows this consolidation group (perhaps with subordinated consolidation groups) and the
tasks of the consolidation group dependent task group.

See also: Consolidation Monitor [Ext.] in the Implementation Guide for Consolidation

Features
The consolidation monitor has essentially the same features as the Data Monitor [Page 20] [Page
20]. For this reason, the following will only describe the differences.

Monitor Layout

Hierarchy      
Cons Group

--

Cons Group

Cons Group
Cons Group

++

-- Cons Group

--

--

--

++ Cons Group

++ Cons Group

Hierarchy of Org. Units Tasks

Consolidation Monitor

IU Elimination Cons of Invmts Reclassification

Status Display

...

Color/Symbol Legend
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Organizational Units
In the consolidation monitor, the hierarchy of organizational units is only broken down to the
consolidation group level. This implies that the consolidation monitor executes tasks for
consolidation groups. You also have the option of running tasks directly in the SAP menu, area
Consolidation (without using the monitor). The initial screen also allows you to select
consolidation units.

Tasks
By contrast with the data monitor, the consolidation monitor requires only a few specific task
sequences. The most important requirement is that the task Validation of consolidated financial
data be run after the consolidation tasks that do postings (such as, interunit elimination). The
sequence of the other tasks can be defined in Customizing, particularly taking into consideration
the postings that build on top of other postings.

Status Management
The consolidation monitor features the additional Overall Status:

Overall Status: Data monitor unblocked

All data monitor tasks must be blocked before you can run a task in update run in the
consolidation monitor.



Consolidation (EC-CS)  SAP AG

Master Data

34 April 2001

Master Data
Use
You use master data to build up your corporate structures in the system. See the topics that
follow.
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Dimension
Definition
A specific characteristic of consolidated reporting in SAP Consolidation.

Use
In general, you define one dimension for each consolidation type [Ext.] your want to portray. You
can have multiple dimensions in the system at the same time. The standard R/3 system contains
a predefined dimension for each of the following types of consolidation: company consolidation,
business area consolidation, profit center consolidation. There is also a dimension for generic
uses.

The one-to-one relationship between dimensions and consolidation types is not mandatory. If
needed, you can portray several consolidation types within one dimension. However, doing this
can easily cause a lack of clarity of the dimension's data.

In the dimension you define your corporate structure as a hierarchy of consolidation units and
consolidation groups.

Structure
The dimension is one of the "pillars" of the architecture of SAP Consolidation. The only key field
the dimension is subordinate to (dependent on) is R/3's client. Conversely, much of the master
data and control data is subordinate to the dimension. This means that this type of data is
delimited to the dimension, in which it is created.

Dimension-dependent are:

− Organizational units

− Control data such as tasks and methods

Dimension-independent are:

− Consolidation charts of accounts

− Consolidation versions

You make some fundamental decisions in the dimension's master record concerning:

•  the organizational units in the dimension

The dimension determines the field lengths of the consolidation units and groups.

•  the consolidation entries posted in the dimension

The dimension determines whether old documents are deleted prior to re-posting, or
are reversed.
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Integration
The integration feature between Consolidation and the transaction-processing systems of SAP is
available for all dimensions you use for company consolidation, business area consolidation, or
profit center consolidation. Integration enables the Consolidation system to collect the reported
financial data directly from the operational components.
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Organizational Units
Definition
The organizational units of SAP Consolidation encompass the consolidation groups and the
consolidation units. See the topics that follow.
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Consolidation Unit
Definition
Smallest element in a corporate group structure that can be used as a basis of complete
consolidation.

Use
This business object can have different contents: A consolidation unit can be such things as a
company, business areas within a company, or profit centers within a company. What a
consolidation unit is made up of depends on the consolidation type [Ext.] for which you are using
the consolidation units.

Internal accounting transactions that are to be eliminated by consolidation are processed
between the consolidation units. In an accounting transaction, a consolidation unit can be the
triggering consolidation unit or the partner unit.

Structure
The consolidation unit depends on the dimension in which it was created. This means that the
master record you create for a consolidation unit exists only in that dimension.

You make the following entries in the master record of a consolidation unit:

•  You enter master data such as the name, language key, correspondence data, local
currency key, and the reason for inclusion

•  You enter attributes, for example the country. You can use these in reports and in
addition in the consolidation functions validation, interunit elimination and reclassification.

You can define your own attributes according to your special requirements, so-called
custom attributes of the consolidation unit [Page 69].

•  You assign control parameters such as the financial data type, translation method, tax
rate, and data transfer method

Some of the master data and control parameters that you specify in the master record is valid
only in dependency on other data. In particular, some data in the master record is date- and
version-sensitive. The following table shows the dependencies for selected data (this list is
incomplete):

Dependencies:

Fiscal
year
effective

Period
effective

Version Period
category

Ledger

Local currency X
Financial data
type

X

Data transfer
method

Version for data entry

Validation Version for data entry X
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Currency
translation
method

X X Version for currency
translation

Fiscal year
variant

X

Integration
A prerequisite for integrated data transfer in the case of company consolidations or profit center
consolidations is that the organizational units in consolidation be based on the operational
organizational units.

The maintenance screen of the consolidation hierarchy provides a function with which you can
structure the organizational units. You create rules in Customizing in which you specify which
codes and names you want the system to assign when you structure the organizational units.

See also: Copy Organizational Units [Ext.] in the Implementation Guide for SAP Consolidation

Assignment Between Operational Organizational Units and Consolidation Units

Operational Organizational Units Consolidation Units
Company code Company
Company code / Business area Company / Consolidation business area
Company code / Profit center Company / Profit center
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Consolidation Group
Definition
User-defined group of consolidation units created for consolidation and reporting purposes.

Use
In the dimension that you have chosen for your consolidation, you can use the business object
consolidation group to represent the structure of the group. Depending on the complexity of your
group, you can:

•  Group the consolidation units into a consolidation group

•  Create multiple consolidation groups and arrange them into a hierarchy.

•  Create multiple hierarchies of consolidation groups in parallel to structure the
organizational units according to different perspectives

A given consolidation unit can belong to different consolidation groups, and a given consolidation
group can belong to different hierarchies.

In each dimension, you can define the hierarchy levels and arrange these levels into the desired
sequence. You can then assign the levels to the consolidation groups of a hierarchy to clarify the
hierarchy structure.

The following graphic shows two parallel hierarchies in one dimension for a business area
consolidation. The hierarchies each use part of the hierarchy levels that were defined for the
dimension. Each consolidation group is assigned to only one level.

Group

Company

Segment

Group by Company

Hierarchy 1

Company /
Segment

Company /
Business area USA / Beverages

Group by Segment

USA / Nonfood USA / Foodstuffs

Hierarchy 2

Business area

Foodstuffs . . .

France USA . . .

. . .

Nonfood

Beverages

UK / BeveragesUSA / Soups

Soups

Dimension: Business Area Consolidation
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The next graphic shows an example of profit centers structured by group area. This is shown in a
dimension for profit center consolidation.

Dimension: Profit Center Consolidation

Group by SegmentGroup by Segment

BABA 5 5 BABA 7 7. . .. . .

SegSeg B B SegSeg C C

. . .. . .

SegSeg A A

BABA 3 3 BABA 4 4

PC PC 3131 PC PC 3232

CoCo 2/ 2/
PC PC 3232

PC PC 32A32A PC PC 32B32B

PC PC 7272PC PC 7171

CoCo 2/ 2/
PC PC 7171

CoCo 9/ 9/
PC PC 7171

CoCo 9/ 9/
PC PC 3232

...

...

... ...

...

Structure
Like the consolidation unit, the consolidation group depends on the dimension in which it was
created. The master record that you create for a consolidation group therefore exists only in that
dimension.

You specify the following information in the master record of a consolidation group:

•  You specify master data such as the name, language key, and correspondence data.

•  You assign a ledger.

 The ledger currency is determined by the currency in which the consolidation group
reports.

•  You assign control parameters such as the consolidation frequency and validation rule.

•  If applicable, you assign the lower-level consolidation units and consolidation groups.

 This is only necessary if you create the consolidation group in individual processing
rather than in hierarchy maintenance. In hierarchy maintenance, the assignment is
specified by graphic positioning of the organizational units.

•  If applicable, you enter control parameters for first consolidation and divestiture
accounting for the assigned consolidation units and groups.

 This is only necessary if you perform consolidation of investments.

•  If applicable, you assign control parameters such as the financial data type, tax rate, and
translation method.
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This is only necessary if you want to enter or post data for the consolidation group.

Integration
See also: Consolidation Unit [Page 38]

If the consolidation units are structured automatically, the system also creates consolidation
groups. The following overview shows the characteristic values of the consolidation groups:

Automatic Structuring of Consolidation Groups

Consolidation Type Entered Value
Company consolidation Consolidation group for companies
Business area consolidation •  Consolidation business area

•  Company
You choose one of the two values when you perform the
function.

Profit center consolidation •  Profit center

•  Company
You choose one of the two values when you perform the
function.
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Maintenance of Organizational Units
Use
In large groups with complex organizational structures, the number of organizational units to be
created can be very high. This component therefore provides a number of entry aids that
facilitate maintenance of the organizational units.

Features
Initial Setup of Organizational Units
There are a number of different ways to create organizational units in the system:

•  You can create the organizational units manually. In this case you can choose between
hierarchy maintenance and individual processing.

− In hierarchy maintenance, you create the organizational units from the top down. The
hierarchy maintenance screen displays the organizational units as a graphic when they
are created. The graphic provides an overview of the structure of the organizational
units. You can access the master data of the organizational units directly from the
hierarchy.

Note that the investment relationships between companies (in the case of company
consolidations) are not entered in the hierarchy maintenance screen. You enter
investment relationships in the additional financial data for the consolidation of
investments.

If you want to create more than one consolidation unit or consolidation group at a
given hierarchy level, the system provides the following assistance: You can enter
the codes and names as a list and then go directly to the master data maintenance
screen of the first organizational unit in the list. The master data that you enter there
is passed on to the other organizational units. You then only need to enter the
variances in the master data that was passed on.

See also: Maintain Hierarchies [Ext.] in the Implementation Guide for Consolidation

− In individual processing you can maintain the master data of the individual organizational
units and assign the lower-level consolidation units and groups to the consolidation
groups. When you then create the higher-level consolidation group in the hierarchy, the
lower-level organizational units are automatically included in the hierarchy.

See also: Maintain Consolidation Groups Individually [Ext.] in the Implementation
Guide

• You can use a flexible upload to copy the consolidation units (and part of their master data)
from an Excel file into Consolidation.

See also: Copy Cons Units from PC File by means of Flexible Upload [Ext.] in the
Implementation Guide

• If you transfer data for integrated consolidation data from operational components, you must
have the system automatically create the organizational units of consolidation from the
operational organizational units.

See also: Copy Organizational Units [Ext.] in the Implementation Guide
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Mass Changes
If you want to change the master data of multiple organizational units in the same way, you can
use the mass change function in Customizing: You can replace selected master data values with
new values in one step.

See also: Carry Out a Mass Change [Ext.] in the Implementation Guide

Defining Required Entries and Optional Entries
Only part of the data in the master records of the organizational units is needed for your specific
requirements. In the master record of the dimension, you can therefore define which entries for
the master data are optional and which are required.

User-Defined Fields
You can use SAP enhancement FMC10001 to develop your own screens for maintaining the
master data of the organizational units. These screens can contain additional fields with special
tables. Enhancement projects require knowledge of ABAP programming.

Reporting Options
You can list the organizational units for purposes such as producing hard copies. There are a
number of different ways to list the data:

•  In the application menu of Consolidation, choose Information system → Master data →
Consolidation units or Consolidation groups.

•  In the master data maintenance screen or display screen, choose the Print function.

The lists are formatted with the ABAP List Viewer. The List Viewer enables you to set filters or
change the content and width of the columns.

See also: ABAP List Viewer [Ext.] in the SAP Library

Generating Sets
For Report Writer reports you can have the system generate sets from the consolidation units
and consolidation groups of the hierarchy information. The system automatically offers this
function when you save the hierarchy.
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Consolidation Chart of Accounts
Definition
Systematic classification of financial statement items that enables preparation of consolidated
financial statements. The classification is based on the external or internal requirements
regarding the consolidated financial statements that you want to prepare on the basis of the
consolidation chart of accounts.

Use
For the administration of operational data, the consolidation units use local charts of accounts
with corresponding levels of detail. To enable preparation of consolidated financial statements
from the financial data of the consolidation units, however, the operational data must first be
aggregated uniformly across the group and reported to the head office. In the head office, you
therefore define one or more consolidation charts of accounts to be used by the consolidation
units.

The following overview lists the predefined consolidation charts of accounts that are included in
the standard system. These charts of accounts are structured according to statutory
requirements. You can also define charts of accounts structured according to your internal
reporting requirements.

Consolidation Charts of Accounts in the Standard System

Legal framework Industry Income
statement
accounting

Disclosure of retained
earnings

Remarks

US GAAP Manufacturi
ng

Cost of sales balance sheet See 1

EU directives Manufacturi
ng

Period income statement See 1

EU directives Manufacturi
ng

Period balance sheet See 1

EU directives Banking income statement See 2
Japanese GAAP Manufacturi

ng
Cost of sales balance sheet See 3

Notes:
1. The standard system contains subsequent Customizing settings for these consolidation

charts of accounts with the corresponding financial statement items, such as data entry
layouts.

2. The consolidation chart of accounts for Banking contains German item texts.

3. The consolidation chart of accounts for Japanese GAAP contains English item texts.

Structure
Like the dimension, the consolidation chart of accounts is one of the foundations in the
architecture of consolidation. The consolidation chart of accounts is not dependent on any data
except the client.
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The consolidation chart of accounts is therefore not dependent on the dimension.
You can use a consolidation chart of accounts for multiple dimensions or
consolidation types.

The financial statement items and the breakdown categories are dependent on the consolidation
chart of accounts.

In the consolidation chart of accounts, you arrange the items into FS item hierarchies. For
example, you define a consolidation chart of accounts with an FS item hierarchy for balance
sheet items and a hierarchy for items in the income statement.

The following graphic illustrates part of an FS item hierarchy:

01 Consolidation Chart of Accounts

Balance Sheet

Assets

Franchises
Goodwill

...

Intang. Transferred Assets

You enter the following information in the master record of a consolidation chart of accounts:

•  The name of the consolidation chart of accounts

•  The output length of the item numbers

•  How the appropriation of retained earnings is stated

•  You can also set the master record of the items to read-only.
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Financial Statement Item (and Its Subassignments)
Definition
Fundamental account assignment in the entry, posting, and reporting of quantities or monetary
values.

Use
Financial statement items can have different contents. They can represent the following:

•  A monetary amount from sources such as the balance sheet or the income statement
that are relevant to accounting

•  A statistical amount

•  A key figure

Structure
A financial statement item is valid only for the consolidation chart of accounts in which it was
created.

You enter the following information in the master record of a financial statement item:

•  Item texts

•  Properties of the item such as the item type, debit/credit sign, and where-applied
indicator

•  Subassignments

Subassignments
Through subassignments you can differentiate and "expand" the FS item values further. There
are standard subassignments which are delivered by SAP, as well as custom subassignments.

Standard subassignments are:

•  Partner unit

•  Subitem category and subitem

•  Transaction currency

•  Year of acquisition

•  Period of acquisition

•  Unit of measure

Custom subassignments could be for example:

•  Region

•  Product group

•  Distribution channel

•  And so on
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See also: Custom Characteristics [Page 63].

Subassignments keep the number of items in consolidation charts of accounts down to a
manageable level. Without subassignments, you would have to figure out all combinations of
subassignments and define them as FS items. For example, you would have to create an FS
item for receivables or liabilities for each partner unit.

Not all items require the same subassignments.

For example, you must enter the values of the items receivables and liabilities with
partner breakdown and possibly with breakdown by transaction currency if you want
to consolidate these values.

The values of the FS items of the transferred assets, however, must be differentiated
by transaction type to show an asset history sheet.

Therefore you create groups of items that require the same assignments. There are usually some
items that do not require subassignments.

Breakdown category
You define a breakdown category in Customizing for each FS item set that requires
subassignments. In the master record, you assign this breakdown category to all FS items of the
group.

With the definition of a breakdown category the system offers you all the standard
subassignments and all the custom subassignments. Per subassignment you specify:

•  Breakdown type

The breakdown type determines whether the FS item value should be expanded when
entering and posting to this subassignment and how the system should check the
respective subassignment.

The system offers the following breakdown types:

Breakdown
type

Description Meaning

0 No breakdown

1 Optional breakdown Null value allowed.

2 Required breakdown If no entry, then the system sets the default value.

3 Required breakdown The system forces the value entry; the default
value is allowed.

4 Required breakdown The system forces the value entry; the default
value is not allowed.

•  Fixed value, if applicable

A fixed value specifies the characteristic value of the subassignment and to be precise
for all FS items with this breakdown category. You enter a fixed value for the following
subassignments:
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− Subitem category (see also subitem category and subitem [Page 54])

− Unit of measure

− Custom subassignments which, in accordance with the definition, must have a fixed
value in the breakdown category.

•  Default set, if applicable

You can enter a set with default values (except with fixed value), which are to be shown
during online or offline data entry.

You will find more information on the fixed value and the default set in the Implementation Guide
for Consolidation, section Master Data, step Define Breakdown Category [Ext.].

The following graphic shows the Customizing of a breakdown category.

Dim. Chart ...

Brkd Type Fixed Value Set NameCharacteristic

Brkd cat 1000

Breakdown by Characteristic:

Partner unit

Trans. crcy

Subitem categ

Subitem

Unit / measure

...

3

3

1

CS01-1000

0101

The next graphic shows different breakdown categories from the SAP standard system and its
use:
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FS Items
Cash

Supplies

etc. 

Property/Plant/Equip

Sales revenues

etc. 

Receivables: Partners

Breakdown Categories

Partner + currency0110

Subitem = TransType1000

Subitem = Region4000

...

No subassignments-

The next graphic shows the assignment of breakdown category 1000 in the master record of a
fixed-asset item. The breakdown category means that the item values are to be broken down into
subitems. The subitem (subitem category) is used as a transaction type (subitem category with
fixed value 1).

Chart/accts

Consolidation item
Appropriation item

FS item
FS item type
Dr/Cr sign

Contra item

Where applied
FS item category

Assets
1
+
A

Breakdown category 1000

Subitem cat

Texts   Brkd Cat   Item Cat

Breakdown Information
Subassignment BD Type Fixed Value Set Name

3 1 (ttype)
Subitem 3 -

-

CS01-1000
(ttype set)
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Integration
If you want to integrate reported financial data from operational SAP applications into
consolidation, there must be a link between the operational FI accounts and (if applicable) the
secondary cost elements on the one hand, and the items of consolidation on the other:

•  If realtime update or rollup is being used, the operational accounts or the group accounts
assigned to the accounts must have the same code as the FS items.

•  If a periodic extract is being used, the items in the financial statement version (G/L
accounting) must have the same code as the items in consolidation.

To ensure that the codes match, you can create the consolidation chart of accounts based on an
FI chart of accounts or financial statement version.

You will find more information in the section Group chart of accounts, financial statement version,
consolidation chart of accounts  [Page 169]
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Maintenance of Financial Statement Items
Use
The component offers a number of functions that simplify creating and changing one or more
consolidation chart of accounts.

Features
Creating a New Consolidation Chart of Accounts
The standard system contains a number of predefined consolidation charts of accounts. You
should make use of these predefined charts of accounts if possible. This is because if you decide
to create your own consolidation chart of accounts, you must maintain the financial statement
items in many affected Customizing settings, such as differential items.

You can create your own consolidation chart of accounts or change an existing one in the
following ways:

•  You can enter or change the financial statement items manually. You can choose between
hierarchy maintenance and individual processing. The procedure is the same as with
Maintenance of Organizational Units [Page 43].

See also:

− Maintain Item Hierarchies for Cons Chart of Accounts [Ext.] in the Implementation Guide
for Consolidation

− Maintain FS Items Individually [Ext.] in the Implementation Guide

•  You can use a flexible upload to copy the FS items from an Excel file into Consolidation.

See also Copy FS Items from PC File by means of Flexible Upload [Ext.] in the
Implementation Guide

•  You can create the FS items based on an FI chart of accounts or a financial statement
version.

See also Copying FS items [Ext.] in the Implementation Guide.

Mass Changes
If you want to change the master data of multiple financial statement items in the same way, you
can use the mass change function in Customizing: You can replace selected master data values
with new values in one step.

Reporting Options
You can list the financial statement items for purposes such as producing hard copies. There are
a number of different ways to list the data:

•  In the application menu of Consolidation, choose Information system → Master data → FS
items.

•  In the master data maintenance screen or display screen, choose the Print function.

The lists are formatted with the ABAP List Viewer. The ABAP List Viewer enables you to set
filters or change the content and width of the columns.
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See also: ABAP List Viewer [Ext.] in the SAP Library.

Generating Sets
For Report Writer reports you can have the system generate FS item sets from the hierarchy
information. The system automatically offers this function when you save the hierarchy.
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Subitem Category and Subitem
Definition
Subitem and subitem category are subassignments for the financial statement items in
Consolidation. Both characteristics are in a compound with each other. The subitem is dependent
on the subitem category. The subitem category classifies the values of the subitem.

You can define more subitem category-like subassignments yourself, so-called
Custom Subassignments [Page 64]. The following should explain the concept for this
kind of subassignment.

Use
Subitems enable you to make subassignments for the item values as needed. You can use these
subassignments with various FS item sets in different ways. You define a breakdown category for
each way the subitem is used. In the breakdown category, the subitem category determines how
the subitem is to be used. This is called fixed value in breakdown category (see also: Financial
Statement Items [Page 47]).

The SAP standard system contains a number of predefined subitem categories:

•  Transaction types for transferred assets

•  Functional area

•  Product groups

•  Regions

•  Transaction types for provisions

•  Transaction types for equity

The following graphic shows the relationship between the subitem, the subitem category, the
breakdown category, and the FS item:

•  The subitems in subitem category 001 are used as transaction types. You need this
subassignment for the items of the transferred assets. In the graphic, the following
subitems are assigned to the subitem category:

− 100: Opening balance APC

− 120: Acquisitions

140: Divestitures

Breakdown category 1000 is used to assign subitem category 001 to the items of the
transferred assets.

•  With subitem category 004, the subitem is used as region. You need this subassignment
for the items of the sales revenues, for example. In the graphic, the following subitems
are assigned to the subitem category:

− Europe
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− Asia

− Africa

Breakdown category 4000 is used to assign subitem category 004 to the items for net
sales.

Item

Breakdown Categ.

Sales

0 0 0

Assets

1

Subitem Category 0 0 1

001... Transaction type
004... Regions

... ... ... ...

0 0 4 ... ... ...

...

Subitem
(Max. 10 places)

01 0

21 0

41 0

(Max. 3 places)

U R

SA I

FA R

PO E

A

CI A

E

(4 places)
0 0 04

Structure
The subitem category is not dependent on any data except the client. The subitems are
dependent on the subitem category.

This means that neither the subitems nor the subitem categories are dependent on
the consolidation chart of accounts.

You specify control parameters for the subitems in the master record of the subitem category.
You maintain the master records of the subitems in dependency on these control parameters.

Integration
In integrated data collection, the subitem can be filled from the accounting document. You specify
which sender field is transferred into the subitem in the master data of the subitem category.
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Version
Definition
Identifies a separate area in the consolidation database.

Use
Versions make it possible to consolidate financial data according to different criteria. Managers
frequently require financial data to be prepared and consolidated according to different criteria or
using different valuation approaches.

Versions enable you to:

• Manage and consolidate different categories of data separately, such as
actual data, budget data, forecast data, or long-term planning data

• Perform simulations for your consolidated data, such as:

• Simulating the effects of various exchange rates on your
consolidated financial statements

• Simulating the effect of the divestiture of a consolidation unit on your
consolidated financial statements

• Prepare restatements — that is, apply the current "settings" to data of a
previous period

For example, if you changed the consolidation hierarchy, you could
report the data of the previous fiscal year in the new hierarchy as a
restatement.
In simple cases, you can perform such restatements using the
functions of reporting without using a new version: You could effect
the restatement using a drilldown report if the report does not include
postings that are dependent on the consolidation group.

• Prepare different consolidated financial statements in parallel in accordance
with different statutory accounting requirements, such as according to
GAAP, IAS, or HGB (German accounting law).

• Adapt the "normal" consolidated financial statement for value-based
management to be able to calculate performance key figures

• And so on

Structure
The version concept in the SAP Consolidation component includes a number of "version building
blocks" that together eliminate redundancy and facilitate data management.
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Consolidation Versions and Special Versions
Consolidation Versions
Consolidation versions are used to record, consolidate, and report the financial data collected
from consolidation units. A consolidation version is the version in which a consolidated financial
statement is prepared. Alternative consolidated financial statements (see the section Use) can be
represented in different consolidation versions.

Along with dimensions, consolidation charts of accounts, subitem categories, and ledgers,
consolidation versions are one of the foundations in the architecture of consolidation. That is,
consolidation versions are not dependent on any data except the client. Instead, much of the
data depends on the consolidation version.

Special Version
The system stores the totals data of consolidation in the consolidation version. Control
parameters are required to process this totals data. Each task accesses both Customizing data
and master data. A task may also access additional financial data. The system manages much of
this data in special versions. The system uses one or more special versions for each process in
consolidation.

There are special versions for:

• Tasks such as data entry, currency translation, or reclassification

• Additional financial data for consolidation of investments

• Master data such as hierarchies of consolidation groups and ledger
assignments

Relationship Between Consolidation Version and Special Version
Special versions eliminate the need for multiple entry of control parameters that are identical in
different consolidation versions. Such data only needs to be entered once in special versions.

You assign the special versions that apply to a particular consolidation version to that
consolidation version in Customizing.

The following graphic illustrates this. Consolidation versions 001 and 002 differ only in the
exchange rates. Otherwise the same special versions are assigned to these versions.
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Consolidation Version 001 Act.

Data entry 001

Ledger 001

Selected items 001

Structure 001

... 001

Exchange rates 001

Reclassifications 001

...

Exchange Rates

Consolidation Version 002 Plan

Data entry 001

Ledger 001

Selected items 001

Structure 001

... 001

Exchange rates 002

Reclassifications 001

...

Version From To Rate
001 USD DEM 1.50
002 USD DEM 1.80

When you perform a task in a consolidation version, the system reads the special versions that
are relevant for that task and that are assigned to that consolidation version. The system uses
the special version to read the relevant Customizing data and the master data or additional
financial data stored in special versions.

The following graphic shows how the system does this:
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Global
Parameters

Special
Version

Special
Version

Special
Version

CustomizingTotals Data
Data

Processing

Consolidation
Version

There is also Customizing data that depends directly on the consolidation version
and that is not stored in special versions. For example, the assignment of a
consolidation frequency to a consolidation group and the assignment of a task group
to a dimension depend directly on the consolidation version.

The following overview lists some of the data that depends on special versions:

Data That Depends On Special Versions

Special Version Dependent Data
Data entry Assignments to consolidation unit:

- Data transfer method, upload method, logical file name,
validation, and so on
- Data entry profile

Ledger Assignment of ledger and local currency to consolidation group
Selected FS items Definition of selected FS items
Structure Hierarchy of consolidation groups

Assignment of consolidation of investments method
Tax rate Definition of tax rate of consolidation unit
Translation method Assignment of translation method to consolidation unit
Exchange rates Assignment of exchange rate type to exchange rate indicator
Reclassifications Assignment of method and document type to task
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Elimination of IU profit and
loss

Customizing:
- Definition of posted items
- Definition of task

Additional financial data:
- Inventory data and supplier data

Consolidation of
investments method

Assignment of consolidation of investments method
Assignment of document type to the task or to activities/accounting
techniques

Investment Values of changes in investments
Group shares

Equity Values of the changes in investee equity
Values of equity holdings adjustments

Fair value adjustments Customizing:
- Amortization and prioritization of fair value adjustments
- Values of the fair value adjustments

For the task Interunit Elimination, there are task versions that are assigned to the
interunit eliminations in Customizing for consolidation versions.

See also: Interunit Elimination [Ext.] in the Implementation Guide for Consolidation

Normal Versions and Add-On Versions
Some of the application examples in the section Use involve deviations from normal
consolidation. The version concept therefore makes a distinction between normal versions and
add-on versions.

For example, suppose you want to prepare consolidated financial statements in
conformity with the statutory accounting requirements of HGB and a reconciliation in
conformity with GAAP. For the reconciliation, you want to post supplementary
entries.

You prepare the consolidated financial statements in conformity with HGB in the
normal version, and save the supplementary entries in an add-on version.

An add-on version always references another version (called the base version). In reports for an
add-on version, the system also includes the data of the base version. The base version can be a
normal version (in the above example, the version for the HGB financial statements) or another
base version.

In the definition of a version in Customizing, you can specify a base version in two places:

•  You can specify a base version for the consolidation version.

•  You can specify a base version for the structure version (special version; see earlier).

You can also copy the data of one consolidation version into a second consolidation version and
perform the supplementary postings in the second version. The drawbacks here are that the
copied data is redundant, and changes made in the first version are not automatically reflected in
the second version.
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The following graphic shows the methods available for including the data of one consolidation
version (version 1 in the graphic) in other consolidation versions, and why this may be required:

New

Add-on version
Japanese GAAP
Reference to version 1

Add-on version
Japanese GAAP
Reference to version 1

Version 2:   Actual - Japanese GAAPVersion 2:   Actual - Japanese GAAP

Version 3:   Simulation DivestitureVersion 3:   Simulation Divestiture
Add-on version
US GAAP
Reference to version 1

Add-on version
US GAAP
Reference to version 1

Version 4:   Simulation ConversionVersion 4:   Simulation Conversion
Normal version
US GAAP
Copy of version 1

Normal version
US GAAP
Copy of version 1

Version N:   Budget, Plan, ForecastVersion N:   Budget, Plan, Forecast

Normal version
US GAAP
Normal version
US GAAP

Other GAAP

Other Data

Simulation

Restatement
Normal version
US GAAP
Normal version
US GAAP

Version 1:  
Actual - US GAAP
Version 1:  
Actual - US GAAP

Reference

Ref.

Copy

Data Collection

The next graphic shows an example for an add-on structure version:

Add-on structure version
Change in hierarchy of consolidation groups
Reference to version 1

Add-on structure version
Change in hierarchy of consolidation groups
Reference to version 1

Reference
Normal structure version
Hierarchy of consolidation groups
Normal structure version
Hierarchy of consolidation groups

Structure Version 1:  Actual - GroupStructure Version 1:  Actual - Group Structure Version 2:  Simulation DivestitureStructure Version 2:  Simulation Divestiture

Simulation



Consolidation (EC-CS)  SAP AG

Ledger

62 April 2001

Ledger
Definition
Contains transaction figures and documents showing the changes in the values and quantities
resulting from accounting transactions.

Use
The currency of the ledger determines the currency in which the consolidation groups carried in
the ledger report their financial data. This is therefore the consolidation group currency.

If you want to consolidate in different currencies, you need a separate ledger for each currency.

The following graphic illustrates this:

Ledger in DEM Ledger in USD

USA Canada

Totals Database

ECMCT

Germany Switzerland

Consolidation Group 1

Consolidation Group 2

Structure
The structure of the ledger is determined by the totals table ECMCT.

You assign a ledger to each consolidation group in the master record of the consolidation group.
The system saves the assignment in a specific ledger version. This means that you can assign
different ledgers, and therefore different consolidation group currencies, to a consolidation group
in different consolidation versions.
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Custom Characteristics
Use
SAP delivers a large number of predefined characteristics in the consolidation database, for
example the consolidation unit, the financial statement item, the subitem and so on. If your
group’s need for information exceeds that and you therefore want to carry out additional account
assignments, then you require so-called custom characteristics.
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Custom Subassignments of the Financial Statement
Item
Definition
Characteristic that is defined by customers to enhance the transaction data of consolidation
(totals records and line items).

Use
You can enhance the transaction data of consolidation with up to five subassignments, for
example with the subassignment of the product group, the region, the division or the distribution
channel. This enhancement is necessary, if the subassignments which SAP delivers, do not
cover your group’s need for information.

The following standard subassignments for the financial statement item are delivered
by SAP:

•  Partner unit

•  Subitem categories and subitems

•  Transaction currency

•  Year of acquisition

•  Period of acquisition

•  Unit of measure

Just like the standard subassignments, you can control which items are to be posted and entered
with the custom subassignments via the breakdown category.

Differentiation of the Usage Possibilities of the Subitem
You can specify any number of breakdowns for the item values via the standard characteristics
Subitem Category and Subitem [Page 54], by maintaining several values for the characteristic
subitem category (for example region, functional area, transaction type and so on). However, you
can only use one subitem category per item (as a fixed value in the breakdown category).

By defining additional subassignments you can specify several custom breakdowns per item.

Structure
Definition of Characteristic
You define the subassignments at the beginning of Customizing for Consolidation.

You can define existing entities of other SAP components as subassignments, for example the
characteristics country, region or functional area. But you can also define new entities whose
technical environment (Data Dictionary, program, maintenance interface and so on) have to be
generated again. You carry out the generation in Customizing. You do not have to carry out any
programming work.
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The custom subassignments enhance the totals database and the line item database
of consolidation with additional key fields. Depending on the usage of this
subassignment, the data volume in the database can increase greatly.

For more information on the definition of subassignments, see the Implementation Guide (IMG)
for Consolidation in step Add Characteristics [Ext.].

Dependency between Custom Subassignments
Consolidation supports the following combinations:

•  Independent characteristics

These are characteristics whose values you define independently of the values of the
other characteristics.

Product group

•  Characteristics in a compound

These are pairs of characteristics in which one of the characteristics is an independent
characteristic. The values of the second characteristic (dependent characteristic) are
dependent on the values of the independent characteristic.

Country and region

The country is the independent characteristic and the region is the dependent
characteristic. In every country there are different regions.

Note that Consolidation does not support any combinations where there are more
than two characteristics in a compound.

•  Subitem category-like characteristic

These are characteristics in a compound where you set a fixed value in the breakdown
category for the independent characteristic.

Characteristic pair Subitem Category and Subitem [Page 54]

You use this combination when you require more than five additional subassignments,
but you do not want to simultaneously expand an individual item. For each
subassignment which you want to portray through this, create a value for the
independent characteristic (for example the value functional area). You assign this value
via the breakdown category of the respective item which should be expanded by this
subassignment. You maintain the value of the subassignment (for example the different
functional areas) in the independent characteristic.
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Characteristic Values
The characteristic values are the master data of the characteristics. You maintain this master
data in the IMG of Consolidation in section master data, step Custom Subassignments: Define
Characteristic Values [Ext.]

For characteristics which you have defined with reference to entities in other SAP components,
the system offers the master data maintenance of the corresponding SAP components.

For characteristics which you have defined with a new check table, the system offers a
maintenance transaction which was specially generated for this. In addition to this you can
transfer values by means of a flexible upload in the system.

Default Values
While defining a  subassignment you can decide whether you want to maintain a default value.
You maintain the default values in the IMG of Consolidation in section master data, step Define
Default Values for Subassignments  [Ext.]

In exactly the same way you can enter a default value for the standard
characteristics partner unit and subitem.

You can use the default value of a subassignment as follows:

•  For entry and manual posting

In the breakdown category, you can specify that the system updates the default value
when you do not enter a value for the characteristic.

•  For automatic postings

For example in Customizing you can specify that the system posts the default value for a
subassignment if it can not derive the value from the triggering document line item. For
more information, see the R/3 Library for each consolidation function.

For dependent characteristics you can enter a default value for the dependent
characteristic for each value of the independent characteristic.

Hierarchy
For every custom characteristic you can maintain the hierarchies manually. These hierarchies
can be displayed in research and active excel reports.

In exactly this way you can maintain hierarchies for the standard characteristics item,
acquisition year, acquisition period, sub-item and document type.

For more information, see the IMG of Consolidation in section master data, step Maintain
Hierarchies for Characteristics [Ext.].
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Custom Subassignments in Consolidation Functions
Features
The custom subassignment are taken into account in almost all of the functions of Consolidation.
An overview is given below, for more information see the R/3 Library for each consolidation
function.

Data Collection
With all data collection methods you can transfer the reported data with details to the custom
subassignments. You carry out the corresponding enhancements in the settings of methods in
Customizing.

Currency Translation
You can post currency translation differences or rounding differences with custom
subassignments. You control this with the breakdown category of the differential item.

Validation
You can define validation rules, which take custom subassignments into account.

Interunit Elimination
You can use custom subassignments both with the sets to be eliminated and with the differential
items.

Reclassifications
You can use custom subassignments both with the triggering account assignments and with the
source and target account assignments.

Elimination of Interunit Profit/Loss in Transferred Inventory
Product Group as Custom Subassignment
If the system is to read the inventory data from the summary database, then you have to define
the product group as a subassignment.

Other Custom Subassignments
The system posts the elimination of interunit profit and loss with the subassignment which you
have entered in Customizing with the posting item.

If in the message of inventory data, subassignments are given as well, then the system can not
prove the intercompany profit per value of this subassignment.

Consolidation of Investments
The system can only post the custom subassignments to the special posting items.

More Functions
With the following functions, the system posts the custom subassignments without having to
carry out special settings to do this.
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•  Determination of the contra item and calculation of the retained earnings or annual net
income.

•  Apportionment

•  Preparation for consolidation group changes

•  Carrying forward of balances

Reports
In active excel, research, report writer and line item reports, as well as in database listing, the
system treats the custom subassignments exactly like the standard subassignments.

In addition to that the hierarchies to the subassignments can be displayed in active excel and
research reports.
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Custom Attributes of the Consolidation Unit
Definition
Characteristic that is defined by customers to enhance the master record of consolidation units.

Use
You can define any number of attributes for the consolidation unit. You can use these attributes
in some consolidation functions and in reports.

All custom attributes are of equal importance to the standard attributes of the consolidation unit.

SAP delivers the following standard attributes for the consolidation unit.

•  Country

•  Company

•  Business area

•  Controlling area

•  Profit center

Differentiation of the SAP enhancement
You can use SAP enhancement FMC10001 to develop your own screens for maintaining the
master data. These screens can contain additional fields with your own defined tables. However
this enhancement requires extensive programming work by the customers. In contrast to that,
you do not have to carry out programming work with the custom attributes for the consolidation
unit.

Structure
Definition of Characteristic
You define the attributes at the beginning of Customizing for Consolidation.

You can define existing entities of other SAP components as attributes. But you can also define
new entities whose technical environment (Data Dictionary, program, maintenance interface and
so on) have to be generated again. You carry out the generation in Customizing.

All custom characteristics which are not marked as subassignments, can not be assigned to the
characteristic consolidation unit as an attribute. The system automatically assigns the
characteristics partner unit and investee to the attribute.

For more information on the definition of subassignments, see the Implementation Guide (IMG)
of Consolidation in step Add Characteristics [Ext.].

Characteristic Values
The characteristic values are the master data of the characteristics. You maintain this master
data in the IMG of Consolidation in section master data, step Custom Attributes: Define
Characteristic Values [Ext.]
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For characteristics which you have defined with reference to entities in another SAP component,
the system offers the master data maintenance of the corresponding SAP components.

For characteristics which you have defined with a new check table, the system offers a
maintenance transaction which was specially generated for this. In addition to this you can
transfer values by means of a flexible upload in the system.

Maintenance of Organizational Units
When you have defined attributes for the characteristic consolidation unit, then in the master
record of the consolidation unit under the tab page attributes, you can enter values for the
attribute and therefore assign the respective consolidation unit.

The system saves these values  version and time-dependent.

•  As version it saves the attribute version which the current consolidation version is assigned
to (global parameter).

•  The assignment is valid from the current fiscal year and from the current period (global
parameter).
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Custom Attributes in Consolidation Functions
Features
You can use custom attributes as well as all standard attributes for the consolidation unit in the
following Consolidation functions:

•  Validations

You can define validation rules, which take custom attributes into account.

•  Interunit Elimination

You can enter the method attributes in Customizing in order to restrict the data to be
eliminated per set.

•  Reclassifications

You can enter attributes as triggering account assignments.
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Data Collection
Purpose
Consolidated financial statements are created on the basis of financial data reported by individual
consolidation units, and sometimes so-called additional financial data reported as well by said
consolidation units. This data must therefore be collected in the consolidation application.

You require additional financial data if you want to carry out the functions consolidation of
investments or elimination of interunit profit and loss in inventory.

This component contains the functions for collecting the data.

Features
You execute the task of "data collection" in the Data Monitor [Page 20]. The task features the
following activities:

•  Collection of reported financial data

•  Manual posting

•  Collection of additional financial data

The following illustration shows an example of the selection screen, which appears after starting
the task Data Collection for the consolidation unit Pharma 1:

-- Segments

++ KonsGüter Non-food

-- Pharma

--

--

--

++ Elektronik

++ Andere

 Datenübern. Valid. RFDGesStat. ...

Pharma-2

Pharma-3

Data Collection: Update Mode

Data Entry

Data Entry

Data Entry

Flex.Upload 

Consolidation Unit: Pharma 1

...

Name
Reported Data

01-1000 Balance Sheet
D.E.Layout

Name
Manual Posting

05 Adjustments/RD
Doc. Type

Additional Financial Data

Supplier data
Inventory  data

Change in investments
...

Collection of Reported Financial Data
In Customizing you assign a method for collecting the reported financial data to each
consolidation unit (data transfer method).
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The following data transfer methods are available:

• Online data entry in the SAP System

• Offline data entry on the basis of Microsoft Access, with the option of using the Interactive
Excel interface

• Integrated data collection

− Realtime update

− Periodic extract

− Rollup

• Flexible upload from a non-SAP system

The procedure for collecting reported financial data depends on the methods you assign to the
consolidation units. The following overview shows when each method can be used, and how
each method is started in the monitor:

Data transfer methods for data collection

Method Use Execution in the Monitor

Online data entry Manual data entry using data
entry layouts is available for any
consolidation scenario.

Special consideration: You can
use online data entry even if a
different method is assigned to
the consolidation unit in its
master record.

With this method you only run data
collection for a single consolidation
unit. You only start the online data
entry for a group, when the
consolidation group itself is
ascertainable.

The selection screen lets you
choose all relevant data entry
layouts.

Offline data entry,
flexible upload

You use these methods if one or
more units do not use
integration, but keep their
financial data on a PC.

This method allows you to run data
collection for a single unit as well
as an entire group.

Realtime update You can use this method for
integrated data collection if one
or more units keep their financial
data in the same SAP system
and client.

Restriction:
You cannot use this method for
profit center consolidation.

There is no need to run a task in
the monitor because the G/L-
related postings are updated in the
Consolidation system in "realtime".
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Periodic extract You can use this method for
integrated data collection if one
or more units keep their financial
data in any SAP system.

The data collection takes place
with an extract from the
consolidation staging ledger.

Restriction:
You cannot use this method for
profit center consolidation. In
addition you cannot copy the
functional area, as this field is not
contained in the totals table of
the consolidation staging ledger.

This method allows you to run data
collection for a single unit as well
as an entire group.

Rollup With this data collection method,
you can transfer the reported
financial data from any ledger
into Consolidation.

Note:
You can transfer the reported
financial data for integrated profit
center consolidation per rollup
from the profit center ledger.

Manual Posting
The data collection task features an option for manually posting entries. These must use
document types that:

•  have a posting level less than 20

•  are defined for manual postings

•  are not assigned to any tasks

For example, the standard SAP system includes a document type for posting adjustments to
reported financial data.

Collection of Additional Financial Data
Additional financial data can be:

•  entered manually

•  collected using the flexible upload method

As an alternative, for certain additional financial data of consolidation of investments you can go
to Customizing and determine that the data is to be gathered directly from the totals database.

Before you collect the additional financial data, customize the additional financial data in the
Implementation Guide for Consolidation for the areas:

Elimination of Interunit Profit/Loss in Transferred Inventory [Ext.]
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Consolidation of Investments [Ext.]

You can collect the additional financial data for a single consolidation unit or for an entire
consolidation group.

Special consideration
Status management lets you collect additional financial data even if the data collection task is
already blocked. At the time of the collection of reported financial data it is often unclear which
additional financial data will be needed. However, subsequent collection of additional financial
data can cause the system to unblock tasks that have already been carried out.

Case in point 1: Additional financial data for the consolidation of investments
Say, you collect additional financial data for the consolidation of investments after the tasks in the
data monitor have been completed, or even after the consolidation of investments task has been
run. Then the system unblocks the task for validating the standardized financial data as well as
all of the tasks that follow.

Case in point 2: Additional financial data for the consolidation of investments, currency
translation with key 3 and 4
Same as case 1. In addition, assume that the equity and investment values are translated
historically using the additional financial data. Then the system unblocks the currency translation
task along with all tasks that follow.

Case in point 3: Additional financial data for the elimination of interunit profit and loss in
inventory
Same as case 1.

Hence, SAP recommends that you collect the additional financial data directly after
the collection of the reported financial data.
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Online Data Entry in the SAP System
Purpose
This component enables you to enter reported financial data online using data entry layouts.

Implementation Considerations
Install this component if you want to enter reported financial data online in the SAP System for at
least one consolidation unit or consolidation group.

Online data entry in the SAP System is one of the methods available for collecting data in the
Consolidation application. You can also use the following methods:

•  Automatic data transfer from SAP Systems

•  Data transfer using the offline data entry program on the basis of Microsoft Access

•  Data transfer from non-SAP systems using the flexible upload program

The options you choose depend on the organization of your corporate group and the systems it
uses.

Features
Using the data monitor, you enter financial data online which was reported by those consolidation
units for which you specified this data transfer method.

You enter the data in data entry layouts. You can use these layouts to enter the individual
financial statements of your consolidation units, for example.
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Data Entry Layout
Definition
Form for entering financial data reported by consolidation units and consolidation groups.

Use
Data entry layouts are used for entering reported financial data both online in the SAP System
and offline on the basis of MS ACCESS. You can use various layouts, depending on the type of
data to be entered and the level of detail involved.

Structure
You define the layouts that you require in Customizing, in the section Define Data Entry Layouts
[Ext.].

Each definition is valid for a particular consolidation chart of accounts. You can also restrict a
layout to a particular fiscal year, period, version, dimension, consolidation unit and/or unit of
measure.

When you define a data entry layout, you specify its structure. A layout consists of a header and
an input area.

•  The header data specifies the fiscal year, period, chart of accounts, consolidation unit, and
so on, for which you are entering data.

•  The input area is where you enter financial data. It consists of lead columns and value
columns:

− Lead columns contain characteristics. Financial statement (FS) items, measure of unit
and all subassignments (partner unit, subitem, transaction currency, year of acquisition,
period of acquisition and all custom subassignments) are supported as characteristics.

The line structure of the data entry layout is a combination of characteristics and their
corresponding values. This structure usually consists of FS items and their breakdown by
subassignments.

− Value columns contain key figures. Group currency, local currency, transaction currency,
and quantity are supported as key figures.

You enter reported financial data in the value columns. Depending on how you define
your value columns, you enter data in one or more currencies, or as quantities.

You can also define comparative value columns, for example to display the data from
the prior year as a comparison. Comparisons are possible for the characteristics
fiscal year, FS item and version.

In addition to that you can define the value columns with formulas, for example to
display the difference between the current local currency values and the local
currency values of the prior year.

You also have the possibility to use Microsoft Excel functions: The data entry layouts, which were
already defined, can be reworked with Excel functions, for example formatting, and then entered
in the financial data spreadsheet.
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For further information, see the Implementation Guide (IMG) step Define Data Entry Layouts
[Ext.].
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Data Entry Using Flexible Layouts
Use
You use data entry layouts to enter the data of your consolidation units/groups online. You can
use various layouts, depending on the type of data to be entered and the level of detail involved.

Features
You can define your own data entry layouts in Customizing:

•  For each layout, you can define a specific structure and determine which currencies/units of
measure can be entered.

•  The lines in a layout usually contain financial statement (FS) items and their breakdown by
subassignments. You can determine which breakdowns are used during data entry in one of
the following ways:

− Specify fixed values for breakdowns in the definition of the data entry layout.

When you access this layout in order to enter data, it automatically contains the
appropriate breakdowns.

− Specify variables for breakdowns in the definition of the data entry layout.

Either you need to enter values in the initial screen for data entry, or the system uses
groups which you can specify in the definition of breakdown categories for your FS
items.

When entering data, you are not restricted to the breakdowns you preset. You can also
manually add new lines with additional breakdowns for your FS items.
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Entry of Different Currencies, Entry of Quantities
Use
You can use data entry layouts to enter both monetary values and quantities for your
consolidation units/groups.

•  Monetary values can be entered in local currency, transaction currency and/or group
currency.

•  Quantities can be entered: for example, number of employees, number of shares, barrels of
oil.

Both currencies and quantities can be entered in the same data entry layout.
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Entry of Data Meeting Local and Group Requirements
Use
Financial data reported by your consolidation units either meets the local requirements of those
units, or has been adjusted to meet your group’s requirements. Local and group requirements
can differ, particularly if you are performing a statutory consolidation of data.

•  If reported data meets local requirements, you can enter it in the Consolidation application
and then post standardizing entries so that it meets the group’s requirements. You can use a
separate posting level for standardizing entries in order to distinguish them from other
entries.

•  If the reported data has already been adjusted to meet group requirements, you do not need
to post standardizing entries after entering it in the Consolidation application. If you need to
post any corrections, you can use a separate posting level for this.
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Entry of Periodic or Cumulative Data
Use
If you are using online data entry as your data transfer method, you can decide what type of data
you want to enter for each consolidation unit. You can enter data periodically or cumulatively.
Cumulative entry is the most common input type.

Features
•  For periodic entry, you enter the change in the total value since the last data entry as the

periodic value.

•  For cumulative entry, you enter the total value as of the entry date.

The input type only determines the type of values you enter in the data entry layout. Irrespective
of the input type you choose, the system always saves the change in the total value as a periodic
value in the database.
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Entry of Data with Financial Statement Item Breakdowns
Use
You can enter data for financial statement (FS) items, broken down by the relevant subitems,
partner units, transaction currencies, year of acquisition, period of acquisition or custom
subassignments. You enter a breakdown category in the FS item master data to specify the
breakdown you require for an item. For example, you can specify that you want payables and
receivables items to be broken down by partner unit.

It is technically possible to break down subitems by FS item, however, it is more usual to break
down items by their subassignments.

In order to enter online in data entry layouts, using FS item breakdowns, you need to set up
appropriate “lead” columns for your layout in Customizing.

Features
You define lead columns for the FS item and its breakdown by subassignments. You sort these
columns to match the structure of the financial data you want to enter.

The following table shows some possible combinations of lead columns in a data entry layout:

Example Lead column 1 Lead column 2 Lead column 3
1 Financial Statement Items
2 Financial Statement Items Subitem
3 Financial Statement Items Partner unit
4 Financial Statement Items Subitem Partner unit
5 Financial Statement Items Partner unit Transaction currency

Data entry for FS items with breakdowns depends on the combination of lead columns and on
the breakdown category of the individual items:

•  The combination of lead columns determines which breakdowns are supported by a
particular layout.

•  The breakdown category of each individual FS item determines how that item is broken
down.

Data for an FS item must always entered with the highest possible level of detail. If an item’s
breakdown category specifies a breakdown that is not set up in the data entry layout you are
using, you cannot enter data in the layout for that particular item.

The following table summarizes the requirements for entering data for an FS item in a layout,
using a breakdown by subitem as an example:

Requirements for entering data with subitem breakdown

Is a subitem breakdown
specified by the
breakdown category?

Is a lead column for
subitems set up in the
layout?

Can data be entered for the
breakdown by subitem?
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Yes Yes => Yes. You can enter data for the
breakdown.

Yes No => No. The layout does not allow data
entry for the breakdown.
You cannot use this layout to enter
any data for the FS item.

No Yes => No. The FS item is not set up to allow
this breakdown.
You can enter data for this item
without a breakdown.



 SAP AG Consolidation (EC-CS)

Examples of Financial Statement Item Breakdowns

April 2001 85

Examples of Financial Statement Item Breakdowns
If you want to enter balance sheet values for a consolidation unit, you use a layout which enables
data to be entered for FS items, with a breakdown.

Example 1
The following table shows an extract from a data entry layout for FS items with a breakdown by
subitem (in this case transaction type).

Excerpt from a data entry layout

Financial
Statement
Items

Transaction type Local currency USD

...

191100 Real estate 100 Opening balance 10,000,000.00

120 Acquisitions 200,000.00

220 Depreciation 0.00

... ...

191500 Machines and
equipment

100 Opening balance 50,000.00

120 Acquisitions 2,500.00

...

Example 2
The following table shows an extract from a data entry layout for FS items with a breakdown by
partner unit and subitem (in this case transaction type).

Excerpt from a data entry layout

Financial
Statement Items

Partner unit Transaction type Local currency
USD

...

170100 Proportionate
shares in affiliated
cos

Cons unit 1 100 10,000,000.00

120 100,000.00

220 0.00

...

Cons unit 2 100 2,000,000.00
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120 250,000.00

...

130100 Loans to affiliated
companies

Cons unit 1 100 50,000.00

120 0.00

...

Cons unit 2 100 0.00

120 0.00

...
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Online Entry of Reported Financial Data in the SAP
System
Purpose
Before you execute any consolidation tasks, you need to collect the financial data reported by
your consolidation units in the Consolidation application. Use the process described below if you
want to enter data for one or more consolidation units online in the SAP System. You need to do
this in the following cases:

•  The consolidation units do not manage their financial data in a SAP System. You
therefore cannot transfer the data automatically in the consolidation processing ledger.

•  For technical or organizational reasons, the consolidation units can neither transfer their
financial data to the Consolidation application using the offline data entry program based
on Microsoft Access, nor transfer into the Consolidation application by means of a
flexible upload.

Prerequisites
When you set up master data in the Consolidation application, you specify a data transfer
method for each consolidation unit. You apply this process to all units which have online data
entry in the SAP System specified as the data transfer method.

You can also enter reported financial data online for the consolidation units, which
you have assigned to another data transfer method in the master record. Therefore
online data entry is possible for all consolidation units.

Process Flow
1. You provide your consolidation units with printouts of the data entry layouts.

2. The consolidation units fill out the data entry layouts with their financial data, and return them
to the group headquarters.

3. You access the data monitor from the Consolidation menu and choose the data entry
function. You then specify the data entry layout and consolidation unit/group in the initial
screen. The systems refers to the global parameters for further selection criteria.

4. The system checks the following:

– Does the data entry layout exist for the selected chart of accounts?

If your layout has any fixed values in its general data selection (for example, period,
version, dimension or consolidation units), the system checks to see if these
correspond with the selection you use to access data entry.

– Does the data entry layout belong to the data entry group assigned in the unit’s data
entry profile?
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− Is the language specified for the data entry layout identical to the logon language? If
necessary, you can translate the texts of a layout (refer to the section Preparing for
Production [Ext.] in the Consolidation Implementation Guide).

The following overview shows how the system determines a consolidation unit’s data
entry profile and assigned data entry layouts. On the basis of your selection criteria, the
system reads your Customizing settings to find the applicable data entry layouts.

Selection criteria

Assigned data entry
layouts

Data entry profile

Dimension Cons version

Data entry
 layouts

Special version
for data entry Period category

Cons unitYear Period

Data entry
 group

Financial data
type

5. You then enter the reported financial data using a data entry layout.

If you have activated Microsoft Integrated Excel in Customizing, step Define Data
Entry Groups [Ext.], then the system starts the Excel spreadsheet, and you enter
your financial data in it.

Result
After you have entered data, you run validations to check that it is consistent. Then you proceed
with your remaining consolidation tasks.
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Entering Reported Financial Data Online
Procedure
1. In the Consolidation menu, choose Data collection → Monitor.

2. Check the global parameters by choosing Environment→ Global parameters.

3. Put the cursor on the consolidation unit for which you want to enter data and the task for data
entry, and choose Update run.

4. Select a data entry layout and choose Enter.

5. If you have entered variables instead of fixed values or a range of values in your definition of
the subassignments, you are required to enter values for the variables in the following
screen.  Enter these values and choose Goto → Reported data.

Further procedures are dependent on whether you have activated Integrated Excel in
Customizing, step Define Data Entry Groups [Ext.].

Further Procedures for Data Entry without Integrated Excel
1. The data entry layout appears. This contains header data, lead columns and value columns.

To reduce the amount of information on the screen, you can hide the header data if you do
not need it for reference.

2. Enter the financial data in the value columns. You enter values for items and subitems
without a debit/credit sign. The system automatically determines the sign from the item
master data.

•  Your financial statement items show any breakdowns that are specified both
in the layout and in the breakdown category for the individual items.

•  If an item has a breakdown, its identifier and text are displayed in the first
row only (for the first breakdown), and you only see the breakdown
information. This feature makes it easier for you to locate individual items in
the input area. However, you can show the item information in all rows again
by choosing Settings → All key values on/off.

•  The system automatically inserts 0.00 in any lines where you cannot enter
values (for example, a totals item).

•  Totals items are displayed if you specifically specify this by choosing
Settings → Lead columns. However, this is only possible if you specified a
set generated for item hierarchies as the characteristic value for the item in
the layout definition.

3. If you want to make an additional entry with a subassignment value, for a financial statement
item in your layout, which will not be displayed as the default value, then use the empty lines
at the end of the layout.

To move the new entry to the correct position, choose Refresh. The new entry will only
be displayed if you entered a value other than zero.
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4. Save your entries.

5. To print out the layout with the data you entered,  choose Reported data → Print reported
data.

Further Procedures for Data Entry with Integrated Excel
1. If in Customizing, you have only set the indicator for the use of Integrated Excel and have not

designed any spreadsheet templates, then the system presents the data in the data entry
layout, without formatting, in the upper left corner of the new spreadsheet.

If you have designed a spreadsheet template in Customizing, then the system opens it.

2. Enter your financial data. Note the following:

a. Avoid the following Excel functions:

i. Delete

ii. Insert

iii. Sort

When you use these Excel functions, then the system cannot import the data
correctly into the database.

b. If you want to delete the values entered, then choose Edit → Delete, in the SAP menu.

c. The ready for input status of individual cells corresponds to how they were defined in the
data entry layout, provided that the Excel spreadsheet is protected.

d. The SAP system only imports data from the first spreadsheet of an Excel folder.
Therefore you can execute additional calculations or insert diagrams in the second
spreadsheet.

e. If you enter Excel formulas in the SAP data area, these are overwritten when posting
with the result of the formula, and the formula itself is lost.

f. When you want to save, no cells can processed in Excel at that point. You can control
this by showing the formula bar in Excel (View → Formula bar in Excel).

The following functions, which the system offers when you enter financial data with
data entry layouts, are not supported when using Integrated Excel:

•  FS item hierarchy display

•  The following functions under the menu option Settings:

•  Number format

•  All key values on/off

•  Header presentation on/off

3. If you want to make an additional entry with a subassignment value, for a financial statement
item in your layout, which will not be displayed as the default value, then use the empty lines
at the end of the layout.

To move the new entry to the correct position, choose Refresh. The new entry will only
be displayed if you entered a value other than zero.
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4. Save the data.
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Offline Data Entry with Interactive Excel
Purpose
This component enables a consolidation unit to enter its financial data locally in user-defined
matrices, save it to a Microsoft Access database for the offline data entry program, and then
transfer it to a central SAP System.

Implementation Considerations
You can use this component if, for technical or organizational reasons, the following methods of
data entry are not feasible or desired for the parent and subsidiary in question:

•  Online data entry in the SAP System

•  Integrated data transfer from an SAP System

•  Flexible upload from a non-SAP system

•  Offline data entry with Microsoft Access as a standalone solution for decentralized data
entry

As a tool for entering data in an Access database, the Interactive Excel component
allows you greater flexibility in the definition of data entry forms than the offline data
entry program with Access. Data entry form layouts are fixed in Access, and you
cannot change the column definition as desired, for example.

Integration
•  You can use master data and control parameters in the database to help you define data

entry forms.

•  Various scenarios are possible for the use of Interactive Excel, as regards the
relationship between components and the organization of the data entry procedure. For
more information, see the process description Offline Data Entry with Interactive Excel
[Page 94].

Flexible Definition of Data Entry Forms
In a data matrix, you enter financial data for various characteristics and combinations of
characteristics.  In order to simplify definition of a data matrix, you can use lists of proposals for
the characteristics predefined in Interactive Excel. These are generated from the master data and
control parameters in the database.

However, you are also free to define your own matrix or part of a matrix without using values
from Access, and to apply any formatting that you require.

Excel Formatting
Interactive Excel is added on to the standard Microsoft Excel application in the form of a
template. It therefore has the advantage of being based on a well-known spreadsheet program
that offers a wide range of formatting functions.
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Preparation for Data Entry
Before you enter data in a matrix, you can run a preparation for data entry. During this procedure,
matrix cells in which data cannot be entered are blocked, and data from the database is imported
into the matrix as a reference.

Checks/Validations
Interactive Excel checks the consistency of data before exporting it to the database. You also
have the option of triggering a validation of reported financial data using validation rules stored in
the database.

Interactive Excel can also be used for reporting. For more information see Reporting
with Interactive Excel [Page 421].
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Offline Data Entry with Interactive Excel
Purpose
The following graphics illustrate the central scenarios in which Interactive Excel can be used for
data entry within a subgroup.

Each scenario is determined by decisions taken within a subgroup concerning the technical
organization and procedures for data entry.

Prerequisites
•  You have installed Microsoft Excel 97 or Microsoft Excel 2000 and the Interactive Excel

component provided by SAP.

•  Microsoft Access or the offline data entry program (possibly in the form of a runtime
version) is installed at least once within your local area network.

•  The relevant Access database is available in the form of a file.

Scenario I: Local Definition of Data Entry Matrices

Parent Subsidiary

SAP

Master data +
control paras

Offline data entry
(Access)

Offline data entry
(Access)

Interactive
Excel

Access file Master data +
control paras

Financial
data

ASCII
file

Data
import

Data
export

1. A parent company installs the offline data entry program based on Microsoft Access and
configures it with master data and control parameters from the SAP System. It then
provides a subsidiary with a copy of the Access database.

2. A subsidiary creates its own data entry matrices in Interactive Excel with the help of
master data and control parameters from the Access database. It may also run a
preparation for data entry for the matrices.

3. The subsidiary enters its financial data in the matrices and saves the data to its local
Access database. It then exports relevant data from Access into an ASCII file, which it
makes available to the parent company.

4. The parent uploads data from the ASCII file into the SAP System.
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Comments

• In this scenario, the parent allows its subsidiary to define its own matrices.

• By using a local copy of an Access database, the subsidiary can run the following checks
before passing on its data to the parent company:

− Checks on the data structure and matrix definition when saving to the database

− Validation of data in the Access database

Scenario II: Central Definition of Data Entry Matrices

Master data +
control paras

Financial
data

Access file

Master data +
control paras

Excel file

Parent Subsidiary
Data

import

Data
export

Interactive
Excel

Offline data entry
(Access)

SAP

Interactive
Excel

Offline data entry
(Access)

ASCII
file

1. A parent company installs the offline data entry program based on Microsoft Access and
configures it with master data and control parameters from the SAP System. It also
installs Interactive Excel in order to create data entry matrices. The parent then provides
a subsidiary with a copy of the database and the matrices (for which it may have run a
preparation for data entry).

2. The subsidiary enters its financial data in the matrices and saves the data to its local
Access database. It then exports relevant data from Access into an ASCII file, which it
makes available to the parent company.

3. The parent uploads data from the ASCII file into the SAP System.

Comments

• In this scenario, the parent company creates all the necessary data entry matrices centrally
in order to ensure that they are correctly defined.

• By using a local copy of an Access database, the subsidiary can run the following checks
before passing on its data to the parent company:

− Checks on the data structure and matrix definition when saving to the database

− Validation of data in the Access database
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Low-Level Scenario: Data Transfer Within a Network

Access +
offline data entry

file

Subsidiary

ComputerComputer

PCPC
Interact.

Excel

ExportASCII
file

PCPC
Interact.

Excel

PCPC
Interact.

Excel

PCPC
Interact.

Excel

Comments

•  A parent company provides a subsidiary with a copy of its Access database.  One
instance of this file resides within the subsidiary’s network, either on a central computer
or on a local PC.

•  The database file can be accessed through the local area network in order to save data
entered using Interactive Excel.

•  Microsoft Access must be installed on at least one subsidiary computer in order to be
able to generate an ASCII file of data entered.

Result
After the completion of offline data entry, you can continue processing the data in the SAP
system, particularly you can run a consolidation with the SAP Consolidation component.
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Data Matrix
Definition
User-defined table in Interactive Excel that can function as either a data entry form or as a report.

Use
You can use data matrices for the following purposes:

•  Entering financial data in an Access database for the offline data entry program

The parent in a consolidation group usually decides whether it will define the data entry
matrices for all subsidiaries using Interactive Excel, or whether it will allow the
subsidiaries to define their own matrices.

•  Reporting on the basis of current financial data in a SAP System or Access database for
the offline data entry program

Structure
A data matrix consists of the following elements:

Header Data
Characteristics that are valid for a whole matrix and appear outside the row and column layout of
the matrix. Single values (for example, fiscal year or version) or set aggregations (for example, a
consolidation group consisting of several consolidation units) can be used for these
characteristics. Each characteristic value that is defined as header data fills exactly one cell. The
values that you select are inserted into the sheet in a block, but you can subsequently move
them to a different position.

Constants
Characteristics that are fixed for a whole matrix. You specify these characteristics during matrix
definition, after which they are hidden in the matrix and can not longer be selected during further
definition.

Column Layout
Multiple values or set aggregations for a characteristic, which extend across several columns. A
column layout in a matrix can consist of several rows. These rows do not necessarily have to be
positioned directly beneath one another.

Row Layout
Multiple values or set aggregations for a characteristic, or one or more hierarchies, which extend
across several rows. A row layout in a matrix can consist of several columns. These columns do
not necessarily have to be positioned directly beneath one another.

User-Defined Entries
Empty rows or columns in the column/row layout (in other words where no characteristics are
specified for a whole column/row). In reporting, you can these cells for your own functions, for
example, an Excel formula.
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Data Area
Area directly adjacent to the row and column layouts, in which financial data is entered or report
data displayed.

Interactive Excel must be able to identify the row and column layout before it can
identify a data area. The program cannot distinguish a layout that only covers one
row/column from header data, and therefore cannot identify it as a row/column
layout. If your layout cannot be identified, a message appears asking you to explicitly
indicate the data area.

A Simple Data Matrix and Its Base Elements

Header data

Data area

Row layout
Versions

Column layout

FS item
hierarchy

Partner Transaction
currency

Matrix name :
Aspect :
Cons group :

Report CGA
CS
A

Microsoft Excel - Report Cons Group A.xls Microsoft Excel - Report Cons Group A.xls 
File Edit View Insert Format Tools Data Window Help

B I U

Ready

Fiscal years

Cons C/A :
Ledger :
Key figure :

1997
CS
GV GC CD

If you have created a complex matrix and want to identify the various elements in the
matrix definition, you can choose SAP → Origin of data → Active matrix. This
function marks the row and column layout and the header data on a sheet.
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Opening a New Workbook with Interactive Excel
Prerequisites
You have installed Microsoft Excel 97 and the Interactive Excel component provided by SAP.

If you open an existing workbook from Excel that has been created using the
Interactive Excel template, the menu option SAP automatically appears. You can use
this to log on to a database connected to the SAP System.

Procedure
1. Start Microsoft Excel.

2. In the Excel menu, choose File →  New. Open the Interactive Excel template by double-
clicking on the SAPActiveX icon in the General group.

3. In the following dialog box, choose Enable macros.

4. Alternatively, the installation can create an Interactive Excel icon in the SAP Systems Start
Menu.

Result
The item SAP is added to the standard Excel menu. You use this to log on to a SAP Systems or
MS Access database.
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Interactive Database Connection
Use
This central function of Interactive Excel enables you to do the following:

•  Save reported financial data from a data entry form to the database

•  Import up-to-the-minute data into reports defined in Interactive Excel

•  Use master data and control parameters stored in the database as value proposals when
defining data entry forms and reports

Prerequisites
You have access to the appropriate database.

Features
Communication Between Interactive Excel and the Database
Data can be transferred between Interactive Excel and a database as follows:

•  You can only save data entered in an Interactive Excel form to an Access database for
the offline data entry program.

•  You can import data from an Access database or a SAP System into an Interactive Excel
report.

Loading of Interface Texts for Interactive Excel
•  When using an Access database for the offline data entry program

 The interface texts for Interactive Excel are stored in the Access database and originate
in the SAP System. You specify the text language when you download master data and
control parameters from the central SAP System into the database.

•  When using a SAP System as a database

The language that you specify when logging on to the SAP System determines the
interface language of Interactive Excel.
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Connecting Interactive Excel to an Access Database
Prerequisites
You have opened an empty or predefined file that was created using the Interactive Excel
template.

Procedure
1. Choose SAP → Logon → Other MS Access Database.

In the following dialog box, enter your user name and password for the offline data entry
program and specify the relevant database file and path, if necessary using the Browse
function.

The entries that you make here are saved as defaults for the next time you log on. You
only need to reenter the password.

If an authorization check is active for the Access database in the Microsoft environment,
choose More. Check the default values in the additional fields and change the Access
user name and password if required.

2. Choose Open.

Result
You are connected to the database and a menu option, which refers to the linked SAP
application (for example Consolidation, Strategic Enterprise Management), is added to the
standard Excel menu.

Additional functions appear under the menu item SAP, such as Read values automatically,
Settings, or Data origin.
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Creation of a Data Matrix
Purpose
In this process, you create a new data matrix as a data entry form or report, by making settings
that are valid for the whole matrix. You can create several matrices in a single worksheet.

Prerequisites
•  You have opened a workbook that was created using the Interactive Excel template.

•  If you want to use master data and control parameters from the target or source database as
proposals for the definition of characteristic values, you have logged on to the appropriate
database. For more information see Connecting Interactive Excel to an Access Database
[Page 102].

You can define a matrix without using proposals originating from existing master data
and control parameters, however this fully manual procedure involves making extra
definitions, and is therefore more complex.

•  You have selected an aspect for the matrix.

An aspect determines the source or target database for matrix data, for example the SAP
consolidation application from which you want to import data into reports, and whose
master data and control parameters you want to use for the matrix definition.

You cannot change an aspect after it has been selected for a matrix.

Your selected aspect is automatically used as the default for further matrices, which you
process with Interactive Excel, until you change it.

Process Flow
1. You make the following global settings:

Matrix name
If you define several matrices for a single worksheet, you can differentiate between them
by giving them different names.

 Once a name has been assigned to a matrix, you can not change it later.

Debit/credit sign logic
The logic that you select determines the debit and credit signing used for entering data or
displayed when data is imported from a database. The logics supported are shown in the
following table:

Debit/credit sign logic Represents
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Database values Values are entered/displayed as they are saved in the database,
for example assets items as positive (without a sign) and
liabilities/stockholders' equity items as negative (with a minus
sign).

Values as per item sign A value is entered/displayed without a sign if its balance
corresponds with the debit/credit sign set in the master data of
the item/subitem concerned. If the balance is reversed, the
value is entered/displayed with a minus sign.

Example: The balance of a liabilities/stockholders’ equity item is
normally a credit, and therefore the sign — (minus) is set for
those items. However, if a debit balance occurs for this item, a
minus sign is entered/displayed for the value to indicate a
reversed sign.
You can use this logic for balance sheets, for example.

Inverse database values Income statement values are entered/displayed as the inverse
of database values. Each time data is transferred, values are
automatically converted using the database logic.

This logic can be used for an income statement, for example, if
you want to show expenses as negative (with a minus sign) and
revenue as positive (without a sign). This relationship between
positive and negative values enables you to calculate financial
results using standard Excel formulas.

Scaling
Data can be entered/displayed at a specified scaling factor. Scaling of 1, 1,000, or
1,000,000 is possible when you create a matrix. However, you can later change the
scaling factor as required (condition: this must be a scale).

Return units indicator
If you select this indicator, values are displayed with a unit in Interactive Excel reports
(for example currency, unit of measure).

Data entry matrix indicator
You need to set this indicator if you want to use a matrix in order to enter data and run a
preparation for data entry.

Display blank lines indicator
Normally blank lines are also displayed in a data matrix, and therefore the indicator is
selected. Deselecting the indicator suppresses blank lines. You may want to do this to
improve clarity.

Display blank columns indicator
Normally blank columns are also displayed in a data matrix, and therefore the indicator is
selected. Deselecting the indicator suppresses blank columns. You may want to do this
to improve clarity.

Post 0 for blank cells indicator
When you want to write 0 for blank cells, then you have to use this indicator. You can
use this to enter a numerical value in all items.
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Update mode
The update mode specifies how the values of data records, which were posted earlier,
should be treated. You have the following options:

− Delete (all items, all subassignments): all existing data for each object is reset to
zero

− Delete (entered FS items, all subassignments): all existing data for each object in
posted items, is deleted before writing the uploaded data.

− Delete (FS items in the matrix, all subassignments): all existing data for each
object in the matrix, is deleted with all subassignments, before writing the
uploaded data

− Overwrite (entered FS items + subassignments): the existing entries are
overwritten by the uploaded ones (when identical to the item and all
subassignments), other uploaded data is written, otherwise existing settings
remain unchanged

− Divide (overwrite, but total per item remains unchanged): the value, which
already exists in an item, is divided onto the uploaded subassignments, the total
per item remains unchanged. To achieve this, an automatic offsetting entry is
generated on the respective default subassignment.

The function Divide is currently restricted to the subassignment Partner.

2. You specify global characteristic values.

You can specify single values or set aggregations as characteristic values for a matrix
header. To do this, you can use master data and control parameters in the source/target
database as proposals.

If a characteristic value is valid for an entire matrix, you can flag it as a constant. The
value is set in the background, and the characteristic is no longer available for definition,
thereby reducing the number of characteristics that are listed.

You can find out which characteristics are set as a constant and undo this setting at
any time. For more information, see Make Global Settings for a New Data Matrix
[Page 433].

If a particular characteristic is irrelevant for your matrix, you can mark it as a constant
without assigning a value. It will then be inactive and no longer offered for selection.

If you subsequently change a characteristic value in a report matrix when connected
to a database, the matrix is automatically refreshed with appropriate database data.
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Making Global Settings for a New Data Matrix
Prerequisites
You have opened a workbook that was created using the Interactive Excel template.

Procedure
1. Place the cursor on a cell that you want to form the upper left corner of the matrix header

data.

2. Choose Consolidation → Data matrix → New.

The settings of existing matrices are copied as default values into your matrix.

A dialog box appears, in which you are shown the Preset Characteristics (= global
parameters). You have the possibility to deactivate some parameters.

3. On the Settings tab page, enter a name for your matrix and specify the following parameters:

− A debit/credit sign logic

− A scaling factor for data

− Whether you want to enter values with units or display units for imported data

− Whether the matrix is a data entry matrix

− Whether blank lines should be displayed

4. On the Characteristics tab page, specify values for characteristics that are valid for the whole
matrix as follows:

a) Select a characteristic in the upper part of the dialog box.

b) Determine the characteristic type for the value. You can define the value as either a
single value or a set aggregation.

c) Use the arrow button next to the bottom field to display a list of possible values. Select
one of these values.

d) Set the Constant flag if a characteristic is valid for the whole matrix and you do not want
it to appear in the sheet.

e) Choose Confirm to complete your definition of the characteristic.

− If you want to change the value selected for a characteristic, position the
cursor on the characteristic, select a new value from the list of possible
values, and choose Confirm.

− If you want to remove the value selected for a characteristic, position the
cursor on the characteristic, select the empty entry at the top of the list of
possible values, and choose Confirm.

5. Repeat step 4 until you have specified all the characteristic values that you require. Then
choose OK.
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Result
•  The relevant characteristic vales are inserted as a block at the cursor position, unless you

specified them as constants, in which case they are invisible. General information, for
example user, scaling factor, and aspect are also inserted.

•  Header data can be formatted, moved, or deleted after being inserted into a worksheet. All
global settings except for the matrix name and aspect can be changed after insertion.

•  You can check your settings and make changes at any time by choosing Consolidation →
Data matrix → Change and the Settings tab page.

In this way, you can find out which characteristic values are flagged as constants and
therefore do not appear on the sheet. You can also remove the Constant flag for a
characteristic value.

•  For more information about changing values, see Changing Characteristic Values [Page
448].

•  You can preset the settings for new data matrices. To do this choose Settings  → Global
Parameters → Preset Characteristics. In exactly the same way, you can copy the settings of
already existing matrices as default values.
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Definition of a Matrix
Purpose
n this process, you define the row and column layout of a data entry form or report matrix by
arranging characteristics and characteristic values on a worksheet.

Prerequisites
You have completed the process Creation of a Data Matrix [Page 430], in which you make basic
settings for your matrix.

Process Flow
1. You define characteristic values and insert them into the worksheet as a row and column

layout.

You can specify characteristics and their values in the following ways:

•  By manually inserting them in the matrix

•  By selecting them from proposal lists that are generated from master data and
control parameters in the database

The advantage of selecting values from lists of proposals is that the reference of the
cell in which a characteristic value is located is automatically recognized by
Interactive Excel, and does not need to be explicitly specified. For more information
see Determination of Values for Characteristics [Page 451].

If you use proposals, you can display either the key, the short or long text, or everything,
in the matrix. If, in addition to the key, you use the long text, the long text automatically
changes if you choose a different characteristic value by entering a new key.

The following types of characteristics can be used to define the matrix layout:

•  Single values
 You can arrange these in sequence, either horizontally or vertically.

•  Set list
 A series of single values arranged in sequence, either horizontally or vertically.

•  Set aggregation
 A single entry in the matrix definition that summarizes data for all set entries.

•  Hierarchy
A series of single values arranged vertically with a structure of up to 8 levels.

You can insert an unlimited number of single values, sets, and hierarchies into your data
matrix, and subsequently delete, move, format, or change them.

When you insert a single value or set aggregation into a cell on the sheet, a help function
for values is automatically set for this cell. You can display a list of possible values for the
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characteristic by positioning the cursor on the cell and using the function button that
appears. This function enables you to change a characteristic value quickly and easily.

If you subsequently change a characteristic value in a report matrix when connected
to a database, the matrix is automatically refreshed with appropriate database data.

•  Certain characteristics are dependent on others. When you define
characteristics, you should take this into account, since the value you set for
one characteristic could determine the values that Interactive Excel proposes
for a second characteristic.

When you use the Consolidation menu in Interactive Excel to set values for
characteristics that you want to insert into a matrix, you need to define any
delimiting characteristics before a proposal list can be generated.
•  Before you can prepare a matrix for data entry, you need to define all

required characteristics.

The following table shows the characteristics supported by Interactive Excel, and their
dependencies:

Characteristic Characteristic
required

In SAP dependent
on...

In Access dependent
on...

Dimension X

Cons chart of accounts X

FS item X Cons chart of
accounts

Cons chart of
accounts

Version X

Fiscal year X

Period X
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Consolidation group

•  Single value

•  Attributes

•  Hierarchy

Characteristic
required, if:

- no ledger or
- no
consolidation
unit or
- consolidated
data
(posting level
30)

•  Dimension

•  Dimension

•  Version

•  Fiscal year

•  Dimension

•  Version

•  Fiscal year

•  Period

•  Dimension

•  Dimension

•  Version

•  Fiscal year

./.

Consolidation unit

•  Single value

•  Attributes

•  Set

•  Hierarchy

Characteristic
required, if no
cons group •  Dimension

•  Dimension

•  Fiscal year

•  Dimension

•  Fiscal year

•  Period

•  Version

•  Dimension

•  Fiscal year

•  Period

•  Version

•  Dimension

•  Dimension

•  Fiscal year

•  Dimension

•  Fiscal year

•  Period

•  Dimension

•  Fiscal year

•  Period

•  Version

Partner unit

•  Single value/Set

•  Attributes

•  Dimension

•  Dimension

•  Fiscal year

•  Dimension

•  Dimension

•  Fiscal year

Key figure X

Subitem category

Subitem Subitem category Subitem category

Unit of measure
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Year of acquisition

Custom characteristic

Transaction currency

Document type Dimension Dimension

Ledger Characteristic
required, if no
cons group

Reference version

Reference fiscal year

Reference period

Posting level Key figure

Data is aggregated for characteristics without a defined value. If, for example, a
receivables item has a breakdown by trading partner and transaction currency and
you do not specify a value for the trading partner breakdown, the sum of all data
records with a trading partner assignment is calculated (reporting) or must be
entered (data entry) for this item. If a row or column contains no specified
characteristics, it can be used for a user-defined entry, for example an Excel formula.

2. You have the option of displaying additional information for certain characteristics in any cell,
in the form of an attribute.

You can display the debit/credit sign of a financial statement item or the currency,
text, or language of a company. This additional information is irrelevant for the import
(reporting) and export (entry) of data, since it has no influence on the matrix
definition.

3. You make sure that values or value references are set for all the characteristics that you
have defined, so that data can be saved correctly to or imported correctly from the database.

4. You specify any remaining required characteristics and check your global settings.

5. To check the data structure of the data matrix, choose  or Consolidation or SEM → Data
matrix→ Check.
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Specifying Single Values
Prerequisites
You want to use a list of proposed values to define a characteristic as a single value and insert it
into the matrix.

Procedure
1. Place the cursor on the cell in which you want to insert a characteristic value.

2. In the Interactive Excel menu, choose Consolidation → Single values and the characteristic
you require.

A dialog box appears with a list of values for the characteristic. Depending on the
characteristic that you are defining, values for other characteristics that you have already
specified, and on which the values in the proposal list are dependent, may appear in
fields at the top of the box.

You may want to specify a value for a characteristic that is dependent on the values
of characteristics that you have not yet specified. In order to generate a list of valid
proposals, you need to specify these delimiting characteristic values An example of a
delimiting characteristic value is the consolidation chart of accounts, which
represents a compound of the characteristic FS item. Only after you have made this
specification is a value list displayed.

If a list is very long, first a condensed form of the list is displayed, which you can
selectively expand as desired.

3. Select one or more values. You can use Windows selection functions to select multiple
values (CTRL + mouse click) or blocks of values (SHIFT + mouse click). You can also use
the search function by ID values or long texts, in order to go to its position in the list. In
addition to that, you can position on a value using   .

4. If you want to insert more than one single value, specify how you want them to be arranged
on the sheet.

5. Choose OK.

Result
The values are inserted at the cursor position, either beside or beneath each another (depending
on the alignment selected).

If you select multiple values, these are inserted in the sequence in which they are listed in the
database.

Single values can be formatted, moved, deleted or changed after insertion into a worksheet.

You can define multiple single values in a single step.
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Specifying Sets
Prerequisites
You want to use a list of proposed values to define a characteristic as a set and insert it into the
matrix. Sets with the following characteristics are offered: consolidation unit, FS item, transaction
currency.

Procedure
1. Place the cursor on the cell in which you want to insert the first entry in the set.

2. In the Interactive Excel menu, choose Consolidation → Sets and the characteristic you
require.

A dialog box appears with a list of values for the characteristic. Depending on the
characteristic that you are defining, values for other characteristics that you have already
specified, and on which the values in the proposal list are dependent, may appear in
fields at the top of the box.

You may want to specify a value for a characteristic that is dependent on the values
of characteristics that you have not yet specified. In order to generate a list of valid
proposals, you need to specify these delimiting characteristic values. Only after you
have made this specification is a value list displayed.

If a list is very long, first a condensed form of the list is displayed, which you can
selectively expand as desired.

3. Select one or more sets. You can use Windows selection functions to select multiple values
(CTRL + mouse click) or blocks of values (SHIFT + mouse click). You can enter a value ID
(in the form of the field name) in order to go to its position in the list. You can also use the
search function by ID values or long texts to go to their position in the list. In addition to that,
you can position on a value using  .

4. Determine the following:

− How the set entries should be arranged on the sheet (in the case of a set list or
multiple set aggregations)

− Whether the ID and/or short text and/or long text of the characteristic should be
displayed

− Whether the set is a list set or a set aggregation

5. Choose OK.

Result
•  Set list

The relevant set entries are inserted at the cursor position, either beside or beneath each
another (depending on the alignment selected).
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Set entries are inserted in the sequence in which they are entered in the set.

•  Set aggregation
Only one entry is inserted into the worksheet. This entry represents the sum of all entries
in the set.

Sets can be formatted, moved, deleted or changed after insertion into a worksheet.
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Specifying Hierarchies
Prerequisites
You want to use a list of proposed values to define a characteristic as a hierarchy and insert it
into the matrix. You can specify hierarchies for the following characteristics:

•  Consolidation group

•  Consolidation unit

•  Partner unit

•  FS item

Procedure
1. Place the cursor on the cell in which you want to insert the first entry in the hierarchy.

If a list is very long, first a condensed form of the list is displayed, which you can
selectively expand as desired.

2. In the Interactive Excel menu, choose Consolidation → Hierarchies and the characteristic
you require.

A dialog box appears with a list of values for the characteristic. For example, here you
can choose consolidation unit.

If a list is very long, first a condensed form of the list is displayed, which you can
selectively expand as desired.

3. Select one or more hierarchies. You can use Windows selection functions to select multiple
values (CTRL + mouse click) or blocks of values (SHIFT + mouse click). You can enter a
value ID in order to go to its position in the list.

4. Choose SAP → Settings, and determine

− Whether you want hierarchy levels to be indented when inserted into the worksheet,
and whether the column width should be automatically adjusted to fit the contents

− How many hierarchy levels (up to 8) should be expanded when the hierarchy is
inserted into the worksheet

− Whether a color should be applied to the hierarchy

− Whether the ID and/or short text and/or long text of the characteristic should be
displayed

You can also change these settings by using the context menu and a right mouse click.

5. Choose OK.
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Result
The relevant hierarchy is inserted at the cursor position, with the specified formatting. All
hierarchy entries are inserted, regardless of the number of levels that are expanded.

You can change the color format and indent of the individual levels by choosing SAP → Settings.
Your settings are saved locally and are therefore only computer-specific.

You can format, move, delete or change hierarchies after insertion into a worksheet. In exactly
the same way you can update the hierarchies at any time.

If you want to delete a hierarchy, choose SAP → Delete hierarchy. You thereby ensure that the
layout, values, and formatting for a hierarchy are completely removed from the worksheet.
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Specifying Attributes
Prerequisites
You have specified header data for your matrix. You may have also defined the matrix layout.
You now want to insert an attribute into the matrix to provide additional information about a single
value, set entry or hierarchy entry. An attribute is not part of the information required for
communication between Interactive Excel and the database. Possible attributes are supplied by
SAP as well as further custom characteristics.

The information that can be provided by an attribute depends on the characteristic, for example a
debit/credit sign or short text can be inserted for a financial statement item.

You cannot insert attributes for a set aggregation, since this characteristic has
multiple values.

Procedure
1. Place the cursor on the cell in which you want to insert an attribute.

2. Choose Consolidation → Attribute and then the relevant characteristic.

A modeless dialog box appears in which you specify the relevant characteristic value.

3. Place the cursor on the cell in which the ID or long text for the value is located.

The cell reference is displayed in the field. Choose OK.

By entering an area, you can also display the attributes for all of the fields within the
area.

4. In the next dialog box, select an attribute and choose OK.

You may want to specify an attribute for a characteristic that is dependent on the
values of characteristics that you have not yet specified. In order to generate a list of
valid attributes, you need to specify these delimiting characteristic values. Only after
you have made this specification is a list of attributes displayed.

Result
The attribute is inserted at the cursor position, and can be subsequently formatted, moved,
deleted, or changed.

You can use the procedure described above to change an attribute that you have already
defined. When you change an attribute, you need to confirm that you want it to be overwritten
with new data.
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Working with Structures
Prerequisites
You want to process characteristics with structures. Structures are available in Interactive Excel
for all the hierarchies and sets.

Procedure
In the Interactive Excel menu choose Consolidation →  Structures → Update or  →
Change/Combine/Detach. You have the following options:

Update structure You can update the structure, in order to supply it with current data from
the SAP System.

Change structure Here you have the following options:

- Only compile the area of definition: only the cells which belong to the
area of definition of the matrix, are processed/deleted

- Compile matrix area: all cells can be processed/deleted, which either
belong to the are of definition or to the output area of the matrix

- Compile complete rows/columns: complete rows or columns are
always processed

- You can also select a different hierarchy or a different set for the
structure To do this, press Edit, select the structure to be changed and
change it

With this option you can activate and/or deactivate the automatic update
using 

Combine structure You can combine several structures for different characteristics The values
of all combinations are multiplied through all levels.

For example, this applies to all breakdowns, to sets with consolidation
units, transaction types, transaction currencies.

Detach structure You can detach various combined structures.

Delete structure You can delete structures, for example the structure of the consolidation
units.

Result
By working with structures, you can make the dataset clearer and in particular easier to evaluate.



 SAP AG Consolidation (EC-CS)

Changing Characteristic Values

April 2001 121

Changing Characteristic Values
Prerequisites
You want to change some or all of the values that you have already specified for characteristics
in a matrix. To do this, you can use one of the procedures described below.

Procedure
Changing Values Manually in a Matrix
Change the existing values by typing over them.

Changing Values by Means of Proposal Lists
Two procedures are available for changing values by means of proposal lists:

•  By a selection list:

a) Place the cursor on the cell you want to change.

b) When sets and/or single values, choose a value from the dropdown menu, for example
the name of a specific consolidation unit. You can change hierarchies via the menu,
because there is no dropdown menu for hierarchies.

c) If a dropdown menu appears, click on the desired value.

d) Choose OK.

•  Using Interactive Excel, from where you go to the application menu for Consolidation:

a) Place the cursor on the cell in which the characteristic you want to change is located.

b) Choose Consolidation and then the relevant characteristic type and the characteristic.

c) When prompted, confirm that you want the existing value to be overwritten.

d) A dialog box appears with a list of values for the characteristic.

e) Select the appropriate value, check that the display format is correct and choose OK.



Consolidation (EC-CS)  SAP AG

Additional Settings

122 April 2001

Additional Settings
Use
Under SAP →  Settings, you can make several formatting settings and general setting for your
work with Interactive Excel.

Features
Formats for Hierarchies
You can change the color of the individual levels and their indent level. Your settings are saved
locally and are therefore computer-specific.

Formats for Matrix Cells
You can define different formats for the following cells:

•  Cells that cannot be used for data entry (for example totals items or invalid
characteristics)

•  Cells that can be used for data entry

•  Report cells into which data is imported

These settings are valid for the entire workbook.

You choose Change for the relevant cells, and a standard Excel dialog box appears. In this box,
you define the formats that you want to use.

The default format template for Interactive Excel is set, and should be sufficient for your needs.
However, you can choose a different template as required.

Settings
Shortcut Key for Possible Entries Function
When you insert a single value or set aggregation into a cell, a possible entries function is
applied to the cell. You can use the button to the right of the cell to display a list of possible
values.

The key combination STRG + h is set as default for this function, should you prefer to use the
keyboard rather than the mouse. However, you can set a different key combination if desired.

Always read values manually
Choose this setting, when you want to prevent data being automatically read from the SAP
System.

Changed matrix data is normally automatically read again from the SAP-System. You can stop
this, for example, when you want to create varied valuations on the basis of data from a key date,
using Interactive Excel.

When you have activated this option – that means only allowing the manual update – every time
you log onto Interactive Excel, you receive a system message informing you that the automatic
update is deactivated.
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Define Font
If desired, you can change the font used for displaying the interface texts (dialogs) in Interactive
Excel. Follow these steps::

1. Choose menu item SAP.

A dropdown menu appears.

2. Choose Settings.

A list of options is displayed.

3. Choose the tab Font.

You can choose either a fixed-width font or a proportional font, for which there are further
choices available. You can display sample texts.

Global Settings
Here your selected global parameters, which you work with in the SAP system, are listed and can
also be changed by you interactively.

Default Settings
You can use the function SAP defaults to restore the predefined settings for Interactive Excel.

Activities
Make your desired settings at menu item SAP → Settings.
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Determination of Values for Characteristics
Use
The link between the database characteristics and the characteristics available in Interactive
Excel is pre-programmed. Your assignment of characteristic values in a matrix to the preset
Interactive Excel characteristics enables data to be transferred between the correct database
fields and matrix fields.

You can identify a characteristic value by entering one of the following:

•  A cell reference

•  A single value

If you use master data and control parameters from a database as proposals when defining
characteristics, the value reference of characteristic is automatically set. This reference is
automatically adjusted when a characteristic is moved to a different location on a sheet.

However, you need to manually specify the value or value reference for characteristics that you
have defined as follows:

•  By manual insertion in a matrix, outside a list of set entries or a hierarchy

•  By copying and pasting from another matrix

It is helpful to specify missing values or missing value references after you have completed the
definition of a matrix. To do this, the Interactive Excel menu choose Consolidation → Data matrix
→ Change, then specify the missing values.
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Specifying a Value/Value Reference for Characteristics
Prerequisites
A characteristic value or the cell reference of a characteristic value has not yet been specified, for
example if you manually inserted the characteristic into your matrix.

Procedure when Using Detailed Menu
1. Choose Consolidation → Data matrix → Change.

2. On the tab strip in the following dialog box, choose Optional characteristics and select the
appropriate characteristic.

3. Enter one of the following in the Value/Value reference field.

– A single value

If the ID of the single value is identical to a possible cell coordinate, for example a
transaction type with the ID B10, you need to enter the value preceded by an
apostrophe, for example, B10.

– A cell reference, for example, B3

– A cell reference, by clicking on the button to the right of the entry field

A dialog box appears. When you drag the cursor over the appropriate matrix area on
the worksheet, its coordinates appear in the dialog box field. Use the function button
next to the co-ordinate field in order to confirm your entry.

4. Choose Confirm, to complete your selection.

5. Once you have specified all values and value references, choose OK.

If a required characteristic has not yet been defined, a warning message appears. In this case,
choose Consolidation → Data matrix → Change and define the appropriate characteristics on the
Reqd char. tab strip. Then choose OK.

Procedure when Using Context Menu
1. Select one or more fields, by marking it/them, for example the FS item.

2. Right mouse click

3. Choose SAP → Item or a characteristic that you have chosen instead.

Result
Cell Reference
An assignment is created between a characteristic on the worksheet and a characteristic preset
in Interactive Excel. The cell reference of a characteristic is automatically adjusted if you move
the characteristic to a different location on the sheet.

Single Value
The characteristic is invisible on the sheet, as is the case for all constants.
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Identifying the Area for Data Input/Output
Use
Before it can import data into or export data from a matrix, Interactive Excel must be able to
identify the data area in the matrix. The data area in a matrix is adjacent to the column and row
layout, and consists of cells relating to these layouts. For a simple graphic showing the different
elements of a matrix definition, see Data Matrix [Page 427].

If you define a matrix in which the row and column layouts and their respective cells are
unambiguous, Interactive Excel automatically recognizes the data area.

If a layout only occupies a single row or column, it can be confused with the header data and is,
therefore, not recognized as a row or column layout. In this case, you are prompted to explicitly
specify the data area at the following events:

•  After you have saved a matrix definition that you have changed by choosing
Consolidation → Data matrix → Change.

•  If you choose Consolidation → Import data in order to fill a matrix with data.

You have inserted a hierarchy of consolidation items in the row layout of a matrix and
a version in the column layout. Interactive Excel cannot identify the data area
because it does not recognize a layout that only contains one characteristic value.

Activities
1. Select the data area by dragging the cursor over the sheet.

2. Select Choose to the right of the coordinate field to confirm your entry.

3. Choose Confirm.
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Entry of Specific Data Categories
Use
You can enter cumulative financial data for a combination of the following parameters by
specifying an appropriate key figure:

•  Valuation
– Local requirements (reported financial data)

•  Currency or quantity
– Local currency

– Transaction currency

– Quantity

You select the key figure LV LC CD (reported financial data, local currency,
cumulative).

Activities
When you define a data matrix, you specify the data category for your financial data by setting
the appropriate key figure as a global characteristic value. Make Global Settings for a New Data
Matrix [Page 433]
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Creation of Further Matrices
Use
When you create an additional matrix, global characteristic values set for the initial matrix are
automatically proposed for the header data.

Features
When you create an additional matrix, global characteristic values set for the initial matrix are
automatically proposed for the header data. This minimizes the effort required for defining two or
more matrices with similar or identical header data.

Activities
You create an additional matrix in the same way as the initial matrix, by choosing Consolidation
→ Data matrix → New.

You select the values that you want to copy. A value is selected when the field to its left is
checked. Once you have confirmed your selections, a further dialog box appears for you to
define other global settings.
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Deleting a Matrix
Prerequisites
Use this procedure to completely remove a data matrix definition from a worksheet and reset all
settings made for the matrix.

Procedure
1. Choose SAP → Delete matrix.

2. A dialog box appears. There are two ways of identifying the data to be deleted: (a) You can
enter the name of the matrix to be deleted. (b) You can select the area to be deleted by
dragging the cursor over the appropriate matrix area on the worksheet, after which its
coordinates appear in the dialog box field. Use the function to the right of the field to confirm
the coordinates of the fields to be deleted.

3. Click OK to delete the selected area.
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Entry of Data in a Matrix
Purpose
In this process, you enter financial data in a data matrix and save it to an Access database for
the offline data entry program.

Prerequisites
The matrix in which you want to enter data is already defined, and you have access to the file in
which the matrix is saved. Either you have already completed the process Definition of a Matrix
[Page 435], or a parent company/unit has provided you with a predefined matrix in which you can
enter data.

Process Flow
1. If required, you run a Preparation for Data Entry [Page 132].

 During the preparation, current data from a local Access database is imported into the
matrix, certain cells in the matrix are blocked, and other automatic settings are made.

 
 A parent can run a preparation for data entry on a matrix before sending it to a
subsidiary. If this is the case, the subsidiary does not have to run a preparation when
it receives the matrix.

2. You enter your financial data for the period in the data area of the matrix, either in empty
fields or by typing over the reference data from the preparation for data entry.

3. You save the data to the database.

When you save data to the database, characteristic values in your matrix definition are
checked for consistency. You also have the option of triggering a validation of data using
rules that are stored in the Access database.

If desired, you export data in test mode in order to find and remove any errors before
you update the database.
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Preparation for Data Entry
Use
This function enables you to prepare a data matrix for the entry of financial data. During the
preparation, Interactive Excel blocks certain cells in the matrix and makes other automatic
settings, as described below. It then imports existing financial data from the database as a
reference for data entry.

Preparation for data entry ensures that data is entered correctly. It can be carried out by a parent
before distribution of matrices to subsidiaries, or it can be performed by the subsidiaries
themselves, if they have access to the appropriate Access database.

Prerequisites
•  You have defined a matrix locally following the process Definition of a Matrix [Page 435],

or received a predefined matrix from a parent, for which the Data entry matrix indicator is
set.

•  The Access database in which you want to save data is available in the form of a file.

Features
Blocking of Cells against Data Entry
Interactive Excel checks all cells in the data area to determine whether they are valid for data
entry. Cells that are not valid for data entry (for example those in which totals items or invalid
characteristics are located) are locked and their content cannot be saved to the database.

•  If you enter data in invalid cells and try to export it to the database, a warning message is
issued and you can then correct the error. Once you have corrected an error, data can
be exported to the database. You do not need to rerun the preparation.

•  If you do not correct a recognized error and you try to export data to the database again,
data is transferred, however the data with errors is not saved in the database, and an
entry is made in the error log. This procedure enables you to save correct data to the
database without having to first correct any data with errors.

Using the function Information about the Origin of Data [Page 468], you can display cells that are
blocked for data entry.

Insertion of Totals Formulas for Hierarchy Nodes
Values for hierarchy nodes are replaced by totals formulas, which automatically calculate the
sum of data entered for all items below the nodes.

Due to the insertion of totals formulas, preparation for data entry is not suitable in the
following cases:

•  If you use hierarchies of companies/consolidation units in the matrix
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Only summarization within a hierarchy of consolidation items can produce a
value that is valid for consolidation purposes.

•  If you have specified that you want to use the debit/credit sign logic ‘Values as per item
sign’.

Since the majority of values are entered/displayed as positive using this logic,
the total calculated at the hierarchy nodes will be incorrect.

A cell comment contains information from the SAP system as to the reason why the
update cannot take place. Some reasons might be:

•  Subassignments were not transferred from the SAP System.

•  A wrong, non-existing company was addressed.

•  The item is a totals item.

Deactivation of the Matrix
After it has been prepared for data entry, the matrix is deactivated. The connection to the
database is not terminated, but if you subsequently change the definition of the matrix, data is not
automatically refreshed. You still have the option of manually triggering a refresh of data,
however.

You prepare a matrix with actual data for 1997. You then redefine the matrix for the
entry of 1998 plan data, and use the actual data for 1997 as a reference for data
entry. When you change the year to 1998, data is not refreshed.

Data Import
Any data that exists in the database for the combination of characteristic values in your matrix
definition is inserted into the matrix and serves as a reference that can simply be typed over.

Activities
You can run a preparation as follows:

•  When saving a matrix definition under Consolidation → Data matrix → Change, by
choosing Import data

•  By choosing Consolidation → Import data and the relevant work area
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Saving Financial Data to the Database
Use
This function enables you to export financial data entered in a data matrix into an Access
database for the offline data entry program.

Prerequisites
•  You have entered financial data in a matrix, possibly after preparing your matrix for data

entry. 

•  The relevant Access database is available in the form of a file.

•  The Access application is not running when you save.

Features
Checks
When you save data to the database, characteristic values in your matrix definition are checked
for consistency.

•  A warning message appears if characteristic values in a matrix are inconsistent with
those in the database, for example, if they are invalid or have an incorrect breakdown.
You can correct any errors and restart the database update.

•  Data in rows or columns without a definition is not saved to the database.

•  The value 0 (zero) is saved for empty cells.

Error Log
Errors that are detected during the export are written in an error log in a text editor window. You
can delete errors in the text editor once you have corrected them in the matrix, and you can copy
the log to other applications in order to print or archive it.

Validation
You have the option of running a validation of reported financial data. This validation takes place
in the Access database itself and uses the validation rules that are already stored there. You can
run a validation when saving data in either test or update mode. Any errors are listed in the error
log.

Before data can be validated, validation rules must either be defined in the SAP
System and downloaded into the offline data entry program or maintained directly
within the program itself.

•  For more information about validations, see the Consolidation Implementation Guide,
section Data →  Validations for Reported Data and Standardized Data.

•  For more information about downloads, see the Consolidation Implementation Guide,
section Data → Data Collection → Online and Offline Data Entry → Additional Settings
for Offline Data Entry.
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Database Generation
If the Access database has not yet been generated, the update triggers a generation for the
combination of dimension, version, consolidation unit, fiscal year, and period defined in the
matrix.

Test Run
You have the option of saving in test mode. Characteristics are checked, data validated if so
specified, and a log generated for any errors, without the database being updated. The test run
enables you to remove any errors before saving in update mode.

Activities
To save data to the database, you choose Consolidation → Export data. You specify whether
you want to run the update in test mode and whether data should be validated.

You can save data from all matrices in a sheet or all matrices in a file to the database.

At the time the validation and generation of the database takes place in Access, and
not in the SAP system, the monitor remains in the SAP system for the status of the
validation.
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Information About the Origin of Data
Use
This function provides you with important information regarding the current status and the origin
of data in a data matrix, pivot table, or individual cell on a worksheet.

Features
Origin of Data in a Matrix
You can display and, if required, insert the following information into the worksheet at the cursor
position:

•  The characteristics used in the matrix and their values

•  The logon user name with which data was imported

•  The database from which data was imported

•  The date on which report data was last refreshed

•  The scaling factor

•  Further technical information

The following functions are also available in the documentation dialog box:

•  Highlighting of cells blocked for data entry

The blocked cells are marked with a color.

•  Demarcation of the data matrix definition

The various elements in the matrix definition are highlighted on the worksheet.

The relevant cells are marked until you choose another function. However, you can print out a
copy of the sheet with this information displayed before you continue.

Origin of Data in a Cell
You can display and, if required, print information about the parameters for the data in a cell. You
may want to do this, for example, if you cannot establish the origin or data in a cell from the
characteristic values that appear in the sheet.

If data has been calculated using an Excel formula, the formula is displayed.

Data that has been typed directly into the sheet is identified as a constant.

Activities
To display information about the origin of data, choose SAP → Origin of data → Current matrix or
Cell.

Alternatively you can get information about the origin of data by using the context menu SAP →
Origin of Data.



 SAP AG Consolidation (EC-CS)

Information About the Origin of Data

April 2001 137



Consolidation (EC-CS)  SAP AG

Creating a Snapshot of a Worksheet or Workbook

138 April 2001

Creating a Snapshot of a Worksheet or Workbook
Prerequisites
As a security measure, or for test or presentation purposes, you may want to create a copy of a
worksheet or workbook. The data in this copy cannot be refreshed by importing data from a
database.

Procedure
1. Choose SAP → Snapshot → Workbook or Worksheet.

2. In the following dialog box, enter the name of the workbook in which you want to create a
snapshot, or leave the field empty if you want to create the snapshot in a new workbook.

3. Choose OK.

Result
An identical copy of the workbook or worksheet is created in the specified workbook.

This copy cannot be connected to a database.
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Upgrading Workbooks in Interactive Excel
Prerequisites

•  You have received and installed a new version of Interactive Excel. Now you want to
update the template in your Interactive Excel workbooks to make the workbooks
compatible with the new version.

•  You have opened a workbook or several workbooks, which are in the same directory, in
Microsoft Excel with the Interactive Excel template.

Procedure
1. Choose SAP →  Upgrade.

2. In the following Windows dialog box, select one or several Interactive Excel workbook(s) the
template of which you want to update. A prerequisite for this, is that you execute the upgrade
for several workbooks at the same time, and that these workbooks are in the workbook.

Choose Open.

The selected workbooks are upgraded.

The following rule applies here for the derivation of the file name: Enter the desired
directory for the workbook and provide the original file name with a prefix and a suffix, to
make it easily identifiable.

3. Repeat this procedure until you have updated the templates of all the relevant workbooks.
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Data Entry with MS Access
Purpose
Decentralized data entry and processing of individual financial data is possible with MS Access.

Implementation Considerations
Use MS Access to execute the decentralized data entry of individual financial statements for
some consolidation units, which have no access to the SAP system.

Features
You can execute the following actions decentrally with the offline data entry program MS Access:

•  Display master data

It is only possible to display master data here, no changes can be made.

•  Import control parameters, which are necessary for data entry, into MS Access

The control parameters for offline data entry are delivered by the upper unit and are
made available for the import with a download from the SAP system. The following data
is necessary for this:

− Master data

•  Consolidation units and consolidation group

•  Consolidation chart of accounts

•  Data entry layout

•  Exchange rate (optional)

•  Version

•  Dimension

•  Consolidation chart of accounts

− Validation rules

•  Data entry of individual financial data

After generating the data structures on the basis of the imported control parameters, the
data entry of the individual financial data takes place. You can give authorizations to
some employees dependent on the consolidation unit.

•  Data entry of additional financial data (inventory and supplier data) for the elimination of IU
profit and loss in transferred inventory

•  Validation of entered values

Validation must be executed before exporting reported financial data into the SAP
system. Validation rules are defined in the SAP system. Though in addition to that you
can define and change validation rules locally.

•  Copying reported financial data
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•  Translation of data with an exchange rate indicator and a translation ratio for reporting
purposes or in the sense of a data entry in group currency

•  Reporting

The component Interactive Excel [Page 92] can also be used for reporting on the basis of
data entered in Access. For further information on this read Reporting with Interactive
Excel [Page 421].

•  Transferring data into the SAP system as well as into Interactive Excel

The reported financial data can be exported from MS ACCESS and uploaded into the
SAP system.

Reported financial data and control parameters can be imported again into the PC data
entry program after a release upgrade.

•  Compressing the database to the required size

This should be carried out at regular intervals. To do this choose Tools → Compress
database

•  Deleting reported financial data

You choose this option when you no longer require reported financial data in MS Access
after the end of a fiscal year or period.

Constraints
You can only enter cumulative data, not periodic data with MS Access.
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Technical Prerequisites for the Installation of MS
Access
Hardware

•  Processor: Pentium

•  RAM: 32 MB minimum; 64 MB recommended

Software

•  MS Windows or MS Windows NT

•  MS Access 97 or MS Access 2000

•  MS Excel 97 or Excel 2000 (if PC data entry or Reporting with Interactive Excel is used)

Installation

The front-end CD Presentation contains the program for offline data entry with MS Access.

In order to install the program for offline data entry on the PC, first you create a new subfolder on
the hard disk of the PC.

From the front end CD start the program SAPSETUP.EXE, which automatically creates the new
file WDFAECCS.MDB. This contains the offline data entry program.
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Prerequisites in the SAP System
Prerequisites
Working in the SAP System
First check the steps on MS Access entry in the Implementation Guide.

In particular you must create directories for consolidation groups and parameter records for the
specific and general download. The columns are to be interpreted as follows, the first two
columns specify the receiver of control parameters, that is the unit to be entered. The other
columns specify the data to be entered.

In offline data entry you can enter data simultaneously for several dimensions or versions. To do
this you create several entries which do not differ in the receiver view, the receiver consolidation
group and the language. If these entries are downloaded simultaneously, a record of control
parameters is generated, which contains all the parameters in the remaining columns.

For example the versions 100 and 200 could be generated in dimension 01 by the following rows:

Dimension Cons group Dimension Version Hierarchy Top cons
group

Language

01 CG1 01 100 01 CG1 DE

01 CG1 01 200 01 CG1 DE

Execute the download of specific and general control parameters. If you want to transfer
comparison values or balance carried forward values into offline data entry with Microsoft
Access, then you should also execute a download of reported financial data.

Activities
Customizing of Offline Data Entry in MS Access
After the download of the control parameters into the SAP system has been completed, the
following preparations must be made:

1. Maintain the directory for the import/export of data with the menu Transfer → Definition.

2. Import the control parameters from the SAP system with the menu Transfer → Import →
Control parameters (SAP).

3. Set the global parameters (dimension, version, fiscal year, period, consolidation chart of
accounts) with the menu Tools → Customizing → Global parameters. The version must be
three figures with possible leading zeros to be entered.

4. You assign the companies to be processed to the individual users with the menu Tools →
Administration → Authorization profile. This task can only be carried out by the users admin
and gadmin.

5. Generate the data structures using the menu Data entry → Generation.

6. If necessary import the reported financial data exported from the SAP system with Transfer
→ Import → Reported financial data.
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Data Entry
1. From the data entry layout definition, only the offline data entry is transferred, which contains

value items and totals items in the data entry layout.

2. You can only enter the breakdown in accordance with the definition in the breakdown
category.

3. You can go to the respective breakdown form by double-clicking on the input field when
entering an FS item.

− The F4 input help for the corresponding breakdowns lists possible input values, taking
account of the breakdown indicators (optional, required, no default and so on) and
possibly defined maximum sets.

− The default sets defined in the breakdown category are not relevant for the F4 help.

4. The offline data entry only generates default rows on account of the default sets defined in
the breakdown category, without taking into account possible values defined in the data entry
layout.

5. If in Access Customizing, you do not activate the indicator Check, whether total breakdown
equals value in main form, you can enter a total value for the FS item in the overview form,
which you then later distribute to the individual subassignments using the breakdown form.
Later during validation, it is checked whether the entered total value corresponds to the total
breakdowns.

Reporting Data to the Head Office
1. Execute validation and if required, correct the data entered.

2. Export the reported financial data with Transfer → Export → Reported financial data.

3. Load the reported financial data into the SAP system.

As long as the control parameters do not change in the SAP system, you can
execute the entry of reported financial data with the same database, without
downloading and importing control parameters, for as many periods and years as
you like. Though it is advisable to delete financial reporting data which is no longer
required from time to time and to compress the database.
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Preparations for Data Entry with MS Access
Features
Starting the PC Data Entry Program in MS ACCESS
Open the file WDFAECCS.MDB in MS ACCESS with the menu option File → Open database.
The logon screen appears.

Logon
Logon with ADMIN in the User name field and enter ECCS in the Password field.  Enter the
language as well.

The system administrator (user ADMIN/GADMIN) has the authorizations for all functions of the
data entry program including authorization assignment for further users. Therefore for security
reasons, you should change the password ECCS after logging on for the first time. You make this
change under Tools → Administration → Change password.

In addition, user GADMIN has the authorization to maintain validations in MS Access.

Global Parameters
After logging on enter the global parameters dimension, version (consolidation version), year,
consolidation chart of accounts and period.  These are saved, you can change them using the
menu option Tools → Customizing → Global parameters.

If no control parameters were imported, then you cannot change the set values.

Importing Control Parameters
The control parameters must be imported from the SAP system for every consolidation version.
For this enter the path via Transfer → Definition, in which the data is stored, that is downloaded
from the SAP system. You execute the import via the menu option Transfer → Import → Control
parameters (SAP).

All of the control parameters are imported, which are necessary with regard to the consolidation
units intended for the decentralized PC data entry with MS ACCESS.

Authorizations for Users
As the system administrator you can create users and allocate authorizations to them. This takes
place via the menu option Tools → Administration.

The authorization profiles are based on the consolidation units which can be processed. Users
can enter and evaluate the consolidation units which are listed in their authorization profile.

As system administrator (user ADMIN) execute the following steps when allocating
authorizations:

1. Create the required additional users.

2. Define the authorization profile for the individual users by assigning the respective
consolidation units to be processed to them.

You can subsequently delete users or change their authorization profile.
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Generating Data Structures
Before entering the reported financial data, you generate the data structures in the offline data
entry program.  This generation takes place on the basis of the imported control parameters.

During generation, the data records are generated with the key fields. The value and quantity
fields of the data records are filled by the subsequent data entry.

Generation must take place for every consolidation version and every fiscal year. Execute
generation via the menu option Data entry → Generation. You can execute the generation
separately for the individual consolidation units or related for a  consolidation group.

The parameter Effective from period enables generation of a period interval dependent on the
consolidation frequency of the consolidation group. This generation is relevant for mid-year
consolidation with regard to data entry.
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Executing Data Entry with MS Access
Procedure
Manual Data Entry of Reported Financial Data
You execute the manual data entry in the offline form-based data entry program MS Access
analogous to the online data entry in the SAP system. Choose the menu option Data entry. In the
initial screen you select the consolidation unit to be entered, and one of the data entry forms that
relate to the unit.

Note the following FS item attributes:

•  Totals items

These are indicated with the sign *. Data cannot be entered for totals items. When
entering reported financial data you can calculate the values of the totals items with the
function Update totals.

•  Breakdown items

The breakdowns to be assigned for various FS items are displayed in the data entry
form.

•  Debit/credit sign

A debit/credit sign is pre-set for every FS item. This enables data entry without a
debit/credit sign.

Various entry aids are available for data entry:

•  For the data entry of breakdowns to item values you can go to the detailed form by placing
the cursor on the input field of a FS item and double-clicking.

•  The option of breakdown control enables validation between the data entry of the breakdown
and the FS item value in the higher-level form.

You can activate the breakdown control with the menu option Tools → Customizing →
Options. This has the following effects:

− With active breakdown control it is not possible to enter FS item values without entering
the breakdown.

− Likewise, changing the FS item value without changing the breakdown is not possible.

− After entering the breakdowns the FS item value is automatically calculated and entered
in the higher-level form.

•  By defining the scaling factor you can determine which powers of 10 the entry of values and
quantities should be based on. The default scaling factor is set to 0, which means that whole
values and quantities are entered.

You can set the scaling factor individually for values as well as for quantities via the
menu option Tools → Customizing → Scaling factor.

•  The definition for the value scaling factor takes place per combination of version and
currency. You can choose powers of 10 from 0 to 9.
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•  The quantity scaling factor is defined flat-rate. You can choose powers of 10 from 0
to 9.

•  During entry the program carries out a check of the decimal places. The entries are based on
the definition of the respective currency, which was made in the SAP system, with regard to
the decimal places.

•  Within a data entry form, you can change the consolidation unit to be entered. The following
prerequisites must be fulfilled for the consolidation unit which you want to change to:

•  The form is assigned to the consolidation unit via the data entry form group.

•  The consolidation unit has the same local currency.

Manual Data Entry in Interactive Excel
Data can be entered in data matrices in Interactive Excel, which were defined with the help of
control parameters from the offline data entry program. The control parameters are transferred to
MS ACCESS by a link.

After the entry of data matrices, data can be posted in MS ACCESS. An ASCII file is then
exported from the database, which can be imported into the consolidation system.

You can find further information on the data entry of a MS-ACCESS-Database with Interactive
Excel under Offline Data Entry with Interactive Excel [Page 94].

Displaying and Printing a Data Entry Log
You can display and print the data entry log from the menu Data entry → Log → Reported data.

You can only enter cumulative data, not periodic data with MS Access.
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Currency Translation in MS Access
Use
Currency translation in the offline data entry program serves decentralized reporting purposes.

Features
Translation takes place with an exchange rate indicator and a translation ratio. The exchange
rate table is made available as part of the control parameters from the SAP system. It can be
updated locally.

Activities
Choose Currency translation for local maintenance as well as the execution of currency
translation. You can display and print a log on currency translation.
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Validation of Data Entered with MS Access
Use
Before exporting the reported financial data into the SAP system it is necessary to execute a
validation. The export can only take place when the validation has been executed without errors.

Features
You define the validation rules in the SAP system.  In addition the user can define and change
the ADMIN rules locally. The validation of breakdowns is predefined as validation under the
validation group SAP, in the offline data entry program.

Choose the menu option Validation to define and or change the validation rules as well as to
execute validation. If during execution of validation errors or inconsistencies occur which result in
warning messages, then a validation log is generated by the system. You can display and print
this for processing.
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Exporting Reported Financial Data
Use
The reported financial data is exported, after executing the processing steps in the offline data
entry program. They are uploaded into the SAP system and are then available for the execution
of Consolidation.

Furthermore you can transfer the reported financial data from MS ACCESS into Interactive Excel
via the interface. There you can prepare and evaluate the spreadsheet with the standard
functionality.

Features
You define the path for the export of data under Transfer → Definition. You have to define a path
for the export as well as the import of data.

Execute the export under Transfer → Export → Reported financial data.
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Release Upgrade
Use
For a release upgrade of the offline data entry program, you must execute the tasks mentioned
below with regard to control parameters, which are generated decentrally, and reported financial
data, which has already been entered.

In this way you avoid the loss of data during a release upgrade.

Activities
•  Before executing the release upgrade, export the validation rules created in the offline data

entry program. After executing the release upgrade, import these control parameters back
into the offline data entry program.

•  You have two alternatives to make the reported financial data available after the release
upgrade:

− You can export the reported financial data before the release upgrade and import
them again after the release upgrade.

− You can import the reported financial data directly from the database.
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Integrated Data Collection
Purpose
With SAP Consolidation you can execute different consolidation types that are based on user-
definable organizational units.

These components enable an integration to operational, data delivering SAP applications for the
following consolidation types:

•  Company consolidation

(Consolidation units: Companies)

•  Business area consolidation

(Consolidation units: Combinations of companies and consolidation business areas)

•  Profit center consolidation

(Consolidation units: Combinations of companies and profit centers)

Therefore these consolidation types are described as integrated consolidation types.

For integrated consolidation types the system can transfer the business transactions which are
relevant to the general ledger. You enter them in the operational SAP applications, in realtime or
periodically as reported data in Consolidation.

Features
Data Transfer Methods
The following data transfer methods are available:

•  Realtime update

•  Rollup

•  Periodic extract

The possible uses of this method are dependent on

•  for which integrated consolidation type you want to carry forward the operational data

•  which company scenario you have

Enterprise Scenarios
The components differentiate the following enterprise scenarios:

•  Central scenario:

The company units, which want to carry forward data from operational SAP applications
to the SAP Consolidation, work in the same SAP System and in the same clients as the
Consolidation.

The following graphic shows this scenario. You see, from which operational applications,
data can be delivered to the Consolidation.
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Gen. ledger (FI-GL) Controlling (CO)

Profit center actg (EC-PCA)

Consolidation (EC-CS)
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•  Decentralized scenario

The operational enterprise units work in another system or client to the Consolidation.
The following graphic shows this scenario:

Group headquarters

Operational company units

SAP Consolidation 

Operational
SAP applications

Data transfer
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Possible Uses of the Data Transfer Methods
The following table shows with which data transfer methods you can transfer operational data,
dependent on the enterprise scenario and integrated consolidation type.

Realtime
update

Periodic
extract

RollupRealtime 
update

Periodic
extract

Rollup

Company consolidation

Business area cons

Profit center cons

Central scenario Decentralized scenario
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Local and Global Account Assignments
Use
The operational applications work partly with other account assignments than Consolidation.
Some of these account assignments are local characteristics. The characteristic values of the
local characteristics are only known in the respective SAP system. In contrast to that, the
characteristic values of global characteristics are clear group wide; therefore you must make sure
that the global characteristics are maintained the same in all (integrated) SAP systems and
clients and are assigned the corresponding local characteristics.

The Consolidation derives the characteristic values of the corresponding Consolidation
characteristics from the characteristic values of the global characteristics.

Assuming that the companies of a group are managed in several SAP systems and
every company corresponds to a company code. The identifications of the company
codes are identical in different systems, although they represent different companies.
However the company identifications must be clear group wide.

Structure
The following tables assign local characteristics, global characteristics and Consolidation
characteristics to each other.

Assignment of organizational units

Integrated Cons type Local
characteristic

Global characteristic Cons characteristic

Company Cons Company code Company Consolidation unit
Business Area Cons Company code /

Business area
Company / Cons
business area

Consolidation unit

Profit center Cons Company code /
Profit center

Company / Profit
center

Consolidation unit

In the Implementation Guide (IMG) you assign the global organizational units company and
consolidation business area to the operational organizational units Company Code and if
applicable Business Area.

For business area consolidations (and profit center consolidations) the system derives the
consolidation units from the combinations of company codes and business areas (and profit
center).

Assignment of accounts to FS items

Data transfer
methods

Local
characteristic

Global characteristic Cons
characteristi
c
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a) Account Group
account

FS Item

Realtime
update

b) Account
a) Account Group

account
b) Account

Rollup

Secondary cost
element

Periodic
extract

Account FS item group financial
statement version

The transfer of a group value into a FS item value is dependent on the data transfer method.

•  Realtime update

You have two possibilities:

− In the IMG you can assign every operational account a group account, whose key is
identical with an item key of Consolidation. As a rule it is useful to assign several
operational accounts one group account and to aggregate through it.

− Alternatively it is possible that every account corresponds exactly to a consolidation item.
Then the aggregation with the group account is not necessary.

•  Rollup

The transfer of account in FS item is exactly as with the realtime update, therefore with
or without the group account. In addition to that you can transfer the cost elements in FS
items, in fact a cost element in a FS item (1:1) or ranges of cost elements in FS items
(N:1).

•  For periodic extracts you assign every account a  financial statement version in the IMG,
whose item key agrees with the item keys of Consolidation(group financial statement
structure). As a rule you assign several operational accounts the same FS item of the group
financial statement version and aggregate with it.

With this relationship between account and global key, the system can transfer the values to the
FS items of Consolidation.

Assignment of subassignments

Local characteristic Global characteristic Cons characteristic
Transaction type asset
accounting (FI-AA)

Cons transaction type Subitem or custom
characteristic

Business area Cons business area Subitem or custom
characteristic

Partner to account assignment of organizational
units (see above)
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The subassignments transaction type and business area are aggregated to global characteristics
as well. The transfer of partner assignment, that means partner company code and partner
business area is analogue to the characteristics company code and business area.
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Data Transfer Method 'Realtime Update'
Use
The realtime update is a data transfer method with which you can transfer general ledger
relevant business transactions in realtime as reported data in Consolidation. You enter the
business transactions in the operational SAP applications.

With this data transfer you can transfer reported data for company consolidations and for
business area consolidations, however not for profit center consolidations.

Integration
It concerns a realtime update in a fixed ledger to the totals table ECMCT. This update is different
from updates which offer the component special purpose ledger (FI-SL) in variable ledgers. It is
not possible to define a variable ledger to the totals table ECMCT.

Prerequisites
Prerequisite for the realtime update is that the sender and receiver of data work in the same SAP
System and in the same client.

Features

AC doc

Operational
Applications

+
Consolidation

ECMCTECMCTCons ledgerG/L

Account

Company code

...

FS item

Consolidation unit

...
Subitem

Parallel Posting in the Consolidation Processing Ledger
When you have activated the realtime update, then the system generates a parallel posting in the
consolidation processing ledger for every FI posting. The totals records are updated, in fact with
posting level space.
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You can determine with the definition of the consolidation processing ledger, that journal entries
are generated on realtime update. Journal entries are helpful when you have to post FI data
subsequently. With the help of the journal entries the system recognizes when posting
subsequently, which documents are already available in the consolidation processing ledger. On
the other hand a high volume of data arises from the journal entries. When you decide on journal
entries then you must define a document type in the Implementation Guide (IMG) of
Consolidation, in the section Integration.

Conversion of Operational Account Assignments into Consolidation
Account Assignments
The AC document, from which the Consolidation documents will be set up, contains amongst
other things account assignments (for example account, company code, business area). They
have to be converted into the account assignments of Consolidation (for example FS item,
consolidation unit, consolidation business area). This conversion is controlled as follows:

•  In the Implementation Guide you have to assign some local account assignments to the
global account assignments, for example every company code to be included in the
company.

•  In Consolidation you always use fixed ledgers with the totals table ECMCT. The transfer of
operational fields (sender fields) in the Consolidation fields (receiver fields) is preset by SAP.
Therefore you do not have to maintain any field transfers, except for custom subassignments
(see below).

•  Some of the account assignments in the AC document can be interesting for evaluations in
Consolidation, although there are no corresponding fields in the totals table of Consolidation
(ECMCT). It may possibly be requested to transfer the values with realtime update into
Consolidation. It concerns the following account assignments from the AC document:

− Consolidation transaction type

− Functional area

− Business area

− Customer’s country

− Cost center

− G/L account

For these account assignments Consolidation offers the field Subitem. In the subitem
category, you can define per FS item, which sender field the account assignment in the
subitem should be transferred from .

Update in Custom Characteristics of Consolidation
In Consolidation you have the possibility to enhance the database with additional characteristics,
so called custom characteristics. In order to fill these characteristics with sender fields of the AC
document, you have to add to the field movement 0C03 correspondingly in the IMG and possibly
execute the enhancement FMC10011 with the function module exit 250.

See also:
Make Settings for Custom Subassignments [Ext.] in the IMG.
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Update in several Ledgers and Fiscal Year Variants
In the master data, the consolidation units can be assigned several ledgers and fiscal year
variants. Then it is updated parallel in this ledger. So that the updated data remains consistent,
the following applies: A document is updated in a ledger when

•  the ledger is assigned all the consolidation units to be posted to on the basis of the document

•  the consolidation units use the same fiscal year variant

Activities
You activate the realtime update in the IMG of Consolidation, section Settings in the Sender
System.

Before you must have executed all the preparations for consolidation steps so that
the correct data is updated to the consolidation processing ledger.
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Data Transfer Method ‘Periodic Extract’
Use
The periodic extract is a data transfer method, with which you can transfer general ledger
relevant business transactions periodically as reported data in Consolidation. You enter the
business transactions in the operational SAP applications.

With this data transfer you can transfer reported data for company consolidations and for
business area consolidations, however not for profit center consolidations.

An important difference to the data transfer method of realtime update is that the operational
system, the consolidation system and the client do not have to be identical. The data is
transferred per file from the transaction system to the consolidation system.

Prerequisites
In the transaction system, you must have set up a financial statement version, whose item key is
identical with the item keys of the relevant consolidation of investments consolidation (group
financial statement structure).

Features

GLT3GLT3

Transaction
system

Consolidation
system

Doc.

GLT0GLT0 GLT3GLT3Cons prep.
ledger 09

Gen.ledger

ECMCTECMCT Cons ledger

Extract: RFBILA00
             +
Transfer of file

Update to cons

Cons prep.
ledger 09

Info about ledger currency

Parallel posting
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Transaction System
Parallel Posting in the Preparation for Consolidation Ledger
When you have activated the data transfer method periodic extract, then the system generates a
parallel posting in the preparation for consolidation ledger for every FI posting. The totals records
in the preparation for consolidation ledger are updated; journal entries are not generated.

SAP delivers the fixed ledger 09 with the totals table GLT3 as the preparation for consolidation
ledger. It is not possible to use another ledger for this.

Parallel posting in the preparation for consolidation ledger is justified that the
information which the totals records of the general ledger accounting offers, is not
sufficient for the Consolidation. In particular the partner information is missing.

The totals table of the preparation for consolidation ledger, the table GLT3, includes
these fields. These fields are filled from the AC document during the realtime update.

When you require the account assignment of the functional area for the portrayal of
the cost-of-sales accounting, then you have use a rollup as data transfer method
instead of the periodic extract, actually from a ledger whose totals table includes the
functional area. The totals table GLT3 does not include the functional area.

Generating a Periodic Extract from the Preparation for Consolidation Ledger
Before executing the consolidation, you generate an extract in the preparation for consolidation
ledger. For this you use the program RFBILA00 in the task level menu of the general ledger
accounting (section info system). In the initial screen of the program you enter in the field extract
to consolidation, whether the system should generate the extract at company code level or at
business area level. This causes the system to convert the local characteristics company code,
business area and so on in the global characteristics company, consolidation business area and
so on. You also enter the group financial statement version. The system summarizes the
operational accounts to the FS items of this structure.

An extract at business area level can also be useful for company consolidations,
namely then, when in the consolidation data you want to manage the consolidation
business area as a subassignment.

You can start the extract for one company code or for several company codes.

The system checks when generating the extract whether the totals of the general
ledger agree with the totals of the preparation for consolidation ledger. This
guarantees a correct dataset. If it finds variances then the system generates the
extract from the totals records of the general ledger, this does not then include the
necessary breakdowns by partners and so on.
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At the fiscal year change you have to execute a balance carried forward in the
preparation for consolidation ledger, actually at the same time as in the general
ledger. You start the balance carried forward via the task level menu of the
component special purpose ledger (FI-SL).

Transfer of the File
While generating the extract for company or business area consolidation, enter in a dialog box,
the logical file name, which you have defined before in the Implementation Guide (IMG) of
Consolidation, section Integration: Preparation for Consolidation  → Preparations in the Sender
System → Preparation and Activation of the Data transfer → Periodic Extract from Preparation
for Consolidation Ledger. Then choose whether the file should be stored on an application
server, or on a presentation server. The system informs you after generating the file, what the file
name is (including the link).

The transfer of the file is dependent on the condition of your system. For example the transfer
can take place via access to the network.

Updating the Extract to the Consolidation Processing Ledger
In the consolidation system, you run the tasks for the data collection in the data monitor. You
enter the physical file name of the extract (including the link) in a dialog box.

Note that the system can only process one extract per execution of the task. If
several extracts for a consolidation group are ready for updating, then you have to
run the tasks for the relevant consolidation units individually.

The system reads the data from the extract, converts the account assignments and updates the
data in the Consolidation processing ledger, actually in local currency, transaction currency and
group currency.

To update group currency values, the system proceeds as follows:

1. It determines the currency of the preparation for consolidation ledger (in the consolidation
system!).

2. It compares this currency with the currency of the Consolidation processing ledger.

a. When these ledger currencies are identical, then the system updates the group currency
values from the extract in the Consolidation processing ledger.

b. When these ledger currencies are different, then the system translates the group
currency values from the extract in the ledger currency of the Consolidation processing
ledger and updates them.

You should make sure organizationally, that the ledger currency of the preparation for
consolidation ledger in the consolidation system is identical with the ledger currency of
the preparation for consolidation ledger in the transaction system, which the periodic
extract delivers. When you can not implement this, then the system interprets the group
currency values of the extract in the wrong currency. Then you must calculate the
transferred local currency values again.

The periodic distances, in which you generate this extract, are dependent on the
consolidation frequency of the consolidation group.
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When you use custom characteristics in the Consolidation and want to fill these by a
periodic extract, then you have to execute the enhancement FMC 10011 with the
function module exit 250 in the IMG.

See also:
Execute Enhancement for Custom Subassignment [Ext.]

Activities
You activate the data transfer method Periodic Extract in the IMG of Consolidation, section
Settings in the Sender System.

Before you must have executed all the preparations for consolidation steps so that
the correct data is updated to the preparation for consolidation ledger and can be
transferred to Consolidation.
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Data Transfer Method ‘Rollup’
Use
Rollup is a data transfer method with which you can transfer general ledger relevant business
transactions periodically as reported data in Consolidation. You enter the business transactions
in the operational SAP applications.

Rollup is the only possibility to transfer data from the operational SAP applications, when

•  operational data for profit center consolidations should be transferred

•  operational data should be transferred with the account assignment of the functional area (for
example from the table GLFUNCT), in order to map the cost of sales accounting with the
account assignment of the functional area.

•  operational data should be transferred from your own defined tables

Integration
This data transfer method concerns the rollup  of the component special purpose ledger (FI-SL).

Features

AC docs

ECMCTECMCT
Cons ledger

GLPCTGLPCT
Profit center

ledger

a) central scenario
                   +
c) decentr. scenario with  ALE

ECMCTECMCTCons ledger
Standard rollup
GLPCT ECMCT

b) decentr.
    scenario
    w/o ALE

c) decentr.
    scenario
    with ALE

Export rollup
ECMCT ECMCT

Standard-Rollup
ECMCT ECMCT

Posting in Quantities
In the operational applications you set up the postings in the sender ledger. You can generate a
rollup from any ledger. However the ledger totals table must contain the field, whose account
assignments are necessary for Consolidation.
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Rollup from the Sender Ledger
To transfer the data to Consolidation, you execute a rollup which selects the operational data in
the sender ledger and converts it in the Consolidation totals table (ECMCT). The following
activities are required for this:

1. You Define Rollup for Data Exports [Ext.]  in the Implementation Guide (IMG) of
Consolidation. A rollup is preset in the SAP standard system which you should use as a
reference.

2. You execute the rollup via the task level menu of the component special purpose ledger (FI-
SL).

Transfer of the Rollup Data
Update of the rolled data records in the consolidation processing ledger is dependent on the
enterprise scenario.

•  Central scenario (same system, same client) as well as decentralized scenario with ALE
The system updates the rolled data records directly in the consolidation processing
ledger.

•  Decentralized scenario (different systems or clients) without ALE

− The standard rollup in the sender system (GLPCT → ECMCT) writes the data records to
a file. For this you must enter the physical file name and link when executing the rollup in
the parameter screen via Extras → Export File within the context of Output Data. Link
and name can be up to a maximum of 30 characters.

− The transfer of the file to the Consolidation system and to the Consolidation client is
dependent on the condition of your system. For example the transfer can take place via
access to the network.

− In the Consolidation system / clients you require a standard rollup to apply the file, which
roles from ECMCT to ECMCT. This rollup reads the file, checks the data and updates
them in the consolidation processing ledger. The following activities are required for this:

•  You Define Rollup for Data Imports [Ext.] in the Implementation Guide (IMG) of
Consolidation.

•  You execute the rollup in the task level menu of Consolidation either via the data
monitor, or you choose Data → Reported Data → Rollup In the parameter screen
you enter the physical file name and link via Extras → Export File within the context
of Input Data.

If required you can also use this procedure in a central scenario.

•  Decentralized scenario with ALE

− As with the central scenario: The system updates the rolled data records directly in the
consolidation processing ledger of the sender system.

− To apply the data via ALE in the Consolidation system, you require an export rollup,
which roles from ECMCT to ECMCT. Via ALE you update the data in the Consolidation
system.
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You will find more information in the IMG Special Purpose Ledger (FI-SL), section Tools
→ Distribution (ALE) [Ext.].

Activities
You set the data transfer method Rollup in the IMG of Consolidation, section Settings in the
Sender System.

Before you must have executed all the preparations for consolidation steps so that
the correct data is updated to the preparation for consolidation ledger and can be
transferred to Consolidation.

When you want to execute a rollup from the consolidation staging ledger (Ledger
09), then note the following:

•  When you have set the data transfer method rollup in step Activate Data
Transfer [Ext.] , then you can not execute the FI documents in the
preparation for consolidation ledger in realtime. The realtime execution in
the preparation for consolidation ledger only functions when you have set the
Periodic Extract as data transfer method.

•  However you can set the data transfer method Rollup and post the FI
documents subsequently and periodically in the consolidation staging
ledger. You have to make sure here, that in the periods to be posted
subsequently, no more current postings will take place. For posting
subsequently, the step Tools for the Structure of the Initial Data Set → Post
FI Documents [Ext.] is available. Afterwards you can execute the rollup from
the preparation for consolidation ledger and apply it in the consolidation
processing ledger.
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Group Chart, Financial Statement Version, Cons Chart
Purpose
In the Implementation Guide (IMG) of Consolidation, section Preparations in the Consolidation
System, tools are available with which you can set up the group chart of accounts, the group’s
financial statement version and the consolidation chart of accounts of Consolidation. Which of
these structures you require, depends on the data transfer methods which you set in your group.

Some scenarios and how you can set the tools are suggested in this document.

•  Scenario 1: Group chart of accounts is used
In this scenario we assume that

− for the data transfer in your group, you only use the realtime update and/or the rollup

− the operational accounts do not agree 1:1 with the FS items of Consolidation, therefore
you require the group accounts for the transfer of operational accounts into FS items

•  Scenario 2: Group’s financial statement version is used
In this scenario we assume that you set the periodic extract for the data transfer in your
group.

•  Scenario 3: Group chart of accounts and group’s financial statement version are used
In this scenario we assume that you set both the periodic extract and the realtime update
for the data transfer in your group and possibly also the rollup.

Prerequisites
We assume that in the consolidation system not only the consolidation chart of accounts of
consolidation are set up, but also the group chart of accounts and the group’s financial statement
version are set up and transferred to the transaction systems.

Process Flow
Scenario 1: Group chart of accounts is used
Activities in the Consolidation system
1. Set up consolidation chart of accounts manually

2. Set up group chart of accounts automatically from consolidation chart of accounts

When the group chart of accounts already exists then you can set up the
consolidation chart of accounts from it automatically. Though you have to rework the
master data of the FS items.

3. Transport the group chart of accounts into the transaction system

4. When data transfer takes place for profit center consolidation, then, if necessary, assign the
interval secondary cost element to the FS items.
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5. When rollup is used (for any integrated consolidation type), then export the rollup relevant
Customizing settings to file, in order to transfer them to the transaction systems.

Activities in every transaction system
1. Import group chart of accounts

2. Assign group chart of accounts to the operational chart of accounts

3. Assign group chart of accounts to the operational accounts manually

4. When rollup is used, then import the rollup relevant Customizing settings of the consolidation
system.

Scenario 2: Group’s financial statement version is used
Activities in the Consolidation system
1. Set up the group’s financial statement version manually

You only create the FS items in the structure and do not assign any accounts. (The
assignment of accounts takes place in the transaction systems.)

2. Set up the consolidation chart of accounts automatically from the group’s financial statement
version, provided that it does not exist.

3. Transport the group’s financial statement version into the transaction systems

Activities in every transaction system
1. Import the group’s financial statement version

2. Assign ranges of operational accounts to the FS items of the structure

Scenario 3: Group chart of accounts and group’s financial statement
version are used
Activities in the Consolidation system
1. Set up the group’s financial statement version manually

You have the following possibilities:

a. You set the indicator group account number and assign the corresponding group account
to the FS items in the lowest navigation group (after having executed steps 3 and 4).

Explanation:

In this case you do not assign operational accounts to the structure, but group
accounts instead. Then the sender system carries forward the operational account
values while generating a periodic extract, via the assigned group accounts in the FS
items of the financial statement version.

b. You only create the FS items in the structure and do not assign any accounts. (The
assignment of accounts takes place in the transaction systems.)

2. Set up the consolidation chart of accounts automatically from the group’s financial statement
version, provided that it does not exist.

3. Set up group chart of accounts automatically from cons chart of accounts
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4. Transport the group’s financial statement version and group chart of accounts into the
transaction systems

5. When data transfer takes place for profit center consolidation, then, if necessary, assign the
interval secondary cost element to the FS items.

6. When rollup is used (for any integrated consolidation type), then export the rollup relevant
Customizing settings to file, in order to transfer them to the transaction systems.

Activities in every transaction system
1. Import the group’s financial statement version and group chart of accounts

2. If you have chosen case 1.b in the consolidation system, then assign operational account
intervals to the FS items of the group’s financial statement version

3. Assign group chart of accounts to the operational chart of accounts

4. Assign group chart of accounts to the operational accounts:

a. When you have assigned the group’s financial statement version operational account
intervals (see step 2), then automatically assign the group accounts to the operational
accounts with the help of this structure.

b. Otherwise assign the group chart of accounts to the operational accounts manually

5. When rollup is used, then import the rollup relevant Customizing settings of the consolidation
system.

Result
After these activities you have created the link between the operational accounts and the FS
items of Consolidation.
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Integrated Company or Business Area Consolidation
Purpose
This process description explains how you transfer data for a company or business area
consolidation from operational SAP applications.

Process Flow
A. Customizing in the Sender System and in the Consolidation System
For the integrated data collection you have to execute the Customizing settings both for the
sending of data and for the receiving of data.

•  Sender of data are the operational SAP applications.

•  Receiver of data is Consolidation.

With a central scenario the sender and receiver work in the same system and client,; with a
decentralized scenario the sender and receiver work in different systems and clients.

All Customizing settings are offered in the IMG of Consolidation, in the section
Integration → Preparation for Consolidation. You will find detailed explanations in the
documentation on the individual sections.

The IMG section is divided into preparations which are to be executed in the sender
system and preparations which are to be executed in the consolidation system. From
the more general case, the IMG assumes that the operational applications work in
other systems (at least partly). When you have a central enterprise scenario, then
nevertheless you have to execute the IMG section part Preparations in the Sender
System and Preparations in the Consolidation System. Only the steps which offer the
transfer of Customizing settings between the systems do not apply in a central
scenario.

The following graphic shows, in an overview, which settings are to be executed in the IMG. The
numbers 1 to 5 set the order of the settings chronologically. As the sender system relies on the
Customizing settings of the consolidation system and vice versa, at least a part of the
Customizing settings must be organizationally reconciled to each other.
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IMG Cons system IMG Sending system

Transfer global master data:
- Companies
- Cons business areas
- Group chart of accounts or
  Group financial statement version 
- Cons transaction types

Create or import global
master data

Assign integrated cons types of 
views

Set up Cons units/groups

 Prepare data transfer:
 - Assign charts of accts and cons C/A 
 - Define data streams
 - and so on

Define combinations CoCd/
business areas

Transfer combination
CoCd/BA to cons system

On Rollup: transfer settings to
sending system

On Rollup: transfer settings
from cons system

2

44

Activate data transfers5

Prepare acct. assignment:
Cons TType, Cons BA, Partner
company

Enter chart of accounts

Assign operational accts3
3

1

1. The group headquarters sets the global master data in advance:

Global characteristics Transfer to sender systems

Companies

Cons business areas

Group chart of accounts and/or group financial
statement version

(according to data transfer method / scenario;
compare Group C/A, Financial Statement Version,
Cons C/A [Page 169]

Cons transaction types

On organizational way or by transport

In the IMG section Preparations in the Consolidation System, you will find the tools to
create and transport the group chart of accounts and the group financial statement
version.

In addition to that you define which integrated consolidation types are to be displayed in
the views.

2. In the sender system you create the global master data or import them from the consolidation
system. You assign the global organizational units to the local ones:
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Global characteristics Local characteristics

Company Company code

Cons business area Business area

For business area consolidations you also enter which business areas the individual
company codes manage. The system converts the combinations of company codes and
business areas which have been defines by you to the combinations of company
codes/business areas. It then exports this into a file. You transfer this file to the
consolidation system.

3. The next steps can run parallel in the sender system and in the consolidation system.

− In the consolidation system you automatically set up the integrated consolidation units
and groups per view.

Integrated Cons type Cons unit’s structure Cons group’s structure

Company consolidation from company codes, to which
a company is assigned

a top consolidation group

Hierarchy by cons business
areas

Business area
Consolidation

from combinations
companies/cons business
areas Hierarchy by companies

For every hierarchy you have to create the top consolidation group manually. This is
not integrated, that means that there are no corresponding operational organizational
units.

Subsequently you prepare the transfer of data. A prerequisite for this is that you find
out from the sender system on the organizational way, which operational charts of
accounts are being used.

− In the sender system you summarize the operational accounts according to the data
transfer method.

•  With realtime update and rollup you assign the group chart of accounts to the
operational accounts (that is if the operational accounts correspond to the FS items
of Consolidation 1:1).

•  With periodic extract you assign the group financial statement version to the
operational accounts.

In addition to that you assign the global characteristics cons transaction type, cons
business area (provided that it has not already taken place) and trading partner to
the local characteristics, so that the operational data is supplied with that.
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The steps for this from the operational applications are compiled in the IMG of
Consolidation. A part of the step is cross-consolidation type, that means it is
necessary for all consolidation types. There are also steps which are only necessary
for business area consolidation.

If required you prepare to manage parallel currencies and evaluations in the
operational data.

4. When you use rollup as a data transfer method, then you export the consolidation system’s
Customizing settings to a file and transfer this to the sender system. The sender system
requires some of the Customizing settings in order to convert the operational data, so that
they can be processed in the consolidation structures.

5. In the sender system you define per integrated consolidation type, with which data transfer
method you want to transfer data to Consolidation. You prepare this method(s) and
subsequently activate them.

Note that from the activation of the data transfer methods Realtime Update and
Periodic Extract, the operational data is updated to the consolidation processing
ledger and the preparation for consolidation ledger. You have to set up the initial
data set before (see B.).

Structure of the Data Initial Set
In the consolidation processing ledger, the preparation for consolidation ledger and the sender
ledger for rollup, you set up the initial data set.

See also:
Legacy Data Transfer [Page 197]

Update of Operational Data
The procedure how you transfer data in the consolidation processing ledger, is dependent on the
data transfer method.

•  Realtime update

The system updates the data directly in the consolidation processing ledger.

Note that the realtime update is dependent on the status which the tasks for data
collection have in the data monitor of Consolidation. Even when tasks are blocked,
documents are updated.

With realtime update, the status of the tasks for the data collection are not updated.
When the status is initial, then it does not change with the realtime update. You can
block tasks at a suitable time to execute the subsequent tasks.

See also:
Data Transfer Method Realtime Update [Page 159]

•  Periodic extract
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The system updates the data in the consolidation processing ledger. There you create a
periodic extract on the key date of Consolidation. You transfer these to the consolidation
processing ledger.

See also:
Data Transfer Method Periodic Extract [Page 162]

•  Rollup

The system updates in the sender ledger for the rollup, for example a variable ledger to a
custom table. From there you execute a rollup in the consolidation processing ledger at
the key date.

See also:
Data Transfer Method Rollup [Page 166]

Result
In Consolidation the integrated data can be formatted and consolidated.
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Account Assignment Company and Trading Partner
Use
For postings which originate from inter-group business relationships, company and trading
partner have to be assigned, so that these activities can be consolidated.

These account assignments are not only for company consolidations, but are also necessary for
business area consolidations and profit center consolidation.

Features
Derivation of the Company
With company code postings, to which a company is assigned, this company is assigned in an
AC document.

Derivation of the Trading Partners
Customizing
For every customer and vendor which display an affiliated internal trading partner, you have to
enter the company identification in the master record.

When, instead of a customer account or vendor account, a general ledger account is used
specially for an affiliated business partner, then also enter the company identification in the
master record of this master record. However this case represents an exception.

See also
Account Assignment Trading partner [Ext.] in the IMG Consolidation.

Automatic Account Assignments
When you post to an affiliated customer or vendor, then the system derives the trading partner
from the master record and assigns it:

•  in the current document line item

•  in the document line items of the offsetting entry (inheritance)

However passing on the trading partner from the current lines to the other document line item is
only possible when only one trading partner is posted to per document. You can define this in the
document type (see IMG step Account Assignment Trading Partner).

Manual Account Assignment
When postings have no current reference, then the trading partner can not be automatically
derived. For example this applies for a transfer between income statement accounts. In this case
you have to enter the trading partner manually in the document header.

Explanation for Selected Business Transactions

Vendor / Customer Invoice (FI-AP/AR)

•  Vendor / customer invoice
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The system transfers the company identification from the master record and passes it on
in the offsetting entry. Only the trading partner can be posted to per document.

•  Vendor / customer payment

It can be required with these business transactions, that more than one trading partner is
assigned per document (control via the document type). Then the trading partner is only
assigned in the current line and not in the cash accounts. This is sufficient, as the cash
accounts are not partner relevant.

•  Down payment and down payment clearing

These business transactions always have current reference and are therefore treated
like the customer / vendor invoice.

Asset Accounting (FI-AA)

•  Asset transfers between company codes

The system create two documents when transferring a fixed asset in another company
code. In all document line items, every document has the company identification of the
other company code as trading partner.

Materials Management (MM)

•  Goods/invoice received

For goods receipt and invoice receipt from an affiliated supplier, the system derives the
trading partner from the vendor’s supplier data. It assigns both the goods / invoice
received and the offsetting entries with this trading partner.

Controlling (CO)

•  Cross-company code allocations

These are transferred periodically, via the reconciliation ledger, as adjustment entries to
financial accounting. The trading partner derives itself from the company code.
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Assignment of Business Area and Partner Business
Area
Use
Prerequisite for reports about business areas is, that all FS items of financial statements and
income statements, for which the business area has responsibility, are to be supplied with the
business area account assignment. This is in particular the FS items of the transferred assets,
the receivables and payables, the material stocks, as well as all FS items of the income
statement.

In addition to that for business area consolidations, it is necessary that the postings, which
originate from group-internal business relationships, are supplied with the trading partner
business area.

Therefore the operational postings to the accounts which are relevant for business areas, have to
contain business area account assignments and trading partner account assignments.

Features
Account Assignment of Business Area
It depends on the business transaction, how the business area is assigned in the operational
postings. Fundamentally there are two possibilities: The system can either derive the business
area automatically from master records of the concerned account assignment objects, or the
administrator has to enter the business area manually.

You will find detailed explanations at FI Business Area [Ext.] (SAP Library).

The following table explains the account assignment of the business area (BA) in an overview.
The table is divided according to the components in which the accounting document occurs. Per
component you will be able to go to the detailed FI documentation on the business area.

SAP components Autom. derivation? Manual Entry? FI-Documentation

G/L accounting When you enter a CO
account assignment
object, then the
system can derive the
BA from its master
record.

always necessary
when no derivation
from CO account
assignment object
occurs

BA in General Ledger
Accounting [Ext.]

Asset accounting from master record of
the asset

not necessary BA in Asset
Accounting [Ext.]
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Accounts receivable /
payable accounting

from one or more
business areas for
G/L account offsetting
entries

When several BAs are
assigned in offsetting
entries, then you have
to readjust the BA in
the reconciliation
account (see below).

not necessary BA in Accounts
Receivable/Accounts
Payable [Ext.]

Controlling from master record of
the CO account
assignment object

not necessary BA in Controlling
[Ext.]

Materials
management

from the BA
assignment for
material, in fact per
combination of
division and plant

not necessary BA in Materials
Management [Ext.]

Sales Derivation rule per
sales area (IMG):
either BA assignment
for each plant/division
or each sales area

not necessary

In the IMG of Consolidation, section Preparations in the Sender System → Further
Settings for Business Area Consolidation, steps from the operational applications are
compiled, which are to be executed for the account assignment of the business area.
The compilation was intended as a checklist from a Consolidation point of view.

Assignment of Trading Partner Business Area
As with assigning the business area, it depends on the business transaction, as to how the
trading partner business area is assigned. Fundamentally there are two possibilities: The system
can either set the trading partner business area “diagonally”, or the administrator has to enter the
trading partner business area manually.

“Diagonal” Derivation of the Trading Partner Business Area
With the business transactions of materials procurement and sales, the system can automatically
derive the trading partner business area. Prerequisite for this is that the delivering and receiving
partner set the SAP components Materials Management and Sales in the same SAP System and
in the same client.

Process Flow:

•  You enter a purchase order in Materials Management. In the MM document you assign the
business area, for which you are ordering the material. From the purchase order, the system
generates a sales order. In the SD document the business area is assigned, from which the
material is delivered.
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•  General ledger relevant documents are created for goods issue (SD) and goods receipt
(MM). The system sets the trading partner business area “diagonally” in the documents.

− In the goods issue document the system assigns the trading partner business area,
which it derives from the purchase order.

− In the goods receipt document the system assigns the trading partner business area,
which it derives from the supplier data.

•  Subsequently issue receipt (SD) and invoice receipt (MM) are posted. The payment
transaction is processed in the vendor / customer invoice.

Materials Mgmt Sales

CoCd: C100
Material: C-SA1
BusAr: 6000  

Order

CoCd: C100
Material: C-SA1
BusAr: 6000 
Partner BA: 4000

Goods rcpt

CoCd: C100
Material: C-SA1
BusAr: 6000 
Partner BA: 4000

Invoice rcpt

CoCd: C100
Material: C-SA1
BusAr: 4000  

Sales order

CoCd: C100
Material: C-SA1
BusAr: 4000
Partner BA: 6000  

CoCd: C100
Material: C-SA1
BusAr: 4000
Partner BA: 6000  

Goods issue

Issue receipt

FIFI

FI FI

Customizing:
In the IMG the companies have to identify the same clients to enable the automatic derivation of
the trading partner business area.

When Materials Management and Sales of group-internal business partners do not
work in the same system and in the same client, then you can bring about the
automatic assignment of the trading partner business area via the substitution rule.
For example you define the rule that on delivery of material C-SA1 from plant 1,
trading partner business area 6000 is assigned.

Manual Entry of Trading Partner Business Area
When you enter in accounts receivable/payable accounting, then you enter the trading partner
business area in the document header or in the G/L account. The trading partner business area
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is not passed on to the current line (also not when it is clear in the document). Therefore it must
be readjusted to the reconciliation account Receivables or Payables (see below).

To enter the trading partner business area, the administrator must have the information which
business area is concerned with the group-internal business partner. You have to organize this
flow of information.

Adjustment of Balance Sheet and Income Statement with Business Areas
and Trading Partner Business Areas
Business Area Adjustment
The adjustment of business areas is always necessary when you want to create a business area
balance sheet / income statement in financial accounting. In addition to that it is also necessary
for business area consolidations.

You execute the adjustment in the G/L accounting (menu Periodic Work) in fact for the following
reasons:

•  When posting a document, not all document line items are supplied with the business area.
The document line items are not supplied for the following accounts:

− Reconciliation accounts for receivables and payables (when the business area is not
clearly in the document)

− Tax accounts

− Cash discount accounts

− Accounts for exchange rate differences

The adjustment program distributes the business area account assignment from the
offsetting accounts to the accounts to be adjusted.

•  The adjustment program makes sure that the entire balance is null, per business area. The
program creates the corresponding elimination postings.

In the menu Period Work there is an adjustment program for the balance sheet account and an
adjustment program for the income statement accounts.  You will find detailed information in the
FI documentation Generating Business Area Financial Statements [Ext.] (SAP Library).

The adjustment can not be carried out at any time, rather it must take place after the
evaluation of open items. After that you are not allowed to carry out any more
postings to business areas.

The following example explains the adjustment of business areas to the reconciliation accounts
Receivables, with the help of a simple posting example. Tax postings are disregarded.

Example A
A customer invoice is created in which the sales revenue is assigned to a business area.

Invoice

Account Business area Amount
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Customer / receivable 6000 (passed on as offsetting entry) 1,000.00

Revenues 6000 1,000.00-

As the business area is clear in the document, the system can pass on the business area
account assignment from the G/L account line to the current line and with it to the reconciliation
account Receivables. Therefore no adjustment is necessary for this posting.

Example B
A customer invoice is created in which the sales revenue is assigned to several business areas.

Invoice

Account Business area Amount

Customer / receivable 1,000.00

Revenues 5000 600.00-

Revenues 6000 400.00-

The system does not pass on the business area to the current line. Otherwise the customer
posting would be excessively large. It is important that the receivable is divided into the business
areas. You achieve this with the adjustment program.

Adjustment

Adjustment account Business area Amount

Receivables 1,000.00-

Receivables 5000 600.00

Receivables 6000 400.00

The adjustment program writes off the amount of 1,000.00 to the adjustment account for the
receivable without the business area account assignment and with stock allocation to the
business areas again.

Receivables account and adjustment account must be assigned the same FS item
from the financial statement version as well as the same consolidation item.

Trading Partner Business Area Adjustment
When you have activated the data transfer for business area consolidation in Customizing, then
the adjustment program also assigns the trading partner business area to the accounts to be
adjusted.

Invoice

Account Business area Trading partner BA Amount

Customer / receivable 6000 (passed on as offsetting
entry)

1,000.00
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Revenues 6000 4000 1,000.00-

As the business area is clear in the document, the system passes it on from the G/L account line
to the current line and with it to the reconciliation account Receivables. However the system does
not generally pass on the business area to the current line. Therefore the trading partner
business area must also be adjusted.

Adjustment

Adjustment account Business area Trading partner BA Amount

Receivables 6000 1.000,00-

Receivables 6000 4000 1.000,00

The adjustment program writes off the amount of 1,000.00 to the adjustment account for the
receivable without the business area account assignment and with the business areas again.

Activities from the Consolidation Point of View
The execution of the adjustment is not the Consolidation administrator’s responsibility, instead it
is the responsibility of the G/L accounting.

However as the person responsible for the data transfer to Consolidation, you should check
whether the adjustment program was executed, so that the data, which you transfer to
Consolidation, had the necessary business area account assignments.
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Data Stream
Use
With the help of the definition of the data stream and with the help of other Customizing settings,
the system calculates how it should update the operational data streams in the consolidation
processing ledger.

Features
The following graphic shows an overview of how the system calculates the Consolidation data
streams with the realtime update of operational documents.

Subsequently you will find explanations for the data stream with the utilization of the rollup or the
periodic extract.

OrgUnits

Accts

Breakdowns:

 Doc.

Concatenation rules (int. GS) 

Define active data streams:
View / Cons C/A / Version

Master data Cons units 

SAP enhancement + Cust.exit  

Assgt C/A - Cons C/A 

Master data subitem cat.  

Assgt Accounts - FS items 

Cons Data

Tty
Country
Region
...

Customizing View

Cons unit

Version

Cons C/A

Ledger

FS item

Subassignment

Define global OrgUnit
Fiscal yr/Period

Company code
Business area
...

Realtime update
for Co. Cons/
BA Cons

Posting date

•  View, version and Consolidation chart of accounts.

From the IMG settings Define Data Streams (section Preparations in the Consolidation
system) the system calculates the active data streams per active consolidation type).

According to the data transfer method the following applies:

− The realtime update can fill several data streams parallel, that means several data
streams can be active at the same time for an active consolidation type.
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− A rollup can only fill one data stream. When several data streams are active for an active
consolidation type, then the system must choose a data stream exactly.

•  When you start posting the rollup data in the Consolidation menu via the data
monitor, then the system chooses view, version and consolidation chart of accounts
from the global parameters.

•  When you start posting the rollup data in the Consolidation menu via the detail
monitor, then the system identifies the view, version and consolidation chart of
accounts from the entries which you made while defining the rollup in the rollup reset
set.

− The periodic extract can only fill one data stream. You choose this data stream by
entering the view, version and consolidation chart of accounts while applying the extract
on the initial screen.

•  Consolidation processing ledger

− The system calculates the Consolidation processing ledger(s) from the master data of
the consolidation unit on the realtime update.

The system updates the operational document in every assigned ledger, provided
that the following conditions are filled:

•  The ledger must be assigned all consolidation units which are to be posted
to via the document.

•  The consolidation units must use the same fiscal year variant.

− On rollup the system calculates the Consolidation processing ledger(s) which you have
entered in the rollup sequence while defining the rollup. Make sure that these ledgers are
assigned to the consolidation units to be posted to.

− While applying the periodic extract in Consolidation, the system calculates the ledger
from the global parameters. Make sure that this ledger is assigned to the consolidation
units to be posted to.

•  Fiscal year and period

− Realtime update

From the posting date and the fiscal year variant, which are set in the master data of
the consolidation unit, determines the system the fiscal year and the period.

− Rollup

When creating a rollup, the system uses the fiscal year variant for consolidation
which you specified in the IMG setting Activate Data Transfers (section Preparations
in the Sender System). If the company code data for the rollup is kept in the sender
ledger under a different fiscal year variant, the system converts the periods in the
rollup.

− Periodic extract

The systems determines the fiscal year and period from the global parameters.

See also: Data Collection with Shifted Fiscal Years [Page 195]

•  Consolidation unit and consolidation group
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On the basis of the IMG settings Enterprise Structure and Define Concatenation Rules,
the system converts the operational organizational units into the organizational units of
Consolidation.

•  FS item

− With realtime update and rollup

From the IMG settings Assign Chart of Accounts to the Cons Chart of Accounts
(section Preparations in the consolidation system) and the IMG settings Operational
Accounts: Groups Account Assignment.

− With periodic extract

The periodic extract already delivers the data with the consolidation item
identification, as the extract is generated with the group’s financial statement version.

•  Subassignments

The system reads the account assignment category from the master data of the FS item
and calculates the breakdown by subassignments.

− When the account assignment category plans a breakdown by subitems, then the
system calculates the sender field from the subitem category and transfers the
characteristic value of the sender field into the subitem.

− When the account assignment category plans a breakdown by partners , the system
converts the partner assignment in the operational document into the partner unit
(analogue to the conversion of the consolidation units).

− When the account assignment category plans a breakdown by custom subassignments,
then you have to set up the transmission of operational characteristics in these
subassignments in the IMG settings Preparation and Activation of the Data Transfer.
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Integrated Profit Center Consolidation
Purpose
This process description explains how you transfer data for a profit center consolidation from
operational SAP applications. Rollup is available as a data transfer method.

Prerequisites
You set the profit center accounting and post the data of the current controlling area in the profit
center ledger (totals table GLPCT).

Process Flow
A. Customizing in the Sender System and in the Consolidation System
For the integrated data collection you have to execute the Customizing settings both for the
sending and receiving of data.

•  Sender of data is the operational SAP applications.

•  Receiver of data is Consolidation.

With a central scenario the sender and receiver work in the same system and client, with a
decentralized scenario the sender and receiver work in different systems and clients.

All Customizing settings are offered in the IMG of Consolidation, in the section
Integration → Preparation for Consolidation. In the documentation on the individual
sections you will find detailed explanations.

The IMG section is divided into preparations which are to be executed in the sender
system and preparations which are to be executed in the consolidation system. From
the more general case, the IMG assumes that the operational applications work in
other systems (at least partly). When you have a central enterprise scenario, then
nevertheless you have to execute the IMG section part Preparations in the Sender
System and Preparations in the Consolidation System. Only the steps which offer the
transfer of Customizing settings between the systems do not apply in a central
scenario.

The following graphic shows, in an overview, which settings are to be executed in the IMG. The
numbers 1 to 5 set the order of the settings chronologically. As the sender system relies on the
Customizing settings of the consolidation system and vice versa, at least a part of the
Customizing settings must be organizationally reconciled to each other.
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IMG Cons system IMG Sender system

Transfer global master data:
- Companies
- Group chart of accounts
- Cons transaction types

Create or import global
master data

Assign integrated cons types of 
views

Set up Cons unit/group
 Prepare data transfer:
 - Assign charts of accounts, cons C/A
 - Assign cost element intervalls of items
 - Define data streams
 - and so on
       

Define combinations
CoCd/Profit Center

Transfer combination CoCd/
profit center to cons system

Transfer settings to sender
system

Transfer settings from  cons
system

12

3

44

Activate data transfer 5

Prepare acct assgmt:
Cons Tty,  partner Co Parter
profit center

Enter chart of accounts

Assign operational accts3

4. The group headquarters sets the global master data in advance:

Global characteristics Transfer to sender systems

Companies

Group chart of accounts

(see also Group C/A, Financial Statement
Version, Cons C/A [Page 169]

Cons transaction types

On organizational way or by transport

You define the profit center independently of the controlling area. When you include
several controlling areas in your profit center consolidation, then you must note the
following:

•  You must make sure that the profit center is clearly defined group wide. That
means: Every characteristic value of the characteristic profit center must be
clear group wide and represent one profit center exactly.

•  So that you can assign the profit center another controlling area as partner in
a controlling area, you have to create the partner profit center in the
controlling area to be posted. The system checks whether the partner profit
center exists. You should set the block indicator in the master data of this
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potential partner profit center. This makes sure that it only posts as partner
profit center and not as profit center.

In the IMG section Preparations in the Consolidation System, you will find the tools to
create and transport the group chart of accounts.

In addition to that you define which integrated consolidation types are to be displayed in
the views.

5. In the sender system you create the global master data or import them from the consolidation
system. You assign the global organizational units to the local ones:

Global characteristics Local characteristics

Company Company code

You also enter which profit centers the individual company codes manage. The system
exports the combinations company / profit center to a file. You transfer this file to the
consolidation system.

6. The next steps can run parallel in the sender system and in the consolidation system.

− In the consolidation system you automatically set up the integrated consolidation units
and groups per view.

Integrated Cons type Cons unit’s structure Cons group’s structure

Hierarchy by profit centersProfit center Cons from Combinations
Co/Cons BA Hierarchy by companies

For every hierarchy you have to create the top consolidation group manually. This is
not integrated, that means that there are no corresponding operational organizational
units.

Subsequently you prepare the transfer of data. A prerequisite for this is that you find
out from the sender system on the organizational way, which operational charts of
accounts are being used.

− In the sender system you summarize the operational accounts according to the data
transfer method. You assign the group chart of accounts to the operational accounts
(that is if the operational accounts correspond to the FS items of Consolidation 1:1).

In addition to that you assign the local characteristics cons transaction type, trading
partner, partner profit center to the local characteristics, so that the operational data
is supplied with that.

The steps for this from the operational applications are compiled in the IMG of
Consolidation. A part of the step is cross-consolidation type, that means it is
necessary for all consolidation types. There are also steps which are only necessary
for profit center consolidation.
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You possibly prepare to manage parallel currencies and evaluations in the
operational data.

4. You export the consolidation system’s Customizing settings to a file and transfer this to the
sender system. The sender system requires some of the Customizing settings in order to
convert the operational data on rollup, so that they can be processed in the consolidation
structures.

5. You prepare the rollup in the sender system and enter that you want to transfer data for the
integrated consolidation type Profit Center Consolidation.

B. Structure of the Data Initial Set
You set the data initial set in the profit center ledger.

C. Update of Operational Data
At the Consolidation key date you execute a rollup in the profit center ledger. You transfer these
to the consolidation processing ledger.

See also:
Data Transfer Method Rollup [Page 166]

Result
In Consolidation the integrated data can be formatted and consolidated.
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Assignment of Profit Center and Partner Profit Center
Use
The primary objective of Profit Center Accounting is to determine the net profits for each area of
responsibility. To achieve this goal, all costs and revenue must be allocated to each profit center.

The assignment of balance sheet items to profit centers enables the extension of the profit center
to an investment center and its assumption of responsibility for the tied in assets. This also
enables the determination of controlling figures, such as Cash Flow, Working Capital, Return on
Investment, and so forth.

Profit center consolidation also requires that costs and revenue and any balance sheet changes
stemming from group-internal business transactions be assigned with the partner profit center.

Features
Assigning the Profit Center
Profit Center Accounting reflects the portion of transaction data from transaction applications that
is relevant. The profit center is not an independent coding object in the SAP system. Instead, the
system derives the profit center from the original, posted coding objects.

You make settings in the Implementation Guide for Profit Center Accounting to achieve this
derivation. Two essential settings are mentioned here:

- The assignment of coding objects to profit centers:

You assign all objects that contain profit-related data to a profit center - for example
orders, cost centers, controlling areas, etc.

- The selection of additional financial statement accounts as well as the assignment of a
default profit center and, if needed, the definition of derivation rules (in the Implementation Guide
under Actual Postings):

For example, you could include the balance sheet items for group-internal receivables
and payables in Profit Center Accounting and in profit center consolidation.

However, you can transfer these balance sheet items to Profit Center Accounting only
periodically, usually at the end of the month. Prior to the transfer, in the G/L application
menu you must run the calculation of balance sheet adjustments (General ledger →
Periodic tasks → Closing → Transfers → Balance sheet adjustment: Calculate). Using
the relevant FI documents, this program determines which profit centers and partner
profit centers are to assume the receivables and payables.

This is illustrated in the following example:

FI Document: Invoice

Account Profit Center Partner Profit Center Amount

Customer / receivable 1000.00

Revenues A C 700.00-
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Revenues B C 300.00-

The FI document divides the revenues by profit centers; however, the customer or
reconciliation account Receivables is not divided up.

The FI program passes on the revenue allocation to the receivable.

Calculation of the Adjustment

Account Profit center Partner Profit Center Amount

Receivable A C 700.00

Receivable B C 300.00

However, instead of in G/L, you post the adjustment in the application menu of Profit
Center Accounting (Actual posting → Period closing → Transfer receiv. / payables).
The system only posts in Profit Center Accounting - no FI documents are created.

Posting the Adjustment

Account Profit Center Partner Profit Center Amount

Receivable 1000.00-

Receivable A C 700.00

Receivable B C 300.00

For more information about profit center determination and assignments, see the
documentation on Profit Center Accounting in the SAP Library, specifically the
following sections:

•  Basic Functions → Profit Center Allocations

•  Actual Postings → Transfer of Actual Data

•  Actual Postings → Balance Sheet Items in Profit Center Accounting

Derivation of the Partner Profit Center
Automatic "Cross-diagonal" Derivation
In material acquisition and sales, the system is able to derive the partner profit center
automatically if the supplying or receiving partner uses the corresponding SAP applications on
the same system and the same client.

- In the goods issue document the system assigns the partner profit center, which it derives from
the purchase order.

- In the goods received document the system assigns the partner profit center, which it derives
from the delivery data.

You activate this derivation in the Implementation Guide for Profit Center Accounting, section
Preparation for Consolidation → Reread Purchase Orders/Sales Orders, where you identify the
trading partners in your SAP system.
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For more information, see the Profit Center Accounting documentation in the SAP
Library, section Preparation for Consolidation.

Using Derivation Rules
If the partner assignment cannot be derived automatically because of different systems or clients,
you can use derivation rules to determine the partner profit center. You can have the partner
profit center be determined from the vendor number, customer number, material number, partner
company, sender profit center, or from a combination of these assignments.

You define these rules in the Implementation Guide for Profit Center Accounting in section
Preparation for Consolidation  → Derive Partner Profit Centers in Purchasing and Sales.

For more information, see the Profit Center Accounting documentation in the SAP
Library, section Preparation for Consolidation.

Transfer from Non-SAP Feeder Systems
If you do not use the SAP components Materials Management and Sales, you must transfer the
partner profit centers from the non-SAP feeder systems to SAP Financial Accounting.
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Data Collection with Shifted Fiscal Years
Use
The fiscal year variant links the calendar year with the fiscal year. It determines how many
periods and special periods a fiscal year has, and assigns the accounting period to each
calendar time frame. If the fiscal year periods differ from the calendar year periods, this is
referred to as a "shifted fiscal year".

During data collection in Consolidation the system must determine the fiscal year variant that is
relevant for consolidation.

Features
The procedure how the system determines the fiscal year variant depends on the data transfer
method. This usually involves the fiscal year variant you specified in Activating Data Transfers
[Ext.] .

Realtime Update
The system converts the posting date to the period and fiscal year using the fiscal year variant of
the consolidation unit.

The following illustration shows the conversion using an example:

Transaction Application Consolidation

Co. code: C100
Date: 06/30/1999
Account: …
Amount: ...

Cons Unit Master Data
Assignment of Ledger -
Fiscal year variant "B"
(shifted fiscal year)

Cons unit: 10000
Period: 003
FS item …
LC amount: ...

Realtime Update

Document Entry:



Consolidation (EC-CS)  SAP AG

Data Collection with Shifted Fiscal Years

196 April 2001

Periodic Extract
The system posts the periodic extract data to the consolidation database using the period and
fiscal year that is set in the global parameters.

Rollup
When creating a rollup, the system uses the fiscal year variant for consolidation which you
specified in the Implementation Guide setting Activate Data Transfers.

If the company code data for the rollup is kept in the sender ledger under a different fiscal year
variant, the system converts the periods in the rollup.
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Legacy Data Transfer
Use
The initial data must be accurate before starting to transfer operational documents via realtime
update to the consolidation processing ledger, the consolidation staging ledger, or the rollup
ledger (all of which are referred to as "consolidation ledgers" in this text). This concerns both the
initial data (legacy data) and the account assignments that are specifically needed for
consolidation.

Initial Data
Usually the customer has legacy data from earlier accounting systems when implementing SAP
General Ledger. After the implementation team transfers this data to SAP General Ledger, you
can start posting entries in the transaction applications for the current fiscal year.

If you start using SAP Consolidation after you are already using SAP General Ledger, and you
want to use integrated data collection, you need to transfer the legacy data as well as the FI
postings that have already occurred as the initial data for the consolidation ledgers. You will most
likely post cumulative (or year-to-date) balances to generate the beginning balances.

Consolidation-related Assignments
When SAP General Ledger is implemented, customers often transfer the legacy data only as
cumulative balances. These balances usually do not include the assignments that are specifically
needed for consolidation purposes. In particular, this includes partner assignments and
consolidation transaction types.

The FI postings of the current fiscal year only include these assignments if the following
customizing settings have been made:

•  The company IDs have been inserted in the vendor, customer and G/L master records.

•  The consolidation transaction types have been assigned to the asset accounting transaction
types.

You must add any missing assignments in the appropriate consolidation ledger.

Features
Various tools are available for preparing the data.

Subsequent Posting of FI Documents
You can adjust the FI documents if they have not yet been archived.

•  For information on subsequent postings in "non-consolidation" ledgers, such as the profit
center ledger, see the documentation of the corresponding component, for example, Profit
Center Accounting.

•  You can perform subsequent posting in the consolidation processing ledger or the
consolidation staging ledger in the Implementation Guide under Integration: Preparation for
Consolidation → Preparation in the Sender System → Tools for Building the Initial Data →
Subsequently Post FI Documents [Ext.] :

− For subsequent postings in the consolidation processing ledger you need to make the
following settings in Activating Data Transfers [Ext.] :
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•  Integrated consolidation type Company Consolidation or Business Area
Consolidation

•  Data transfer method Realtime Update'

− For subsequent postings in the consolidation staging ledger you need to make the
following settings in Activating Data Transfers [Ext.] :

•  Integrated consolidation type Company Consolidation or Business Area
Consolidation

•  Data transfer method Periodic Extract or Rollup

If consolidation-related assignments are missing in the FI documents to be subsequently
posted, you can specify in the subsequent posting program that the following
assignments should be reread:

− Company ID from the customer, vendor and (if applicable) G/L account master records

− Country of the customer from the customer master record

− Consolidation transaction type from the assignments to the asset accounting transaction
types

Please note that you cannot simultaneously make subsequent postings in the period
in which operational documents are posted. Hence, you should only subsequently
post in past periods, which have been closed for operational postings.

Manual Data Entry
If the FI documents are already archived, you must enter the initial balances manually in the
consolidation ledger.

When posting manually to the consolidation staging ledger, please note that
simultaneous posting is not permitted. Otherwise, update problems can occur.
Therefore, you should organize a posting break during the time you post manual
entries.

Deleting Transaction Data
If the consolidation ledger contains incomplete data, it usually makes sense to delete this data
and repost the FI documents.

Matching the General Ledger with the Consolidation Staging Ledger
You can reconcile these two ledgers to ensure that all G/L data has been posted to the
consolidation staging ledger.



 SAP AG Consolidation (EC-CS)

Legacy Data Transfer Scenarios

April 2001 199

Legacy Data Transfer Scenarios
Purpose
The Implementation Guide for Consolidation features various tools for legacy data transfer,
depending on your specific situation. Some scenarios are described in this document.

Process Flow
Scenario 1:  Subsequent Posting of FI Documents
Assume the following situation:

The sender system has FI documents pertaining to the FI beginning balances as well as the day-
to-day FI documents of the fiscal year. However, the FI documents do not have the necessary
account assignments. The consolidation ledger (consolidation processing ledger, consolidation
staging ledger, rollup ledger) already contain data, but it is incomplete - that is, realtime update is
already activated.

Procedure:
1. You customize the assignment of partner companies and consolidation transaction types.

2. You delete the data that was posted in realtime from the consolidation ledger.

3. You repost all of the FI documents. On the selection screen of the program you specify that
the system should reread the missing assignments from the master data.

4. You reconcile the reposted balances with General Ledger.

Scenario 2: Manual Entry of the Initial Data
Assume the following situation:

The transfer of legacy data into SAP General Ledger took place over a year ago. For this reason,
the effort to repost all FI documents would be too great. It is also possible that the FI documents
of preceding years have been archived and no longer exist in the system. No data resides in the
consolidation ledger.

1. You customize the assignment of partner companies and consolidation transaction types.

2. In the consolidation ledger you manually enter the cumulative balances (including all
necessary assignments) and post these to the highest prior-year period that was posted in
General Ledger.

3. You reconcile the entered balances with General Ledger.

4. You carry forward the balances to the current fiscal year.

5. You activate realtime update, which posts all FI documents of the current month to the
consolidation ledger.

6. You subsequently post the FI documents for the past months of the current fiscal year. On
the selection screen of the program you specify that the system should reread the missing
assignments from the master data.
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Please note that you cannot simultaneously make subsequent postings in the period
in which operational documents are posted. Hence, you should only subsequently
post in past periods, which have been closed for operational postings.

Scenario 3: Manual Entry of the Assignments in the Consolidation Staging
Ledger
Assume the following situation:

All FI documents, including the FI legacy data, have been posted to the consolidation staging
ledger, but do not contain all of the necessary assignments.

1. You customize the assignment of partner companies and consolidation transaction types.

2. In the consolidation staging ledger you enter the missing breakdowns for the existing totals
records, using the highest period already posted. The system writes new data records.

3. You delete the old data records.

Please note that you cannot simultaneously post manual entries. Otherwise, update
problems can occur. Therefore, you should organize a posting break during the time
you post manual entries.

Result
The data in the consolidation ledger is now correct.  Realtime updating of FI documents can now
be performed and be transferred as reported financial data to SAP Consolidation.

There are many other combination of the scenarios described above. You need to
adjust your procedures to suit your situation when building your data.
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Postings
Purpose
The following consolidation tasks lead to postings in the system:

•  Standardizing or corrections to reported financial data

•  Reclassifications

•  Interunit eliminations

•  Elimination of interunit profit and loss

•  Preparations for consolidation group changes

•  Consolidation of investments

The system creates documents for all postings, they are also called journal entries. The
documents record the changes that are made to the values in the database. This lets you
reconstruct all of the changes that were made to the original reported financial data of the
consolidation units in order to arrive at the consolidated data.

The fundamental use of the consolidation components is that you execute the consolidation tasks
with postings, which are necessary for your consolidated financial statements and the system
creates them automatically. As a result you achieve a high level of automation and with it the
efficient processing of your consolidated financial statements. In particular cases you possibly
want to supplement automatic postings with manual postings. In addition to this it is often
necessary to manually adjust the reported data of consolidation units to the requirements of the
group. Therefore these components offer you both automatic and manual posting functions
for the execution of your consolidation tasks.

With the following consolidation tasks the system, instead it updates the values to
the database. You can find out about the value changes with the help of reports and
database listings:

•  Data entry

•  Currency translation

•  Apportionment

•  Item substitution and calculation of the retained earnings

•  Rollup to consolidation groups

•  Balance carried forward

•  Validation (no database update)

Features
The following graphic shows the relationship between

•  the Customizing settings, which are necessary for postings
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•  the posting itself

•  and the totals records and journal entries, which are generated during posting

Post 

ECMCTTotals records   ECMCA Documents

SpecialSpecial  FS itemsFS items

Totals evaluation Document
evaluation

Document typesDocument types Number rangesNumber ranges

TasksTasks MethodsMethods

Below the relationships which the graphic shows are explained in more detail, on the one hand
for automatic postings and on the other hand for manual postings.

Automatic posting Manual
posting

For example for interunit
eliminations

For
example
for manual
standardizi
ng entries

Task

Assignment of a document type
and possibly of a method

Indicator Automatic Indicator
Manual

Settings for:

Posting level, currencies to be
posted, post deferred taxes to
the credits, treatment of the
subassignments and so on.

Custo
m.

Document type

Assignment of number ranges
with document number interval
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Method You control in detail how the
system creates postings with the
method settings.

For example you define in a
method for interunit eliminations,
which FS items sets should be
eliminated against each other.

Exception: The function
elimination of interunit profit/loss
in transferred assets does not
know any methods.

None.

For both automatic and manual
postings the system generates
automatic line items for Financial
Statement Imbalances, Deferred
Income Tax and Consolidation
Unit Balance Adjustment  [Page
210].

So that the system can
determine the FS items for these
automatic line items, you define
selected FS items.

Selected FS items

For automatic postings of
consolidation of investments and
elimination of interunit profit/loss
in transferred assets, you define
more selected FS items.

You run the tasks via the data/
consolidation monitor or via the
detail menu.

Post

The system generates the
posting automatically.

In the Transaction for Manual
Posting [Page 229] you enter the
document header data and the
document line item and post the
document.

Data The system creates data records
to the totals database and journal
entries to the journal entry
database. You can evaluate this
with reports and database
listings.
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Rever
sal

In the master data of view, you
can define what should happen
to the old documents when a
task is executed again: These
can be reversed or deleted.

Therefore the reversing or
deleting of automatically posted
documents is only possible with
the repetition of consolidation
tasks.

You can reverse [Page 226]
documents individually, or use
mass reversal.

To use the support of the system for the consolidation tasks, you should execute the
tasks with automatic postings, as far as possible.



 SAP AG Consolidation (EC-CS)

Classification of Entries with Posting Levels

April 2001 205

Classification of Entries with Posting Levels
Use
A document type is assigned to each entry. The document type determines the entry's posting
level, which lets you classify the different types of entries. The system saves the posting levels in
the totals records as well as in the journal entries on posting.

The posting level enables a selection of data by content:

•  You can evaluate individual sections of the consolidation process in your Consolidation
reports, by using the posting levels in the data selection.

For instance, you evaluate the adjusted reported financial data of a consolidation
unit, by selecting the data from posting levels space, 00, 01, 08 and 10 for this unit.

When you include the consolidation group in the selection then you receive the data
of posting levels 02 and 12 in addition.

•  The system uses the posting level

− for internal consistency checks of data

− for the selection of data to be edited

For example the system selects all data for interunit eliminations (the consolidation
units to be ) with posting level smaller than or equal 20 (except for 02 and 12).

Features
The posting levels are predefined for the following entries:

Posting level Use

00 Reported (financial) data

Space Reported data from realtime update

01 Adjustment entries to reported data

02 Reported data: Cons group changes

08 Item substitution and calculation of the retained earnings

10 Standardizing entries

12 Standardizing entries: Cons group changes

20 Two-sided eliminating entries

22 Two-sided eliminating entries: Cons group changes

23 Two-sided eliminating entries: Special logic

24 Two-sided eliminating entries: Cons group changes with special logic

30 Consolidation of investments postings
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Explanations:

•  Reported data (00, space)

The reported data have posting level 00; however they are posted without a document.

Exception: When reported data are transferred into Consolidation per realtime update,
then the system saves them with posting level space.

•  Adjustment entries to reported data (01)

When you have transferred reported data of consolidation units and subsequently want
to change these in the corporate headquarters, then we recommend carrying out these
changes with adjustment entries with posting level 01. This has the advantage that the
documents report your changes.

•  Standardizing entries (10)

May be needed to standardize the reported data to comply with corporate policies or
corporate valuation rules

The consolidation unit is assigned to an account in the data records of the posting
levels smaller than or equal 10 (except for 02, see below), however not the
consolidation group. In reporting the data records are valid in all consolidation
groups, in which the consolidation unit is included with purchase method, pooling of
interest method or with proportional consolidation.

•  Two-sided eliminating entries (20, 23)

Examples for two-sided eliminating entries are interunit eliminations (20, 23),
reclassifications (20) and elimination of interunit profit/loss (20). In the data records the
consolidation unit as well as the partner unit are assigned to an account. In reporting the
data records are valid in all consolidation groups, in which both the consolidation unit and
the partner unit are contained, with marginal conditions concerning the accounting
techniques (see the following table).

You only use posting level 23 for elimination of investment income with the mutual stock
method.

The following table shows, with which accounting techniques the data records of
posting levels 20 and 23 are included in reporting:

Cons unit\Part. unit Purchase
method

Pooling Proportional
cons

Mutual
stock

Equity/Cost
method

Purchase method 20,23 20,23 20,23 23 -

Pooling 20,23 20,23 20,23 23 -

Proportional cons 20,23 20,23 20,23 23 -

Mutual stock 23 23 23 23 -
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Equity/Cost method - - - - -

•  Preparation postings for consolidation group changes (02, 12, 22, 24)

You carry out these postings in order to correctly display the reported data (02), the
adjusted reported data (12) or the consolidated data (22, 24), for the acquisitions or
divestitures of consolidation units. Therefore the postings prepare the first consolidation
or divestiture accounting of the consolidation of investments.

The preparation postings correct the data of the following posting levels:

Corrected pstng level Pstng level of preparation pstngs

Space, 00, 01, 08 02

10 12

20 22

23 24

In the data records both the consolidation unit as well as the consolidation group are
assigned to accounts, in addition the partner unit with levels 22 and 24. In reporting the
data records are only valid in assigned consolidation groups.

•  Consolidation of investment postings

In the data records of consolidation of investment postings the consolidation unit, partner
unit and consolidation group. In reporting the data records are valid in assigned
consolidation groups and in the higher-level consolidation groups.
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Example for the Selection of Data Records
The following graphic shows three consolidation groups: Group 1 contains all units from A to E as
well as both lower-level groups G2 and G3. All consolidation units are fully included.

AA

CC DD

EE

BB

Doc. 2
Doc. 3

Doc. 1

Doc. 5

G2G2
Doc. 4

G3G3

G1G1

Five documents with different posting levels are booked:

Doc. no. Pstng level Unit Partner Cons group Text

1 10 C - - Standardizing entries

2 20 A B - Elim. of IU payables and
receivables

3 20 A D - Elim. of IU payables and
receivables

4 30 E D G3 Cons of investments

5 30 E D G1 Cons of investments

The following table shows in which consolidation groups the documents in reporting are valid:

Docs\Cons groups G1 G2 G3

1 X X X

2 X X -

3 X - -

4 X - X

5 X - -



 SAP AG Consolidation (EC-CS)

Example for the Selection of Data Records

April 2001 209



Consolidation (EC-CS)  SAP AG

Financial Statement Imbalances, Deferred Income Tax and Consolidation Unit Balance
Adjustment

210 April 2001

Financial Statement Imbalances, Deferred Income Tax
and Consolidation Unit Balance Adjustment
Use
It can be necessary for both manual and automatic postings to post financial statement
imbalances, deferred income tax or consolidation unit balance adjustments. The system checks
each manually or automatically generated posting documents whether a financial statement
imbalance, deferred income tax or a consolidation unit balance adjustment needs to be posted
and generates additional line items, if necessary.

With manual postings, we are talking of automatic line items as the system independently
supplements your manually entered document line items with line items.

See following table:

Line items are generated... if these conditions are given
For posting a financial statement balancing
adjustment [Page 216]

An entry between balance sheet and income
statement accounts leads to an imbalance in
the financial statements

When posting deferred income taxes [Page
218]

The given document type supports this
feature, and the entry requires an adjustment
for financial statement imbalances

To clear imbalances in each individual
consolidation unit [Page 220] when posting
interunit entries

The document type supports this feature, and
requires a posting level greater than or equal
20 and selected FS items

Features
You will find detailed explanations for financial statement imbalances, deferred income tax or
consolidation unit balance adjustments in the subsequent sections of the Consolidation
documentation. In this section functions are explained which are valid for all three kinds of
additional line items.

Selected FS items
So that the system can generate individual line items for financial statement imbalances, deferred
income tax and consolidation unit balance adjustments, you have to set the following in the
Implementation Guide (IMG) of Consolidation:

•  in step Specify Selected FS Items for Posting [Ext.] enter the items which the system should
post for financial statement imbalances and deferred income taxes

You can set the selected FS items for deferred income taxes per document type and
as a result override the settings, which you have executed in step Selected FS Items
for Posting.
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•  in the definition of document types (see the step in the respective IMG unit, for example
Document Types for Manual Posting  [Ext.])

− the indicator post deferred income taxes to the credits to credit deferred income taxes or
post deferred income taxes to the debits to debit deferred income taxes (as well as the
tax rate in the master records of the consolidation units)

− possibly the selected FS items for deferred income taxes (see note above)

− the selected elimination FS items for the consolidation unit balance adjustments

Subassignments for these Selected FS Items
The selected FS items for financial statement imbalances, deferred income tax and consolidation
unit balance adjustments, which you have defined in the step selected FS items for posting or in
the definition of document types, require a breakdown by Subassignment [Ext.] according to the
breakdown category.

In Customizing you have various possibilities to control how the system determines the
subassignments for the selected items:

Selected FS Items for Financial Statement Imbalances
For every selected FS item, which allows for one or more subassignment, you can set the
indicator Default per subassignment and/or enter a you do not set the indicator. The following
logic is valid in phases:

•  When you do not set the indicator Default, then you have to enter the you do not set the
indicator. The system then always posts this characteristic value as a subassignment to the
selected FS item.

Exception: When it concerns an optional breakdown then you do not have to enter the
characteristic value. The system then does not post the subassignment, instead it debits
the null value.

•  When you set the indicator, then you do not necessarily have to enter a characteristic value
for the subassignment.

The system goes forward step-by-step in order to determine the subassignment. The
graphic shows these steps from a) to d):
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No. FS item Text SIC    SI Value  AL

1

2

3

4

191500

311950

251200

390000

Eqpt.

Amortiz.

RE-ct yr

ANI

1 220

2 0005

?

100-

100

100

100-

1

1

Default value
SI cat. 
Subitem

Selected FS items

FS item 
ANI IS 

FS item 

Subitem. Default X

ANI FS

6

251200

390000

a

b

c

SI cat. 6

Customizing

Error message reqd breakdwn d

6

Explanations:

a. First the system checks whether it can determine the subassignment from the document.

b. When a) this is not possible, then it checks whether you have entered the subassignment
as a selected FS item.

c. When b) is not correct, then it takes the subassignment, which you have defined in step
Define Default Values for Subassignments [Ext.].

d. When c) is unsuccessful and the breakdown category for the subassignment plans a
required breakdown, then the system displays an error message.

Step a), therefore the determination of the subassignment from the document is
possible when:

•  the subassignment is clearly in the document, that means the same
characteristic value is assigned to an account in all line items with this
subassignment

•  the document per subassignment is divided into a shared document, for
which the imbalance over all financial statement items is null (see the
graphic example for the clearing item)

Selected FS Items for Deferred Income Tax
The logic how the system finds the subassignment for selected FS items of deferred income tax,
is fundamentally exactly the same as the selected FS items for financial statement imbalances.
The only difference is that you can define the selected FS items document type dependent.
When posting the system first checks whether the selected FS items are maintained for the
document type and defines the subassignments in the way which is explained above.
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When the selected FS items are not entered per document type, then it gets the (global) settings
in step Define Selected FS Items for Posting [Ext.] and uses the logic there.

No. FS item Text  SIC    SI Value AL

1

2

3

4

191500

311950

251200

390000

Eqpt.

Amortiz.

RE-ct yr

ANI

1 220

2 0005

100-

100

60

60-

1

1

Default value
SI cat. 
Subitem.

Selected FS items

FS item 
Dfd. inc. tax IS

FS item 

Subitem. Default

Lat.St. GuV 

2

350100

150100

a

c

SI cat. 2

Error message reqd breakdwnd

Doc. type/Sel. items

FS item 

Subitem Default X

Dfd inc.tax IS 
350100

b
SI cat. 2

5 150100 Inc. tax 40 2

6 350100 Inc. tax 40- 22 ?

6 120
0005

Selected Clearing Items
You maintain the selected clearing items per document type. The logic how the system
determines the subassignments is the same as for the selected FS items for financial statement
imbalances and deferred income taxes.
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No.   FS item  Text  Partner  Value AL

1
2

130100

210100

131000

Rec.

Lbty.

Elim.

B

A

?

100-

100

100 3

Default value
Partner unit 

Doc. type/ Sel. items

FS item 

Def. X

Clearing item 
251200

a
c

Partner unit

Customizing

Error message reqd breakdwnd
b

3

 PL unit

A

B

131000 Elim. 100- 34 B

A

?

In the example in the graphic, the system can determine the partner assignment from
the document in step a) and to be precise

•  Partner B in row 3

•  Partner A in row 4

The document is then divided into two shared documents for which the imbalance
over all financial statement items is null.

Manual Posting: Help Functions for Automatic Line Items
Simulation
When you enter a posting document in the manual posting transaction, then the system
generates the automatic line items while saving the document and subsequently updates the
complete document in the database. Before saving the document you can simulate it. The
system shows the automatic line items in the simulation. Therefore you can see beforehand
whether and how the system will post financial statement imbalances, deferred income tax and/or
consolidation unit balance adjustments.

Identification
The system marks the automatic line items with a special number in the document, so that you
can differentiate them from your manually entered line items:

Field AUT Meaning

1 Automatic line items for financial statement imbalances

2 Automatic line items for deferred income taxes

3 Automatic line items for cross-clearing cons units
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Entering Manually or Correcting Automatic Line Items
Instead of generating the automatic line items by the system, you can also enter these rows
manually. You should note the following:

•  When you want to enter the rows manually, then you have to enter all "automatic" rows.

•  You have to enter the correct values, that means

− the imbalance and the net income or loss of the complete document must be 0

− you must post the tax portion in the financial statement imbalances of the complete
document to the selected FS items for deferred income taxes

First you can simulate the automatic line items by the system and then change, for example
change the subassignments or distribute the simulated values to several document line items.
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Financial Statement Imbalances
Use
Standardizing and consolidation entries can cause an imbalance in the financial statements. For
example, an adjustment to depreciation on machinery involves posting in both the income
statement and the balance sheet, causing these two statements to become out of balance. This
imbalance is calculated by the system and balancing adjustments are automatically posted.

The system posts the financial statement imbalances automatically. This ensures that the
balance sheet and income statement are posted consistently. Once the adjustment is posted, the
two balance again.

Features
•  During each posting, the program checks whether any income statement items are being

posted with a non-zero balance. If so, it computes and posts a financial statement
balancing adjustment.

•  Where the appropriation of retained earnings are stated also affects the financial
statement balancing adjustment:

− If the appropriations are stated after the income statement, the adjustment is posted to
retained earnings items, in the balance sheet as well as the income statement.

− If the appropriations are stated in the balance sheet, the adjustment is posted to annual
net income items, in the balance sheet as well as the income statement.

You determine the which items are posted to in the Customizing of selected items for
retained earnings and annual net income.

The financial statements remain in balance because the balancing adjustment takes both
financial statements into consideration.

Example
Assume that after you post a standardizing entry to a balance sheet item, the balance sheet and
the income statement are no longer in balance.

The following illustration shows you how the accounts are affected by the original entry as well as
the automatic financial statement balancing adjustment. The automatic posting is depicted for
both cases of where the appropriation of retained earnings are stated.
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Original entry

1000

Balance sheet
 item

Income statement
 item

1000

Automatic balancing adjustment

Retained earnings
(B/S)

Annual net income
(B/S)

Annual net income
(I/S)

Retained earnings
(I/S)

1000

1000

1000

1000

Balance
sheet
balance

Retained earnings
appropriations
after the income
statement

Retained earnings
appropriations
in the balance
sheet

Income
statement
balance
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Deferred Income Taxes
Use
Because of the tasks that are performed during consolidation, the consolidated earnings for the
year usually differ from the sum of the earnings reported by the individual consolidation units.
Deferred income taxes are posted within the consolidated financial statements, to adjust the sum
of all reported tax expenditures to the consolidated earnings.

The system provides an option of automatically calculating and posting deferred income taxes.

Features
Deferred income taxes can arise from standardizing entries against the reported financial data of

the consolidation units, or from consolidating entries.

In Customizing, you can activate the posting of deferred income taxes for each document type.
You also define the tax rates for each consolidation unit, and the selected items for the
allocation of deferred income taxes.

The system posts deferred income taxes provided you have activated the function in
Customizing, and a financial statement imbalance occurs during an entry.

The financial statement imbalance is multiplied by the tax rate. The resulting deferred income tax
is posted to the consolidation unit to which the financial statement imbalance itself is posted.

Example
Assume that you post a standardizing entry against a balance sheet item. You use a document
type which allows the posting of deferred income taxes. When the standardizing entry is posted,
the balance sheet and the income statement are no longer in balance.

The following illustration shows you how the accounts are affected by the original entry, the
automatic financial statement balancing adjustment, and the automatic entry for deferred income
taxes.

•  Prior to posting the deferred income taxes, the financial statement imbalance amounts to
1000 currency units.

•  The system multiplies the financial statement imbalance by a tax rate of 60 % and posts
the resulting deferred income taxes of 600 currency units. The financial statement
imbalance remaining to be posted is 400 currency units.

•  The system posts this amount.
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Automatic posting of deferred income taxes

Deferred income
 taxes

Income tax
 expense

600 600

Income statement
 item Income

statement
balance

Tax rate of
60%



Consolidation (EC-CS)  SAP AG

Clearing of Imbalances Caused by Interunit Entries

220 April 2001

Clearing of Imbalances Caused by Interunit Entries
Use
Under certain circumstances, it may be necessary to clear imbalances caused by interunit entries
– that is, entries between different consolidation units – not only for the entire document but also
for each consolidation unit.

Consequently, after the consolidation, you are also able to create consolidated individual
statements for each consolidation unit.

Features
A clearing item is needed for clearing the entries of the consolidation units. In Customizing, you
define the clearing item for document types with posting levels greater or equal to 20. Each
consolidation chart of accounts requires its own clearing item. Defining a clearing item ensures
that the system always posts a balancing entry.

During posting, the system calculates the balance for each consolidation unit, posts it to the
clearing item.

Example
You want to post interunit eliminations between two consolidation units. In the document type you
are using, you previously defined a clearing item for interunit entries. This results in the following
posting document:

Posting document

Line item Cons unit Financial statement item Amount (USD)
01 Cons unit 1 Receivables from affiliates 1,000.00 -
02 Cons unit 2 Payables to affiliates 1,000.00
03 Cons unit 1 Clearing item 1,000.00
04 Cons unit 2 Clearing item 1,000.00 -

Remarks

•  Lines 03 and 04 are automatic line items inserted by the system.

•  The entire entry balances to zero:

− All line items add up to zero.

− Each consolidation unit has a zero balance.

− The balance of the clearing item remains zero.
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Posting in Transaction Currency
Features
You can post FS items with breakdown by transaction currency, when

•  the document type allows posting in transaction currency

•  the breakdown category of the FS item is set up to allow the breakdown by transaction
currency.

You can post several transaction currencies in one document. The system does not check
whether the balance per transaction currency is null.
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Posting in Quantities
Features
You can post FS item values in quantities, when

•  the document type allows posting in quantities

•  the breakdown category of the FS item is set up to allow the breakdown by quantity.

The unit of measure has a fixed value in the breakdown category, that means the unit of measure
is defined in the breakdown category of the FS item.

You could post FS items in a document, which is assigned different breakdown
categories with different units of measure. This means that you can post several
quantities in one document. The system does not check whether the balance is null,
neither per unit of measure nor for the complete document.
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Further Functions for Manual Posting
Use
The subsequent sections explain functions, which only the manual posting function offers.



Consolidation (EC-CS)  SAP AG

Fixing or Hiding Subassignments

224 April 2001

Fixing or Hiding Subassignments
Use
The FS items which you post to manually, require a breakdown by subassignment according to
breakdown category. When you enter documents with lots of FS items and lots of
subassignments, then the document entry can be very unclear. Therefore you have the
possibility in the Customizing of the document type for each subassignment, to fix or hide them.

•  Fixing means that the subassignment must clearly be in the document, so it is only allowed to
have a fixed value. You can fix a subassignment permanently or temporarily. When you only
fix a subassignment temporarily in Customizing, then you can deactivate the fixing when
entering the line item.

For example you could fix the subassignment transaction currency temporarily or
permanently, when you normally only enter documents in a transaction currency.
Through the fixing you make sure that you do not enter two different transaction
currencies by mistake.

In the manual posting transaction the system shows the fixed subassignments on the tab
page Clear Subassignments. The system displays the unfixed characteristics per
document line item.

•  You can hide subassignments which only appear for a few FS items.

The system then displays these subassignments again, when you enter a FS item in the
document line items, whose breakdown category is set up to allow the subassignment(s).
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Validations
Use
The system provides standard validations for verifying the entries. You can supplement these by
defining your own custom validation rules in Customizing.

The validations are performed during the posting process, specifically, at the callup point defined
in the validation rule. There are three callup points: the document header, the document line
item, and the posting event.

 
You might define validation rules for the following purposes:

•  To ensure that specific financial statement items are only posted with certain subitems

•  To define the currency limits which users are authorized to post

•  To ensure that the total amount of depreciation that is posted to asset items using certain
subitems, coincides with the total amount in the corresponding depreciation expense item
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Reversal of Manual Postings
Use
This function enables you to reverse manual postings. The system reverses the document and
adapts the totals record in the totals database.

Features
Two ways to reverse posted documents:
Manual Reversal
You can reverse individual documents with reference to the document to be reversed

Procedure:

1. In the Consolidation menu choose Data → Enter Manual Posting or Consolidation → Manual
Posting → Enter. Then you enter the document type, document number and fiscal year for
the document to be reversed.

2. In the following screens you can merely change the text for the reversal document. The other
data is only displayed. The amounts of individual document line items have the inverse
debit/credit sign in contrast to the document to be reversed

3. You reverse by saving.

.

In the header data you see the corresponding document number of the reversal
document. These document numbers are automatically included in the header data
on posting.

Mass Reversal
With the function mass reversal you can select and reverse manually posted documents by
various criteria, for example by organizational unit, version, time, task, subassignment and so on.

The following status management is valid with regard to this:

•  When the status management is active, then the following documents can be exclusively
reversed:

− Documents, whose document type is assigned a task for manual postings

− Documents, whose document type is not assigned a task, but however is posted with a
posting level which is smaller than 20

For these documents the system assumes that they belong, as regards content, to
the tasks for data entry

The system resets the status of the concerned tasks after the mass reversal.

•  When the status management is deactivated, then you can reverse all manually posted
documents with this function, without having the assignment of tasks checked.

Procedure:
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In the Consolidation menu choose Data → Enter Manual Posting or Consolidation → Manual
Posting → Mass Reversal.

Then you enter the data, by which the documents to be reversed should be selected.

You execute the function and receive a list of the reversed documents.

Reversing a reversal document
If you reversed a document and want to undo the reversal, you can reverse the reversal
document. This is equivalent to posting an entry with reference to the source document. In other
words, when reversing a reversal entry, the system posts a regular document – not another
reversal entry.

Reversing an already reversed document
The system makes sure that you only reverse a document once. A reversed document cannot be
reversed again.

However, the following situation is conceivable: For example, you reversed a document in period
001 with a reversal document in period 002. Afterwards you find out that the reversal should have
taken place in period 001. If you then try to enter a reversal in period 001, the system suggests a
new document, the values of which contain reversed debit/credit signs. Note that this new
document (clearing document) does not reference the reversed document, or vice versa.

See the illustration:

Doc   9991
Period 001
Reversal doc: 9992

Line 1: 1000

Line 2: 1000-

Doc  9992
Period 002
Reversed doc: 9991

Line 1: 1000-

Line 2: 1000

Period 001 Period 002

Doc  9993
Period 001

Line 1: 1000-

Line 2: 1000

Reversed doc

Clearing doc

Reversal doc

To clear all documents with each other you need to do one of the following:

•  also reverse the reversal document 9992 of period 002

•  post the clearing document 9993 using a document type that automatically reverses the
subsequent period
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Manually Posting an Entry
Procedure

The steps 1 to 4 depend on whether you execute the manual posting with the
monitor or with the detailed menu.

Start of the Posting Transaction with the Monitor:

1. In the Consolidation menu, choose Data collection → Monitor or Consolidation → Monitor.

2. Check the global parameters by choosing Environment → Global parameters.

3. Place the cursor on the consolidation unit for which you want to post data and on the relevant
task and choose Update run.

 Once you have entered additional account assignments for a line item, an indicator
on the line item screen (see steps 5 and 6) shows that additional account
assignments exist.

 When you have not assigned a task to the document type for manual posting, then
the system automatically assigns the task for data entry.

4. The document type and the global parameter are already in the tab page General. Enter
further necessary data: an explanatory text, the organizational units (each according to the
posting level of the document type), if applicable activity and activity number for the
consolidation of investments.

5. See below.

Start of the Posting Transaction with the Detailed Menu:

1. In the Consolidation menu choose Data → Manual Posting  → Enter or Consolidation →
Manual Posting →Enter .

2. In the tab page General, you enter the document type with which you want to carry out the
manual posting.

The global parameters View, Consolidation Chart of Accounts, Version, Period and
Fiscal Year are already preset in the initial screen. You can overwrite the parameters
Period and Fiscal Year.

3. You can post with the template of a held document or a reference document.

− Held document:

You can enter a document and before posting, save it in a user-defined, parked
clipboard and to be precise either as a sample document or as a simple held
document. You enter a number to identify the document. At a later date you can call
up, complete and post this document as a template. The system deletes the simple
held documents immediately after updating. Sample documents are kept.

− Reference document:
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You can use a reference document of the same document type as a template, in
order to enter a new document. This is useful, when most of the document line items
of the reference document are relevant for the new document to be posted..

In addition to that you can reverse a referenced document, by setting the
corresponding indicator. See also Reversing Manual Postings [Page 226].

4. After releasing the data, enter the necessary data in the next screen of the tab page Genera:
an explanatory text, the organizational units (each according to the posting level of the
document type), if applicable the activity and activity number for the consolidation of
investments.

5. See below.

Further Steps both for the Monitor and Detailed Menu:
1. On the tab page Clear Subassignments the system shows the subassignment, which you

have fixed permanently or temporarily in the document type (see also Fixing or Hiding
Subassignments [Page 224]). You enter the fixed value per subassignment. For the
subassignments which are only temporarily fixed, you can undo the fixing, by removing the
subassignment from the tab page. When entering the document line items you can fix the
removed subassignments again, if required.

2. Choose the tab page Document Line Item and enter the necessary account assignments.
The system offers you the following help functions:

− You can copy, reassign or delete individual document line items.

− When you enter * in a value field, then the system sets the negative document balance in
this field.

− When you place the sign -  in the value field of a value, then the system inverts all the
values in the document line item.

7. If applicable remember this document, possibly as a sample document. You can complete
and post the document later, by calling it up as a template (see step 3 under the section Start
of the posting transaction with the detailed menu).

8. Simulate the posting to inform yourself about the of the data and the document line items
which were automatically generated by the system. Choose Posting → Simulate.

During the simulation the system checks whether

− The document balance is null

− all necessary subassignments have been entered

− all necessary currencies have been entered

With automatic line items you can recognize with the help of an indicator, whether it
concerns a financial statement imbalance posting, a deferred income tax posting or the
balance adjustment for consolidation units. If required you can change the automatic line
items, for example choose other subassignment for the selected FS items (see also
Financial Statement Imbalances, Deferred Income Tax and Consolidation Unit Balance
Adjustment [Page 210]).

9. Record the document by choosing Save.

A message shows you which document number was assigned to the document.
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10. If desired, display the recorded document by selecting Consolidation → Manual Posting →
Display in the Consolidation menu. Then enter the document number.



Consolidation (EC-CS)  SAP AG

Currency Translation

232 April 2001

Currency Translation
Purpose
This component enables you to translate financial data reported by consolidation units into the
currency of your consolidation group.

Financial data reported by consolidation units is usually collected in the Consolidation application
in local currency. You need to translate this data into group currency before you can create
consolidated financial statements.

Implementation Considerations
Install this component if the local currency of at least one consolidation unit in your group differs
from the group currency, and you want to translate this data after it has been reported.

Integration
Financial data may already exist in the Consolidation application in group currency before central
currency translation. This is the case if:

•  You enter data directly in group currency.

•  You enter data using realtime update, periodic extracts or rollups, which transfer both
local and group currency values.

If you want to perform consolidation based on these group currency values, you do not need to
run central currency translation.

It is common practice, however, to retranslate reported financial data centrally.

Features
Currency translation is based on translation methods. You can use any number of methods to
translate reported financial data, however you can only specify one translation method for each
unit.

The type of currency translation you use depends on the relationships between your corporate
group and its individual consolidation units, and also on the economic situation in the countries
where these units are based. You define methods in the Consolidation application to represent
those currency translation methods which you use frequently, for example, the current-rate
method, temporal method, and so on.

You define translation methods in Customizing.
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Translation Method
Definition
Method that determines the exchange rate used for translating financial statement (FS) items,
and how translation differences are posted.

Use
Reported financial data which is entered in the Consolidation application in local or transaction
currency is translated into group currency using a translation method.

You can define several methods for translating data reported by your consolidation units.
However, for each unit you specify a single translation method.

Structure
You define translation methods in Customizing of Currency Translation [Ext.].

These methods are dimension-dependent, meaning that different methods can be used in
different dimensions.

When you define a method, you determine the exchange rate used to translate FS item values,
and how you want translation and rounding differences to be handled in the system. You define a
method using a method entry, which can either be a translation entry or a rounding entry.

•  Translation entries are used for translating FS item values.

Each translation entry comprises:

− An FS item set containing the items you want to translate

− A currency translation key and an exchange rate indicator

− The differential items to which you want the system to post translation differences

•  Rounding entries are used for calculating rounding differences

Each rounding entry comprises:

− One or two FS item sets containing the items that you want to reconcile

− FS items to which you want the system to post rounding differences

You can check your translation methods for errors. The system checks individual method entries
and lists any inconsistencies, for example, overlapping FS item sets, in a log.

Translation methods that have no errors can be activated. By activating a method, you indicate
that you want to use it for currency translation.
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Management with the Data Monitor
Use
Currency translation is one of the tasks whose status is managed by the data monitor. In the
monitor, a distinction is made between final and provisional translation.

You can run final currency translation once you have entered all your financial data in the system
and run validation checks. If you require translated data at an earlier date, you can run
provisional translation.

Features
The following table provides a comparison of provisional and final currency translation:

Comparison of provisional and final translation

Provisional translation Final translation
Purpose Provisional translation must be run

before you can create reconciliation
lists as part of interunit elimination,
because these lists are based on
group currency.

Final translation must be run before
you can execute further consolidation
tasks in group currency.

Prerequisites None Status management must allow you to
execute the translation task.

When can I
execute
translation?

You can execute provisional
translation at any time.

You can only execute final translation
after you have completed the
preceding task and subsequently
blocked it.

Are group
currency values
saved to the
database?

Yes Yes
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Translation of Transaction Currency to Group Currency
Use
Financial data reported by consolidation units is usually translated from local currency into group
currency. If any financial statement item values are reported in both local and transaction
currency, you may want to translate from transaction currency into group currency.

For example, you can translate values from goods and service transactions from transaction
currency into group currency. This is typically the case for payables and receivables, and
revenue and expense.

Features
Local currency or transaction currency can be the base currency for translation. You use a
currency translation key in Customizing to determine the base currency as follows:

•  With translation keys '9' and 'A', the transaction currency is the base currency.

•  With all other translation keys, the local currency is the base currency.
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Currency Translation Using Financial Statement Item
Sets
Use
Financial statement (FS) item sets are the basis for the translation of reported financial data.
They contain the FS items that you want to translate. You use translation rules for each set, to
determine the exchange rate with which the system translates the items in each set, and how it
posts translation differences.

You can therefore translate different FS items in different ways.

You have the option of restricting FS item sets to subitems, so that the system only translates the
FS item values which have one of the subitem assignments you specified.

Features
You define FS item sets and their translation rules in Customizing.

FS item sets always contain items with the same where-applied indicator. They contain one of
the following:

•  Balance sheet items

•  Income statement items

•  Statistical items

The number of FS item sets you need for translation depends on which exchange rates you want
to use. The following situations are possible:

•  If you want to translate all items in an individual financial statement in the same way, you
only need two item sets for translation: one set containing balance sheet items and one
set containing income statement items.

You translate all items in an individual financial statement using the current
exchange rate, as listed in the exchange rate table.

•  If you want to translate groups of FS items in different ways, you need to use multiple FS
item sets.

You might want to use the following FS item sets:

− Investment items, translated historically using data from the changes in investments
table.

− Equity items, translated historically using data from the changes in investee equity
table.

− Other balance sheet items, translated using the current exchange rate taken from the
exchange rate table.
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− Income statement items, translated with the average exchange rate for the fiscal
year taken from the exchange rate table.

•  If you want to translate values for subitems using different methods, you need to use
subitem sets in addition to your FS item sets.

You can use an FS item set containing asset items to translate asset values, and
restrict this set to certain subitem sets.

See also:
Reporting of Temporal Translation Differences in Asset History Sheets [Page 267]
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Currency Translation Keys and Exchange Rate
Indicators
Use
Different financial statement item sets are usually translated using different exchange rates. You
use various combinations of a currency translation key and exchange rate indicator to determine
these exchange rates.

You select a currency translation key for each item set you want to translate. Depending on the
translation key, you also select an exchange rate indicator. Your settings provide the system with
information which enables it to determine the exchange rate for translation:

•  The currency translation key determines the base currency for translation, the table used to
find the exchange rate, and the procedure for calculating group currency values.

•  The exchange rate indicator specifies whether the current rate, average rate, historical rate,
and so on, is used.

Features
Currency Translation Keys
The following table shows the currency translation keys pre-defined in the system:

Currency translation keys

No. Description Procedure for translation

0 Translation resulting in
consolidated value of zero

The system calculates the group currency value for the
current period in such a way that the sum of the group
currency values — from the carryforward period to the
current period — is equal to zero.

1 Translation using the
current rate in the exchange
rate table

The exchange rate is taken from the exchange rate table.

The system translates the local currency values
accumulated between the carryforward period and the
current period, using the exchange rate for the current
period. The result is a cumulative group currency value.

From this value, the system subtracts the group currency
value accumulated up to the prior period. It saves this
difference as the group currency value for the current
period.
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2 Historical translation by year
of acquisition, using rates in
the exchange rate table

In order to use this translation key, you must have entered
values broken down by year of acquisition.

The exchange rate is taken from the exchange rate table.

The system translates the local currency values
accumulated between the carryforward period and the
current period, using the exchange rate for the year of
acquisition concerned. The result is a cumulative group
currency value.

As with translation key 1, the system calculates the
difference between this value and the group currency value
accumulated up to the prior period. It saves this difference
as the group currency value for the current period.

3 Historical translation based
on data from the changes in
investments table

In order to use this translation key, you must have entered
investment values in both local and group currency in the
changes in investments table. When using this key, you
cannot specify that the system read data from the database.

The system reads the group currency value for each
investment item to be translated from the changes in
investments table. It reads the group currency value in the
table for each investment item to be translated

As with translation key 1, the system calculates the
difference between this value and the group currency value
accumulated up to the prior period. It saves this difference
as the group currency value for the current period.

4 Historical translation based
on data from the changes in
investee equity table

Same as translation key 3

The system reads the values for translation from the
changes in investee equity table.

5 Translation using the
monthly rate in the
exchange rate table

The exchange rate is taken from the exchange rate table.

The system translates local currency values of each period
using the exchange rate for each respective period. The
result is a cumulative group currency value. As with
translation key 1, the system calculates the difference
between this value and the group currency value
accumulated up to the prior period. It saves this difference
as the group currency value for the current period.

Unlike translation key 1 (for which the system translates
cumulative local currency values using the exchange rate
for the current period), key 5 indicates that the values for
each period are translated using the exchange rate for each
respective period.
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6 Existing group currency
values are not retranslated

The group currency values which exists in the database are
considered valid. Therefore the system does not retranslate
the local currency value.

The data transfer methods realtime update, periodic extract,
and rollup usually provide the Consolidation application with
data in both local and group currency.

7 User-defined determination
of exchange rates

A user exit determines the exchange rates. In all other
respects, the procedure is the same as for translation key 1.

9 Translation of transaction
currency values using rates
in the exchange rate table

The exchange rate is taken from the exchange rate table.

In this exceptional case, transaction currency is the base
currency for translation. The system translates the
transaction currency values accumulated between the
carryforward period and the current period, using the
exchange rate for the current period. The result is a
cumulative group currency value.

As with translation key 1, the system calculates the
difference between this value and the group currency value
accumulated up to the prior period. It saves this difference
as the group currency value for the current period.

A Translation of transaction
currency values using rates
in the exchange rate table

The system translates local currency values of each period
using the exchange rate for each respective period.

Additional Features for Certain Translation Keys
Additional features are available with some of the translation keys, which are explained above.
You can choose these in the translation methods of Customizing, when defining translation
entries.

•  Use the exchange rate from the previous year

You can use this feature with currency translation keys 1, 2, 5, 9 and A. When
customizing these currency translation keys, the indicator Exchange rate from previous
year appears.  When you select the indicator, the system reads the exchange rate from
the previous year from the exchange rate table.

You need this feature, for example, when you want to record temporal translation
differences in the transferred assets items, in order to create an asset history sheet.

See also: Reporting in Asset History Sheets [Page 267]

•  Use the average rate from the previous period for decreases in value

You can use this feature with currency translation keys 5 and A. When customizing these
currency translation keys, the indicator Average rate appears.  The indicator has the
following effect: When the period value decreases the cumulative FS item value, then the
system translates the period value with the average rate, which arises from the previous
period of the fiscal year.

The following table explains this with an example:
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FS Item Period LC Value GC Value Exchange rate

12345 (example) 001 1,000 1,500 1.5

12345 002 1,000 2,000 2.0

12345 003 1,000- 1,750- 1.75

Explanation:
In period 003 the FS item value decreases by 1,000 monetary units in local currency.
The system calculates the exchange rate for this period value as follows:

(1,500 + +2,000 / 2,000 = 1.75 ( Average rate)

•  Record temporal translation differences

You can use this feature with currency translation keys 1, 7 and 9. When customizing
these currency translation keys, the indicator temporal translation difference appears.
When you select the indicator, the system then calculates the temporal translation
differences and records them separately in the database.

See also: Temporal Translation Differences [Page 248]

Exchange Rate Indicators
Exchange rate indicators are not preset for specific translation keys in the system. You decide
which indicators you want to use when you maintain your exchange rates. For example, you
could use the indicators Current rate, Average rate, Current rate from previous year, and so on.

Whether or not you need to specify an exchange rate indicator when defining currency translation
methods in Customizing, depends on the currency translation key you use, as illustrated in the
following table:

Currency translation key Exchange rate indicator required?

0 No

1 Yes

2 Yes

3 No

4 No

5 Yes

6 No

7 No

9 Yes

A Yes
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Example: Translation Using Translation Keys 1 and 5
The following example shows the differences in the translation of values with translation keys 1
and 5.

The values and exchange rates for the carryforward period and three subsequent periods are the
basis for the translation. For each translation key you can calculate the cumulative value in each
period in local and group currency, and the group currency value for each individual period.

Values on which translation is based

Period Value for period in local currency Exchange rate for period

000 (Carryfwd period) 1000  -

001 1000 0.8

002 1000 0.6

003 1000 0.7

Values using translation key 1

Period Cumulative value in
local currency

Cumulative value in
group currency

Group currency
value for period

000 (Carryfwd period) 1000 (carried fwd) 700 (carried fwd) 700 (carried fwd)

001 2000 1600 900

002 3000 1800 200

003 4000 2800 1000

Values using translation key 5

Period Cumulative value in
local currency

Cumulative value in
group currency

Group currency
value for period

000 (Carryfwd period) 1000 (carried fwd) 700 (carried fwd) 700 (carried fwd)

001 2000 1500 800

002 3000 2100 600

003 4000 2800 700
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Calculation of Translation Differences
Use
Translation differences arise when different translation rules are applied to different financial
statement (FS) item sets within a single translation method. Two types of translation differences
can occur when you translate individual financial statements: differences in the balance sheet
and differences in the income statement:

•  Balance sheet differences occur, for example, if you translated investment and investee
equity values using historical exchange rates and the remaining balance sheet items
using the current rate.

•  Income statement differences occur, for example, if the appropriation of retained
earnings is reported on the income statement, and you translate revenue and expense
using an average exchange rate and the appropriation of retained earnings values using
the current rate.

In order to produce balancing financial statements after translation into group currency, the
system calculates translation differences and posts them to differential items.

Features
•  Because it is not usually possible to identify the FS items from which translation

differences originate, the system translates all item values into group currency using a
reference exchange rate, in addition to running actual currency translation. For example,
it could translate all items using the current exchange rate as a reference rate.

•  This additional translation produces a reference value in group currency for each FS item
set. The system uses this reference value to calculate translation differences, which it
posts to differential items.

Activities
In Customizing, you specify a reference exchange rate for each translation method. In each FS
item set, you also specify one item to which translation differences are posted as debit entries
and one item for credit entries.

The system calculates and posts the translation differences as follows:

− Each item value is translated using the reference exchange rate. This is how the system
determines the reference value.

− All FS items contained in the translation entry for the translation method are translated using
the exchange rate derived from translation key and exchange rate indicator. This is how the
system determines the group currency values.

For each item that has a difference between these two values (i.e.,  a translation difference) the
system creates two data records:

Data record per item when a translation difference exists

Item Translation ID Value
123456 (example) 0 Reference value
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123456 1 Difference between reference value and group currency
value
(= Translation difference)

The sum of both data records equates to the item's group currency value.

•  The system posts only one data record with the group currency value for
items, whose reference value matches the group currency value (i.e., those
without a difference).

•  The system translates any FS items which are not contained in one of the
translation method entries using the reference exchange rate, and saves the
resulting value to the database as the actual group currency value.

To settle the posted translation differences, translation differences are calculated for each FS
item set and posted to the appropriate differential item, depending on whether they are a debit or
credit entry.
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Example: Calculation of Translation Differences
The following example uses sample balance sheet data to demonstrate how local currency is
translated into group currency, and how translation differences are calculated.

Customizing
A translation method is assigned to the consolidation unit whose data is to be translated. This
method contains the following entries, amongst others:

Translation entry FS items Transl. key Exchange rate indicator

Investments 1033020    3    -

Current assets 1040000 to 1049999    1 Current rate

Reference exchange rate indicator for the translation method: Current rate

Translation
The system calculates translation differences as follows:

1. All FS items are translated using the reference exchange rate (current rate on translation
date: 1.5)

 FS item Local currency value Reference value

 1033020  10,000  15,000

 1041010     100     150

 1042010     400     600

 and so on   

 

2. The FS items are translated using the exchange rates defined in the translation entries:

 FS item Local currency value Group currency value

 1033020  10,000  14,000

 1041010     100     150

 1042010     400     600

 and so on   

 Note:

 For FS item 1033020 (Investments), the system reads the group existing currency value
— in this case 14,000 units — from the changes in investments table.
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3. The translation differences are calculated as the difference between the reference value
and group currency value.

 FS item Reference value Group currency value Translation differences

 1033020  15,000  14,000  1,000-

 1041010     150     150      0

 1042010     600     600      0

 and so on    

 

4. Updating group currency values

FS item Crcy transl.
indicator

Local currency value Group currency value

1033020 0 10,000 15,000

1033020 1 0 1,000-

1041010 0 100 150

1042010 0 400 600

5. Updating the currency translation indicator of 1,000 to the differential item, which was
defined for the translation entry.
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Temporal Translation Differences
Use
In your consolidated financial statements you may want to determine how exchange rate
fluctuations have an effect on the FS item values in group currency. You may like to display
these effects separately.

A change in the group currency value, which occurs exclusively through a change in the
exchange rate, is called temporal translation difference. On the other hand the change in the
group currency value, which occurs through a change in the local currency value, is called
transaction difference.

An example for the requirement to display temporal translation differences is the
asset history sheet in group currency. In an asset history sheet, you present the
changes of the asset values from the opening balance to the closing balance. At the
fiscal year change, the closing balance of the old year is transferred to the opening
balance of the new year. If during this change, the exchange rate (current exchange
rate) changes, then the opening balance in the new year (calculated with the new
exchange rate) does not agree with the closing balance of the old year (calculated
with the old exchange rate). In this case it useful to display this temporal translation
difference.

The temporal translation differences in an asset history sheet can be displayed in the subitems of
the FS items of the transferred assets. For FS items where this procedure is not possible (no
breakdown by subitem), the SAP currency translation offers a separate display of temporal
translation differences in the totals records.

Prerequisites
Displaying temporal translation differences is only possible and useful for currency translation
keys 1, 9 or 7.

Features
Asset History Sheet: Displaying Temporal Translation Differences in
Subitems
You will find a detailed explanation in the process description Asset History Sheet Reporting
[Page 267].

Displaying Temporal Translation Differences in the Totals Records
In the Customizing of currency translation, in fact in the definition of translation entries, you can
set the indicator temporal translation difference, The indicator has the following effect:

•  The system calculates temporal translation differences between the periods, within a fiscal
year

•  The system displays the temporal translation differences under a translation indicator and
generates separate totals records.

Table: Differentiation of the totals records with the translation indicator
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Transl.
ind.

Period value in local curreny Period value in group currency

0 LC value of transaction Reference value of transaction

1 Value 0 Delta between value in group currency and
reference value of the transaction

2 Value 0 Delta between old reference value and new
reference value and for the prior period values

Therefore: the temporal translation difference on
the basis of the change in the reference exchange
rate

3 Value 0 Change of the deltas between value in group
currency and reference value and for the prior
period values

Therefore: the temporal translation difference for
the delta between value in group currency and
reference value

The separated display of the temporal translation differences is reset for the balance
carried forward, that means

•  the totals records with translation indicator 2 go into the totals records with
translation indicator 0.

•  the totals records with translation indicator 3 go into the totals records with
translation indicator 1.

Examples

Example 1: Translation for the reference exchange indicator, therefore no currency
translation differences
Scenario: The reference exchange rate changes from 1.5 (period 000) to 1.6 (period 012)

Totals records in 1998

Period: 000
Ref. exchange
rate: 1.5

Period: 012
Ref. exchange
rate: 1.6

Period:
012
cumulativ
eFS

Item
Transl
. ind.

LC GC LC GC LC GC
12345
6

0 1,000 1,500 100 160 1,100 1,660

12345
6

2 0 0 0 100 0 100

Note:
The change of the reference exchange rate between period 000 and period 012, results in the
temporal translation difference of 100 (1000 LC * 0.1 GC/LC) for the value 1,000 from period 000.
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The system calculates the difference as follows:

Reference value cumulative to period 012 1,760

  - Reference value cumulative to prior period 1,500

  - Reference value of period 012 160

  = Temporal translation difference at the prior period 100

Totals records in 1999

Period: 000
Ref. exchange rate:
1.6

Period ...
Ref. exchange rate ...

FS Item Transl.
ind. LC GC LC GC

123456 0 1,100 1,760 … …

123456 2 0 0 … …

Note:
For the balance carried forward, the temporal translation difference of 100 goes into the totals
record with translation indicator 0, so that the cumulative value in group currency is 1,760 in the
balance carried forward period.

Example Translation to an exchange rate which is unequal to the reference exchange rate,
therefore currency translation differences arise
Scenario:

The reference exchange rate changes from 1.6 (period 000) to 2.0 (period 012). The exchange
rate stays the same.

Totals records in 1998

Period: 000
Ref.
exchange
rate: 1.6
Exchange
rate: 1.7

Period: 012
Ref.
exchange
rate: 2.0
Exchange
rate: 1.7

Period:
012
cumulati
ve

FS
Item

Trans
l. ind.

LC GC LC GC LC GC
12345
6

0 1,100 1,760 100 200 1,200 1,960

12345
6

1 0 110 0 -30 0 80
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12345
6

2 0 0 0 440 0 440

12345
6

3 0 0 0 -440 0 -440

Note:
As the exchange rate differs from the reference exchange rate, in period 000 a currency
translation difference of 110 is displayed under translation indicator 1.

The change of the reference exchange rate between period 000 and period 012 results in two
temporal translation differences.

•  Temporal translation difference 1 under the translation indicator 2 is 440 (1,100 LC * 0.4
GC/LC).

•  Temporal translation difference 2 under the translation indicator 3 is 440- (1,100 LC * 0.4
GC/LC-).

The system calculates the temporal translation difference 1 as follows:

Reference value cumulative to period 012 2,400

  - Reference value cumulative to prior period 1,760

  - Reference value of period 012 200

  = Temporal translation difference 1 440

The system calculates the temporal translation difference 2 as follows:

Value in group currency cumulative to period 012 2,040

  - Value in group currency cumulative to prior period 1,870

  - Value in group currency of period 012 170

  - Temporal translation difference 1 440

  = Temporal translation difference 2 -440

Totals records in 1999

Period: 000
Ref. exchange rate:
2.0
Exchange rate: 1.7

Period: ...
Ref. exchange rate:
...
Exchange rate: ...FS Item Transl.

ind. LC GC LC GC
123456 0 1,200 2,400 … …

123456 1 0 360- … …
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123456 2 0 0 … …

123456 3 0 0 … …

Note:
For the balance carried forward, the temporal translation difference 1 of 440 in goes into the
totals record with translation indicator 0, so that the cumulative value in group currency is 2,400
in the balance carried forward period. The temporal translation difference 2 of 440- goes into the
totals record with translation indicator 1, so that the cumulative value in group currency is 360- in
the balance carried forward period.
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Transl. Diffs with the Ref. Exch. Rate Indicator *
Use
The system normally uses the current exchange rate to determine reference values.

However, if reported financial data in both local and group currency exists before you start
translation, you also have the option of using the reference exchange rate indicator *.

If you use the reference exchange rate indicator *, the system uses values that already exist in
group currency as the reference values when it calculates translation differences.

Integration
Reported data usually exists in both local and group currency if you collect it in the Consolidation
application by means of automatic data transfer, realtime update, periodic extract or rollup.

This is because the system translates local currency values into group currency when posting
them to the consolidation processing ledger, consolidation staging ledger or rollup ledger, using
the current exchange rate on the date of posting.

Features
You select the asterisk character * as the reference exchange rate indicator in Customizing.

The system calculates and posts the translation differences as follows:

•  For each FS item contained in a translation entry, the local currency or transaction
currency value is translated using the exchange rate defined in the translation method.

•  The translation difference is calculated as the difference between the new group
currency value after translation and the existing group currency value.

•  The translation difference is posted for each FS item set.

•  The new group currency value replaces the existing value (the reference value).
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Disclosure of Translation Differences
Use
When customizing the methods for currency translation, for each item set you can define which
items are to be posted with the translation differences. As you see, there are various ways to
disclose the translation differences in your consolidated statements.

Features
Translation differences in the balance sheet
If you post translation differences that occur in the balance sheet within the balance sheet, the
balance sheet remains balanced.

If you post the balance-sheet translation differences to income statement items, both the balance
sheet and the income statement are (at first) out of balance and contain a net balance. This
financial statement imbalance should usually flow into the annual net income and retained
earnings. The system automatically posts this financial statement imbalance.

However, you may have the requirement to separately disclose the balance sheet-originated
translation difference in the income statement and the balance sheet without incurring a net
balance and thus a financial statement imbalance. For this situation the system features an
automatic balancing adjustment. You can set up the balancing adjustment in Customizing for
Currency Translation. This might look like this:

Income statement item Balance sheet item

Transfers to currency translation differences
(debit)

To Currency translation differences (credit)

(or vice versa)

See also: Set Up Postings for B/S Translation Differences to the I/S [Ext.]

Translation differences in the income statement
Translation differences incurred in the income statement are usually disclosed under income
statement items. In this case, the income statement remains balanced.

But it is also possible to disclose income statement differences on the balance sheet. The
standard SAP system includes a method that discloses the differences as follows. (This method
is set up for consolidation chart of accounts 01 – US GAAP, retained earnings appropriations in
the balance sheet).

•  The reference exchange rate is the current rate.

•  Revenue and expense items are translated at the average rate. Differences are posted to a
differential item in stockholders' equity.

•  The annual net income item in the income statement is also translated at the average rate.
The difference is posted to the annual net income item in the balance sheet.
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Translation Differences During Subsequent
Consolidation
Use
If you post translation differences that affect earnings, you need to differentiate between
translation during first and subsequent consolidation of reported financial data, as follows:

•  When translating data during first consolidation, the system posts the entire translation
difference with an effect on earnings.

•  When translating data during subsequent consolidation, you can only post changes in
the translation difference since the prior period. Differences affecting earnings that are
posted in prior periods may not affect earnings in subsequent periods.

•  When translating data during subsequent consolidation in a new fiscal year, translation
differences must be posted from prior periods to the statement of retained earnings,
usually to the unappropriated retained earnings item.

Features
You use a selected statistical item to differentiate between first and subsequent consolidation
when posting translation differences that affect earnings.

The system uses this item to keep a current record of translation differences. It can then
calculate any changes resulting from currency translation prior to a subsequent consolidation,
and handle these appropriately.

You define this selected item in Customizing of Currency Translation in the step Define postings
for balance sheet translation differences in the income statement [Ext.].
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Differential Items with Subassignments
Use
You may want to post from the currency translation using Subassignments [Ext.]

Features
You have the following options:

•  Post translation differences to differential items with subassignments (see below).

•  Post translation differences to their originating FS items with subassignments.

If you choose this option, you leave the differential item blank in Customizing and state,
which subassignment the system should use when posting a translation difference to its
originating item.

You have specified a breakdown by the subitem ‘transaction type’ for asset items.
You want to translate depreciation using an average exchange rate, and translate
the values for the other subitems using the current rate.

In this case, you should post the translation differences to the relevant asset items,
using a transaction type assignment specifically defined for this purpose:

− The asset item is the originating item for the translation difference. The system
therefore posts the difference to the asset item.

− In order to distinguish the difference entry from other transaction data, the system
posts it using the transaction type you specified.

Subassignments to the Differential Item
So that you can post the translation difference with subassignments to the differential items, the
master data of the differential item must record a breakdown by the desired subassignment. This
can be a required breakdown as well as an optional breakdown.

For example, it might be necessary for the elimination of investment income, to
differentiate currency translation differences by partner units.

Depending on which settings you executed in Customizing of the Translation Methods [Ext.] for
the differential item, the system determines the characteristic values of the subassignment(s):

1. You can set a default indicator for the respective subassignment. If you do not set the
default indicator, then you have to define the characteristic value of the subassignment.
Then the system always posts the subassignment with this characteristic value.

Exception: If it concerns an optional breakdown, then you do not have to define the
subassignment. Then the system does not post the subassignments, it debits the null
value instead.

2. When you set the default indicator, then the system tries to determine the characteristic
value of the subassignment from the totals record to be translated.
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3. When you have set the default indicator and the system can not determine the
subassignment from the totals record, then it does the following:

When you have defined a value for the subassignment in Customizing, in addition to
the default indicator, then the system assigns this value to an account during the
difference posting.

4. When you have not defined a value, then the system assigns the general default value to an
account, which you have defined in the IMG step Default Values for Subassignments [Ext.].
When you have not defined any general default values and for the subassignment

− it concerns a required breakdown, then the system displays an error message

The following graphic shows the logic of the system when you set the default indicator (a shows
step 2 and b, c and d show step 3):

No  FS item Text SIC    SI LC value

1

2

170100

...

Bet. 120 100-

Default value
SI cat.

Subitem

Method entry
investment

FS item 

Subitem Default X

Crcy trans. diffs 

6

250920

a

b

c

SI cat. 6

Customizing

Error message reqd breakdownd

...

1
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Calculation of Rounding Differences
Use
The translation of financial data can produce differences that are caused by rounding in the
system. These differences are not related to translation differences.

If rounding differences occur, translated financial data does not pass subsequent validation
checks.

Examples of validation checks on translated data

Total assets   = Total liabilities and stockholders’ equity

Total revenue + expense   = Annual net income

Amortization/depreciation in the balance sheet   = Amortization/depreciation in the income
statement

In order to calculate rounding differences, the system performs rounding checks. It then posts
any differences it finds to the appropriate differential items.

These differences are usually very small, because they are purely the result of the inaccuracies
involved in rounding.

Features
Financial Statement Item Sets
In Customizing, you define financial statement (FS) item sets to be used for rounding checks. For
each set, you specify the FS item to which rounding differences are posted.

You have the following options for setting up rounding checks:

•  Run a rounding check using one FS item set only. The system checks whether the sum
of items in this set is zero.

You can check whether the sum of all balance sheet items is zero.

•  Run a rounding check using two FS item sets. The system checks whether the sum of
items in the first set is equal to the sum of items in the second.

You can check whether the sum of the annual net income and appropriation of
retained earnings is equal to the retained earnings in the balance sheet.

•  Run a rounding check using two FS item sets and restrict the first item set to a set of
subitems. The system then checks whether the sum of subitems in the first set is equal
to the sum of items in the second set.
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You can check whether the sum of asset items, restricted to depreciation items, is
equal to the corresponding sum of depreciation items in the income statement.

Sequence of Rounding Entries
You can define any number of rounding entries. If you are performing multiple rounding checks,
you need to specify a check sequence in Customizing, to prevent rounding checks from annulling
any previous checks.

You should run localized rounding checks first, for example to establish whether balance sheet
depreciation on assets is equal to similar deprecation in the income statement. You can then run
larger-scale checks, for example to establish whether the sum of all balance sheet items is zero.

Calculation and Posting of Rounding Differences

•  The system performs rounding checks for FS item values in local currency. No
differences are allowed for these values. If the system finds any, it outputs an error
message.

•  Next, the system performs rounding checks for FS items in group currency and
calculates rounding differences.

•  The system posts the differences to the appropriate differential item, depending on
whether they have a debit or credit sign.
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Use of Rounding Entries for Reconciling Financial
Statement Items
Use
You can use rounding entries to reconcile financial statement (FS) items whose values should be
equal after currency translation.

If you report the appropriation of retained earnings at the end of the income statement, for
example, you need to reconcile the retained earnings items in the balance sheet with those in the
income statement if you have translated them using different exchange rates. Before you can
continue with further consolidation tasks, these items must have identical values (with reverse
debit/credit signs) in group currency.

Similarly, you need to reconcile annual net income items in the balance sheet with those in the
income statement if you report appropriation of retained earnings in the balance sheet.

Features
If you report the appropriation of retained earnings at the end of the income statement, you
reconcile retained earnings items in the balance sheet and income statement as follows:

•  You define the translation method:

− You define a rounding entry using an FS item set which contains the retained earnings
items for the balance sheet and income statement.

As the differential item for rounding differences, you specify the retained earnings
item in the income statement.

− You define a second rounding entry which rounds items in the income statement items
(including the appropriation of retained earnings). As the differential item, you specify the
carryforward item for retained earnings.

•  You run currency translation

− The system checks whether the sum of all retained earnings items is zero, and posts any
differences to the retained earnings item in the income statement.

− The system then checks whether the sum of all income statement items is zero, and
posts any differences to the carryforward item for retained earnings.
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Repetition of Currency Translation
Use
If you make changes to the reported financial data in local currency after executing currency
translation, you need to repeat the translation run.

You can repeat both a provisional and a final translation. The system overwrites any previously
translated values with the new values.
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Audit Trail for Currency Translation
Use
The following audit trail and list are available for documenting currency translation:

•  An audit trail of the translation run, and information about translation differences and their
posting.

•  A list of translation rules and financial statement item sets for a translation method.

The system generates these during test runs and update runs of currency translation.
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Currency Translation
Purpose
You need to follow this process if you want to translate financial data reported by one or more
consolidation units. You can perform both provisional and final currency translation.

Prerequisites
You will need to perform currency translation if you have done the following:

•  Collected reported financial data in the Consolidation application, either by manual entry
or automatic transfer

•  Posted any necessary standardizing and correcting entries in local currency

The data from these activities requires translation into group currency.

Process Flow
1. You decide whether you want to perform provisional or final currency translation.

2. You check your settings in the system:

 – When running a final translation, you check whether:

 – The translation method and exchange rates are defined

 – The translation method is error-free and activated

 – The data validation task has been executed and blocked

 – When running a provisional translation, you only need to check if the translation
method and exchange rates are defined.

 If you do not check the translation method, or if the check finds errors, you can still
perform provisional translation.

3. In the method definition, you find out whether investment or equity items are translated
historically, using data from the changes in investments and changes in investee equity
tables.

 If they are, you need to check whether the data in these tables is complete.

 If you are performing provisional currency translation and can tolerate errors which
occur missing entries in these tables, you do not need to complete this step.

4. You start currency translation in the consolidation monitor.

5. The system translates the financial statement items from local currency (or in certain
cases from transaction currency) into group currency.

6. For each translation entry, the system calculates translation differences and posts them
to the differential items you defined.

 Depending on the differential items you assigned to your translation entries, the system
posts differences either with or without an effect on net income.
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7. If the system posts differences with an effect on net income, it also calculates and posts
a financial statement balancing adjustment.

8. The system runs rounding checks using your rounding entries.

 – First it checks whether any rounding differences exist in local currency. If they do, it
terminates the translation run with an error message.

 – If the rounding check does not find rounding differences in local currency, the system
checks for differences in group currency. It posts these to the differential items that
you pre-defined.

9. You use the translation audit trail to see if the system output any error messages. If you
are performing final translation, no errors are allowed. If any errors occur, the system
regards the translation as being provisional.

Result
•  If you performed a final translation, block the translation task in the consolation monitor.

You can then perform subsequent consolidation tasks in group currency.

•  If you performed provisional translation, you cannot block the translation task in the
consolidation monitor.

You can generate a reconciliation list for interunit elimination, based on the values
produced by provisional translation.
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Running Currency Translation
Procedure

1. In the Consolidation menu, choose Data collection → Monitor.

2. Check the global parameters by choosing Environment → Global parameters.

3. Place the cursor on the consolidation unit whose data you want to translate and on your
currency translation task, and choose Update run.

The audit trail for the translation is displayed.
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Asset History Sheet Reporting (Temporal Translation
Differences)
Purpose
Asset history sheets, which show changes in asset values between the opening and the closing
balance, are often required as a supplement to both the individual and consolidated financial
statements.

If you translate asset values using the current exchange rate for the current period, and not
historically by year of acquisition, then temporal translation differences occur if the current
exchange rate changes with a new fiscal year. The closing balance for the prior year no longer
corresponds to the opening balance of the current year. In asset history sheets, however, these
two balances must be identical.

You follow the process described below if you want to report temporal translation differences
separately in your asset history sheet. You would want to do this in order to show the
correspondence between the closing balance of the prior year and the opening balance of the
current year.

Prerequisites
The system must calculate temporal translation differences during currency translation and post
them separately, before it can report them in the asset history sheet. This process therefore
begins with definition of translation methods.

Process Flow
1. You define translation methods in Customizing.

 – You select the current rate as the reference exchange rate indicator.

 – You make translation entries for the asset items you want to include in the asset
history sheet, to specify how temporal translation differences will be handled, as
shown in the following table:

 Entries for translation differences

 No.  Content  Exchange rate
indicator

 Trl.
key

 Differential item

001  Set of assets items, restricted
to the subitem for acquisition
and production costs (APC).

Current rate for
last period of
prior year
 
 (indicator in trl.
entry)

   1  Originating item
Post with the subitem for
temporal translation
differences in APC.

002  Set of asset items, restricted
to the subitem for the opening
balance of value adjustments.

Current rate for
last period of
prior year
 
 (indicator in trl.
entry)

   1  Originating item
Post with the subitem for
temporal translation
differences in accumulated
depreciation.



Consolidation (EC-CS)  SAP AG

Asset History Sheet Reporting (Temporal Translation Differences)

268 April 2001

003  Set of asset items, restricted
to remaining subitems.

 Current rate    1  Item for differences from
currency translation.

You select the indicator Exchange rate from the previous year, for translation
entries 001 and 002. This means that the system reads the exchange rate from
the previous year from the exchange rate table.

2. You run currency translation. In accordance with the settings you made in your
translation entry, the system:

 – Calculates temporal translation differences between the current rate for the last
period in the prior fiscal year and the current rate for the current period. It does this
for acquisition and production costs, and for the opening accumulated depreciation
balance.

 – Posts any temporal translation differences to the relevant asset items with the
subitems you specified for temporal translation differences.

 – Translates the remaining asset items (acquisitions, depreciation, transfers, and so
on) using the current exchange rate for the current year.

3. In order to determine the structure of your asset history sheet, you define a report with
the following line and column layout:

Example data

Closing bal.
prior yr

Temporal transl. diffs Open.
bal.

Acquis. ... Clos. bal.

APC
Accum. Depr.

The opening balance equals the closing balance of the prior year plus any temporal
translation differences.

Result
You can use the report you defined to generate an asset history sheet which reports temporal
translation differences separately.

To see how temporal translation differences are calculated and recorded see also                   
Temporal Translation Differences [Page 248]
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Interunit Elimination
Purpose
This component enables you to eliminate trading partner relationships within your corporate
group, which exist if goods or service transactions take place between consolidation units.
Interunit (IU) elimination includes the following main procedures:

•  Elimination of IU payables and receivables

•  Elimination of IU revenue and expense

•  Elimination of investment income

These procedures are necessary if pairs of consolidation units report reciprocal payables and
receivables, revenue and expense, and/or costs and sales revenue. From the group point of
view, these relationships must be eliminated.

Implementation Considerations
The elimination of IU trading partner relationships is one of the central procedures in
consolidation.

Install this component if you want to perform IU eliminations using automatic posting. If you do
not install this component and still want to perform IU eliminations, you can use manual posting.

Features
•  To enable the system to eliminate trading partner relationships within your corporate

group, you need to enter the relevant financial statement (FS) item data using trading
partner account assignments. The system uses these account assignments to identify
trading partner relationships between consolidation units.

•  You define tasks and methods for IU eliminations in Customizing.

− Tasks represent consolidation procedures such as the elimination of IU payables and
receivables or revenue and expense, and so on. You can define as many tasks as
required to match the procedures you use.

− Methods determine the FS items for reciprocal elimination and how the system should
post any elimination differences.

•  You execute IU elimination tasks from the consolidation monitor. From the method
assigned to the task, the system determines the FS item values to be eliminated for each
pair of consolidation units, and automatically generates an entry.

The system posts any differences to the differential items, which you specify in
Customizing.

•  You can execute IU eliminations in test mode, and generate a reconciliation list during
your preparations for consolidation, in order to find any differences before you start
actual consolidation. You can then use this list to evaluate each difference.
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Two-Sided Elimination Entries
Use
The system performs interunit (IU) eliminations for pairs of consolidation units, using a predefined
posting level (level 20, or 23 for mutual stock consolidation) that is reserved for this task. The
automatic elimination entries which the system generates are based on the financial statement
(FS) items for elimination which you specify in Customizing, and on the partner account
assignments of the data to be eliminated.

The system generates an elimination entry if:

•  a consolidation unit reports a value for an FS item requiring elimination (possibly
delimited by subassignments - see further on)

•  another consolidation unit is assigned as the trading partner for this value

•  you have specified that both of the above consolidation units are to be included in IU
elimination

Features
Elimination Entries
Each line item in an elimination entry posts the amount to be eliminated to both a consolidation
unit and a partner unit, with a reversed debit/credit sign.

FS Item Sets
You define financial statement item sets for your methods for IU eliminations [Ext.] in
Customizing. In these sets, you specify the FS items which eliminate each other.

You can create multiple pairs of FS item sets for each IU elimination method. The first set in
the pair contains the FS items for elimination; the second set contains the corresponding
offsetting items. These pairs of FS item sets represent a trading partner relationship.

To delimit the which item values are eliminated, you can create the following characteristic values
for each item set:

Characteristic Procedure What is Listed

Subassignments The system displays the
subassignments that are defined in
the breakdown category of at least
one of the items in the set.

You can specify a single value or a
set of values for each subassignment.

NOTE: Delimiting by a subassignment
value is usually only useful if all items
of the set are broken down by such a
subassignment.

all item values in the
item set that were
posted with this
subassignment
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Consolidation unit or
partner unit

only those consolidation
units and partner units
that you specify in the
IU Elimination selection
screen via the
consolidation group

Attributes of the
consolidation/partner
units

only those units with
matching attributes

Document type

You can also display these
characteristics and specify a single
value or a set of characteristics.

only those data records
that were posted with
these document types

 
You could create the following pair of FS items for a method:

•  Item set 1: Interest and similar expenses

•  Item set 2: Interest and similar revenue

You could delimit the selection values to certain consolidation and partner units. For
example, if you distinguish between production companies and finance companies,
you could constrain the IU elimination to one of these company types. This would
allow you to evaluate the IU differences separately.

Differentiation of Trading Partner Relationships
The system differentiates elimination entries according to trading partner relationships, as
follows:

•  The system processes each pair of consolidation units.

•  For each pair of consolidation units, the system processes one pair of FS item sets at a
time.

•  The item values of consolidation unit 1 in item set 1 (with consolidation unit 2 as the
trading partner account assignment) and the item values of consolidation unit 2 in item
set 2 (with consolidation unit 1 as the trading partner account assignment) indicate a
trading partner relationship. The system eliminates these values and determines any
remaining difference.

The reverse correlation also indicates a trading partner relationship, therefore the system
eliminates the item values of consolidation unit 2 from item set 1 and the item values of
consolidation unit 1 from item set 2.

Elimination Differences
Elimination differences are posted to differential items. You define these items as item pairs in
item sets in Customizing. You also define the strategy [Page 281] the system uses to choose
which consolidation unit the difference is posted to.
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How to control subassignments of the differential items
If the differential item has a breakdown by subassignments, the system needs to know which
value is to be posted for each subassignment. You can define a value for each subassignment in
Customizing, and you can also set the default value. The system uses the following logic:

•  If the default flag is not selected, you must enter a value for the subassignment. This value is
then always assigned to the differential entry.

Exception: If the breakdown is optional, a value does not have to be entered. If no value
is entered, the subassignment is left blank.

•  If the default falg is selected, the system attempts to obtain the subassignment from the
elimination data.

•  If the default flag is selected and the system cannot derive the subassignment from the data,
the system proceeds as follows:

− If Customizing shows a value for the subassignment, in addition to the default flag, the
system uses assigns this value.

− If Customizing does not show a value for the subassignment, the system uses the
general default value that is defined in IMG step Default Values for Subassignments
[Ext.] .

− If there is no general default value and the subassignment is a required breakdown, the
system displays an error message.

Other factors concerning the default flag are taken into consideration for
subassignments that belong to a compound:

•  The default flags of compound characteristics (e.g., country and region)
should be either both selected or both not selected.

•  If the independent subassignment has a fixed value in the breakdown
category (subitem category-like subassignments), then you can select the
default value for the dependent characteristic only if:

•  all items of both item sets are broken down by these
subassignments, and

•  the fixed value of the independent subassignment is identical for all
concerned items (or rather in the breakdown categories of those
items)

Otherwise, the data can become inconsistent.

Which data records does the system aggregate to calculate and post elimination
differences?
1. The system aggregates all data records that belong to the same business relationship.

2. If the differential item has subassignments and the system determines these subassignments
from the data records (that is, the default flag is selected), then the system posts the
elimination difference for each different subassignment value (see the example).
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Posting Documents
A posting document is created for each business relationship.
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Example of Elimination Entries
Scenario
This example reflects data of a business relationship between consolidation units A and B.

Customizing
Item Set 1

Characteristic Single Value / Set

FS item Receivables

Subitem category BA

Subitem

Customer group

Item Set 2

Characteristic Single Value / Set

Item Payables

Subitem category BA

Subitem

Customer group

The case studies below show how to customize the differential items.

Differences are always posted to consolidation unit A because this unit supplies the
values from item set 1 (receivables).

Initial Data in the Database (Posting Level < 20)

Cons Unit Item Partner Unit Subitem Cat Subitem Customer Group Cons Value

A Receivables B BA 1000 C1 60

A Receivables B BA 2000 C2 80

B Payables A BA 3000 C2 20-

B Payables A BA 1000 C1 30-
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Interunit Elimination
Case 1
Customizing of the Differential Item

Characteristics Debit Credit Default

Item Other Expenditures Other Revenue

Subitem category BA BA

Subitem X

Customer group X

Entries (Posting Level 20)

Cons Unit Item Partner Unit Subitem Cat Subitem Customer Group Cons Value

A Receivables B BA 1000 C1 60-

A Other Exp. B BA 1000 C1 60

A Receivables B BA 2000 C2 80-

A Other Exp. B BA 2000 C2 80

B Payables A BA 3000 C2 20

A Other Rev. B BA 3000 C2 20-

B Payables A BA 1000 C1 30

A Other Rev. B BA 1000 C1 30-

The differentials are displayed in italics for better orientation.

Case 2
Customizing of the Differential Item

Characteristics Debit Credit Default

Item Other Expenditures Other Revenue

Subitem category BA BA

Subitem 9000 9000

Customer group C3 C3

Entries (Posting Level 20)
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Cons Unit Item Partner Unit Subitem Cat Subitem Customer Group Cons Value

A Receivables B BA 1000 C1 60-

A Receivables B BA 2000 C2 80-

B Payables A BA 3000 C2 20

B Payables A BA 1000 C1 30

A Other Exp. B BA 9000 C3 90

Case 3
Customizing of the Differential Item

Characteristics Debit Credit Default

Item Other Expenditures Other Revenue

Subitem category 1 1

Subitem 1 1

Customer group X

Entries (Posting Level 20)

Cons Unit Item Partner Unit Subitem Cat Subitem Customer Group Cons Value

A Receivables B BA 1000 C1 60-

B Payables A BA 1000 C1 30

A Other Exp. B 1 1 C1 30

A Receivables B BA 2000 C2 80-

B Payables A BA 3000 C2 20

A Other Exp. B 1 1 C2 60

Case 4
Customizing of the Differential Item

Characteristics Debit Credit Default

Item Other Expenditures Other Rev.

Subitem category 1 1

Subitem 1 1

Customer group C3 C3
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Additional breakdown Z Z

Entries (Posting Level 20)

Cons Unit Item Partner Unit SI Cat Subitem Customer
Group

Addl.
Breakdow

n

Cons Value

A Receivables B BA 1000 C1 60-

A Receivables B BA 2000 C2 80-

B Payables A BA 3000 C2 20

B Payables A BA 1000 C1 30

A Other Exp. B 1 1 C3 Z 90
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One-Sided Interunit Elimination
Use
One-sided interunit (IU) elimination is a simplified procedure for eliminating data from trading
partner relationships within your corporate group. In this procedure, the system posts elimination
entries based on the values in one financial statement (FS) item set only.

IU revenue and expense, in particular, can be eliminated using this simplified procedure.

Features
When you define elimination methods in Customizing, you select the one-sided IU elimination
option. You define one FS item set for elimination only. In this set, you list the FS items on which
elimination should be based, for example, revenue items. As the differential item, you specify the
offsetting item, for example, an expense item.

When you run IU elimination, the system calculates a difference equal to the sum of the values in
the FS item set you specified, and posts this value to the differential item.

Constraints
When IU elimination is based on values of one FS item set, the system does not calculate and
post real elimination differences. Instead, the values of the FS item set are used for the
elimination entries, and it is assumed that corresponding offsetting values exist.

If the values of FS items in the item set differ from the offsetting values for elimination, the
system eliminates inaccurate values during a one-sided elimination.

 
Within your corporate group, a revenue of 1000 currency units (MU) is offset by
expenses of 900 MU. You want to perform one-sided IU elimination based on
revenue values. You have specified an expense item as the differential item.

Using reversed debit/credit signs, the system posts 1000 MU to revenue and a
difference of 1000 MU to the expense item. This process therefore eliminates from
expenses excesses of 100 MU.
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Using Strategies for Posting Elimination Differences
Use
Elimination differences can occur during interunit (IU) eliminations. The system calculates and
posts these differences for each trading partner relationship between two consolidation units
(further differentiated by subassignments).

The system posts the differences to one of the two consolidation units concerned. In
Customizing, you can define the strategy which the system uses to determine which
consolidation unit it must post the difference to.

Features
The system supports strategies for posting differences according to:

•  A specified financial statement (FS) item set

The system posts differences to the consolidation unit which reports values for the FS
items in a specified item set.

You select one of the sets from each set pair in Customizing.

•  The lower value

The system posts differences to the consolidation unit that reports the lower of the FS
item values.

•  The higher value

The system posts differences to the consolidation unit that reports the higher of the FS
item values.
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Limit for Elimination Differences
Use
When you perform interunit (IU) eliminations, you may want to prevent the system from posting
elimination entries if elimination differences are too high.

For this purpose, you can specify a limit for elimination differences in Customizing.

Features
If elimination differences exceed the limit, the system does not post the elimination entry. It
generates proposed entries only.

Furthermore, the audit trail indicates if the limit is exceeded.
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Splitting of Elimination Differences
Use
Elimination differences can be categorized by the system according to their cause; either
currency-related or other.

•  Currency-related differences occur if a consolidation unit and its partner have the same
transaction currency values in a business transaction, but report different group values
because they use different local currencies and/or exchange rates.

•  Other differences occur if a consolidation unit and its partner report different financial
data for their trading partner relationship.

This data can differ, for example, if:

− The units post their data on different dates

− The units use different accounting and valuation methods

− One unit makes an error in posting

If you specify splitting of elimination differences, you can subsequently post each type of
difference separately.

Features
•  To enable differences to be split, the financial statement items to be eliminated and the

differential items must be broken down by transaction currency.

•  When you define a method for interunit (IU) elimination in Customizing, you specify the
following:

− Splitting of differences as a control option

− Separate differential items for currency-related and other differences

− The exchange rate indicator that is used as a reference exchange rate indicator when
elimination differences are split

You also set up the document type so that the system posts elimination entries in both
transaction currency and group currency.

•  In order to categorize differences, the system reads the FS item values for elimination in
both group currency and transaction currency. If elimination differences exist in
transaction currency, the system translates these into group currency. The reference
exchange rate indicator and the consolidation version determine the exchange rate for
this translation.

The resulting translated value represents other differences. The differential between this
and the total elimination difference in group currency represents currency-related
differences.

The system posts these differences to the allocated FS items.
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Example
You want to eliminate receivables and payables and split elimination differences. The exchange
rate for translating the differences from transaction currency FRF into USD is 0.4.

Initial data

FS item Posting level Transaction currency Local currency Group currency
Receivables 0 1000 FRF 300 USD 300 USD

Payables 0 1200- FRF 1200- FRF 480- USD
--------- -------
200- FRF 180- USD

Splitting of differences

Total difference = 180- USD

Other differences = 80- USD (200- FRF x 0.4)

Currency-related differences = 100- USD
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Balance Reconciliation and Elimination Entries
Purpose
You need to follow this process if you want to reconcile and then eliminate data from trading
partner relationships between consolidation units in a consolidation group.

Before you post elimination entries for interunit (IU) elimination, it is helpful to reconcile the
balances of data from trading partner relationships. You can use the reconciliation list to check
for elimination differences. If any differences are unexpected or unacceptable, you can consult
the consolidation units concerned and make any necessary corrections.

See also:
Reconciliation in Financial Accounting [Page 287]

Reconciliation Entries

 [Page 288]Reconciliation List at Consolidation Group Level

 [Page 289]Afterwards, you post the entries for IU elimination.

Prerequisites
Before you can carry out a preliminary balance reconciliation, you must first carry out currency
translation.

Status management allows currency translation in update mode, even if the preceding tasks
(such as Data Entry) have not yet been blocked. The system regards this as a tentative
translation.

See also:
Management with the Data Monitor [Page 234]

Process Flow
1. You execute IU elimination tasks in test mode from the consolidation monitor during the

preparatory phase of consolidation.

 The system generates a reconciliation list of financial statement item values to be
eliminated, and elimination differences.

2. You analyze the elimination differences and consult the consolidation units concerned, if
required.

3. You may want to post reconciliation entries centrally in the Consolidation application.

4. When you are ready to create your consolidated financial statements, you execute the IU
elimination tasks in update mode. The system generates elimination entries.

5. After the system posts elimination entries, you may want to execute the tasks again in
test mode and request that the system display a list of original values. Using this list, you
can reconstruct the situation before the elimination entries were posted.

Result
Once this process is completed, you can use reports to evaluate your consolidated financial data.
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Reconciliation in Financial Accounting
Integration
The audit trail for interunit elimination features a program for reconciling with the component
Financial Accounting (FI) if you are performing company consolidation in which the consolidation
units are integrated with the company codes of Financial Accounting, and Financial Accounting
uses the same SAP system and client.

The program reconciles customer and vendor documents that were created for business
transactions within the group. The program is intended to guarantee that the customer and
vendor documents match.

SAP recommends that you run this program in Financial Accounting regularly.

Activities
Call up the program from within the audit trail for interunit elimination by placing the cursor on the
second consolidation unit of a given pair of units, and choosing Goto → Reconcile trading
partners. For more information, see the program documentation.
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Reconciliation Entries
Use
You have the option to manually post reconciliation entries if the balance reconciliation list
contains differences that you want to purge prior to posting the elimination entries centrally in the
consolidation system.

You can use posting level 21 for these entries.

You can later use the posting level to select reconciliation entries and to reverse them, if
required. Another option is to post the entries with a reversal in the subsequent period.

Example
The following situation could exist on the day when your units prepare their individual financial
statements:

A shipment between consolidation units is still in transit. The supplying unit has posted a
receivable but the receiving unit has not yet posted a payable. In order to ensure that no
difference is posted during IU elimination, you post a reconciliation entry and reverse this in the
following period.
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Reconciliation Lists Using Aggregated Data
Use
In addition to running interunit elimination on the level of consolidation units, you may want to
simulate elimination on the level of consolidation groups for information purposes, using
aggregated values.

If you specify a hierarchy step on the initial screen for interunit elimination, the system generates
a reconciliation list based on consolidation groups.

Your hierarchy may have several steps because further consolidation groups can be assigned
below the top group. You can display a reconciliation list for each hierarchy step.

 
Reconciliation lists for eliminations on consolidation group level are purely
informative. No elimination entries can be posted on this level.

Consolidation group
 Worldwide

Cons group
 Europe

Cons unit
 1

Cons unit
 3

Cons unit
 2

Cons unit
 4

Cons group
 America

Hierarchy step 0

Hierarchy step 1

Hierarchy step 2
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Running Interunit Elimination
Procedure

1. In the Consolidation menu, choose Consolidation → Monitor.

2. Check the global parameters by choosing Environment → Global parameters.

3. Place the cursor on the appropriate consolidation group and your task for interunit
elimination, and choose Update run.

An audit trail of the elimination is displayed.
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Elimination of Interunit Profit/Loss in Transferred
Inventory
Purpose
This component enables you to eliminate profit and loss resulting from inventory transfers
between subsidiaries in your corporate group. This elimination may be a legal requirement and/or
a policy of management accounting for the group.

You can use this component if:

•  Interunit (IU) profit or loss has been recorded in your group as a result of the sale of
inventory.

•  The subsidiaries involved in the inventory transaction are included in consolidation for the
group.

•  On the date of consolidation, the inventory concerned is still owned by the group.

•  You want elimination entries to be posted automatically.

Implementation Considerations
Install this component if you want to eliminate IU profit/loss resulting from inventory transfers by
means of automatic posting.

Features
The elimination of interunit profit/loss in inventory (IPI) is based on data from the consolidation
unit managing the inventory concerned and the unit that supplied the inventory. This data shows
the supply relationships on the level of product groups, for which elimination takes place. The
product group is in this case used for a comparison between inventory and supplier data.

The calculation base is the book value of the asset and the group cost of goods manufactured
which are determined using additional financial data, or they may exist in the totals database (the
latter applies only to inventory data).

IU profit/loss is the difference between the book value of the inventory and the group COGM. IU
loss (inventory book value greater than group COGM) is eliminated by reducing the book value to
match the group COGM. IU loss (inventory book value less than group COGM) is eliminated by
increasing the book value to match the group COGM. You have the option of not eliminating IU
losses if the inventory concerned was sold at a market price that is lower than the group
production costs, or if it would be relatively difficult to calculate the exact amount involved.

The inventory book value is adjusted to match the group COGM, and an offsetting entry is posted
to the income statement. The retained earnings or annual net income, and deferred taxes are
thereby automatically adjusted.

Constraints
Currently, materials data relevant to IPI cannot be accessed by means of integration with
Product Cost Controlling (CO-PC).

A supply chain encompassing multiple trading partner relationships is not available at present.
Supply relationships can currently only involve pairs of units.
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Product Group
Definition
A collection of individual products for use by the user. The criterion for the aggregation is the
similarity with regards to the type or use of the individual products.

Use
You define product groups to subdivide financial statement items for inventory into logical units.
Product groups are used only for the elimination of interunit profit/loss in transferred inventory
(also referred to as IPI). They serve as a framework for calculating interunit profit or loss from
inventory transfers between group subsidiaries. The product group can be derived from
additional financial data or from the field in the totals database (with respect to inventory data).

In SAP Consolidation, the assumption is made that the supply relationships only exist between
pairs of subsidiaries and that the supplying consolidation unit sells inventory to the inventory-
managing consolidation unit. Data for supply chains cannot be processed.

The system automatically performs the elimination of interunit profit/loss and the respective
valuation allowance for the specified product groups at the level of inventory items or product
groups. Here, the IU profit/loss is calculated at the product group level. In contrast, the posting
takes place at the inventory item level, whereby it is possible that breakdowns by product group
are also posted if you created a custom characteristic for the product group (data element
FC_PRGRP).

Structure
The assignment of inventory items to product groups enables IPI to take place per product group
and pair of consolidation units. You create product groups as in accordance with the
requirements of your corporate group.

You can also create the product group as a custom characteristic in the totals database.

However, the product group is still used in the additional financial data.

 Example
In the automobile industry, product groups could be created for different versions of individual
models.
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Elimination of Interunit Profit/Loss: Elimination Logic
Use
Any profit/loss resulting from the sale of inventory between subsidiaries in a corporate group
must be eliminated from the point of view of the group as a single entity. Interunit (IU) profit/loss
is calculated as the difference between the book value of the goods supplied and the acquisition
and production costs incurred from the point of view of the group.

•  Any positive difference is an IU profit. The value of inventory is decreased to match the group
cost of goods manufactured (COGM).

•  Any negative difference is an IU loss. The value of inventory is increased to match the group
cost of goods manufactured (COGM).

The programmed elimination logic in the SAP Consolidation component enables IU profit/loss to
be eliminated automatically. The following functions are provided as part of the logic:

•  Posting of offsetting entries in the balance sheet or income statement

•  Transfer of translation differences to specified items

•  Transfer of distribution costs to a specified item, such as COGM

The Customizing settings that you make for these functions are specific to the task that you
create for the elimination. Once you have made these settings, automatic entries can be posted
when you run an elimination.

Features
Elimination of interunit profit/loss in inventory (IPI) is executed by means of user-defined tasks
[Ext.] in the SAP Consolidation System. In the data monitor [Ext.], you require tasks for the entry
and validation of data. In the consolidation monitor [Ext.], you require a task for IPI. You specify
the point in time as of which this task is effective, the document types it uses, and a comparative
exchange rate indicator. Consolidation units report data resulting from internal goods
transactions in local currency. You only need to specify a comparative exchange rate indicator if
you want to separately analyze translation differences resulting from the use of different
exchange rates.

The elimination entry is posted using posting level 20 and is not group-dependent. The value of
the balance sheet item is adjusted and an offsetting entry posted against the corresponding
expense (in the case of IU profit) or revenue (in the case of IU loss) item. Financial statement
balancing adjustments and deferred taxes are automatically posted.

Usually only the difference between the IU profit/loss in the prior period and current period is
posted. The only exception is if IU profit/loss was eliminated in the prior period using a document
type which specifies automatic reversal in the following period. In this case, IU profit/loss is
posted in full.

If distribution costs are reported by the supplying consolidation unit, these are automatically
reclassified to an item that you have specified in Customizing, for example, cost of goods
manufactured.

Example
The following assumptions are made in this simple example:
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•  Consolidation units A and B are trading partners, and are consolidated using the purchase
method. A supplies goods to B at an IU profit of 100 monetary units.

•  No translation differences are posted and no reclassification of distribution costs takes place.

•  No IU profit/loss from prior periods is taken into account.

The following standardized data was reported by A and B in group currency:

Individual Financial Statement A

Assets Liabilities & Stockholders’
Equity

Fixed
Assets

500 Stockholders’ equity 700 -

Inventory 500 Liabilities 100 -

Retained earnings 200 -

1000 1000 -

Income Statement A

Sales Revenue 1200 +

Expenses 1000 -

Annual Net Income 200 +

Unappropriated Retained Earnings (prior year) 100 +

Appropriation of Retained Earnings 100 -

Retained Earnings 200 +

Individual Financial Statement B

Assets Liabilities & Stockholders’
Equity

Fixed
Assets

1200 Stockholders’ equity 1000 -

Inventory 300 Liabilities 400 -

Retained earnings 100 -

1500 1500 -

Income Statement B

Sales Revenue 2000 +

Expenses 1500 -
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Annual Net Income 500 +

Unappropriated Retained Earnings (Prior Year) 200 +

Appropriation of Retained Earnings 600 -

Retained Earnings 100 +

The following entries are posted to eliminate the IU profit of 100 monetary units, with a tax rate of
50% (debit entry to credit entry):

Expenses to Inventory 100

Deferred Tax Assets to Deferred Tax Expense 50

Retained Earnings (B/S) to Retained Earnings (I/S) 50

The deferred income taxes [Ext.] that arise are balanced out in subsequent periods.

After the elimination, the consolidated financial statements show the following data:

Consolidated Balance Sheet

Assets Liabilities &
Stockholders’ Equity

Fixed Assets 1700 Stockholders’ Equity 1700 -

Inventory 700 Liabilities 500 -

Deferred
Income Tax

50 Retained Earnings 250 -

Deferred Taxes Payable ----

2450 2450 -

Consolidated Income Statement

Sales Revenue 3200 +

Expenses 2550 -

Annual Net Income 650 +

Unappropriated Retained Earnings (Prior Year) 300 +

Appropriation of Retained Earnings 700 -

Retained Earnings 250 +
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Posting Items
Definition
Balance sheet or income statement items against which entries are automatically posted to
eliminate interunit (IU) profit/loss in transferred inventory. Each posting item that you specify is
defined as an inventory item or a product group.

You can use both assignments in a consolidation activity simultaneously. Furthermore, you do
not need to fill the field for the inventory item/product group (value '  '). In this case, the posting
items you assigned are valid across all inventory items/product groups.

Use
You specify posting items as part of the process of setting up automatic interunit elimination of
profits/losses.

Posting item for offsetting entries
For every inventory item you can decide which income statement item is to be used for the
offsetting entry for IU profit/loss. You can use a debit or a credit item, this in turn with all
subassignments.

The consolidation system clears the IU profit/loss to be eliminated from the inventory item.
Usually, the offsetting entry is posted to an income statement item.

By assigning the item for the offsetting entry, you define the treatment routine for interunit
profit/loss. Interunit profit/loss is posted either with an effect on earnings (to an income statement
item) or without an effect on earnings (to stockholders' equity).

Furthermore, you decide whether the offsetting entry is posted to the inventory managing
consolidation unit or the supplier consolidation unit. To do this, you select the related flag in the
task you create for the elimination of interunit profit/loss.

Posting item for currency translation differences
You use posting items for translation differences if your group needs to separately post and
disclose translation differences arising from the elimination of interunit profit and loss.

Currency translation differences are incurred during the elimination of interunit profit and loss as
follows:

•  Trade relationships are entered for each pair of consolidation units and for each product
group. This additional financial data is translated into group currency when computing the
interunit profit/loss. The system uses the translation method of the inventory managing
consolidation unit and determines the exchange rate for the inventory item assigned to the
product group.

•  Thus, the computed interunit profit/loss is based on the exchange rate for the inventory
accounts. The elimination entry for the interunit profit/loss is posted to the inventory item as
well as the offsetting item, the latter of which is usually an income statement item.

•  Income statement items are often translated with exchange rates that differ from those of
balance sheet items – for example, average exchange rates. Hence, the consolidated value
of the revenue and expenses to be eliminated can differ from the computed interunit
profit/loss. This is the currency translation difference.
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•  Currency translation differences from the elimination of interunit profit and loss are the result
from the twofold currency translation of the additional financial data. On the one hand,
additional financial data is translated with the exchange rate indicator of the translation
method. On the other hand, additional financial data is translated with the comparison
exchange rate indicator stored in the task for elimination of interunit profit and loss.

Posting item for distribution costs
You use posting items for distribution costs if your group generates the income statement
according to the cost of goods sold and, because if this, you have the requirement to disclose the
portion of your distribution costs that is allotted to sales as a part of the cost of goods
manufactured.

Features
The Consolidation system automatically posts the offsetting entry for interunit profit/loss.

The Consolidation system automatically posts currency translation differences incurred on FS
items of inventory to the currency translation difference item defined for the posting items. This
should be the currency translation difference item that is defined as the offsetting item in
Customizing for currency translation. Temporal translation differences result from changes in
exchange rates between different statement dates and themselves influence the interunit
profit/loss. These temporal differences are posted as a total, and are currently not divided into a
"pure interunit profit/loss" portion and another portion that is the result of these exchange rate
fluctuations between the statement dates.

For the respective items of the inventory, the system automatically clears the distribution costs,
which were entered as a distribution cost percentage rate, onto an income statement item (that
belongs to the cost of goods manufactured).

Activities
1. In the Implementation Guide for Consolidation, in the Posting Items section, name the

selected posting items for offsetting entries, currency translation differences, and distribution
costs (both as source and destination item for the latter).

If you want the same item to be used for posting offsetting entries or translation
differences, or for reclassifying distribution costs – regardless of the inventory item
concerned – enter only one item for each of these automatic posting activities. In this
case, you do not need to specify the inventory item concerned.

2. In the task definition specify a comparison exchange rate indicator for the translation of the
posting item.

Interunit profit/loss can be broken down to reflect the effects of currency translation.

3. Enter the distribution cost portion of sales as the additional financial data of the supplying
consolidation unit.

Result
The currency translation differences and distribution costs appear in the audit trail as soon as the
consolidation task is carried out.
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Posting Items, Product Group-dependent
Use
This function allows you to assign the posting items to your product groups to be able to compute
the interunit profit/loss in your group.

If you leave the product group field blank, the posting item settings then apply to all
product groups.

You can make the assignments of posting items to product groups more detailed
than the assignments of posting items to the inventory items.
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Posting Items, Inventory Item-dependent
Use
This function allows you to assign the posting items to your inventory items to be able to compute
the interunit profit/loss in your group.

If you leave the inventory item field blank, the posting item settings then apply to all
inventory items.

You can make the assignments of posting items to inventory items more global than
the assignments of posting items to product groups.
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Additional Financial Data
Definition
Information required in order to perform consolidation. Additional financial data provides
information concerning changes in investments and investee equity, and also concerning goods
supply and service relationships.

Use
In the component SAP Consolidation, additional financial data is required for the consolidation of
investments and the elimination of interunit profit/loss in transferred inventory (IPI).

During IPI, the book value of inventory and the group cost of goods manufactured are determined
from the additional financial data. The basis for this calculation is standardized financial data, in
which incidental acquisition costs requiring capitalization are taken into account.

Structure
The component SAP Consolidation features the following types of additional financial data for the
consolidation of investments [Ext.]:

•  Changes in Investments

•  Changes in Investee Equity

•  Amortization of Goodwill

•  Equity Holdings Adjustments

To enter additional data, you select the function for data transfer/entry in the data monitor and
choose Update run. From the following screen, you can access data entry functions for both
reported financial data (balance sheet, income statement) and additional financial data.

In the list that is displayed, you select the data that affects the consolidation of investments and
you go to the respective entry screen. There you can maintain the basic data for the
consolidation of investments. In the Info System, you can create reports specifically for additional
financial data.

You need to enter the following additional financial data for the elimination of interunit profit/loss
in inventory [Page 291]:

•  Inventory Data

•  Supplier Data

To enter additional data, you select the function for data transfer/entry in the data monitor and
choose Update run. Select the function for entering either inventory or supplier data for IPI. Now
you can specify the supplier relationship.

The inventory and supplier data is valid effective as of the entry period until you make any
adjustments to reflect changes in the supply relationship. This minimizes the effort required for
entering data.
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Additional Financial Data Concerning Supply
Relationships
Definition
Supply relationships are partnerships that form the basis for the sale of goods and services
between subsidiaries. They are established on the level of product groups.

Use
Supply relationships represent the material interdependencies within a corporate group. Data for
these relationships is used to determine the following:

•  The group cost of goods manufactured for an item in the inventory

•  The amount of interunit (IU) profit or loss

Structure
A supply relationship always exists between two consolidation units and is valid for a particular
product group. The supplying consolidation unit supplies inventory items (raw materials and
operating supplies, semifinished and finished products) to the inventory managing unit.

Inventory Data
The most important elements of the inventory data are the inventory quantity and incidental
acquisition costs (which can be expressed as a percentage of sales). Incidental acquisition costs
are cost which must be capitalized from the group’s point of view, and which increase or
decrease the group cost of goods manufactured (COGM).

Supplier Data
In addition to the ID of the unit supplying the inventory and the product group, the supplier data
comprises the profit percentage, distribution cost percentage, and cost of goods manufactured.
You can enter the profit percentage as either a markup or as a gross margin.

Example: Profit Percentage Variants
Profit percentage 20
Supplier sales 300

Profit if markup Profit if gross margin
300 * 20 / 120 = 50 300 * 20 / 100 = 60
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Entering Additional Financial Data for IPI
Use
You follow this procedure to enter the additional financial data required for the elimination of
interunit profit/loss in inventory (IPI).

Procedure
1. From the Consolidation menu, choose Data monitor, and put your cursor on the

intersection between the column for the data entry task you have already created and the
row for the unit whose data you are entering. Then choose Update run.

2. A dialog box appears containing options for entering various types of data.

To enter inventory data online, select Inventory Data and choose Enter.

Inventory Data

Supply relationship Value of goods supplied Other information
concerning the inventory
transfer

Inventory managing
consolidation unit

Book value Inventory quantity

Supplying consolidation unit Valuation allowance (loss
allowed)

Incidental acquisition costs
(absolute value)

Product group (18-character
ID)

Valuation allowance (without
loss)

Incidental acquisition costs
(percentage)

You specify a valuation allowance with no loss allowed if the amount concerned represents a
permanent adjustment that must not change a gross interunit profit into a loss (gross profit =
book value in reporting period - group cost of goods manufactured). This procedure respects the
principles of prudence and minimum values. In this case, the amount to be eliminated cannot be
negative.

To enter supplier data online, select Supplier Data in the dialog box and choose Enter.

Supplier Data

Supply relationship Percentage values Absolute value
Supplying consolidation unit Percentage profit as markup Cost of goods manufactured

per unit of measure

Inventory managing
consolidation unit

Distribution cost

Product group (18-character
ID)

Cost of goods manufactured

If you enter additional data for IPI using the data monitor, make a note of whether the
consolidation unit you select is an inventory managing or supplying unit.
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You have the option of collecting additional financial data by means of a flexible
upload. In order to use this function, you need to complete the steps Define Method
for Uploading Inventory/Supplier Data [Ext.] in the Implementation Guide. You can
also enter additional financial data offline using Microsoft Access.

Result
Once you have entered the relevant additional financial data you can execute the IPI task.
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Validation of Additional Financial Data
Use
This function enables you to validate the inventory data reported as part of the additional financial
data for the elimination of IU profit/loss in inventory (IPI). During the validation, the reported
inventory values are compared with the values in the totals database.

Prerequisites
You have entered the additional financial data concerned and created a data monitor task for the
validation [Ext.] of standardized financial data.

Features
When you run a validation of standardized financial data, the additional financial data for IPI are
automatically checked in local currency.

For each inventory item, the total amount reported by the inventory managing unit is compared to
the corresponding entry in the totals database. If an item has a breakdown by partner unit, the
check takes place per partner, otherwise only the total over all partner units (in this case,
supplying units) is checked.

The validation is only completed successfully if no differences are found in the data.

If the task runs with errors, you cannot execute subsequent consolidation steps until
you have made manual adjustments to reconcile the two sets of data.
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IPI Task
Definition
A task is a user-defined technical object that represents a real-life consolidation processing
activity and which triggers a corresponding function in the system, in this case the elimination of
interunit profit/loss in inventory (IPI).

Use
You use a task to bundle the functions that you require for IPI processing.

Structure
You give your task a meaningful name and define a document type [Ext.] that is suitable for two-
sided eliminations. The document type must have the following characteristics:

•  Posting level 20

•  Posting in group currency

•  Posting of deferred income taxes if appropriate

You also need to perform Customizing for Currency Translation [Page 232].

When you define a task, you can determine whether the offsetting entry for the elimination is
posted to the inventory managing consolidation unit, and whether the posting of interunit loss is
allowed.

If you specify that the offsetting entry is posted to the inventory managing consolidation unit, for
example, the inventory adjustment and offsetting entry is only listed for this unit in reporting.
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Calculation of the Group Cost of Goods Manufactured
Use
The group cost of goods manufactured (COGM) forms the basis for the calculation of the interunit
(IU) profit/loss requiring elimination. This cost is determined for the group as if it were a single
entity. Transportation costs for goods transferred within the corporate group, for example, are
distribution costs from the point of view of the individual enterprise and part of COGM from the
point of view of the group.

Prerequisites
COGM is calculated from the following data:

•  COGM

•  Incidental acquisition costs

You enter the incidental acquisition costs, for example, transportation costs, as part of the
additional financial data [Page 302] concerning the inventory.

The system requires the following additional data in order to determine the group COGM:

Inventory data Supplier data
Consolidation units involved in transaction Consolidation units involved in transaction
Product group Product group
Book value Profit percentage
Inventory quantity Distribution costs (%)
Valuation allowance Cost of goods manufactured (%)
Incidental acquisition costs

Features
The system can calculate group COGM in the following ways:

•  Using the supplier’s profit percentage: group COGM = sales * percentage COGM +
incidental acquisition costs

•  Using the COGM per unit of measure and the inventory quantity: group COGM =
inventory quantity * COGM + incidental acquisition costs

The inventory and supplier data used to determine the IU profit/loss are automatically
translated from local into group currency within the program when you start the
elimination task.
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Calculation of the Interunit Profit/Loss for Elimination
Use
This function automatically determines the amount of profit/loss that results from the transfer of
inventory between group subsidiaries and that must be eliminated. The calculation of the group
cost of goods manufactured [Page 308] forms the basis for the calculation of the interunit (IU)
profit/loss requiring elimination.

Prerequisites
IU profit/loss has resulted from the sale of inventory between individual enterprises in the
corporate group. From the point of view of the group as a single entity, no such profit/loss may
occur. The amount of IU profit/loss calculated depends on the volume of inventory transferred
and the profit percentages fixed within your group. Another factor influencing the profit/loss are
the distribution costs and other incidental acquisition costs that arise at different stages in the
supply chain. From the group’s point of view, these costs are considered part of the cost of goods
manufactured as long as the goods for which they are incurred are not sold externally.

Features
The system calculates the IU profit/loss requiring elimination as follows:

Schema for the Calculation of IU Profit/Loss

Variable Formula Represents

A (Net) book value in reporting period

B Valuation allowance (loss allowed)

C Valuation allowance (no loss allowed), in other words, a valuation
allowance that must not change an interunit profit into a loss.

D A + B + C Value of goods supplied / inventory value from the goods
transaction

E Incidental acquisition costs (absolute or as a percentage); need to
be capitalized from the point of view of the group

F D - E Sales revenue

G Profit percentage; either a markup or a gross margin

H 100 - G Cost of goods manufactured (%)

I (F * H) + E

Or: F * (H + E)

Group cost of goods manufactured

...if incidental acquisition costs are entered as a percentage

J A - I Interunit profit/loss for elimination

•  First, the sales revenue is determined. All value adjustments included in the balance
sheet value / book value are reversed, giving the inventory value. The incidental
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acquisition costs entered as a percentage or as an absolute value are deducted from the
inventory value, giving the sales revenue.

•  The group cost of goods manufactured (COGM) is calculated from the sales revenue, by
multiplying this amount by the percentage COGM and adding the incidental acquisition
costs (or by multiplying sales revenue by the sum of the COGM and incidental
acquisition cost percentages).

•  The IU profit/loss requiring elimination is the difference between the balance sheet value
and group COGM.

Note that incidental acquisition costs are considered to be part of the COGM for the purposes of
calculation. This is because, from the group’s point of view, no incidental acquisition costs can be
incurred for a good that was manufactured within the group and sold to a group subsidiary.

You have two options for calculating IU profit/loss:

Procedure 1
IU profit/loss is calculated using a profit percentage that you enter as part of the supplier data.
The profit percentage can be interpreted in the following different ways:

•  As a markup on COGM

•  As a gross margin (a percentage of sales)

 Example
Profit percentage: 20 %

Invoiced amount: 2500

If the profit percentage is a markup, the following IU profit is calculated:

2500 * 20 / 120 = 417

If the profit percentage is a gross margin, the following IU profit is calculated:

2500 * 20 / 100 = 500

Procedure 2
The COGM for the supplier is calculated by multiplying the inventory quantity by the COGM that
you enter per unit. With this procedure, variant J in the above schema is calculated differently, a
follows:

Schema for the Calculation of the Group Cost of Goods Manufactured

Variable Formula Represents

A Quantity

B Cost of goods manufactured per unit of measure

C Incidental acquisition costs

D A * B + C Group cost of goods manufactured
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Valuation Allowance (with no Loss Allowed)
The following situations can occur during the calculation of IU profit/loss:

1. Typically, IU profit/loss is calculated as follows:

inventory book value - group COGM

2. In exceptional cases:

IU profit/loss = 0

This situation occurs if an IU loss is calculated and you have recorded a valuation
allowance with no loss allowed.

A valuation allowance with no loss allowed must not change an IU profit into a loss. No
loss can be posted in this case in order to respect the principles of prudence and
minimum values.

The book value resulting in this case is the maximum value permitted from group’s the
point of view.

Elimination of IU Profit/Loss
The system eliminates IU profit/loss for pairs of consolidation units, and lists the postings made in
an audit trail. The sum of the group COGM and the IU profit/loss is the inventory book value.

Deferred income taxes are normally posted during the elimination because the IU profit/loss
calculated must be allocated to the period in question. The profit/loss that is eliminated is realized
in a later period on sale of the inventory to an external enterprise. Income taxes therefore
become due at a later date (additional payments or refunds). Distribution costs are reclassified to
COGM (if specified). Translation differences are posted separately if the exchange rate indicator
used for translating the balance sheet differs from that used for the income statement and you
specified a comparative exchange rate indicator in the elimination task.

If you do not want deferred income taxes to be posted, you need to specify this in the document
type that you use for the elimination.

 Example
Unit A Sale of goods to unit B Sales: USD 1,200 COGM: USD 1,000

Unit B Sale of 80% of the
goods from A to an
external company

Sales: USD 1,300 COGM: USD 960

Unit B Inventory supplied by
unit A

USD 240

Currency translation Balance sheet and
annual net income at
current rate of 2.00
DEM/USD

Income statement at
average rate of 1.50
DEM/USD

Unit A Unit B Elimination of
sales revenue

IPI Consolidated
data
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Reported data Reported data Total

Inventory 0 480 - 80 400

Cash 2400 200 2600

Annual net
income

-400 - 680 80 -1000

Stockholders’
equity

- 2000 - 2000

Sales revenue - 1800 - 1950 1800 - 1950

Cost of goods
manufactured

1500 1440 - 1800 60 1200

Translation
differences

- 100 - 170 20 - 250

Transfer to
annual net
income

400 680 - 80 1000
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Elimination of Interunit Profit/Loss
Prerequisites
You have entered additional financial data relevant for the elimination of interunit (IU) profit/loss
in transferred inventory. This data reflects the transactions in which goods were transferred
between consolidation units. You link the trading partners and goods transferred in the
information you provide about the supply relationship.

Features
The system automatically eliminates IU profit/loss resulting from the predefined supply
relationships. It does so using the method described in the section Elimination of Interunit
Profit/Loss in Inventory: Logic [Page 294].

Activities
The system automatically calculates and eliminates IU profit/loss. It also creates an audit trail that
lists the postings that were made.
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IPI Audit Trail
Use
The audit trail for the elimination of interunit (IU) profit/loss in inventory gives you an overview of
the IU profit/loss arising from the transfer of goods between group subsidiaries. It lists the
relevant sales, the group cost of goods manufactured, and other information.

Features
The SAP Consolidation system lists the IU profit/loss that it calculates in an audit trail.

Each inventory transfer involves both the unit reporting data and a partner unit.

The audit trail lists the following information for each pair of units:

•  The IU profit/loss eliminated

•  The IU profit/loss for the current period with posting documents

•  The IU profit/loss for the prior period with posting documents

•  Any messages for the elimination run

Activities
You start the task for elimination of IU profit/loss in inventory in the consolidation monitor.

The posting document listed in the audit trail show the IU profit/loss for the individual inventory
items and product groups, and all the entries posted during its elimination.
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Executing the Task for the Elimination of Interunit
Profit/Loss in Inventory
Use
You follow this procedure to run automatic elimination of interunit profit/loss in transferred
inventory (IPI).

Prerequisites
The data concerning goods transactions between group subsidiaries has been entered in the
SAP System either manually or by means of a flexible upload.

Procedure
1. Create a task for IPI and assign it to the consolidation monitor.

2. Give the task a meaningful name.

• Specify whether the offsetting entry for the elimination is to be posted to the
inventory managing unit or — as is normally the case — to the supplying unit. Also
indicate whether interunit (IU) losses may be posted.

• Assign a document type to the task for postings related to the current and prior
periods, and also the comparative exchange rate indicator for currency translation.

Tasks are valid as of a specified year and period. You therefore do not need to
redefine the task until such time as you change your posting procedures. If you are
running IPI for the first time, you need to assign a document type for posting the
portion of profit/loss calculated for the prior period. This amount is posted against the
retained earnings carried forward and the system simulates IPI for the prior period.
No deferred taxes are posted for the portion of profit/loss relating to the prior period.
However, an offsetting entry is posted to the income statement.

To run IPI, proceed as follows:

3. Define the following in the Consolidation Implementation Guide [Ext.]:

• Product groups, which form the basis of the elimination

• Items for posting offsetting entries

• Any items required for reclassifying distribution costs

• Any items required for reclassifying distribution costs

4. Enter inventory and supplier data as additional financial data [Page 302] in the data monitor.
The data originates from inventory transfers between group subsidiaries, and is used by the
system to calculate the resulting IU profit. This profit must be eliminated because it is
considered an acquisition and production cost rather than a profit from the group’s point of
view.

5. Execute the IPI task that you defined from the consolidation monitor [Ext.] or the
Consolidation menu.
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Result
The system automatically calculates and eliminates IU profit/loss, and documents the amounts
involved in an audit trail.
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Consolidation of Investments

Instead of the normal documentation, SAP offers a Knowledge Product as a CD
ROM on the topic Consolidation of Investments. This was developed in co-operation
with the Institute of Financial Accounting and Auditing at the University of Saarland.

The Knowledge Product explains both the business basics of the consolidation of
investments and the execution of the consolidation of investments in the SAP
System. The process and the activities to be carried out for an example company are
illustrated with Screencams.

The CD can be ordered free of charge by customers and partners. You will
information on how to order the CD in SAPNet, note 0117253.



Consolidation (EC-CS)  SAP AG

Reclassification

318 April 2001

Reclassification
Purpose
This component provides the functionality for reclassifying the values of financial statement (FS)
items.

In the consolidation system you can use reclassifications:

•  to adjust the financial data reported by consolidation units to meet the group's requirements
(standardizing entries)

•  to reclassify already-consolidated data

Implementation Considerations
Choose this component if you want to perform reclassifications needed for consolidation using
automatic posting functions. If you do not choose this component, you must use the manual
posting functions to process reclassifications.
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Reclassification Based on Triggering Items
Use
In general, reclassifications transfer the value of a financial statement item to a second item.
Example: The value of Finished goods might be reclassified to Unfinished goods.

An additional requirement is to be able to reclassify an item's value from a second item to a third
item. Example: The value of Plant Equipment might be reclassified from Sales Revenue to Other
Capitalized Goods On Own Account.

Furthermore, the capability of reclassifying only a portion of an item's value instead of the entire
value should also be given.

Features
You make the settings for the reclassification rules shown hereafter in Customizing, at Method
Definition for reclassification.

Affected Items/Item Sets
You distinguish between:

•  the triggering item, which triggers the reclassification

•  the source item

•  the destination item

The system uses the value of the triggering item, reverses the sign of the value, and reclassifies
that amount from the source item to the destination item.

The following graphic illustrates this:

Reclassification Entry

Source Item Destination Item

500 500

Triggering Item

500

You can reclassify the value of a single item or the total value of a set of items. Whichever you
choose, however, the system always reclassifies onto a single item.

Posting to the triggering consolidation unit, partner unit or other consolidation unit
By default, the system posts the reclassification entries at the triggering consolidation unit.

When reclassifying at posting level 20, you can determine that the reclassification entries are
posted at the partner unit instead of the triggering consolidation unit. Alternatively, when
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reclassifying at posting level 30, you can determine that the reclassification entry is posted at any
other consolidation unit.

•  When you define that the source item or the destination item is posted to the partner unit, the
system assigns the triggering consolidation unit as the partner unit.

A fixed asset is sold by one consolidation unit to another consolidation unit within
a corporate group. From the group's point of view, the sales revenue of the
selling consolidation unit needs to be reclassified as Other Capitalized Goods On
Own Account.

The consolidation unit receiving the asset is the triggering unit. The
reclassification posts to the selling unit, that is, the partner unit.

See also: Example 3: Reclassification of Sales Revenue [Page 335]

•  If you want to post the reclassification entries (at posting level 30) at any consolidation unit,
you can choose any consolidation units for the triggering item as well as the source and
destination item.

Restriction of reclassifications to parent units and subsidiary units
In a reclassification with posting level 30, the system by default posts the entries for all relevant
consolidation units of the consolidation group.

However, you can define the method to also restrict the entries to parent units or subsidiary units.

See also: Reclassification with different posting levels [Page 325]

Percentage Reclassification
If you want to reclassify only a portion of an item's value, you can define a fixed percentage rate
for the reclassification.

When eliminating investment income and you want to automatically reclassify income taxes,
instead of setting a fixed percentage rate you can determine that the percentage rate be set to
the tax rate for investment income that has been defined in the master data of the triggering
consolidation unit. The tax entry is posted within a reclassification task that precedes the
elimination of investment income. A prerequisite for the percentage reclassification is that
dividend payments and the investment income tax are each posted to separate items.

You can also use the respective tax rate for investment income defined in the master
data of the consolidation unit for other reclassification entries (beyond the elimination
of investment income). In each case, the system uses the individual percentages
instead of the fixed percentage.

Partner Selection
At posting level 30 the system selects the item values regardless of the partner assignment.
However, at posting level 30 you can influence the partner selection to the extent that only those
partner units are selected, which belong to the group, or do not belong to the group.

Posting level 30 also provides the following function:  If you chose the consolidation group as the
characteristic for the triggering item, in the Settings you can influence the entries at the various
levels of the consolidation group hierarchy in the following way:  You can determine whether the
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entry is or is not posted in the group, and whether the entry is posted in the lower-level or higher-
level groups.

See also:

Reclassification with Subassignments [Page 322]

Reclassification with Different Posting Levels [Page 325]
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Reclassification with Subassignments
Use
When reclassifying item values you can use the following characteristics:

•  You can restrict the triggering item values to:

− the standard subassignments (subitem, partner unit, subitem category; and subitem,
transaction currency, acquisition year, acquisition period, unit of measure)

− custom subassignments

− attributes

− several standard characteristics, such as consolidation unit, document type and posting
level

If you do this, the system reclassifies only those item values that have been collected or
posted with these subassignments or attributes.

•  You can use all standard and custom subassignments for the source and destination
assignments.

Features
You define the reclassification rules in Customizing under the definition of reclassification
methods. There you can specify subassignments for the triggering item, the source item, and the
destination item. Plus, you can specify attributes for the triggering item.

In general, the system displays a default indicator for the source and destination
subassignments. In some cases it is selected, in other cases it is not. You should not
modify the setting of the default indicator. Then, the system posts using the logic that
results from the you other settings (for example, inheritance of a subassignment from
the triggering item).
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Inheritance of Account Assignments
Use
A reclassification can automatically pass on the financial statement items as well as
subassignments between the triggering item, the source item and the destination item.

Some possible applications are:

•  You want to reclassify the value of an FS item to a second item.

In this case, the triggering item and source item are the same. Therefore, there is no
need to specify the source item. It defaults to the triggering item.

The item Finished Goods is reclassified as Unfinished Goods. The triggering item
and source item are identical.

•  The same applies when reclassifying the values of FS item sets to a destination item. Here,
you specify the triggering item set and the destination item. The source items automatically
default to the set of triggering items, respectively.

•  You want to reclassify an item's value, delimited to a set of subitems or partner units, to a
second item, and at the same time retain these subassignments.

In this case, the subassignments of the triggering item must be passed to the source
item and the destination item when the reclassification entry is posted.

Your Finished and Unfinished Goods items are classified by enterprise areas using
subitems. During consolidation it might be necessary to reclassify the Finished
Goods as Unfinished Goods. The subassignment of the enterprise areas need to be
retained.

Features
You define automatic inheritance of items and subassignments in Customizing under the
definition of reclassification methods for the triggering item, the source item and the destination
item, and their respective subassignments.

The following chart shows in detail which defaults/transfers are supported for each of the three
items. The Customizing Settings column lists which settings can be generally made for FS items
and subassignments.

Item Inherited
From

Customizing Settings Inheritance Logic
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Triggering item Item
(or item set)

Subitem (or set)

Other characteristics (or
set)

•  Object is passed to the source item if no
setting is made

•  Object is passed to the destination item if
no setting is made

Source item FS item

Subitem

Other subassignments

Object is passed to the destination item if no
setting is made

Destination item FS item

Subitem

Other subassignments

No inheritance occurs because the destination
item is the last item in reclassification

Remarks:

•  You must always specify the triggering item.

•  In some cases, you only want to pass the subassignments from the triggering item to the
source item and destination item, without having passing the items.

In this case, you specify the triggering item (with its subassignments), the source item,
and the destination item. You do not specify any subassignments for the source item and
the destination item.

When running a reclassification triggered by the debit/credit sign (instead of a
standard reclassification), you must always specify the triggering item, the source
item and the destination item.

See also: Sign-triggered Reclassification [Page 328]



 SAP AG Consolidation (EC-CS)

Reclassifications with Different Posting Levels

April 2001 325

Reclassifications with Different Posting Levels
Use
You can use different posting levels when posting reclassifications to achieve different results:

•  Use posting level 10 for standardizing entries at the triggering consolidation unit.

See also:

Example 1: Reclassification of Finished Goods [Page 332]

Example 2: Standardization of Fixed Asset Depreciation [Page 333]

•  Use posting level 20 for consolidation entries taking the partner unit into consideration.

See also:

Example 3: Reclassification of Sales Revenue [Page 335]

Example 4: Sign-triggered Reclassification of a FS Item [Page 337]

Example 5: Netting of Receivables Against Payables [Page 339]

•  Use posting level 30 for consolidation-group-based consolidation entries

See also:

Example 6: Reclassification in Balance Sheet and Income Statement [Page 341]

Example 7: Reclassification of Retained Earnings of Subsidiaries [Page 343]

Features
You define a method and a document type for each task in Customizing in the definition of tasks
for reclassifications. A posting level is assigned to the document type.

The reclassification includes the values of all items that have been entered or posted with a
posting level less than or equal to the posting level assigned to the document type.

Reclassification logic based on posting levels

Posting
level

Values of the triggering
consolidation unit that are included
in reclassification

Reclassification posting

10 All values of the triggering item(s)
posted with posting level less than or
equal to 10.

When applicable, the values can be
delimited to subassignments, such as
subitems.

Entry is always posted at the triggering
unit

Value is broken down by subitems or
other subassignments, when applicable
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20 All values of the triggering item(s) that
are posted with

• A posting level less than or equal
to 20

• A partner unit belonging to the
selected consolidation group

When applicable, the values can be
delimited to subassignments, such as
subitems.

Entry is generally posted at the triggering
unit with a partner unit assignment.

Value is broken down by subitems or
other subassignments, when applicable

30 All values of the triggering item(s)
posted with posting level less than or
equal to 30.

When applicable, the values can be
delimited to subassignments, such as
subitems.

Entry is generally posted at the triggering
company.

Value is broken down by subitems or
other subassignments, when applicable

Keep in mind that the system posts all reclassifications at the triggering consolidation
unit unless you specify in Customizing that they are to be posted to the partner unit
or any other consolidation unit.
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Periodic Reclassifications
Use
When the triggering item is not the same as the source item, the reclassification during
subsequent consolidations keeps on using the original total value of the triggering items as the
basis.

In such cases, it is necessary to reclassify only the changes of the value of the triggering item.

Features
In Customizing in the definition of reclassification methods, you can define the reclassification as
being "periodic" in each reclassification rule.

When a reclassification is periodic, the system only includes the item values of those periods that
belong to the current range of periods in the consolidation frequency.

The following example uses consolidation frequency 2 (semi-annual statements), and you have
chosen the option Periodic Reclassification.

Reclassification

Reclassification

Source Item

Source Item

Destination Item

Destination Item

Consolidation in Period 006

Consolidation in Period 012

500

200

500

200

Triggering Item

Period 001    500
Period 007    200

Note that reclassification entries can only be posted in the last period in the range of periods
specified in the consolidation frequency. For example, when using a semi-annual frequency, you
can only post reclassifications in the periods 6 and 12.
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Sign-triggered Reclassifications
Use
An alternative to the standard reclassification logic is the debit/credit sign-triggered
reclassification. It lets you determine that a reclassification should only take place if the balance
of the triggering item (or the set of triggering items) matches the debit/credit sign you specified in
Customizing.

Some possible applications are:

•  Reclassifications when the sign of an item's value changes

You want to reclassify the value of an item to another item if the item's balance changes
to an undesired debit/credit sign.

See also: Example 4: Sign-triggered Reclassification of an Item [Page 337]

•  Reclassifications for balancing FS items

You want to state the value of two or more items or subitems as a total. The debit/credit
sign determines which item is to state the balance.

See also: Example 5: Netting of Receivables and Payables [Page 339]

Features
In Customizing in the definition of reclassification methods, you can determine for each rule
whether a reclassification should be triggered by a debit/credit sign. You specify the balance the
system checks to determine whether to post a reclassification (value balance < 0; value balance
> or = 0; value balance > 0).

A reclassification then takes place if the balance of the triggering item (or the set of triggering
items) meets the condition you specified.

This type of reclassification reclassifies the value of the source item – as opposed to the standard
reclassification logic, which reclassifies the value of the triggering item (or item set). In other
words, the reclassification "clears" the source item.

The following example illustrates this:
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Reclassification

Bal: 200-

Triggering
Item Set

No
Reclassification

Source Item

Reclassification if sign is "+"
(balance > 0)

Reclassification if sign is "-"
(balance < 0)

Source Item

Item 1

Dest. Item

Dest. Item

Item 2

Rule 2

Rule 1

100100

100

100

300

300

300

100

Sign-triggered reclassification also allows you to restrict the reclassification entries to any
characteristics per financial statement item. Any characteristics can be used to build the balance.

For example, with posting level 30 you can specify whether the balance is to apply per
consolidation unit. If you do not specify a consolidation unit, the system builds a balance for each
consolidation group.

See also: Reclassification with Subassignments [Page 322]
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Repetition of a Reclassification
Use
If you run a reclassification and, afterwards, need to modify the initial data, you need to rerun the
reclassification.

Features
In general, the reclassification can be repeated without causing any problems. Before re-posting
the reclassification entries, the system deletes all of the previously–created journal entry
documents and totals records that pertain to the selected consolidation units and period. Then
the system reposts the reclassification entries.

Constraints
If you run two reclassification tasks, each of which uses a different document type, and both of
which use the same items (or at least partially), the repetition of the first task can lead to incorrect
results.

First, you run reclassification task 1 at consolidation unit A, then you run
reclassification task 2. Different document types are assigned to the tasks. FS item
1234 is the triggering item for both tasks.

Afterwards, you repeat task 1. The system deletes the documents and totals records
initially created during task 1 and reposts the reclassification entries. Because the
documents and totals records created by task 2 still exist, the system finds the value
of item 1234 which was modified by task 2, and reclassifies the wrong value.
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Running of Reclassifications
Purpose
You perform this process if you want to reclassify the reported financial data or the consolidated
data of one or more consolidation units.

Prerequisites
You might need to perform reclassification tasks at various intervals of the consolidation process:

•  After the collection of the reported financial data – in order to standardize the data to meet
standards required for the corporate group

•  After currency translation of the reported financial data – in order to standardize the data
translated into the group's currency to meet standards required for the corporate group

•  After currency translation and the standardization of the reported financial data – as one of
the tasks belonging to the consolidation process itself

•  After performing all of the remaining consolidation tasks – to prepare the consolidated data
for the creation of group statements.

Process Flow
1. You customize your reclassifications.

2. You run the reclassification either in the data monitor or the consolidation monitor, depending
on the type of reclassification task.

See also the examples of how the reclassification process is used.

Result
For documentation purposes, the system displays an audit trail upon completion of the
reclassification. The system displays the audit trails for runs in test mode as well as update
mode.

After running the reclassification, you can perform the following consolidation tasks, based on the
reclassified data.
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Example 1: Reclassification of Finished Goods
Purpose
From the corporate group's point of view, it might be necessary to reclassify Finished Goods as
Unfinished Goods.

The reclassification is posted as a standardizing entry with posting level 10.

Example data

FS item Value

10410300  Finished Goods 400

Prerequisites
You run the reclassification after the reported financial data has been translated. An alternative is
to reclassify in local currency.

Process Flow
1. You customize your reclassifications. You create the following reclassification rules:

Reclassification Rule

FS item Entered Value

Triggering item 10410300  Finished Goods

Source item (blank)

Destination item 10410200  Unfinished Goods

2. You run the reclassification in the data monitor.

The system posts as follows:

FS item Value

10410300 400-

10410200 400

Result
Finished Goods is now reclassified.
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Example 2: Standardization of Fixed Asset Depreciation
Purpose
The corporate group might require a different method for depreciating fixed assets from those
used for the financial statements of the individual consolidation units.

If you use Asset Accounting (FI-AA), you can manage the different valuations simultaneously in
different depreciation areas:

•  The book depreciation area manages values that are valid for the consolidation unit. These
values are posted to the accounts allocated to the items Plant and Equipment and
Depreciation.

•  The group depreciation area manages values that are valid for the corporate group. These
values are posted to accounts allocated to statistical FS items.

In the Consolidation system, you can use reclassifications to adjust the values of the Plant and
Equipment items to match the group values. The reclassification entry uses posting level 10.

Example data

FS item Subitem Value Depreciation area

10320200 Plant and Equipment 220  Depreciation 200- Book depreciation

30710100  Depreciation            - 200 Book depreciation

91032020 Statistical Item for Fixed Assets 220  Depreciation 300- Group depreciation

93071010 Statistical Item for Depreciation            - 300 Group depreciation

Prerequisites
After the reported financial data is translated into group currency, you can standardize the
depreciation. An alternative is to standardize in local currency.

Process Flow
1. You customize your reclassifications. You create the following reclassification rules:

Table: Reclassification Rule 1

FS item/Transaction type Entered Value

Triggering item 10320200  Plant and Equipment

Triggering transaction type 220  Depreciation

Source item 10320200  Plant and Equipment

Destination item 30710100  Depreciation
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Table: Reclassification Rule 2

FS item/Transaction type Entered Value

Triggering item 9111111  Statistical item

Triggering transaction type 220  Depreciation

Source item 30710100  Depreciation

Destination item 10320200  Plant and Equipment

2. You perform the reclassifications in the data monitor.

The system posts as follows:

− Reclassification rule 1 posts the depreciation of 200 currency units against the item
Plant and Equipment and the expense item Depreciation.

FS item Transaction type Value

10320200 220 200

30710100   - 200-

− Reclassification rule 2 posts the depreciation of 300 currency units against the same
items.

FS item Transaction type Value

30710100   - 300

10320200 220 300-

Result
After the reclassification, the values of the items Plant and Equipment and Depreciation are
adjusted from 200 to 300 currency units.
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Example 3: Reclassification of Sales Revenue
Purpose
From the corporate group point of view, sales revenue gained from partner units must be
reclassified as Other Capitalized Goods on Own Account (when using the period accounting
method).

This process does not eliminate interunit profit and loss. In a sense, this type of
reclassification represents a simplified form of elimination of interunit profit and loss
in transferred assets.

The reclassification entry uses posting level 20.

Example data

Cons unit FS item Subitem Partner unit Value
A 10320200

Plant and Equipment
125 (Acquisitions) B 100

B 30100100  Sales Revenue - A 100-

Prerequisites
After the data is translated and standardized, you run the reclassification in the consolidation
monitor.

Process Flow
1. You customize your reclassifications. You create the following reclassification rules:

Table: Reclassification Rule

FS item/Subitem/Partner unit Entered Value
Triggering item 10320200  Plant and Equipment
Triggering subitem 125 (Acquisitions)
Triggering partner unit A partner set including partner unit B
Source item 30300000 Other Capitalized Goods on Own Account
Destination item 30100100  Sales Revenue
In the rule you also specify that entries are to be posted at the partner unit.

In this reclassification, the order of the source item and destination item is reversed
in regards to normal accounting logic. This is necessary because the debit/credit
signs of the triggering item and the source item differ.

2. You run the reclassification in the consolidation monitor.

The system posts as follows:
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Cons unit FS item Subitem Partner unit Value
B 30300000 - A 100-
B 30100100 - A 100

Result
After the reclassification, Sales Revenue is reclassified as Other Capitalized Goods on Own
Account.
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Example 4: Sign-triggered Reclassification of a FS Item
Purpose
Assume that you set up the Customizing of interunit elimination to post elimination differences to
Miscellaneous Expenses, in debit entries as well as credit entries. This lets you state the net total
of the differences.

Just in case the item's balance has a negative balance after the interunit eliminations, you set up
a reclassification triggered by the debit/credit sign, which reclassifies the balance as
Miscellaneous Revenue.

The reclassification entry uses posting level 20.

Example data

FS item Partner Unit Value
30800000  Miscellaneous Expense (any unit within the consolidation group) 100-

Prerequisites
You start this reclassification after interunit eliminations.

Process Flow
1. You customize your reclassifications. You create the following reclassification rules:

Table: Reclassification Rule

FS item Entered Value
Triggering item 30800000  Miscellaneous Expense
Source item 30800000  Miscellaneous Expense
Destination item 30400000  Miscellaneous Revenue
Sign of the net balance -

2. You run the reclassification in the consolidation monitor.

The system posts as follows:

Cons unit FS item Partner unit Value
(any selected unit) 30800000 (any selected unit) 100
(any selected unit) 30400000 (any selected unit) 100-

Result
After the reclassification, the value of Miscellaneous Expense is reclassified as Miscellaneous
Revenue.
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Example 5: Netting of Receivables Against Payables
Purpose
One part of consolidation is interunit elimination, which eliminates receivables and payables
incurred by business transactions that take place within the boundaries of a corporate group.
However, in some instances, your consolidated group may also include trading partners (defined
as partner units), which are not consolidated within your particular consolidation group. This
could be part of a step consolidation scenario, in which your consolidation group is submitted to a
higher-level consolidation group that, in turn, includes the trading partners concerned.

Such business relationships might require that you net your receivables against the payables,
from and to each trading partner – thus, stating a net balance for each trading partner.

The reclassification entry uses posting level 20.

Example data

Cons unit FS item Partner unit Value
A 10420200  Receivables B 300
A 10420200  Receivables C 400
A 20460000  Payables B 200-
A 20460000  Payables C 600-

Prerequisites
You run the reclassification in combination with interunit eliminations.

Process Flow
1. You customize your reclassifications. You define two reclassification rules. You need one

rule for each sign of the net balance.

Table: Reclassification Rule 1

FS item/Partner unit Entered Value
Triggering item set 10420200  Receivables

20460000  Payables
Source item 10420200  Receivables
Destination item 20460000  Payables
Sign of the net balance -

Table: Reclassification Rule 2

FS item/Partner unit Entered Value
Triggering item set 10420200  Receivables

20460000  Payables
Source item 20460000  Payables
Destination item 10420200  Receivables
Sign of the net balance +
In both rules you specify that the net balance is to be computed per partner unit.

2. You run the reclassification in the consolidation monitor.
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The system posts as follows:

Cons unit FS item Partner unit Value
A 10420200 C 400-
A 20460000 C 400
A 20460000 B 200
A 10420200 B 200-

Result
The reclassification results in a net receivable of 100 currency units from partner unit B, and a net
payable of 200 currency units to partner unit C.



 SAP AG Consolidation (EC-CS)

Example 6: Reclassification in Balance Sheet & Income Statement

April 2001 341

Example 6: Reclassification in Balance Sheet & Income
Statement
Purpose
When dealing with provisions, you might be required to net the additions to provisions against the
reversals. This must also take into consideration the subitems of the provisions balance sheet
item as well as the related revenue and expense items in the income statement.

The reclassification entry uses posting level 30.

Example data

FS item Subitem Value
20310000 Provisions 520  (Additions) 300-
20310000 Provisions 560  (Reversals) 200
30800100 Expense for Additions 300
30400100 Revenue from Reversals 200-

Prerequisites
You run the reclassification after all other consolidation tasks are completed.

Process Flow
1. You customize your reclassifications. You define four reclassification rules.

– Rules 1 and 2 net the subitems of the provisions balance sheet item. You need one rule
for each sign of the net balance.

– Rules 3 and 4 net the revenue and expense items. You need one rule for each sign of
the net balance.

Table: Reclassification Rule 1

Item/ Subitem Entered Value
Triggering item 20310000 Provisions
Triggering subitem set 520  (Additions)

560  (Reversals)
Source item 20310000 Provisions
Source subitem 520  (Additions)
Destination item 20310000 Provisions
Destination subitem 560  (Reversals)
Sign of the net balance +

Table: Reclassification Rule 2

Item/ Subitem Entered Value
Triggering item 20310000 Provisions
Triggering subitem set 520  (Additions)

560  (Reversals)
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Source item 20310000 Provisions
Source subitem 560  (Reversals)
Destination item 20310000 Provisions
Destination subitem 520  (Additions)
Sign of the net balance -

Table: Reclassification Rule 3

Item/ Subitem Entered Value
Triggering item 20310000 Provisions
Triggering subitem set 520  (Additions)

560  (Reversals)
Source item 30800100  Expense for Additions
Destination item 30400100  Revenue from Reversals
Sign of the net balance +

Table: Reclassification Rule 4

Item/ Subitem Entered Value
Triggering item 20310000 Provisions
Triggering subitem set 520  (Additions)

560  (Reversals)
Source item 30400100  Revenue from Reversals
Destination item 30800100  Expense for Additions
Sign of the net balance -

2. You run the reclassification in the consolidation monitor.

The system posts as follows:

FS item Subitem Value
20310000 560 200-
20310000 520 200
30400100 200
30800100 200-

Result
After the reclassification, the balance sheet and the income statement both state the net balance
of the additions and reversals of the provisions.
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Example 7: Reclassification of Retained Earnings of
Subsidiaries
Purpose
Frequently, consolidated financial statements of a corporate group need to state the retained
earnings of the parent unit within the group. You can use reclassifications to reclassify the
retained earnings of subsidiaries as appropriations.

The reclassification entry uses posting level 30.

Prerequisites
You reclassify retained earnings after all other consolidation tasks are completed.

Process Flow
1. You customize your reclassifications. You define one of the following reclassification rules

depending on where you state retained earnings:

Reclassification rule if retained earnings are stated
after the income statement

FS item Entered Value

Triggering item 20140000  Retained Earnings

Source item 70800000  Transfers to Appropriations

Destination item 20130000 Appropriations

Reclassification rule if retained earnings are stated
in the balance sheet

FS item Entered Value

Triggering item set 20140000 - 20149990
Annual Net Income + Retained
Earnings

Source item 85600000  Transfers to Appropriations

Destination item 20130000 Appropriations

2. You run the reclassification in the consolidation monitor. Choose Only Subsidiaries in the
selection screen.

Result
After the reclassification, the retained earnings of the group only include the retained earnings of
the parent unit.
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Note the following:

•  The retained earnings of the parent may include standardizing and consolidation entries. If
so, the retained earnings will deviate from the parent's original retained earnings in the
reported financial data.

•  If you state minority interest in retained earnings separately, you must likewise reclassify this
as minority interest in appropriations.
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Running a Reclassification
Procedure
1. In the Consolidation menu, choose

Data → Monitor or

Consolidation tasks → Monitor.

2. Check the global parameters by choosing Environment → Global parameters.

3. Place the cursor on the appropriate organizational unit and your task for reclassification, and
choose Update run.

4. An audit trail of the reclassification is displayed.
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Proportional Consolidation
Purpose
This component enables you to include consolidation units proportionally in the consolidated
financial statements, based on statutory requirements or based on the management perspective.

Proportional consolidation includes the items of the balance sheet and income statement into the
consolidated statements according to the upper unit’s percentage of ownership in the investee
unit, rather than at the full amount (as in the purchase method).

Implementation Considerations
You implement this component...

•  as part of company consolidation when you are required to proportionally consolidate a joint
venture company (rather than using the equity method) due to statutory requirements.
A typical joint venture company is owned by two parent companies at 50% each.

•  as part of business area consolidation or profit center consolidation when you do not want to
consolidate the unit using the equity method.

Integration
You utilize proportional consolidation as part of the SAP component Consolidation.

Proportional consolidation utilizes the rounding logic in Currency Translation [Page 232].

Features
You record the reported financial data and standardizing entries in full amounts. The
proportionally consolidated units are specially treated in all consolidation functions. The system
generates separate apportionment data records for the reported financial data and the
standardizing entries, as well as for all consolidation functions.

•  A dedicated task is available for the apportionment of the reported financial data and
standardizing entries (also after currency translation, if necessary). You can assign this task
in the data monitor.

•  Proportionally consolidated units also require special treatment for the following tasks:

− Interunit Elimination

− Elimination of Interunit Profit/Loss in Transferred Inventory

− Consolidation of Investments

− Preparation of Consolidation Group Change

− Data Selection in Validation and Reports

Here, the apportionment is automatic in the respective consolidation function.

The proportion of consolidation is independent of the consolidation group, which means that the
consolidation unit has the same proportion in each consolidation group, to which it belongs.
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The use of proportional consolidation as part of the consolidation of investments is
not discussed in this section. See the corresponding note [Page 317].

Constraints
Only one proportion change is possible per consolidation period. However, you can specify
whether the proportion change becomes effective at the beginning or at the end of the period.

Reclassifications do not perform apportionments.
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Execution of Proportional Consolidation
Purpose
You perform this process if you want to proportionally consolidate one or more consolidation
units.

Prerequisites
The following prerequisites must be given before beginning proportional consolidation:

•  You have collected the reported financial data (with full amounts, not proportional).

•  You have posted standardizing entries, where applicable.

•  You have performed currency translation, where applicable.

Process Flow
A. Customizing
You execute the following steps in Customizing for Consolidation:

1. You specify that proportional consolidation is to be used as the accounting technique: Go to
Consolidation Functions → Automatic Posting → Consolidation of Investments → Determine
System Utilization for C/I

This must be done, even if this is the only accounting technique used in
consolidation of investments.

2. You define one or more methods for proportional consolidation in step Consolidation of
Investments → Methods → Define Methods.

This must be done, even if this is the only accounting technique used in
consolidation of investments.

3. In step Consolidation of Investments → Methods → Assign Methods to the Consolidation
Units you assign a method with accounting technique proportional (proportional
consolidation) to all consolidation units that are to be proportionally consolidated.

Also enter the proportion (any percentage rate between zero and 100).

The same inheritance rules apply in the consolidation group hierarchy as for the method
itself.

If you change the proportion in a period subsequent to that of first consolidation, you
can assign this proportion change to an activity of that period.

Only one proportion change is possible per consolidation period.
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4. In step Data → Automatic Posting → Apportionment: Define Task you create the task
Apportionment and assign task category Apportionment.

5. In step Data → Data Monitor → Define Task Group you assign the task Apportionment to a
task group for the data monitor.

6. If you use consolidation of investments, you may have to enter selected items for minority
interest; and you may need to specify the ANI Prior to Proportion Change item under Specify
Miscellaneous Selected Items.

7. Proportional consolidation uses the rounding logic of the currency translation function.
Therefore, you must assign a currency translation method, which contains rounding rules, to
the consolidation units to be proportionally consolidated.

This must also be done if the consolidation unit does not require currency translation
(because the local currency and group currency are the same) and you only want to use
the rounding function.

8. When in the process of interunit elimination a proportionally consolidated unit is eliminated
against a fully consolidated unit (purchase method), then a portion of the eliminated amount
(that is, the amount of the third-party share in the proportionally consolidated unit) must be
reclassified from the fully consolidated unit to a separate financial statement item (third
parties).

You define these reclassifications for each item to be eliminated in step Interunit
elimination → Define Methods.

9. When in the process of interunit elimination two proportionally consolidated units are
eliminated against each other, you can choose between Minimum Apportionment and
Product Apportionment [Page 361] procedures for determining the share to be eliminated.
You make this setting in step Master Data → Define Dimensions.

B. Tasks in the Data Monitor
After you have recorded the reported financial data with their full amounts, and you have posted
standardizing entries and performed currency translation (if applicable), you execute the Task for
Apportioning Reported Data and Standardizing Entries [Page 351] .

C. Tasks in the Consolidation Monitor and Further Consolidation Functions
In the consolidation monitor you execute the following tasks relevant to proportional
consolidation:

•  Interunit Elimination including

− Elimination of IU Payables and Receivables [Page 356]

− Elimination of IU Revenue and Expense [Page 356]

− Elimination of IU Investment Income [Page 359]

•  Elimination of IU Profit/Loss in Inventory [Page 363]

•  Consolidation of Investments

Result
The system carries out all consolidation tasks while taking into account the proportion records of
the proportionally consolidated units.
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Example
Here is a typical sequence of consolidation tasks:

Task Posting Level
[Page 205]

Apportionme
nt Indicator

1. Data Collection Space, 00, 01 0

2. (Currency Translation, if applicable) Space, 00, 01 0

3. Apportionment of Reported Financial Data 00 1

4. (Preparation for Consolidation Group Change, if
applicable)

02 0

5. Standardization of Financial Data 10 0

6. (Currency Translation, if applicable) 10 0

7. Apportionment of Standardized Financial Data 00 1

8. (Preparation for Consolidation Group Change, if
applicable)

12 0

9. Two-Sided Elimination Entries 20, 21 0

Apportionment for Two-sided Elimination Entries 20 1

10. Two-Sided Elimination Entries with Special Logic 23 0

Apportionment for Two-sided Elimination Entries
with Special Logic

23 1

11. (Preparation for Consolidation Group Change, if
applicable)

22, 24 0

12. Consolidation of Investments 30 0

Apportionment for Consolidation of Investments 30 1

If you want to execute the tasks...

•  Currency Translation

•  Standardizing Entries, and

•  Preparation for Consolidation Group Change

you need to execute the apportionment between the tasks standardizing entries and
preparation for consolidation group change.
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Apportionment of Reported Data and Standardizing
Entries
Use
You use this function to valuate the reported financial data and standardizing entries using the
proportion of a proportionally consolidated unit. The apportioned (proportionate) values are
written to the totals database and are then available to other consolidation functions.

Prerequisites
You made the following settings in Customizing:

•  You selected the accounting technique proportional consolidation.

•  You assigned a method with accounting technique proportional consolidation to all
proportionally consolidated units.

•  You created the task Apportionment and assigned it to a task group in the consolidation
monitor.

You executed the task for the collection of reported financial data in the data monitor. If
applicable, you also executed the tasks for standardizing the financial data and for currency
translation.

Features
The system apportions the reported financial data, which you recorded at their full amounts. In
order to be able to display the unapportioned values after the apportionment, the system retains
the original values and creates separate data records (proportion records), which are used to
clear the non-apportioned portions of the original records. The focus of the apportionment is the
investment proportion, which is specified in Customizing under Consolidation of Investments →
Methods → Assign Methods to the Consolidation Units.

The system calculates the proportion records as follows:

proportion value = reported value x proportion – reported value

proportion value = reported value x (proportion – 1)

Activities
You execute the apportionment task in the data monitor.

See also: Executing Tasks in the Data Monitor [Page 31]

Example
Say, the consolidation group owns 75% of a proportionally consolidated unit.

The table below shows which proportion records are generated from the reported financial data,
and how the apportioned values are stored in the totals database.

Item Description Reported
Data
(PL 00)

Proportions
for reported
data

Values in
Totals
Database
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191100 Land & Buildings 1200 1200
*(0.75-1)

=-300

900

191500 Machinery and Equipment 2000 -500 1500

135100 Raw Materials and Operating Supplies 1600 -400 1200

120100 Accounts Receivable 2000 -500 1500

110100 Cash 600 -150 450

250100 Common Stock -1200 300 -900

250500 Additional Paid-In Capital -200 50 -150

251100 Retained  Earnings – Prior Years -200 50 -150

251200 Retained  Earnings – Current Year -200 50 -150

201100 Accounts Payable -4000 1000 -3000

201200 Other Liabilities -1600 400 -1200

301100 Sales Revenue -1700 425 -1275

310100 Cost of Materials 1000 -250 750

320900 Other Expenditures 500 -125 375
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Proportion Change
Use
You use this function to record a change in the proportion of the investment (proportion increase
or decrease).

Features
You can specify whether the proportion change is carried out at the beginning or the end of the
period. Only one proportion change is possible per consolidation period.

The proportion change function treats balance sheet items and income statement items
differently:

•  Balance sheet items: The year-to-date values are valued with the new proportion.

•  Income statement items:

− The prior period values remain unchanged.

− A proportion change

•  at the beginning of the period valuates the current period values with the new
proportion

•  at the end of the period valuates the current period values with the old proportion

The clearing entry for the proportion change posts to item Annual Net Income Prior to Proportion
Change or item Clearing for Consolidation of Investments.

The system performs the following when converting the subitems:

•  If the proportion change takes place at the beginning of the period, the year-to-date value of
the prior period is revalued by the proportion change.

•  If the proportion change takes place at the end of the period, the year-to-date value of the
current period is revalued by the proportion change.

The apportionment of the prior period values differs for proportion increases and decreases:

•  Proportion increases post the adjustment to balance sheet items while converting the
subitems to Additions to Consolidation Group. Furthermore, the system posts to the item
Annual Net Income Prior to Proportion Change, instead of the Annual Net Income item.

•  Proportion decreases post the adjustment to balance sheet items while converting the
subitems to Divestitures from Consolidation Group. Here, the system posts to the item
Clearing for Consolidation of Investments, instead of the Annual Net Income item.

Activities
You specify the new proportion for consolidation of investments in Customizing under step
Assign Methods to Consolidation Units. You also specify whether the proportion change takes
effect at the beginning or at the end of the period.
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Example
Example: Proportion Increase
Say, the proportion of a consolidation unit in period 001 is 75%. This is increased at the
beginning of period 002 to 80%.

P=001 P=002

Item SI Reported
Data

Proportions for
reported data

Reported
Data

Proportion
s for
reported
data

Total

L=00;
A=0

L=00;
A=1

L=00;
A=0

L=00;
A=1

M&E Open.Ba
l.

100 -25 75

M&E Additions 50 -10 40

M&E Add. CG 5 5

Ret.Earn.
(B/S)

Additions -100 25 -50 10 -115

ANI Prior
Prop.Chg
.

Add. CG -5 -5

Gain -100 25 -50 10 -115

ANI (I/S) 100 -25 50 -10 115

Abbreviations:

•  P = period

•  SI = subitem

•  L = posting level

•  A = apportionment indicator (0 = no apportionment; 1 = with apportionment)

•  M&E = machinery and equipment

•  ANI = annual net income

•  Prop.Chg. = proportion change

•  Add. CG = additions to consolidation group

•  Div. CG = divestitures from consolidation group

Example: Proportion Decrease
Say, the proportion of a consolidation unit in period 001 is 75%. This is decreased at the
beginning of period 002 to 70%.

P=001 P=002
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Item SI Reported
Data

Proportions for
reported data

Reported
Data

Proportion
s for
reported
data

Total

L=00;
A=0

L=00;
A=1

L=00;
A=0

L=00;
A=1

M&E Open.Ba
l.

100 -25 75

M&E Additions 50 -15 35

M&E Div. CG -5 -5

Ret.Earn.
(B/S)

Additions -100 25 -50 15 -110

Clear  C/I Div. CG 5 5

Gain -100 25 -50 15 -110

ANI (I/S) 100 -25 50 -15 110
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Apportionment with Elim. of IU Payables/Recv. and
Rev./Exp.
Use
You use this function to carry out the elimination of interunit payables/receivables and
revenue/expense for proportionally consolidated units.

Integration
You utilize the functions for interunit elimination.

See also:

•  Interunit Elimination [Page 270]

•  Two-sided Elimination Entries [Page 272]

Prerequisites
You have customized the settings for the apportionment.

You have completed the tasks in the data monitor.

Features
The system uses the same procedure for posting the apportionment for all two-sided elimination
entries, including the elimination if IU payables/receivables and revenue/expense.

Procedure with a single proportionally consolidated unit
If only one of the two consolidation units is proportionally consolidated, the system eliminates
payables and receivables (or revenue and expenses) at the non-proportionally consolidated unit
against the trading partner in accordance with the proportion. The system reclassifies the
remaining amount (that is, the difference between 100% and the proportion percentage) of the
payables/receivables (or revenue/expense) to the corresponding items “... to/from Third Parties”
(for example, Receivables from Third-Parties).

Procedure with two proportionally consolidated units
If both consolidation units are proportionally consolidated, say at the percentage rates of p1 and
p2, and p2 is less than p1, then the system eliminates the proportion of p2 at the unit with rate p1,
and reclassifies the remaining proportion (p1 - p2) to “third parties”.

The procedure for two proportionally consolidated units, which is described here, is
called the Minimum Procedure.

See also: Apportionment Procedures for All Two-sided Eliminations [Page 361]
(minimum procedure and product procedure)

Activities
Execute the task for interunit eliminations in the consolidation monitor.
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See also: Consolidation Monitor [Page 32]

Example
Say, unit A is consolidated with the purchase method, and unit B is proportionally consolidated
with proportion rate of 40%.

Example: Elimination of IU payables/receivables without a difference

CU PU Item Reported
Data

Proportions
for reported
data

Two-sided
Elimination

Proportions
for elimination

Total

L=00;
A=0

L=00;
A=1

L=20;
A=0

L=20;
A=1

A B Rec/Pay 100 -100 0

B A Pay-TP -100 -100*(0.4-1)
=60

100 100*(0.4-1)
=-60

0

A B Rec-3rdP 100*(1-0.4)
=60

60

Abbreviations:

•  CU = consolidation unit

•  PU = partner unit

•  L = posting level

•  A = apportionment indicator (0 = no apportionment; 1 = with apportionment)

•  Rec-3rdP = receivables from third parties

•  Rec-TP = receivables from trading partners

•  Pay-3rdP = payables to third parties

•  Pay-TP = payables to trading partners

•  D = difference

Example: Elimination of IU payables/receivables with a difference

CU PU Item Reported
Data

Proportions
for reported
data

Two-sided
Elimination

Proportions
for elimination

Total

L=00;
A=0

L=00;
A=1

L=20;
A=0

L=20;
A=1

A B Rec/Pay 90 -90 0

B A Pay-TP -100 -100*(0.4-1)
=60

100 100*(0.4-1)
=-60

0

B A D -10 -10*(0.4-1)
=6

-4
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CU PU Item Reported
Data

Proportions
for reported
data

Two-sided
Elimination

Proportions
for elimination

Total

L=00;
A=0

L=00;
A=1

L=20;
A=0

L=20;
A=1

A B Rec-3rdP 90*(1-0.4)
=54

54
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Apportionment for the Elimination of Investment Income
Use
You use this function to carry out the elimination of investment income for proportionally
consolidated units.

Integration
You utilize the functions for interunit elimination.

See also:

•  Interunit Elimination [Page 270]

•  Two-sided Elimination Entries [Page 272]

The elimination of investment income is impacted by the apportionment function as well as the
Consolidation of Investments component.

Prerequisites
You have customized the settings for the apportionment.

You have completed the tasks in the data monitor.

Features
The apportionment for the elimination of investment income works the same way as for the
elimination of IU payables/receivables and revenue/expense [Page 356].

Example
Say, the consolidation group owns 75% of consolidation unit A. Unit A owns 80% of unit B.  Unit
B pays dividends of 100, 80 of which is paid to unit A.

In this example, the consolidation of investments activity subsequent consolidation is formally
split into two parts (30/1 and 30/2)

•  The first part represents the purchase method logic of subsequent consolidation when
dividends are distributed.

•  The second part represents the proportional consolidation logic for the distribution of
dividends.

CU Item Reporte
d Data

Proporti
ons for
reporte
d data

Two-
sided
Eliminat
ion

Proporti
ons for
eliminat
ion

C/I Subsequent
Cons.

Total

L=00;
A=0

L=00;
A=1

L=20;
A=0

L=20;
A=1

L= 30/1 L= 30/2

A Clr Divd -80 16 20 -16 -60

A MI–Clr
Divd

-20 16 -4
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CU Item Reporte
d Data

Proporti
ons for
reporte
d data

Two-
sided
Eliminat
ion

Proporti
ons for
eliminat
ion

C/I Subsequent
Cons.

Total

L=00;
A=0

L=00;
A=1

L=20;
A=0

L=20;
A=1

L= 30/1 L= 30/2

A Ret.Earn
.(B/S)

-80 80 -16 16 0

A MI–
Ret.Earn
.(B/S)

-16 -16

A Divd Inc. -80 80 0

A Invt Inc.–
3rdP

-16 -16

A MI–ANI
(I/S)

16 16

A ANI (I/S) 80 -80 16 -16 0

B Divd
Distr.

100 -20 -80 16 -20 4 0

B MI–Divd
Distr.

20 -4 16

B Clr Divd 80 -16 -20 16 60

B MI–Clr
Divd

20 -16 4

Abbreviations:

•  CU = consolidation unit

•  L = posting level

•  A = apportionment indicator (0 = no apportionment; 1 = with apportionment)

•  MI = minority interest

•  Clr Divd = clearing item for dividend payments

•  ANI = annual net income

•  Divd Inc. = dividend income (received)

•  Invt Inc.–3rdP = investment income from third parties

•  Divd Distr. = dividend distributions
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Apportionment Procedures for All Two-sided
Eliminations
Use
You use this function to eliminate the two-sided relationships between two proportionally
consolidated units. You can choose between the Minimum Procedure and the Product
Procedure.

Features
Minimum Procedure
This type of apportionment carries out a complete elimination at the proportionally consolidated
unit with the smaller proportion. At the proportionally consolidated unit with the larger proportion,
the system posts to a “... to/from Third Parties” item (for example, Receivables from Third
Parties).

Product Procedure
This type of apportionment carries out an elimination at both proportionally consolidated units
using the (mathematical) product of the two proportions. The system clears the difference of the
product to a “... to/from Third Parties” item (for example, to the item Receivables from Third-
Parties at the one consolidation unit and to the item Payables to Third Parties at the other
consolidation unit).

Activities
1. In Customizing of Consolidation, choose Master Data → Dimensions.

2. Choose the desired apportionment procedure.

Example
Example: Minimum Procedure
See the following examples of minimum apportionment:

•  Apportionment with the Elimination of IU Payables/Receivables and Revenue/Expense [Page
356]

•  Apportionment with the Elimination of IU Profit/Loss in Transferred Inventory [Page 363]

Example: Product Procedure
Interunit payables/receivables are to be eliminated between consolidation units A and B. The
consolidation group includes consolidation unit A at the proportion of ½ (one half), and
consolidation unit B at 1/3 (one third).

CU PU Item Reported
Data

Proportions
for reported
data

Two-sided
Elimination

Proportions
for elimination

Total

L=00;
A=0

L=00;
A=1

L=20;
A=0

L=20;
A=1
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CU PU Item Reported
Data

Proportions
for reported
data

Two-sided
Elimination

Proportions
for elimination

Total

L=00;
A=0

L=00;
A=1

L=20;
A=0

L=20;
A=1

A B Rec/Pay 90 90*(1/2-1)
=-45

-90 90*(1-1/2)
=45

0

B A Pay-TP -120 -120*(1/3-1)
=80

120 -120*(1-1/3)
=-80

0

B A D 90+(-120)
=-30

-30
*(1/2*1/3-1)

=25

-5

A B Rec-3rdP 90*1/2
*(1-1/3)

=30

30

B A Pay-3rdP -120*1/3
*(1-1/2)

=-20

-20

Abbreviations:

•  CU = consolidation unit

•  PU = partner unit

•  L = posting level

•  A = apportionment indicator (0 = no apportionment; 1 = with apportionment)

•  Rec-3rdP = receivables from third parties

•  Rec-TP = receivables from trading partners

•  Pay-3rdP = payables to third parties

•  Pay-TP = payables to trading partners

•  D = difference
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Apportionment with Elimination of IU Profit/Loss in
Inventory
Use
You use this function to correctly eliminate the interunit profit and loss of a proportionally
consolidated unit (that is, according to its proportion).

Integration
You use the function Elimination of IU Profit/Loss in Transferred Inventory [Page 291] .

Features
One proportionally consolidated unit:
If the inventory-managing or supplying consolidation unit is proportionally consolidated, the
system does not clear the entire interunit profit/loss from the inventory item. Instead, the IU
profit/loss is multiplied by the proportion.

Two proportionally consolidated units:
If both the inventory-managing unit and the supplying unit are proportionally consolidated, the
system multiplies the interunit profit/loss either by the product of both proportions (product
procedure) or by the smaller of the two proportions (minimum procedure).

See also:

Apportionment Procedures for All Two-sided Eliminations [Page 361] (product procedure and
minimum procedure)

Example
Example: Elimination of IU Profit/Loss with the Minimum Procedure
Consolidation unit B supplies raw materials to A for a value of 120; production costs were 100.
Interunit profit amounted to 30.

A has a proportion of 60%. B has a proportion of 50%. The minimum proportion is 50% (see
emphasized proportion in the table).

CU PU Item Reported
Data

Proportions
for reported
data

Two-sided
Elimination

Proportions
for elimination

Total

L=00;
A=0

L=00;
A=1

L=20;
A=0

L=20;
A=1

A B RMOS 120 120*(0.6-1)
=-48

-30 -30*(0.5-1)
=15

57

B Expense -100 -100*(0.5-1)
=50

30 30*(0.5-1)
=-15

-35

Abbreviations:

•  CU = consolidation unit



Consolidation (EC-CS)  SAP AG

Apportionment with Elimination of IU Profit/Loss in Inventory

364 April 2001

•  PU = partner unit

•  L = posting level

•  A = apportionment indicator (0 = no apportionment; 1 = with apportionment)

•  RMOS = raw materials and operating supplies

Example: Elimination of IU Profit/Loss with the Product Procedure
The initial data is the same as in the previous example. In this case, the product proportion is
30%.

CU PU Item Reported
Data

Proportions
for reported
data

Two-sided
Elimination

Proportions
for elimination

Total

L=00;
A=0

L=00;
A=1

L=20;
A=0

L=20;
A=1

A B RMOS 120 120*(0.6-1)
=-48

-30 -30
*(0.6*0.5-1)

=21

63

B Expense -100 -100*(0.5-1)
=50

30 30
*(0.6*0.5-1)

=-21

-41
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Information System
Purpose
After you have completed your consolidation tasks, you may want create reports in order to
evaluate data. This component comprises the various reporting functions. SAP supplies many
standard reports that you can use, however, you can also create reports to meet you own
individual requirements.

Features
• Master data, reported financial data, and control parameters form the basis of consolidation.

You can use reports predefined by SAP to evaluate this data.

• If you want to evaluate the changes to financial data as a result of consolidation entries, you
can create journal entry reports [Page 414].

• You can use Report Writer or Report Painter [Page 367] reports and Drilldown Reporting
[Page 376] to evaluate consolidated data in reports using different criteria, for example:

− Reports for consolidation units

− Period and fiscal year comparisons

− Listing of data by posting level, subitem, and so on

You can also create detailed reports for the notes to your consolidated financial
statements or for internal information, for example, an asset history sheet, a
sales-by-region report, and so on.

• To analyze data stored in the database, you can generate a database listing.

• You can use the Interactive Excel [Page 421] component to evaluate consolidation data in
reports using the standard spreadsheet functions of Microsoft Excel and a live connection to
the SAP System or an Access database of the offline data entry program.

The following figure shows all of the parts of the Information System.
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Report Writer Reports
Purpose
You use the Report Writer – in conjunction with the Report Painter – to create reports with the
data in SAP Consolidation.

The Report Painter uses a graphic reporting structure, which is the basis for the report definition.
While defining the report, you are able to see the structure of the report as it appears when the
data is output.

Features

You can use Report Writer reports in many SAP applications.

The following sections focus on the special features of Report Writer reports in SAP
Consolidation.

For detailed information, see the SAP Library under Accounting → Financial
Accounting (FI) → Special Purpose Ledger (FI-SL) → Report Writer [Ext.]

You can use Report Writer reports to:

•  define reports

•  edit reports

•  execute reports using report groups

The following characteristics in SAP Consolidation are available for the reports:

•  Dimension, version, and ledger

•  Consolidation units, consolidation groups

•  Financial statement items and subitems

•  Fiscal years and periods

•  and so on

See also

•  Library, Database Structure, Characteristics and Selection Logic [Page 370]

•  Use of Sets and Custom Characteristics [Page 372]

•  Rollup to Consolidation Groups [Page 373]

Constraints
SAP Consolidation does not support multiple selections of data. Instead, you can use variations
for the characteristics in the General Selection (see also: General Selections [Ext.]).



Consolidation (EC-CS)  SAP AG

Report Writer Reports

368 April 2001

Examples of Report Writer Reports in Consolidation
Example: Balance Sheet Changes

Report: Balance Sheet
Changes, Assets

Consolidation Unit: CU1000

Period/Fiscal Year: 012/2000

Assets Reported
(Local) Value

Standardizing
Entries

Elimination
Entries

Consolidated
Value

Inventory XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Accounts
Receivable and
Other Assets

XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Securities XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Total Current
Assets

XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Unpaid Equity
Contributions

XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Intangible Assets XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Property, Plant &
Equipment

XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Financial Assets XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Total Fixed Assets XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Prepayments/Accru
als

XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

TOTAL ASSETS XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX XXX,XXX,XXX.XX

Explanation:

•  The columns use the posting level characteristic.

•  The rows use a generated item set.

Example: Consolidated Income Statement of Business Areas

Report: Income Statement by
Business Areas

Consolidation
Group:

CG1

Period/Fiscal
Year:

012/2000

Annual Net Income Net Sales Return (in %)

Pest Control XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX -
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Seeds XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Agriculture XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Dyes XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Industrial
Chemicals

XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Plastics XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Fine Chemicals XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Chemicals XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Baked Goods XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Beverages XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Soups XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Foods XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Cosmetics XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Pharmaceutical
s

XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Health
Products

XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

TOTAL XXX,XXX,XXX.XX - XXX,XXX,XXX.XX - XXX,XXX,XXX.XX

Explanation:

•  The columns use financial statement items and a formula for the return.

•  The rows use a custom characteristic business area.
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Library, Database Structure, Characteristics and
Selection Logic
For general information on libraries and characteristics, see Library [Ext.].

Library
SAP delivers the library 0CS in client 000 for Report Writer reports in Consolidation.

Database Structure
The name of the database structure for Report Writer reports in Consolidation is FIMC.

It contains all of the essential characteristics needed for Report Writer reports in Consolidation.

Characteristics
Length of Characteristics
The length of the characteristics in the Report Writer must be less than or equal to 24 characters.
Make sure this maximum length is not exceeded when defining custom characteristics in
Consolidation for use with the Report Writer.

Discussion of Certain Characteristics
Certain characteristics of database structure FIMC need further explanation:

Characteristic Explanation

RYEAR Fiscal Year

RPMAX Period

•  Used for selecting data

CGYEAR Fiscal year for drilling down a
consolidation group

PERID Period for drilling down a
consolidation group

•  Time characteristics for drilling
down the hierarchy

•  Each is typically a single value –
for better performance

INICG Consolidation Group You are urged to use this
characteristic uniformly within a
report.

You can use the two separate characteristics for the fiscal year and the period for restatements,
for example, to report on the values of past fiscal years for the present consolidation group
hierarchy.

Consolidation-Specific Selection Logic
Reports for Consolidation Groups
The system uses the consolidation-specific selection logic for the following characteristics in
Report Writer reports for consolidation groups:

•  Consolidation group (INICG)

(with accounting techniques of the consolidation of investments methods)
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•  Posting level (PLEVL)

•  Partner unit (RBUPTR)

In Report Writer reports for consolidation groups, the data selection is dependent on the posting
level:

•  Posting levels 02, 12, 22:

The system selects only the data records that were posted in the selected consolidation
group.

•  Posting levels 20, 21:

The system selects only the data records where both the consolidation unit itself and the
partner unit belong to the consolidation group. (However, the system does not select
data records of consolidation units and partner units which are consolidated using the
equity method or the mutual stock method.)

•  Posting level 30:

The system selects only the data records that were posted in the selected consolidation
group or a lower-level group subordinate to the selected consolidation group.

•  All posting levels:

The date of first consolidation and the date of divestiture are used when determining
whether a consolidation unit belongs to a consolidation group.

Reports for Consolidation Units
In reports for consolidation units (without the characteristic consolidation group), the system does
not assess the aforementioned dependencies that are valid for consolidation groups.
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Use of Sets and Custom Characteristics
Sets
In SAP Consolidation you can automatically generate financial statement (FS) item sets for
Report Writer reports: After creating the hierarchy of the consolidation chart of accounts [Page
52], you choose Edit → Generate Sets.

When you change the item hierarchy, the system automatically offers you to re-generate the FS
item sets (if you specified this feature in Customizing for Consolidation at Master Data → Define
Dimensions).

The same applies to the maintenance of organizational units [Page 43].

We recommend that you use these automatically generated sets for the Report
Writer reports.

Custom Characteristics
If you have defined custom characteristics, these automatically appear in the library.

Report Writer reports treat custom subassignments the same as standard subassignments.

Value Variables and Set Variables
Note the following when you specify sets or values when running a Report Writer report:
Variable Value Entry No Entry
Set
Variable

Selection options appear. Do not make an entry if you want to select <SPACE>
as the set variable.

Example with the posting level:
You select posting level “space” (for
reported data from realtime updates)

Value
Variable

You specify single values. Do not make an entry if you want to select all values.

Example with the posting level:
You select all posting levels.

See also Accounting → Financial Accounting (FI) → Special Purpose Ledger (FI-SL) →
Tools → Variable [Ext.]
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Rollup to Consolidation Groups
Use
You can use this function to increase performance of Report Writer reports.

The use of this function is optional.

The rollup discussed in this topic is not the same as the data transfer method “rollup”
[Page 166].

Prerequisites
To enable rollups to consolidation groups, you need to make the following settings in
Customizing for Consolidation:

•  You define a task under Data → Rollup to Consolidation Groups: Define Task.

•  You assign this task to:

− the task group for the data monitor, or

− the task group for the consolidation monitor

.

Features
You can use a rollup to summarize and transfer the data of consolidation units to consolidation
groups and consolidation group hierarchies. This provides faster access to the required data
because the Report Writer reports no longer need to select data from the entire hierarchy, but
rather only down to the specified hierarchy level.

Example: Rollup up to Hierarchy Level 1
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The following functional restrictions exist when rolling up data to the rollup consolidation units of
the consolidation groups:

•  The rollup produces useful results only for those consolidation groups, to which no individual
consolidation unit has been assigned more than once (in lower-level consolidation groups).
Due to the level-by-level rollups, the data of such a unit would be rolled up multiple times to
the consolidation group – that is, once to each lower-level consolidation group to which the
unit is assigned.

•  The system does not roll up additional field information to higher levels. Hence, these details
get lost during a rollup.

•  Rollups ignore group-dependent data records that were created by the rollup program in
preparation for consolidation group changes (posting levels 02, 12, 22 and 24).

•  Rollups do not recognize method changes for consolidation units that are assigned more
than once within a hierarchy.

•  When the rollup is started directly in the menu, the rollup is considered a task in the
consolidation monitor. Even if the rollup is also defined as a task in the data monitor, the
system still rolls up all (rollup-capable) data records – including totals records with posting
levels greater than 10.

Activities
You start a rollup and the Report Writer report as follows:

1. You start the rollup in the data monitor or the consolidation monitor.

2. In the report, restrict the selection to a certain drilldown level of the hierarchy (hierarchy
level).
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(In the example, this is hierarchy level 1 – see figure.)

3. Execute the Report Writer report.
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Drilldown Reporting
Purpose
This component is a dialog-oriented information system which you can use to generate reports
on the data in your SAP consolidation database.

The component adheres to the principle illustrated below: For example, you can create report on
the sales of individual consolidation units that differentiates between posting levels (reported
financial data, standardizing entries, elimination entries).

�  SAP AG

Posting
Level

FS Item

C
on

s 
U

ni
t

            Reported data
      Standardizing 
Eliminations

  Assets  Inventory  Sales

U
SA

G
er

.
G

B

Report

The Principle of Drilldown Reporting

Drilldown reporting has been designed as follows: Using the forms, both the key figures and the
characteristics become part of a drilldown report. After a drilldown report has been created, you
can still modify it, for example to include different consolidation units. You can also "mail" the
drilldown report or post-edit it in MS Office applications.
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�  SAP AG

Create
Edit

Execute

Drilldown report 

The Architecture of Drilldown Reporting

Reports
Graphics

Word

ExcelPrint

e-Mail

Key Figures Characteristics
Forms

Implementation Considerations
Implement interactive drilldown reporting if you want to evaluate the data in your SAP
Consolidation component according to various characteristics.

Integration
Many other components of the SAP System feature the functions of drilldown report. Under
certain circumstances, the drilldown reports of different components can use the report/report
interface to call each other interactively.

Features
You can use drilldown report layouts and output to create simple, data-driven reports as well as
complex, formatted reports. Drilldown reports can reflect and analyze the data in your SAP
System.

Drilldown reporting features easy-to-use functions for the following scenarios:

Interactive Editing of a Report

•  Sort

•  Pre-defined conditions

•  Ranking lists

•  Exceptions

•  Editing of key figures and characteristics
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Navigation in the Database

•  Next level

•  Next object on the same level

•  Level hiding

•  Detail lists and drilldown lists

•  Saving of data that was selected for a report (for example to further process the report at a
later date)

Outputting and Sending Reports

•  SAP Graphics and SAPmail

•  Print functions in MS Excel and Winword

•  Level hiding

Drilldown reporting in SAP Consolidation lets you use characteristics with special semantics:
Custom characteristics, standard attributes and custom attributes [Ext.] can serve as
selection criteria as well as drilldown characteristics. For more detailed information, see the units
Reference Characteristics [Page 406] and Hierarchy-related Options in Drilldown Reporting
[Page 394].

You can use the characteristic totals consolidation group to define a selection criterion for
consolidation groups in a form or report, thus specifying any combination of consolidation groups
and units as a totals consolidation group.

For more information, see the field help for the totals consolidation group.

Likewise, you can have totals items to easily define a selection criterion for financial statement
items.

You can create global variables with an SAP Exit for certain standard characteristics, which
simplify the handling of drilldown reports considerably. For more information, see the unit
Variable [Page 384] .

You can manipulate the display properties of hierarchies [Page 394] to the extent that the report
proposes hierarchy names while selecting the hierarchies. This also simplifies the handling of
interactive drilldown reports.
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Drilldown Report
Definition
A report that was created using interactive drilldown reporting. It can be an ad-hoc report or a
form report.

Use
Drilldown reports in SAP Consolidation are used to evaluate the consolidation data according to
the information requirements of various users.

Types of Drilldown Reports
A drilldown report [Ext.] can be created as either an ad-hoc report or a form report.

Ad-hoc Report
In ad-hoc reports you assign key figures to the characteristic values. You choose variables,
characteristics and key figures that are used to create a report. You can delimit any
characteristic to a specified characteristic value. The selected characteristics unfold a multi-
dimensional datacube. The columns of the report consist of the key figures. You can create an
ad-hoc report very quickly and flexibly because no form is required.

Ad-hoc Report

      LocalLocal           GroupGroup . . .. . .
CurrencyCurrency    Currency   Currency

AnnualAnnual
Net IncomeNet Income

Property,Property,
Plant &Plant &
EquipmentEquipment

InventoryInventory

Characteristic
Values

Key Figures

For more information, see Ad-hoc Report [Ext.].

Form Report
You define a form that specifies the form report. A form report consists of one or two coordinates.
Form reports are more target-oriented than ad-hoc reports. The contents and layout of a form
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report can be designed as needed. Form reports are generally used for official and, more
importantly, statutory reporting.

�  SAP AG

The Different Types of Forms

      Plan  Actual   Variance       Plan GC       Actual GC    Begin     Acquis Retire

Property

Equipment

A coordinate
without a key

figure

A coordinate
with a key figure

Two coordinates
(matrix)

Creation of a Form Report

For more information, see Ad-hoc Reports and Form Reports [Ext.].

Structure
Elements of a Drilldown Report
•  Characteristics

•  Variable

•  Output type

•  Options

Report Parameters
•  General parameters such as the report name, long text, report type (form vs. ad-hoc)

•  Basic information about the report such as the short text, report description, author, date
created, last date changed

•  General selection criteria such as the fiscal year, period (from/to), dimension, consolidation
chart of accounts, ledger, version

•  Variables: ledger source, fiscal year, dimension, balance sheet hierarchy, totals consolidation
group

•  The chosen hierarchy
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•  The chosen characteristics

 For more information, see Functions in the Report Definition [Ext.] in the general
drilldown documentation.



Consolidation (EC-CS)  SAP AG

Characteristic

382 April 2001

Characteristic
Definition
A data field without a value that is used in drilldown reporting.

You can display characteristic values when you have cube of three characteristics, each side of
which represents one of those characteristics.

A combination of characteristics is called an object.

Use
In drilldown reporting, you can use characteristics as a means of structuring the data.

The following is a sampling of possible characteristics in SAP Consolidation:

•  Consolidation unit:  United States

•  Financial statement item:  Sales

•  Posting level:  Reported financial data

•  Custom characteristics (for example, country, controlling area, company, profit center,
business area)

Integration
Drilldown reporting uses characteristics system-wide.

For more information about characteristics, see Choosing Characteristics [Ext.].
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Key Figure
Definition
A data field with a value that can be used in drilldown reporting as follows:

•  as an amount (local currency, group currency, transaction currency)

•  as a quantity

Use
You can choose key figures in forms or in reports.

Some examples of key figures are: sales, number of employees (basic key figure), earnings by
sales, sales by number of employees (computed key figures).

Integration
Drilldown reporting uses key figures system-wide.  For more information, see Choosing Key
Figures [Ext.].
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Variable
Definition
A parameter of a report or form, which you specify when defining or executing a report.

In drilldown reporting of SAP Consolidation you can create global variables for some of the
standard characteristics, thus simplifying the handling of drilldown reporting considerably.

For more information, see Variables [Ext.] in the general drilldown documentation, and also
Defining Global Variables [Ext.] in the Implementation Guide for Consolidation.

Use
You use a local variable if it is only used in a specific report or form. However, you use global
variables if you want them to be available in all reports or forms.

Structure
SAP Consolidation features several types and categories of variable, which you can use
depending on how often they are needed or reused, and which specific drilldown goals are to be
achieved.

Types of variables in SAP Consolidation

Global Variables Local Variables

Leading character(s) & &$

Where valid all reports or forms only one report or form

Where defined centrally in Customizing in the report or form itself

Example consolidation chart of accounts customer group

You can use the following variable categories in your forms and reports:

•  Variables for characteristic values

•  Variables for texts

•  Variables for formulas

These variables are only defined in reports that use formulas and in the form itself.
Substitution occurs when the report is executed. You can use formula variables, for
example, as an easy way of portraying simulations and projections.

•  Variables for hierarchies [Page 394]
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Standard Report
Definition
A report that is available in the standard SAP Consolidation system.

For more information, see Report [Ext.] in the general drilldown documentation.

Use
You use standard reports for form-oriented reporting, for example to meet statutory reporting
requirements. The following are some of the reports that are available:

•  Balance sheet (for example, balance sheet for the current year with percentage rates)

•  Income statement (yearly/quarterly/monthly comparisons, sales by region, income by
functional areas)

•  Changes in values

•  Asset history sheet

For more information, see the documentation for the individual reports, which will soon be
available.
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Custom, User-defined Report
Definition
A report that is not based on forms, but rather created by the user "ad-hoc" to achieve her
individual reporting objectives.

Use
You use custom reports to evaluate the data in your system according to the characteristics you
select whenever the available form reports do not accommodate the information required.

Structure
The following characteristics are predefined in ad-hoc reorts: dimension, totals consolidation
gorup, version, year.

You can choose the report parameters one-by-one and click  to display those parameters.
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Form
Definition
A form is the basis for a drilldown report. It defines the basic content and technical design of
report listings. One should regard it as a semi-finished report definition that is later completed
with characteristics and key figures.

As opposed to an ad-hoc report, this type of drilldown report requires a form with the same ID as
the drilldown report.

Use
You use forms to design drilldown reports according to your own criteria. Forms enable you to
analyze SAP data according to all characteristics that are contained in the totals database of
Consolidation.

In the list of available characteristics, you choose the characteristics you need for your drilldown
report.

Structure
A form has rows and columns. The rows display the values of the characteristics [Page 382] that
are selected for the columns.

There are different types of forms:

•  One coordinate forms without a key figure (simplest type)

•  One coordinate forms with a key figure

•  Two coordinate forms with a key figure (most complex)

When creating a form, you define the name and the form type.
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Creating a Form
Use
Use this procedure if you want to create a form [Page 387] for a drilldown report.

Prerequisites
The selection screen of the drilldown report is on your screen.

Procedure
1. Choose Environment → Form → Create.

The following screen appears: Report Painter: Create Form.

2. Specify a short and a long text for the name of the form.

SAP recommends using the same name for the drilldown report and the corresponding
form.

3. Under Structure, choose one of the following structures:

•  two coordinates (matrix)

•  one coordinate with key figure

•  one coordinate without key figure

4. If applicable, in the Copy from area choose a form that should serve as a template.

5. Choose Create.

Result
You can create a form and re-use the form for a variety of reports.

This form has characteristics and key figures in the rows and columns.
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Creating a Drilldown Report with a Form
Use
You use these steps to create a drilldown report that is based on a form.

Prerequisites
You want to report on data from within SAP Consolidation according to your own criteria, that is
characteristics [Ext.].

Procedure
1. In the SAP level, choose Accounting → Enterprise Controlling → Consolidation →

Information system → Tools → Drilldown reporting → Drilldown report → Create.

2. Enter a suitable name for the drilldown report.

3. In the Report type area, select Report with form.

4. Choose a form using Possible Entries (F4) and choose Create.

There is also an option to create a report using a template. To do this, under Copy
from choose a template report in the list of possible entries.

5. You create a Report with hierarchy by selecting  (hierarchy) for one of the characteristics.
After doing this, a window appears in which you can select a hierarchy.

Here are examples of hierarchies you can choose from if the characteristic is an
organizational unit:

•  Consolidation group hierarchy (entry of a hierarchy name – this option lets
you specify a fixed name for the hierarchy)

•  Hierarchy from totals consolidation group (This is a hierarchy variable for an
SAP exit. If you choose this option, the system always selects the hierarchy
that is suitable for the transaction data.)

•  No hierarchy

•  Enter at execution (If chosen, you can enter the name when the report is
executed.)

•  Hierarchy names explicitly defined in Customizing

•  Custom, user-created hierarchy variable with a fixed value
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The prior-to-the-last option has the advantage that the hierarchy names defined in
Customizing appear as a default when choosing the hierarchy in the report.

By contrast, using hierarchy variables with a fixed value has the advantage that the
fixed value is defined centrally in Customizing. Changing the fixed value centrally
takes effect immediately in all reports that use the hierarchy variable.

6. In the list of available Characteristics, choose the characteristics you need for your drilldown
report.

You can make the list of available characteristics systemic by first choosing a
characteristic group.

Examples of characteristic groups you can choose at this point:

− Posting characteristics

− Organizational units

− Subassignments

− Version, date

7. Choose the Output Type of the drilldown report. You can choose from graphic, classic, object
list (ALV) and XXL (spreadsheet).

8. Choose further Options:

− Print setup (drilldown and details, or details only)

− Extras

Under Extras you can maintain and display comments, make report assignments,
use the functions of inSight [Ext.]  for your drilldown report, and either read all of the
data or reread the data at each navigation step.

Result
You can reuse the form as often as you like for your reports.
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Drilldown Reports Available in Standard SAP
Consolidation
Definition
Various drilldown reports you use on the data of SAP Consolidation to meet your informational
requirements.

Use
You use these reports to evaluate the data at different time intervals with different criteria.

Standard Report
Standard reports evaluate the balance sheet of the current year using the percentages for each
FS item in relationship with the balance sheet total. The output can be disclosed on your public
consolidated statements.

Comparison Reports
The following comparisons are available:

Period Comparisons Use

Prior-year comparison with balance sheet
percentages

The prior-year comparison is very popular.

You can portray the group's structure (for
example with an industry-specific balance
sheet structure) by also outputting the
proportions of individual balance sheet items to
the corporate balance sheet total.

Multi-year comparison Multi-year comparisons (such as the 10-year
comparison) is also often found in public
consolidated statements.

Quarterly comparison Interim statements are often needed to meet
the requirements of IAS and US GAAP.

These comparisons are of interest to
shareholders and analysts.

Monthly comparison The monthly comparison is mostly used by
internal corporate controllers for timely
recognition of negative variances and reactions
thereupon.

Other Comparisons Use

Comparison of local vs. group currency This comparison shows the effects of currency
translation.
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Version comparison You can use this comparison, for example, to
create multiple versions of consolidated
statements in parallel according to various
accounting principles and valuations.

Comparison of consolidation units shows the materiality of individual
consolidation units

Comparison of consolidation groups shows the materiality of individual
consolidation groups

Comparison of consolidation unit vs.
consolidation groups

shows the parent unit's influence on the
consolidation group

Changes in Values

Changes from reported values to consolidated
values

shows how the aggregated statement changed
to the consolidated statement

Quarterly changes in the income statement shows the short-term changes to the income
statement. This is of interest to internal
controlling as well as equity markets.

Quarterly changes in the balance sheet shows the short-term changes to the balance
sheet. This is of interest to internal controlling
as well as equity markets.

Monthly changes shows very short-term changes to the balance
sheet and/or income statement. This is of
interest to internal controlling as well as
corporate management.

Other Reports

Sales by region shows which regions generated the most sales.

Income statement by functional area is useful for generating an income statement according
to the cost of sales method.

Changes in investee equity IAS 5 requires (further) disclosures on the changes in
stockholders' equity during a fiscal year.

Changes in equity are also useful for multi-period
comparisons (for example, 10-year comparisons) for
assessing the financing of the group over a time period.

Asset history sheet discloses information about capital investments and the
remaining book values of individual portions of fixed
assets.

You customize the standard drilldown reports as follows:

1. Copy the desired report from client 000 to the client you work in, or from another system to
the system you use, by running Import or Transport Reports [Ext.]. in the Implementation
Guide for Consolidation.
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2. Likewise, copy the desired forms for the report from client 000 to the client you work in, or
from another system to the system you use, by running: Import or Transport Forms [Ext.] in
the Implementation Guide for Consolidation.

3. Adjust the chart of accounts and dimension as needed.

4. Replace the fixed values in the global variables with the parameters you require.

Structure
You can use the standard SAP reports in addition to your own custom reports. This minimizes
the effort involved in reporting on the various aspects of consolidation data.



Consolidation (EC-CS)  SAP AG

Hierarchy-related Options in Drilldown Reporting

394 April 2001

Hierarchy-related Options in Drilldown Reporting
Use
You use this function to portray hierarchies in drilldown reports to meet your individual reporting
requirements.

Features
The purpose of hierarchy-related drilldown is to evaluate hierarchies using consolidation units or
financial statement items, and to use different hierarchies as the basis for evaluating a specific
snapshot of your data.

Hierarchy-related Drilldowns: Hierarchy of Consolidation Units
A hierarchy already exists in a dimension. This is differentiated as follows:

Case 1 Case 2

A consolidation unit belongs to
"n" consolidation group(s) in
the hierarchy

n = 1 n > 1

Accounting Technique all The consolidation unit is
included fully or
proportionately in only one
consolidation group at the
most; the unit can be included
in other consolidation groups
using the equity method or the
mutual stock method.

Display of Consolidation Unit The consolidation unit is
shown only in the one
consolidation group.

The consolidation unit is
shown only in the group that
includes it fully or
proportionately; the unit is
hidden in all other groups.

In all other cases an error message is displayed which reveals that the hierarchy
assigned to the drilldown report is ambiguous. This is done because a consolidation
unit has been included fully or proportionately in more than one consolidation group.
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Example

Consolidation Unit A

G2
Consolidation Group

Consolidation Unit B

G3
Consolidation Group

G1
Top Consolidation Group

Consolidation Group Hierarchy

Consolidation Unit Item Partner Unit Entry at posting
level 00 (in group
currency)

Entry at posting
level 20

A Receivables B 100+ 100–

B Receivables A 200+ 200–

A Payables B 200– 200+

B Payables A 100– 100+

When the consolidation group is constructed as shown in the illustration, you could execute a
Report 1 for the relationships shown above with the following parameters:

Item Receivables

Totals Consolidation Group G1

Navigation Characteristic Consolidation unit with a hierarchy for G1

This report would have the following output:
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Hierarchy Display for Drilldown Characteristic
Consolidation Unit

Consolidation Unit A

Consolidation Group G2

Consolidation Unit B

Consolidation Group G3

Top Consolidation Group G1

Value of item Receivables

G1: 0

G2: 0

       A: 0

 G3: 0

  B: 0 

Advantage

•  The hierarchy contains the individual consolidation units.

Disadvantages

•  Particularly the group-dependent eliminations are shown from the perspective of totals
consolidation group G1, hence the desired results are not displayed at the lower levels of the
hierarchy.

•  The report can only be built so that each consolidation unit is fully or proportionately
consolidated in one consolidation group at the most.

Alternatively, you could execute a Report 2 with the following parameters:

Item Receivables

Totals Consolidation Group G1

Navigation Characteristics •  Consolidation unit with a hierarchy for G1

•  Consolidation Unit

This report would have the following output:
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Hierarchy Display for Drilldown Characteristics
Consolidation Group and Consolidation Unit

G1 Consolidation Group

G2 Consolidation Group

G3 Consolidation Group

G1
Totals Consolidation Group

Value of item Receivables with drilldown by
consolidation units:
   Drilldown
Value at  Value at
Group level              Cons.Unit    Unit level
   0            A        0

          B        0

G1: 300-            A        100-
           B        200-

G2: 100+              A        100

G3: 200+              B        200

Advantages

•  All amounts are displayed accurately, even at all hierarchy levels.

•  A consolidation unit can be fully or proportionately consolidated in multiple consolidation
groups. (This is the case, for example, when consolidation units are transferred from one
consolidation group to another.)

Disadvantage

•  Details on individual consolidation units can only be obtained by drilling down.

However, it is possible to combine the drilldowns by consolidation group and
consolidation unit in the printout of the report.

You can do this in Settings for Mass Printing under : Report → Print layout →
Drilldown and Detail List → Mass Print → Settings. Change the sort sequence so
that the consolidation group appears as the first characteristic, and the consolidation
unit appears as the second characteristic. Make the consolidation unit the most
detailed breakdown, and select No page break.

Hierarchy-related Drilldowns: Hierarchy of FS Items
You display the income statement with a hierarchy of financial statement items.

Option: Report Definitions

•  Case 1: The selection is defined using the FS item. Here you generally specify several single
values and ranges. You use the FS item as a navigation characteristic, too.
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•  Case 2: In general, you defined a totals item in hierarchy maintenance, which reflects the
total of all income statement items. This makes the report definition easier as in Case 1 in
addition to the fact that you use the characteristic totals item for the selection criteria: Specify
"Income statement total" as a single value. As in Case 1, you use the characteristic FS item
to display a drilldown or hierarchy of FS items.

In a form, never use the characteristics FS item and totals item as selection criteria
at the same time.

Hierarchy Variables
Hierarchy variables exist for totals consolidation groups and totals items. You can use hierarchy
variables both in ad-hoc reports and form reports.

For more information, see Specify Global Variables [Ext.] in the Implementation
Guide for SAP Consolidation.

If you choose the hierarchy icon  for a characteristic, you must specify the desired hierarchy in
another window.

Activities
As an example, we will define a drilldown report that compares the amounts in local and group
currency. A hierarchy of consolidation units is to be displayed on the first screen. Note that the
consolidation unit must be unambiguous in a report using local currency. This can only be
achieved by defining two reports, and linking them via the Report-Report Interface [Ext.]:

1. Create a one-dimensional form with a key figure and the following general selections:

− Ledger

− Fiscal Year

− Dimension

− Consolidation Unit

Create a local variable for each of these general selections.

One column of the form displays the values in local currency, a second column displays
the values in group currency.

2. Create a report for this form.

3. In the report choose the following characteristics:

− Version

− Consolidation Chart of Accounts

− Item

− Totals Consolidation Group

− Posting Level

4. Define a local variable for each characteristic.



 SAP AG Consolidation (EC-CS)

Hierarchy-related Options in Drilldown Reporting

April 2001 399

5. Create an ad-hoc report. Choose the following characteristics:

− Consolidation Chart of Accounts

− Item

− Consolidation Unit

− Posting Level 00

6. Choose the consolidation chart of accounts as the local variable, and the group currency as
the key figure.

7. For the ledger, choose the global variable &0FROMTCG

8. Sort the characteristics as follows:

− Consolidation Unit

− Item

9. Assign the ad-hoc report you just created to the form report you created beforehand.

10. Start the ad-hoc report.

Result
Using a hierarchy you can compare the amounts in local currency and group currency of
consolidation units. Mark a cell with a consolidation unit and select the function Execute report.
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Restatement Options using Drilldown Reporting
Use
You use this function, for example, to list the figures of past fiscal years the current premises (for
example, the corporate structure) after corporate rebuilding or after shifting to a different
accounting standard (for example from German HGB to IAS or US GAAP).

Prerequisites
You have already created a report using interactive drilldown and want it to be, for example,
based on a modified consolidation group hierarchy.

Features
Restatements permit "what-if" analyses with the following content:

•  Version-based restatement using the reference version:
Here, the reference version of a report determines which (version-dependent)
composition of consolidation units in a consolidation group is to be used for the selection
of transaction data.

If the attributes of the organizational units are version and date sensitive, the reference
version is also the version for which the attributes of the organizational unit are
determined.

With a version-based restatement you can compare the data of different consolidation
versions.

•  Temporal restatement using the reference period and reference fiscal year
Here, the reference period and reference fiscal year of a report determines which (date-
dependent) composition of consolidation units in a consolidation group is to be used for
the selection of transaction data.

If the attributes of the organizational units are version and date sensitive, the reference
period and reference fiscal year are also the period and fiscal year for which the
attributes of the organizational unit are determined.

With a temporal restatement you can compare the data of different periods or years.

You can use these "what-if" analyses to portray how a changed composition of a consolidation
group can affect the group's earnings. This can be useful to show the results of an addition or
divestiture of a certain consolidation unit.

The following illustration shows the display options for a changed hierarchy:
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Restatements in Reporting

Drilldown

    Report with RestatementReport w/o Restatement

Drilldown

TOP

SEG1 SEG2

BA1

10

BA3

20

BA4

30

SEG1 SEG2
BA1

20

BA4

35

BA5

15

BA3

40

BA2

20

BA2

30

Sales

TOP
SEG1

SEG2

SEG2

BA3
BA4
BA5

1997

90

40

50

1998

130

80

50

50

  0
35
15

1997
90
60
30

30
30
0

1998
130

80
50

50
35
15

1997 1998TOP

50

20
30
  0

Sales

TOP
SEG1

SEG2

SEG2

BA4
BA5

Note that in the illustrated Reports without and with Restatement the change in the
composition of business areas takes effect at different dates.

•  The report without restatement shows the same values at the top consolidation group level
as those that are shown in the report with restatement. In fiscal year 1997, the subdivision of
sales revenue is based on the hierarchy of the year 1997, in fiscal year 1998 it is based on
the hierarchy of the year 1998. You define this report by specifying the fiscal year in each
column.

•  The report with restatement evaluates the data of the old fiscal year (1997) with the
hierarchy of the current fiscal year (1998), the latter of which is the reference fiscal year. The
definition of this report is different from the definition of the report without restatement, in that
the reference fiscal year 1998 is specified in the general selection screens of the report.

This technique can be used to portray the corporate group as if it had existed in
1997 in the constellation of 1998. This can be used, for instance, to ensure a high
comparability of the consolidated statements of several fiscal years in a often-
changing consolidation group.

The reference fiscal year [Page 411] relevant in this case is the one that reporting uses as the
base for the reference characteristic when drilling down the consolidation group into
consolidation units. The selection of transaction data uses the reference fiscal year to determine
the (date-dependent) composition of consolidation units in a consolidation group.

If the reference fiscal year is not specified, the characteristic fiscal year is used instead of the
reference fiscal year for drilling the hierarchy and determining the attributes.  This is the case with
the report without restatement.

The report with restatement uses the same fiscal year for both columns in a
hierarchy drilldown; therefore, you can also use the characteristic consolidation unit
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for breakdowns and hierarchy drilldowns. However, this is only possible if the
consolidation unit in question is included using the purchase method or proportional
consolidation in only one consolidation group.

Limitations of Restatements
Restatements are not possible when dealing with group-dependent postings that reflect very
complex business transactions. For example, this is the case with postings for the consolidation
of investments.

Restatement Options up to and Including Release 4.5
Reference characteristics are not available in Release 4.5 and earlier.

The following illustration shows the available restatement options in SAP systems with Release
4.5 and earlier. A means of simulating the hierarchy of the year 1998 is achieved by creating the
total of the amounts of both fiscal years at a given FS item (in a hidden column) and showing the
"old" fiscal year 1997 as the difference between the total of both years (1997 and 1998) and the
amount of fiscal year 1998.

Restatement in Drilldown Reporting
-- Technique up to Release 4.5 --

TOP

SEG1 SEG2

BA1

10

BA1

10

BA3

20

BA3

20

BA4

30

BA4

30

SEG1 SEG2

BA1

20

BA1

20

BA4

35

BA4

35

BA5

15

BA5

15

BA3

40

BA3

40

BA2

20

BA2

20

BA2

30

BA2

30

    Report with Restatement

1997 1998TOP

Column 1997 + 1998
automatically
evaluates the data of
both years with the
hierarchy of the
higher year.

Hence, the difference
column shows the
values of 1997 using
the hierarchy of 1998.

SEG1

SEG2

Sales

TOP

BA1

BA2

BA3

BA4

BA5

1997 (Difference) 
90
60
10
30
20
30
30
0

1998
130
  80
  20
  20
  40
  50
  35
  15

1997 + 1998
220
140
  30
  50
  60
  80
  65
  15

hidden

Activities
Create your reports with reference versions to state additional information about the influence of
individual consolidation units and consolidation groups as well as its history. Do this as follows:

1. In the SAP Consolidation menu choose Information system → Tools → Drilldown reporting.

The screen Execute Drilldown Report: Selection appears.

2. Choose Environment → Form → Create.

The screen Report Painter: Create Form appears.
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Define two columns. Confine the selection of data to the version. Define local variables 1
and 2 for each version.  Create a local variable for the reference version in the general
selection area. Save the form and create the report.

The general drilldown documentation contains all further information for creating and
using forms: see Form [Ext.].

3. Choose the hierarchy name of the consolidation group and define the following:

dimension, consolidation group, version, fiscal year, period

4. Choose .

The drilldown report is executed. The output is shown in the fashion you select
beforehand (for example, as a classic drilldown report).

5. To save the output, choose Report → Save data

6. Afterwards, go back to the drilldown report selection screen and choose  again.

At this point, you should copy the definition of the initial report to a new report, so you
only need to enter the parameters that are to be changed for the additional version.

7. Now choose, for example, a different version so you can run a version-based restatement.
Do not change the other parameters.

8. Execute the modified drilldown report and save the output.

9. Compare the output of the two reports.

Result
You have three versions of your report: the two reports you created utilizing the columns, and the
reference version. Specify that one of the two versions you created is to serve as the reference
version.
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Totals Consolidation Group
Definition
A characteristic in drilldown reporting for SAP Consolidation.

Use
The totals consolidation group is any desired combination of consolidation groups for reporting
purposes.

The characteristics totals consolidation group and consolidation group are different if a
consolidation group (e.g., an upper CG) contains one or more other consolidation groups (e.g., a
lower CG).

You use the characteristic totals consolidation group whenever you want to formulate a
selection condition in a form or a report.

You use the characteristic consolidation group if you want to display drilldowns of consolidation
groups in a hierarchy display of a report.

Consolidation group hierarchies can be displayed only for the characteristic consolidation group,
but not for the totals consolidation group.

Example
Say, the consolidation group ON-TOP CG only contains one other consolidation group,
BENEATH CG. The annual net income of ON-TOP CG amounts to 1000 currency units, 200 of
which belongs to BENEATH CG and the remainder to ON-TOP CG.

When you define a report with the selection condition totals consolidation group = ON-TOP
CG, then the system displays the total value for ON-TOP CG including all lower groups, hence
including the values for BENEATH CG.

In this example, the report shows an annual net income of 1000 currency units.

When you define a report with the selection condition consolidation group = ON-TOP CG, then
the system only displays the value that belongs to ON-TOP CG, that is, a delta value (total value
for ON-TOP CG less the total values of all lower groups).

In this example, the report shows an annual net income of 800 currency units.
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Totals Item
Definition
A characteristic in drilldown reporting for SAP Consolidation.

Use
The totals item is any desired combination of financial statement items for reporting purposes.

Use the characteristic totals item for easy entry of selection conditions concerning FS items in a
form or a report: Instead of specifying each and every value item, or range of items, that belongs
to a totals item, you can use the characteristic totals item and specify the totals item itself. If you
use totals items for the definition of cells (or rows or columns), you should specify the
characteristic totals item in all cells; otherwise, the report may not show the correct values.

You use the characteristic FS item if you want to display drilldowns of financial statement items
in a hierarchy display of a report.

 Item hierarchies can be displayed only for the characteristic FS item, but not for
the totals item.
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Reference Characteristics
Definition
Characteristics [Page 382] that determine the version, period and year for selecting transaction
data in drilldown reporting, which are used:

•  to drill down the consolidation groups into consolidation units

•  to determine the custom attributes of the consolidation units. (In contrast to the standard
attributes, the custom attributes of a consolidation unit are not version and date dependent.)

SAP Consolidation uses the following reference characteristics:

•  Reference version [Page 408]

•  Reference period [Page 409]

•  Reference fiscal year [Page 411]

Use
Reference characteristics are used in drilldown reporting as the basis for drilling into the
consolidation units of a consolidation group.

Furthermore, they are used for determining the attributes of consolidation units. But this only
applies to attributes that are version and date-dependent.

Reference Version
The reference version determines which version is used for drilling into the consolidation units of
a consolidation group. If a consolidation version is specified in addition to the reference version,
the consolidation version determines the version that is used for reading transaction data.

If no reference version is specified, then the characteristic consolidation version is used for
hierarchy drilling and attribute determinations. In this case, the consolidation version must be
unambiguously specified for each cell (or row or column) of the report. Moreover, the
consolidation version always determines the version of the transaction data to be selected.

Reference Period
The reference period determines the period for which the consolidation group hierarchy and the
attributes are read. The consolidation group hierarchy and attributes are the basis for interpreting
the transaction data. The period determines the period of the transaction data to be read. If no
reference period is specified, then the characteristic period is used for hierarchy drilling and
attribute determinations.

Reference Fiscal Year
The reference fiscal year determines the fiscal year for which the consolidation group hierarchy
and the attributes are read. The consolidation group hierarchy and attributes are the basis for
interpreting the transaction data. The fiscal year determines the fiscal year of the transaction data
to be read. If the reference fiscal year is not specified, the characteristic fiscal year is used for
hierarchy drilldowns and attribute determination.
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Example
See the examples that follow in units Reference Version [Page 408], Reference Fiscal Year
[Page 411], and Reference Period [Page 409]:

Version-based Restatement using Reporting

Temporal Restatement in Reporting: Yearly Comparison

Temporal Restatement in Reporting: Period Comparison
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Reference Version
Definition
The reference version of a report is the version that is used during the selection of transaction
data to determine the (version-dependent) grouping of consolidation units in a consolidation
group.

It is one of the characteristics [Page 382] that are used in drilldown reporting for selecting
transaction data for a consolidation group.

Use
You use the reference version to explicitly specify in drilldown reporting the parameters for drilling
into the consolidation units of a consolidation group.

If no reference version is specified, then the characteristic consolidation version is used for
hierarchy drilling and attribute determination. In this case, the consolidation version must be
unambiguously specified for each cell (or row or column) of the report. Moreover, the
consolidation version always determines the version of the transaction data to be selected. If a
consolidation version is specified in addition to the reference version, the consolidation version
determines the version that is used for reading transaction data.

Example
Version-based Restatement using Reporting
You define a form with one coordinate as follows:

Dimension

Totals consolidation group

Fiscal year

Single values

Reference version

Columns 2 columns with the same key figure

Difference between the columns Consolidation version 100 vs. 200

The corresponding report shows transaction data for the two consolidation versions in the two
columns. However, the report uses the composition of the consolidation group as the basis for
the reference version. If you specify the consolidation version of the first column (100) as the
reference period, reporting then re-interprets the data of the second column. This means that the
data of the second column is selected for consolidation version 200. However, this is based on
the composition of the consolidation group according to consolidation version 100 (the reference
version). This enables the report to show a drilldown on the characteristic consolidation group
that shows a hierarchy for consolidation version 100.
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Reference Period
Definition
The period that is used as the reference characteristic for drilling into the consolidation units of a
consolidation group. The reference period of a report is the period that is used during the
selection of transaction data to determine the (date-sensitive) grouping of consolidation units in a
consolidation group.

The characteristic [Page 382] that enables you to explicitly specify in drilldown reporting the
parameters for drilling into the consolidation units of a consolidation group. This is necessary to
select transaction data for a consolidation group.

If the attributes of the organizational units are version and date sensitive, the reference period is
also the period for which the attributes of the organizational unit are determined.

Use
As with all reference characteristics, the reference period is a basis for drilling into the
consolidation units of a consolidation group, and determines which period is used to read the
consolidation group hierarchy and the attributes. The consolidation group hierarchy and attributes
are the basis for interpreting the transaction data. The period determines the period of the
transaction data to be read.

If no reference period is specified, then the characteristic period is used for hierarchy drilling and
attribute determinations. If the period is specified in a cell (or a row or a column) of the report,
then the highest of the specified periods is used as the reference period. If the period is not
specified in a cell of the report, then the value 16 is used as the reference period.

The reference period can only be used in conjunction with the consolidation group, the totals
consolidation group or a version and date-sensitive attribute. If the reference period in a form is
defined in the cell definition, instead of in the general selection, the reference period must then
be specified in all other cells as well.

Example
Temporal Restatement in Reporting: Period Comparison
You define a form with one coordinate as follows:

Dimension

Totals consolidation group

Consolidation version

Fiscal year

Single values

Reference Period

Columns 2 columns with the same key figure

Difference between the columns Period range 0-12 vs. 0-6

The corresponding report shows year-to-date transaction data for the two time periods in the two
columns. However, the report uses the composition of the consolidation group as the basis for
the reference period. If you specify the ending period of the first column (12) as the reference
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period, reporting then re-interprets the data of the second column. This means that the data of
the second column is selected for period range 0-6. However, this is based on the composition of
the consolidation group according to period12 (the reference period). This enables the report to
show a drilldown on the characteristic consolidation group that shows a hierarchy for the given
fiscal year and period 12.
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Reference Fiscal Year
Definition
The fiscal year that is used as the reference characteristic for drilling into the consolidation units
of a consolidation group. The reference fiscal year of a report is the fiscal year that is used during
the selection of transaction data to determine the (date-sensitive) grouping of consolidation units
in a consolidation group.

If the attributes of the organizational units are version and date sensitive, the reference fiscal
year is also the year for which the attributes of the organizational unit are determined.

Use
The reference fiscal year determines the fiscal year for which the consolidation group hierarchy
and the attributes are read. The latter (consolidation group hierarchy and attributes) are the basis
for interpreting the transaction data. The fiscal year determines the fiscal year of the transaction
data to be read.

In this case the following applies: The fiscal year must be specified for each cell (or row or
column) of the report. If more than one fiscal year is entered, the highest fiscal year specified is
used as the reference fiscal year.

The reference fiscal year can only be used in conjunction with the consolidation group, the totals
consolidation group or a version and date-sensitive attribute. If the reference fiscal year in a form
is determined in the cell definition, instead of in the general selection, the reference fiscal year
must then be specified in all cells.

Example
Temporal Restatement in Reporting: Yearly Comparison
You define a form with one coordinate as follows:

Dimension

Totals consolidation group

Consolidation version

Single values

Reference fiscal year

Columns 2 columns with the same key figure

Difference between the columns Fiscal year 2001 vs. fiscal year 2000

The corresponding report shows transaction data for the two fiscal years in the two columns.
However, the report uses the composition of the consolidation group as the basis for the
reference fiscal year. If you specify the fiscal year of the first column (2001) as the reference
fiscal year, reporting then re-interprets the data of the second column. This means that the data
of the second column is selected for fiscal year 2000. However, this is based on the composition
of the consolidation group according to fiscal year 2001 - the reference fiscal year. This enables
the report to show a drilldown on the characteristic consolidation group that shows a hierarchy for
fiscal year 2001.
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Creating, Executing, Reusing, and Modifying Drilldown
Reports
Purpose
You use this process to process drilldown reports for evaluating data in SAP Consolidation.

Prerequisites
You have maintained your consolidation data in the SAP Consolidation component.

Process Flow
1. Define a drilldown report in the Implementation Guide [Ext.] for Consolidation.

Decide whether you want to create a form report or an ad-hoc report.

Also decide if you want to use variables. If you want to use variables, choose .

2. If you want to create a form report, define a form.

3. If you want to create an ad-hoc report, choose the characteristics and key figures that you
find of most interest.

4. If you want to make use of the hierarchy-related options in drilldown reporting, select the flag
 for the characteristic that is to be drilled down.

For more information, see Hierarchy-related Options in Drilldown Reporting [Page 394].

5. Execute the report by choosing  .

6. If you want to double-check your selection, choose  to display the report parameters.

7. If you want to re-use the report, at a later date you can rerun the report with updated data by
choosing  .

8. If you want to modify a report, change the report parameters and save the report.

If you want to retain the original report, save the changed report under a new name.

Result
You utilized the capabilities of drilldown reports, in particular the reusability of once-only defined
reports.
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Journal Entry Reports
Purpose
Within the consolidated financial statements, value-based changes in individual financial data are
entered in the SAP system with posting documents. The journal entries, that means the line
items of postings to the posting levels of consolidation (posting level 01 to 30), can be displayed
by means of the journal entry reports.

You use these components, when you want to create journal entry reports with the help of the
predetermined logic.

Implementation Considerations
Choose these components if you want to display the changes in individual financial data, which
are based on the consolidation entry. In contrast to the database listing of journal entries, on
application of the logic the posting levels are selected. For more information about this logic, read
the section “Classification of Entries with Posting Levels” in the unit Postings [Page 201] in the
Consolidation manual in the SAP Library.

Features
With the help of the journal entry reports you can select all consolidation documents flexibly and
also display them hierarchically. In this way you can evaluate the postings according to freely
selectable sort sequences and summarizations.

Fundamental sort criteria are:

•  Document type

•  Document number

•  FS item number

•  Consolidation unit

You can change the structure of the journal entry report. Settings which are delivered as
standard in the journal entry layouts are available for this. Though the above mentioned sort
criteria and possible summarizations are predetermined by the journal entry layout.

In addition to that in the section Define Journal Entry Layouts [Ext.] in the Consolidation
Implementation Guide, you can define more journal entry layouts according to your requirements.
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Journal Entry Report
Definition
Report which is created by means of the information system and gives information about the
individual postings in the SAP Consolidation component.

Use
You use the journal entry report when you want to analyze the affected items from the
consolidation entries.

Structure
The journal entry report is structured as follows:

The global parameters are listed in the first header:

•  Dimension

•  Consolidation chart of accounts

•  Version

•  Period

The relevant selections are listed for the respective report in the second header:

•  Effective until period

•  Chosen journal entry layout

•  Treatment of reversal documents

•  Chosen currency

The posting document, which is selected by means of the journal entry layout, is listed in the data
block of the journal entry report  Here you can see the individual posting lines of documents in
the respective currency, chosen by you.
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Journal Entry Layout
Definition
Layout which determines the structure of the Journal Entry Report [Page 415].

Use
You use the journal entry layout to determine the hierarchical structure of the list output. This
involves the following:

•  which characteristics and key figures of journal entries are displayed in which order

•  which characteristics should be cumulated.

You can define one of the journal entry layouts as a proposal. This is then used as standard
when you have not used a journal entry layout in a terminal session.

Standard System

Technical name of journal
entry layout

Long text Objective

CS01-01 Documents per consolidation
unit

For the individual
consolidation-specific
document types, documents
posted in the selected period
are displayed in transaction,
local and group currency.

CS01-02 Documents per consolidation
unit with additional account
assignment

In addition to CS01-01 the
partner relationships are
delivered with this one.

CS01-03 FS items per document type For the individual
consolidation-specific
document types, the FS items
posted in the selected period
are displayed.  The posted
amounts are displayed using
the document number.

CS01-04 FS items per document type
and consolidation unit

In addition to CS01-03 the
consolidation units are
delivered with this one. This
means that the journal entries
are first sorted by document
types, and within a document
type by consolidation units.
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CS01-05 FS items per document type
by consolidation unit

In contrast to CS01-04 the
consolidation-specific
document types are displayed
first by FS item and then by
consolidation unit.

CS01-01 FS items per consolidation
unit and document type

Here the consolidation-specific
postings are disclosed by
consolidation unit, for each
affected FS item.

CS03-01 FS items by consolidation
units

First arranged by FS items
and then by consolidation
units, the posted amounts are
displayed here by means of
the individual documents.

CS03-02 FS items by document types First arranged by FS items
and then by document types,
the posted amounts are
displayed here by means of
the individual documents.

CS03-03 FS items by document types
and consolidation unit

First arranged by FS items
and then by document types
as well as consolidation units,
the posted amounts are
displayed here by means of
the individual documents.

CS04-01 Document journal The individual documents are
displayed with the following
components:

•  Document type

•  Posting line

•  FS item

•  Cons unit

•  Amount in transaction and
group currency

CS04-02 Audit trail with text The individual documents are
displayed with the following
components:

•  Document number

•  Document type (with long
text)

•  Posting explanation
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Structure
The journal entry report, which is based on the journal entry layout, has the following structure:

The global parameters with which you work are listed in the header of the journal entry report.

Further selections, which you have made for your journal entry layout, are displayed in the
second block. These are some of the selection parameters and characteristics with clear
characteristic value in the selected data. For example this could be:

•  Effective until period

•  Journal entry layout

•  Treatment of reversal documents

•  Selected currency

In the list, characteristics and key figures are displayed in a hierarchical list structure according to
the journal entry layout. Characteristics with clear values (= potentially redundant information) are
displayed in the list header, to keep the list clearly arranged.
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Creating a Journal Entry Report from the Standard
System
Use
Use this procedure to create a journal entry report from the Standard System [Page 416].

Prerequisites
You want to analyze your consolidation data by means of the journal entry report.

Procedure
1. In the SAP Consolidation component choose Information system → Journal entries.

You reach the screen Journal entries.

2. Limit the search to the journal entries as described in Create a Journal Entry Layout [Page
420].

3. In the technical parameters, select one of the journal entry layouts from the standard system.

4. Copy the layout from client 100 into the client in which you are working.

5. Create your journal entry report on the basis of the journal entry layout.
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Create a Journal Entry Layout and Use as the Basis of a
Report
Use
You use this procedure to create further layouts for the evaluation of data in the SAP
Consolidation component, in addition to the journal entry layouts offered in the Standard System
[Page 419].

Prerequisites
Your need for information exceeds the layouts available in the standard system.

Procedure
1. In the Consolidation Implementation Guide choose the section Define Journal Entry
Layouts [Ext.] and follow the procedure which is described there.

2. In the Consolidation application menu choose: Information system → Tools → Journal
entries. You reach the dialog box journal entry report.

3. Select one journal entry report, limit the search by entering further criteria. Here you have
the following choices:

- Organizational units

- Version/Time period

- Technical settings

- Further restrictions

4. Save your entries.

Result
You can use the journal entry layout repeatedly for your journal entry reports.
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Reporting with Interactive Excel
Purpose
This component enables you to evaluate current data from a SAP System or Microsoft Access
database in user-defined reports, as shown in the following graphic:

Current
data

Current
data

R/3 Offline data entry
(Access)

Interactive
Excel

Implementation Considerations
You can use Interactive Excel to create reports on data from the following sources:

•  A central Access or SAP System database (through a network)

•  An Access database residing locally on your PC

Features
•  Flexible definition of reports

Interactive Excel enables you to evaluate data in the following report types:

– Data matrices

– Pivot tables

– Additions to reports, for example charts

In a report, you evaluate financial data for various characteristics and combinations of
characteristics. In order to simplify definition of a report, you can use lists of proposals for
the characteristics predefined in Interactive Excel by accessing master data and control
parameters that exist in a SAP System or Microsoft Access database. However, you are
also free to define your own report or part of a report without using values from Access,
and to apply any formatting that you require.

•  Excel formatting
Interactive Excel is added on to the standard Microsoft Excel application in the form of a
template. It therefore has the advantage of being based on a well-known spreadsheet
program that offers a wide range of formatting functions.
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•  Import of report data
Current data can be imported from a database into a report for the purpose of evaluation.
Data imported from the SAP System originates from the Consolidation totals table.

•  Refreshing of report data
A live link to the relevant database enables report data to be automatically refreshed
after any changes in the report definition (for example a change in the fiscal year). You
also have the option of triggering a refresh at any time, in order to overwrite data in a
report with the up-to-the-minute data from the database.

•  Manual refreshing of pivot tables
If you already created a pivot table for reporting on the data processed in Interactive
Excel, you can refresh the data for the pivot table without having to creating an entirely
new pivot table. To do this, go to Interactive Excel and choose Consolidation → Pivot
table → Refresh.

With this feature, you can flexibly create and adapt your reports to meet your
changing demands.
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Opening a New Workbook with Interactive Excel
Prerequisites
You have installed Microsoft Excel 97 and the Interactive Excel component provided by SAP.

If you open an existing workbook from Excel that has been created using the
Interactive Excel template, the menu option SAP automatically appears. You can use
this to log on to a database connected to the SAP System.

Procedure
1. Start Microsoft Excel.

2. In the Excel menu, choose File →  New. Open the Interactive Excel template by double-
clicking on the SAPActiveX icon in the General group.

3. In the following dialog box, choose Enable macros.

4. Alternatively, the installation can create an Interactive Excel icon in the SAP Systems Start
Menu.

Result
The item SAP is added to the standard Excel menu. You use this to log on to a SAP Systems or
MS Access database.
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Interactive Database Connection
Use
This central function of Interactive Excel enables you to do the following:

•  Save reported financial data from a data entry form to the database

•  Import up-to-the-minute data into reports defined in Interactive Excel

•  Use master data and control parameters stored in the database as value proposals when
defining data entry forms and reports

Prerequisites
You have access to the appropriate database.

Features
Communication Between Interactive Excel and the Database
Data can be transferred between Interactive Excel and a database as follows:

•  You can only save data entered in an Interactive Excel form to an Access database for
the offline data entry program.

•  You can import data from an Access database or a SAP System into an Interactive Excel
report.

Loading of Interface Texts for Interactive Excel
•  When using an Access database for the offline data entry program

 The interface texts for Interactive Excel are stored in the Access database and originate
in the SAP System. You specify the text language when you download master data and
control parameters from the central SAP System into the database.

•  When using a SAP System as a database

The language that you specify when logging on to the SAP System determines the
interface language of Interactive Excel.
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Connecting Interactive Excel to a Database
Prerequisites
You have opened an empty or predefined file that was created using the Interactive Excel
template.

Procedure
Logging On to an Access Database
1. Choose SAP → Logon → MS Access.

In the following dialog box, enter your user name and password for the PC data entry
program and specify the relevant database file and path, if necessary using the Browse
function.

The entries that you make here are saved as defaults for the next time you log on. You
only need to reenter the password.

If an authorization check is active in your database, choose More. Check the default
values in the additional fields and change the Access user name and password if
required.

2. Choose Open.

Logging On to an SAP System
1. Choose SAP → Logon → R/3.

2. Use the standard R/3 logon popup to log on to the R/3 System.

The language that you specify when logging on determines the interface language of the
Interactive Excel component.

Result
You are connected to the database and the item Consolidation for Interactive Excel is added to
the standard Excel menu. Additional functions appear under the menu item SAP.

You can use a workbook with both SAP and Access interchangeably, however each
workbook can only be connected to a single database at a time.
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Creation of Reports on the Basis of Interactive Data
Matrices
Use
You can use this function to create a report in the form of a data matrix, into which current data
can be imported from a database at any time.

Prerequisites
•  You have installed Microsoft Excel 2000 or Microsoft Excel 97 and the Interactive Excel

component provided by SAP.

•  The source database for report data resides either locally on your PC or can be
accessed through your local area network.
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Data Matrix
Definition
User-defined table in Interactive Excel that can function as either a data entry form or as a report.

Use
You can use data matrices for the following purposes:

•  Entering financial data in an Access database for the offline data entry program

The parent in a consolidation group usually decides whether it will define the data entry
matrices for all subsidiaries using Interactive Excel, or whether it will allow the
subsidiaries to define their own matrices.

•  Reporting on the basis of current financial data in a SAP System or Access database for
the offline data entry program

Structure
A data matrix consists of the following elements:

Header Data
Characteristics that are valid for a whole matrix and appear outside the row and column layout of
the matrix. Single values (for example, fiscal year or version) or set aggregations (for example, a
consolidation group consisting of several consolidation units) can be used for these
characteristics. Each characteristic value that is defined as header data fills exactly one cell. The
values that you select are inserted into the sheet in a block, but you can subsequently move
them to a different position.

Constants
Characteristics that are fixed for a whole matrix. You specify these characteristics during matrix
definition, after which they are hidden in the matrix and can not longer be selected during further
definition.

Column Layout
Multiple values or set aggregations for a characteristic, which extend across several columns. A
column layout in a matrix can consist of several rows. These rows do not necessarily have to be
positioned directly beneath one another.

Row Layout
Multiple values or set aggregations for a characteristic, or one or more hierarchies, which extend
across several rows. A row layout in a matrix can consist of several columns. These columns do
not necessarily have to be positioned directly beneath one another.

User-Defined Entries
Empty rows or columns in the column/row layout (in other words where no characteristics are
specified for a whole column/row). In reporting, you can these cells for your own functions, for
example, an Excel formula.
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Data Area
Area directly adjacent to the row and column layouts, in which financial data is entered or report
data displayed.

Interactive Excel must be able to identify the row and column layout before it can
identify a data area. The program cannot distinguish a layout that only covers one
row/column from header data, and therefore cannot identify it as a row/column
layout. If your layout cannot be identified, a message appears asking you to explicitly
indicate the data area.

A Simple Data Matrix and Its Base Elements

Header data

Data area

Row layout
Versions

Column layout

FS item
hierarchy

Partner Transaction
currency

Matrix name :
Aspect :
Cons group :

Report CGA
CS
A

Microsoft Excel - Report Cons Group A.xls Microsoft Excel - Report Cons Group A.xls 
File Edit View Insert Format Tools Data Window Help

B I U

Ready

Fiscal years

Cons C/A :
Ledger :
Key figure :

1997
CS
GV GC CD

If you have created a complex matrix and want to identify the various elements in the
matrix definition, you can choose SAP → Origin of data → Active matrix. This
function marks the row and column layout and the header data on a sheet.
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Creation of a Data Matrix
Purpose
In this process, you create a new data matrix as a data entry form or report, by making settings
that are valid for the whole matrix. You can create several matrices in a single worksheet.

Prerequisites
•  You have opened a workbook that was created using the Interactive Excel template.

•  If you want to use master data and control parameters from the target or source database as
proposals for the definition of characteristic values, you have logged on to the appropriate
database. For more information see Connecting Interactive Excel to an Access Database
[Page 102].

You can define a matrix without using proposals originating from existing master data
and control parameters, however this fully manual procedure involves making extra
definitions, and is therefore more complex.

•  You have selected an aspect for the matrix.

An aspect determines the source or target database for matrix data, for example the SAP
consolidation application from which you want to import data into reports, and whose
master data and control parameters you want to use for the matrix definition.

You cannot change an aspect after it has been selected for a matrix.

Your selected aspect is automatically used as the default for further matrices, which you
process with Interactive Excel, until you change it.

Process Flow
2. You make the following global settings:

Matrix name
If you define several matrices for a single worksheet, you can differentiate between them
by giving them different names.

 Once a name has been assigned to a matrix, you can not change it later.

Debit/credit sign logic
The logic that you select determines the debit and credit signing used for entering data or
displayed when data is imported from a database. The logics supported are shown in the
following table:

Debit/credit sign logic Represents
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Database values Values are entered/displayed as they are saved in the database,
for example assets items as positive (without a sign) and
liabilities/stockholders' equity items as negative (with a minus
sign).

Values as per item sign A value is entered/displayed without a sign if its balance
corresponds with the debit/credit sign set in the master data of
the item/subitem concerned. If the balance is reversed, the
value is entered/displayed with a minus sign.

Example: The balance of a liabilities/stockholders’ equity item is
normally a credit, and therefore the sign — (minus) is set for
those items. However, if a debit balance occurs for this item, a
minus sign is entered/displayed for the value to indicate a
reversed sign.
You can use this logic for balance sheets, for example.

Inverse database values Income statement values are entered/displayed as the inverse
of database values. Each time data is transferred, values are
automatically converted using the database logic.

This logic can be used for an income statement, for example, if
you want to show expenses as negative (with a minus sign) and
revenue as positive (without a sign). This relationship between
positive and negative values enables you to calculate financial
results using standard Excel formulas.

Scaling
Data can be entered/displayed at a specified scaling factor. Scaling of 1, 1,000, or
1,000,000 is possible when you create a matrix. However, you can later change the
scaling factor as required (condition: this must be a scale).

Return units indicator
If you select this indicator, values are displayed with a unit in Interactive Excel reports
(for example currency, unit of measure).

Data entry matrix indicator
You need to set this indicator if you want to use a matrix in order to enter data and run a
preparation for data entry.

Display blank lines indicator
Normally blank lines are also displayed in a data matrix, and therefore the indicator is
selected. Deselecting the indicator suppresses blank lines. You may want to do this to
improve clarity.

Display blank columns indicator
Normally blank columns are also displayed in a data matrix, and therefore the indicator is
selected. Deselecting the indicator suppresses blank columns. You may want to do this
to improve clarity.

Post 0 for blank cells indicator
When you want to write 0 for blank cells, then you have to use this indicator. You can
use this to enter a numerical value in all items.
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Update mode
The update mode specifies how the values of data records, which were posted earlier,
should be treated. You have the following options:

− Delete (all items, all subassignments): all existing data for each object is reset to
zero

− Delete (entered FS items, all subassignments): all existing data for each object in
posted items, is deleted before writing the uploaded data.

− Delete (FS items in the matrix, all subassignments): all existing data for each
object in the matrix, is deleted with all subassignments, before writing the
uploaded data

− Overwrite (entered FS items + subassignments): the existing entries are
overwritten by the uploaded ones (when identical to the item and all
subassignments), other uploaded data is written, otherwise existing settings
remain unchanged

− Divide (overwrite, but total per item remains unchanged): the value, which
already exists in an item, is divided onto the uploaded subassignments, the total
per item remains unchanged. To achieve this, an automatic offsetting entry is
generated on the respective default subassignment.

The function Divide is currently restricted to the subassignment Partner.

3. You specify global characteristic values.

You can specify single values or set aggregations as characteristic values for a matrix
header. To do this, you can use master data and control parameters in the source/target
database as proposals.

If a characteristic value is valid for an entire matrix, you can flag it as a constant. The
value is set in the background, and the characteristic is no longer available for definition,
thereby reducing the number of characteristics that are listed.

You can find out which characteristics are set as a constant and undo this setting at
any time. For more information, see Make Global Settings for a New Data Matrix
[Page 433].

If a particular characteristic is irrelevant for your matrix, you can mark it as a constant
without assigning a value. It will then be inactive and no longer offered for selection.

If you subsequently change a characteristic value in a report matrix when connected
to a database, the matrix is automatically refreshed with appropriate database data.
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Making Global Settings for a New Data Matrix
Prerequisites
You have opened a workbook that was created using the Interactive Excel template.

Procedure
3. Place the cursor on a cell that you want to form the upper left corner of the matrix header

data.

4. Choose Consolidation → Data matrix → New.

The settings of existing matrices are copied as default values into your matrix.

A dialog box appears, in which you are shown the Preset Characteristics (= global
parameters). You have the possibility to deactivate some parameters.

4. On the Settings tab page, enter a name for your matrix and specify the following parameters:

− A debit/credit sign logic

− A scaling factor for data

− Whether you want to enter values with units or display units for imported data

− Whether the matrix is a data entry matrix

− Whether blank lines should be displayed

5. On the Characteristics tab page, specify values for characteristics that are valid for the whole
matrix as follows:

f) Select a characteristic in the upper part of the dialog box.

g) Determine the characteristic type for the value. You can define the value as either a
single value or a set aggregation.

h) Use the arrow button next to the bottom field to display a list of possible values. Select
one of these values.

i) Set the Constant flag if a characteristic is valid for the whole matrix and you do not want
it to appear in the sheet.

j) Choose Confirm to complete your definition of the characteristic.

− If you want to change the value selected for a characteristic, position the
cursor on the characteristic, select a new value from the list of possible
values, and choose Confirm.

− If you want to remove the value selected for a characteristic, position the
cursor on the characteristic, select the empty entry at the top of the list of
possible values, and choose Confirm.

6. Repeat step 4 until you have specified all the characteristic values that you require. Then
choose OK.
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Result
•  The relevant characteristic vales are inserted as a block at the cursor position, unless you

specified them as constants, in which case they are invisible. General information, for
example user, scaling factor, and aspect are also inserted.

•  Header data can be formatted, moved, or deleted after being inserted into a worksheet. All
global settings except for the matrix name and aspect can be changed after insertion.

•  You can check your settings and make changes at any time by choosing Consolidation →
Data matrix → Change and the Settings tab page.

In this way, you can find out which characteristic values are flagged as constants and
therefore do not appear on the sheet. You can also remove the Constant flag for a
characteristic value.

•  For more information about changing values, see Changing Characteristic Values [Page
448].

•  You can preset the settings for new data matrices. To do this choose Settings  → Global
Parameters → Preset Characteristics. In exactly the same way, you can copy the settings of
already existing matrices as default values.
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Definition of a Matrix
Purpose
n this process, you define the row and column layout of a data entry form or report matrix by
arranging characteristics and characteristic values on a worksheet.

Prerequisites
You have completed the process Creation of a Data Matrix [Page 430], in which you make basic
settings for your matrix.

Process Flow
1. You define characteristic values and insert them into the worksheet as a row and column

layout.

You can specify characteristics and their values in the following ways:

•  By manually inserting them in the matrix

•  By selecting them from proposal lists that are generated from master data and
control parameters in the database

The advantage of selecting values from lists of proposals is that the reference of the
cell in which a characteristic value is located is automatically recognized by
Interactive Excel, and does not need to be explicitly specified. For more information
see Determination of Values for Characteristics [Page 451].

If you use proposals, you can display either the key, the short or long text, or everything,
in the matrix. If, in addition to the key, you use the long text, the long text automatically
changes if you choose a different characteristic value by entering a new key.

The following types of characteristics can be used to define the matrix layout:

•  Single values
 You can arrange these in sequence, either horizontally or vertically.

•  Set list
 A series of single values arranged in sequence, either horizontally or vertically.

•  Set aggregation
 A single entry in the matrix definition that summarizes data for all set entries.

•  Hierarchy
A series of single values arranged vertically with a structure of up to 8 levels.

You can insert an unlimited number of single values, sets, and hierarchies into your data
matrix, and subsequently delete, move, format, or change them.

When you insert a single value or set aggregation into a cell on the sheet, a help function
for values is automatically set for this cell. You can display a list of possible values for the
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characteristic by positioning the cursor on the cell and using the function button that
appears. This function enables you to change a characteristic value quickly and easily.

If you subsequently change a characteristic value in a report matrix when connected
to a database, the matrix is automatically refreshed with appropriate database data.

•  Certain characteristics are dependent on others. When you define
characteristics, you should take this into account, since the value you set for
one characteristic could determine the values that Interactive Excel proposes
for a second characteristic.

When you use the Consolidation menu in Interactive Excel to set values for
characteristics that you want to insert into a matrix, you need to define any
delimiting characteristics before a proposal list can be generated.
•  Before you can prepare a matrix for data entry, you need to define all

required characteristics.

The following table shows the characteristics supported by Interactive Excel, and their
dependencies:

Characteristic Characteristic
required

In SAP dependent
on...

In Access dependent
on...

Dimension X

Cons chart of accounts X

FS item X Cons chart of
accounts

Cons chart of
accounts

Version X

Fiscal year X

Period X
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Consolidation group

•  Single value

•  Attributes

•  Hierarchy

Characteristic
required, if:

- no ledger or
- no
consolidation
unit or
- consolidated
data
(posting level
30)

•  Dimension

•  Dimension

•  Version

•  Fiscal year

•  Dimension

•  Version

•  Fiscal year

•  Period

•  Dimension

•  Dimension

•  Version

•  Fiscal year

./.

Consolidation unit

•  Single value

•  Attributes

•  Set

•  Hierarchy

Characteristic
required, if no
cons group •  Dimension

•  Dimension

•  Fiscal year

•  Dimension

•  Fiscal year

•  Period

•  Version

•  Dimension

•  Fiscal year

•  Period

•  Version

•  Dimension

•  Dimension

•  Fiscal year

•  Dimension

•  Fiscal year

•  Period

•  Dimension

•  Fiscal year

•  Period

•  Version

Partner unit

•  Single value/Set

•  Attributes

•  Dimension

•  Dimension

•  Fiscal year

•  Dimension

•  Dimension

•  Fiscal year

Key figure X

Subitem category

Subitem Subitem category Subitem category

Unit of measure
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Year of acquisition

Custom characteristic

Transaction currency

Document type Dimension Dimension

Ledger Characteristic
required, if no
cons group

Reference version

Reference fiscal year

Reference period

Posting level Key figure

Data is aggregated for characteristics without a defined value. If, for example, a
receivables item has a breakdown by trading partner and transaction currency and
you do not specify a value for the trading partner breakdown, the sum of all data
records with a trading partner assignment is calculated (reporting) or must be
entered (data entry) for this item. If a row or column contains no specified
characteristics, it can be used for a user-defined entry, for example an Excel formula.

3. You have the option of displaying additional information for certain characteristics in any cell,
in the form of an attribute.

You can display the debit/credit sign of a financial statement item or the currency,
text, or language of a company. This additional information is irrelevant for the import
(reporting) and export (entry) of data, since it has no influence on the matrix
definition.

6. You make sure that values or value references are set for all the characteristics that you
have defined, so that data can be saved correctly to or imported correctly from the database.

7. You specify any remaining required characteristics and check your global settings.

8. To check the data structure of the data matrix, choose  or Consolidation or SEM → Data
matrix→ Check.
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Specifying Single Values
Prerequisites
You want to use a list of proposed values to define a characteristic as a single value and insert it
into the matrix.

Procedure
3. Place the cursor on the cell in which you want to insert a characteristic value.

4. In the Interactive Excel menu, choose Consolidation → Single values and the characteristic
you require.

A dialog box appears with a list of values for the characteristic. Depending on the
characteristic that you are defining, values for other characteristics that you have already
specified, and on which the values in the proposal list are dependent, may appear in
fields at the top of the box.

You may want to specify a value for a characteristic that is dependent on the values
of characteristics that you have not yet specified. In order to generate a list of valid
proposals, you need to specify these delimiting characteristic values An example of a
delimiting characteristic value is the consolidation chart of accounts, which
represents a compound of the characteristic FS item. Only after you have made this
specification is a value list displayed.

If a list is very long, first a condensed form of the list is displayed, which you can
selectively expand as desired.

6. Select one or more values. You can use Windows selection functions to select multiple
values (CTRL + mouse click) or blocks of values (SHIFT + mouse click). You can also use
the search function by ID values or long texts, in order to go to its position in the list. In
addition to that, you can position on a value using   .

7. If you want to insert more than one single value, specify how you want them to be arranged
on the sheet.

8. Choose OK.

Result
The values are inserted at the cursor position, either beside or beneath each another (depending
on the alignment selected).

If you select multiple values, these are inserted in the sequence in which they are listed in the
database.

Single values can be formatted, moved, deleted or changed after insertion into a worksheet.

You can define multiple single values in a single step.
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Specifying Sets
Prerequisites
You want to use a list of proposed values to define a characteristic as a set and insert it into the
matrix. Sets with the following characteristics are offered: consolidation unit, FS item, transaction
currency.

Procedure
4. Place the cursor on the cell in which you want to insert the first entry in the set.

5. In the Interactive Excel menu, choose Consolidation → Sets and the characteristic you
require.

A dialog box appears with a list of values for the characteristic. Depending on the
characteristic that you are defining, values for other characteristics that you have already
specified, and on which the values in the proposal list are dependent, may appear in
fields at the top of the box.

You may want to specify a value for a characteristic that is dependent on the values
of characteristics that you have not yet specified. In order to generate a list of valid
proposals, you need to specify these delimiting characteristic values. Only after you
have made this specification is a value list displayed.

If a list is very long, first a condensed form of the list is displayed, which you can
selectively expand as desired.

6. Select one or more sets. You can use Windows selection functions to select multiple values
(CTRL + mouse click) or blocks of values (SHIFT + mouse click). You can enter a value ID
(in the form of the field name) in order to go to its position in the list. You can also use the
search function by ID values or long texts to go to their position in the list. In addition to that,
you can position on a value using  .

4. Determine the following:

− How the set entries should be arranged on the sheet (in the case of a set list or
multiple set aggregations)

− Whether the ID and/or short text and/or long text of the characteristic should be
displayed

− Whether the set is a list set or a set aggregation

5. Choose OK.

Result
•  Set list

The relevant set entries are inserted at the cursor position, either beside or beneath each
another (depending on the alignment selected).
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Set entries are inserted in the sequence in which they are entered in the set.

•  Set aggregation
Only one entry is inserted into the worksheet. This entry represents the sum of all entries
in the set.

Sets can be formatted, moved, deleted or changed after insertion into a worksheet.
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Specifying Hierarchies
Prerequisites
You want to use a list of proposed values to define a characteristic as a hierarchy and insert it
into the matrix. You can specify hierarchies for the following characteristics:

•  Consolidation group

•  Consolidation unit

•  Partner unit

•  FS item

Procedure
1. Place the cursor on the cell in which you want to insert the first entry in the hierarchy.

If a list is very long, first a condensed form of the list is displayed, which you can
selectively expand as desired.

2. In the Interactive Excel menu, choose Consolidation → Hierarchies and the characteristic
you require.

A dialog box appears with a list of values for the characteristic. For example, here you
can choose consolidation unit.

If a list is very long, first a condensed form of the list is displayed, which you can
selectively expand as desired.

3. Select one or more hierarchies. You can use Windows selection functions to select multiple
values (CTRL + mouse click) or blocks of values (SHIFT + mouse click). You can enter a
value ID in order to go to its position in the list.

4. Choose SAP → Settings, and determine

− Whether you want hierarchy levels to be indented when inserted into the worksheet,
and whether the column width should be automatically adjusted to fit the contents

− How many hierarchy levels (up to 8) should be expanded when the hierarchy is
inserted into the worksheet

− Whether a color should be applied to the hierarchy

− Whether the ID and/or short text and/or long text of the characteristic should be
displayed

You can also change these settings by using the context menu and a right mouse click.

5. Choose OK.
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Result
The relevant hierarchy is inserted at the cursor position, with the specified formatting. All
hierarchy entries are inserted, regardless of the number of levels that are expanded.

You can change the color format and indent of the individual levels by choosing SAP → Settings.
Your settings are saved locally and are therefore only computer-specific.

You can format, move, delete or change hierarchies after insertion into a worksheet. In exactly
the same way you can update the hierarchies at any time.

If you want to delete a hierarchy, choose SAP → Delete hierarchy. You thereby ensure that the
layout, values, and formatting for a hierarchy are completely removed from the worksheet.
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Specifying Attributes
Prerequisites
You have specified header data for your matrix. You may have also defined the matrix layout.
You now want to insert an attribute into the matrix to provide additional information about a single
value, set entry or hierarchy entry. An attribute is not part of the information required for
communication between Interactive Excel and the database. Possible attributes are supplied by
SAP as well as further custom characteristics.

The information that can be provided by an attribute depends on the characteristic, for example a
debit/credit sign or short text can be inserted for a financial statement item.

You cannot insert attributes for a set aggregation, since this characteristic has
multiple values.

Procedure
1. Place the cursor on the cell in which you want to insert an attribute.

2. Choose Consolidation → Attribute and then the relevant characteristic.

A modeless dialog box appears in which you specify the relevant characteristic value.

3. Place the cursor on the cell in which the ID or long text for the value is located.

The cell reference is displayed in the field. Choose OK.

By entering an area, you can also display the attributes for all of the fields within the
area.

4. In the next dialog box, select an attribute and choose OK.

You may want to specify an attribute for a characteristic that is dependent on the
values of characteristics that you have not yet specified. In order to generate a list of
valid attributes, you need to specify these delimiting characteristic values. Only after
you have made this specification is a list of attributes displayed.

Result
The attribute is inserted at the cursor position, and can be subsequently formatted, moved,
deleted, or changed.

You can use the procedure described above to change an attribute that you have already
defined. When you change an attribute, you need to confirm that you want it to be overwritten
with new data.
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Working with Structures
Prerequisites
You want to process characteristics with structures. Structures are available in Interactive Excel
for all the hierarchies and sets.

Procedure
In the Interactive Excel menu choose Consolidation →  Structures → Update or  →
Change/Combine/Detach. You have the following options:

Update structure You can update the structure, in order to supply it with current data from
the SAP System.

Change structure Here you have the following options:

- Only compile the area of definition: only the cells which belong to the
area of definition of the matrix, are processed/deleted

- Compile matrix area: all cells can be processed/deleted, which either
belong to the are of definition or to the output area of the matrix

- Compile complete rows/columns: complete rows or columns are
always processed

- You can also select a different hierarchy or a different set for the
structure To do this, press Edit, select the structure to be changed and
change it

With this option you can activate and/or deactivate the automatic update
using 

Combine structure You can combine several structures for different characteristics The values
of all combinations are multiplied through all levels.

For example, this applies to all breakdowns, to sets with consolidation
units, transaction types, transaction currencies.

Detach structure You can detach various combined structures.

Delete structure You can delete structures, for example the structure of the consolidation
units.

Result
By working with structures, you can make the dataset clearer and in particular easier to evaluate.
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Changing Characteristic Values
Prerequisites
You want to change some or all of the values that you have already specified for characteristics
in a matrix. To do this, you can use one of the procedures described below.

Procedure
Changing Values Manually in a Matrix
Change the existing values by typing over them.

Changing Values by Means of Proposal Lists
Two procedures are available for changing values by means of proposal lists:

•  By a selection list:

e) Place the cursor on the cell you want to change.

f) When sets and/or single values, choose a value from the dropdown menu, for example
the name of a specific consolidation unit. You can change hierarchies via the menu,
because there is no dropdown menu for hierarchies.

g) If a dropdown menu appears, click on the desired value.

h) Choose OK.

•  Using Interactive Excel, from where you go to the application menu for Consolidation:

f) Place the cursor on the cell in which the characteristic you want to change is located.

g) Choose Consolidation and then the relevant characteristic type and the characteristic.

h) When prompted, confirm that you want the existing value to be overwritten.

i) A dialog box appears with a list of values for the characteristic.

j) Select the appropriate value, check that the display format is correct and choose OK.
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Additional Settings
Use
Under SAP →  Settings, you can make several formatting settings and general setting for your
work with Interactive Excel.

Features
Formats for Hierarchies
You can change the color of the individual levels and their indent level. Your settings are saved
locally and are therefore computer-specific.

Formats for Matrix Cells
You can define different formats for the following cells:

•  Cells that cannot be used for data entry (for example totals items or invalid
characteristics)

•  Cells that can be used for data entry

•  Report cells into which data is imported

These settings are valid for the entire workbook.

You choose Change for the relevant cells, and a standard Excel dialog box appears. In this box,
you define the formats that you want to use.

The default format template for Interactive Excel is set, and should be sufficient for your needs.
However, you can choose a different template as required.

Settings
Shortcut Key for Possible Entries Function
When you insert a single value or set aggregation into a cell, a possible entries function is
applied to the cell. You can use the button to the right of the cell to display a list of possible
values.

The key combination STRG + h is set as default for this function, should you prefer to use the
keyboard rather than the mouse. However, you can set a different key combination if desired.

Always read values manually
Choose this setting, when you want to prevent data being automatically read from the SAP
System.

Changed matrix data is normally automatically read again from the SAP-System. You can stop
this, for example, when you want to create varied valuations on the basis of data from a key date,
using Interactive Excel.

When you have activated this option – that means only allowing the manual update – every time
you log onto Interactive Excel, you receive a system message informing you that the automatic
update is deactivated.
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Define Font
If desired, you can change the font used for displaying the interface texts (dialogs) in Interactive
Excel. Follow these steps::

4. Choose menu item SAP.

A dropdown menu appears.

5. Choose Settings.

A list of options is displayed.

6. Choose the tab Font.

You can choose either a fixed-width font or a proportional font, for which there are further
choices available. You can display sample texts.

Global Settings
Here your selected global parameters, which you work with in the SAP system, are listed and can
also be changed by you interactively.

Default Settings
You can use the function SAP defaults to restore the predefined settings for Interactive Excel.

Activities
Make your desired settings at menu item SAP → Settings.
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Determination of Values for Characteristics
Use
The link between the database characteristics and the characteristics available in Interactive
Excel is pre-programmed. Your assignment of characteristic values in a matrix to the preset
Interactive Excel characteristics enables data to be transferred between the correct database
fields and matrix fields.

You can identify a characteristic value by entering one of the following:

•  A cell reference

•  A single value

If you use master data and control parameters from a database as proposals when defining
characteristics, the value reference of characteristic is automatically set. This reference is
automatically adjusted when a characteristic is moved to a different location on a sheet.

However, you need to manually specify the value or value reference for characteristics that you
have defined as follows:

•  By manual insertion in a matrix, outside a list of set entries or a hierarchy

•  By copying and pasting from another matrix

It is helpful to specify missing values or missing value references after you have completed the
definition of a matrix. To do this, the Interactive Excel menu choose Consolidation → Data matrix
→ Change, then specify the missing values.
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Specifying a Value/Value Reference for Characteristics
Prerequisites
A characteristic value or the cell reference of a characteristic value has not yet been specified, for
example if you manually inserted the characteristic into your matrix.

Procedure when Using Detailed Menu
1. Choose Consolidation → Data matrix → Change.

2. On the tab strip in the following dialog box, choose Optional characteristics and select the
appropriate characteristic.

3. Enter one of the following in the Value/Value reference field.

– A single value

If the ID of the single value is identical to a possible cell coordinate, for example a
transaction type with the ID B10, you need to enter the value preceded by an
apostrophe, for example, B10.

– A cell reference, for example, B3

– A cell reference, by clicking on the button to the right of the entry field

A dialog box appears. When you drag the cursor over the appropriate matrix area on
the worksheet, its coordinates appear in the dialog box field. Use the function button
next to the co-ordinate field in order to confirm your entry.

4. Choose Confirm, to complete your selection.

5. Once you have specified all values and value references, choose OK.

If a required characteristic has not yet been defined, a warning message appears. In this case,
choose Consolidation → Data matrix → Change and define the appropriate characteristics on the
Reqd char. tab strip. Then choose OK.

Procedure when Using Context Menu
4. Select one or more fields, by marking it/them, for example the FS item.

5. Right mouse click

6. Choose SAP → Item or a characteristic that you have chosen instead.

Result
Cell Reference
An assignment is created between a characteristic on the worksheet and a characteristic preset
in Interactive Excel. The cell reference of a characteristic is automatically adjusted if you move
the characteristic to a different location on the sheet.

Single Value
The characteristic is invisible on the sheet, as is the case for all constants.
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Identifying the Area for Data Input/Output
Use
Before it can import data into or export data from a matrix, Interactive Excel must be able to
identify the data area in the matrix. The data area in a matrix is adjacent to the column and row
layout, and consists of cells relating to these layouts. For a simple graphic showing the different
elements of a matrix definition, see Data Matrix [Page 427].

If you define a matrix in which the row and column layouts and their respective cells are
unambiguous, Interactive Excel automatically recognizes the data area.

If a layout only occupies a single row or column, it can be confused with the header data and is,
therefore, not recognized as a row or column layout. In this case, you are prompted to explicitly
specify the data area at the following events:

•  After you have saved a matrix definition that you have changed by choosing
Consolidation → Data matrix → Change.

•  If you choose Consolidation → Import data in order to fill a matrix with data.

You have inserted a hierarchy of consolidation items in the row layout of a matrix and
a version in the column layout. Interactive Excel cannot identify the data area
because it does not recognize a layout that only contains one characteristic value.

Activities
1. Select the data area by dragging the cursor over the sheet.

2. Select Choose to the right of the coordinate field to confirm your entry.

3. Choose Confirm.
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Creation of Further Matrices
Use
When you create an additional matrix, global characteristic values set for the initial matrix are
automatically proposed for the header data.

Features
When you create an additional matrix, global characteristic values set for the initial matrix are
automatically proposed for the header data. This minimizes the effort required for defining two or
more matrices with similar or identical header data.

Activities
You create an additional matrix in the same way as the initial matrix, by choosing Consolidation
→ Data matrix → New.

You select the values that you want to copy. A value is selected when the field to its left is
checked. Once you have confirmed your selections, a further dialog box appears for you to
define other global settings.
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Deleting a Matrix
Prerequisites
Use this procedure to completely remove a data matrix definition from a worksheet and reset all
settings made for the matrix.

Procedure
1. Choose SAP → Delete matrix.

2. A dialog box appears. There are two ways of identifying the data to be deleted: (a) You can
enter the name of the matrix to be deleted. (b) You can select the area to be deleted by
dragging the cursor over the appropriate matrix area on the worksheet, after which its
coordinates appear in the dialog box field. Use the function to the right of the field to confirm
the coordinates of the fields to be deleted.

3. Click OK to delete the selected area.
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Creation of Reports on the Basis of Pivot Tables
Use
You can use this function to create a report in the form of a standard Excel pivot table, into which
you can import current data from the database as required.

The data in a pivot table can be reorganized interactively in order to summarize it in different
ways.

Prerequisites
•  You have installed Microsoft Excel 2000 or Microsoft Excel 97 and the Interactive Excel

component provided by SAP.

•  The source database for report data resides either locally on your PC or can be
accessed through your local area network.

Features
Interactive Structuring of Reports
Pivot table reports are extremely flexible in their layout. Characteristics are inserted into the sheet
in the form of field buttons that you can drag between the header, rows, and columns, as
required.

Multiple Dimensions
Flexible restructuring of pivot tables enables data to be summarized in different ways.
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Definition of a Pivot Table or a Pivot Chart with Excel
2000
Use
You can use this function to define the basic layout of a pivot table. You define a pivot table by
specifying characteristic values and determining where they should appear when the table is
inserted into the worksheet.

However, you can also interactively rearrange data in the table at any time, using standard Excel
pivot table functions.

Prerequisites
You have opened a workbook that uses the Interactive Excel template.

Features
Specification of Characteristic Values
You can enter the following types of characteristics in a pivot table:

•  Single value

•  Set list
 A list of single values is inserted.

•  Hierarchy
 A list of single values is inserted (without structuring into levels). Only the hierarchy
pages are used.

•  Characteristic without a value
 Data is aggregated for characteristics without a defined value.

 Location of a Characteristic in a Table
•  Row/column layout

 The characteristic values you select are inserted across the rows and/or down the
columns of the table. You can subsequently change their position as required.

•  Header data
 Constant data is displayed as header data.

Specification of Debit/Credit Sign Logic
The logic that you select determines the debit/credit signs displayed when data is imported from
a database. The logics supported are shown in the following table:

Debit/credit sign logic Procedure
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Database values Values are entered/displayed as they are saved in the database,
for example assets items as positive (without a sign) and
liabilities/stockholders' equity items as negative (with a minus
sign).

Values as per item sign A value is entered/displayed without a sign if its balance
corresponds with the debit/credit sign set in the master data of
the item/subitem concerned. If the balance is reversed, the
value is entered/displayed with a minus sign.
Example: The balance of a liabilities/stockholders’ equity item is
normally a credit, and therefore the sign — (minus) is set for
those items. However, if a debit balance occurs for this item, a
minus sign is entered/displayed for the value to indicate a
reversed sign.
You can use this logic for balance sheets, for example.

Inverse database values Income statement values are entered/displayed as the inverse
of database values. Each time data is transferred, values are
automatically converted using the database logic.
This logic can be used for an income statement, for example, if
you want to show expenses as negative (with a minus sign) and
revenue as positive (without a sign).  This relationship between
positive and negative values enables you to calculate financial
results using standard Excel formulas.

You should use the logic of absolute values with caution. Totals can be automatically
calculated for header characteristics in pivot tables, and if you use this logic, totals
will invariably be incorrect.

You can create a pivot chart in Excel 2000 with the indicator pivot diagram and the
selection of the diagram category.
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Defining a Pivot Table
Procedure
1. In the Interactive Excel menu, choose Consolidation → Aspects.

In the next dialog box, select the appropriate aspect and choose OK.

2. Place the cursor on a cell that you want to form the uppermost left corner of the table.

3. Choose Consolidation → Pivot table → New.

4. Specify characteristics and values for selected characteristics as follows:

− Select a characteristic in the upper part of the dialog box.

− Determine the characteristic type for the value. You can define a value as either a
single value, a set, or a hierarchy.

− Use the value help in the form of an arrow button next to the bottom field to display a
list of possible values for the selected characteristic. Select one or more of these
values.

There are two special functions available:

If you want to choose all of the possible values for a characteristic into the table, select
the asterisk from the list.

If you do not want to choose any values for a characteristic, leave the field blank.

− Determine the position in the pivot layout at which the characteristic should be
inserted when the table is generated. You have the following possibilities to choose
from: rows, columns, header, constant.

− Choose Confirm to complete your definition of the characteristic.

If you want to change the value selected for a characteristic, position the cursor on the
characteristic, select a new value from the list of possible values, and choose Confirm.

If you want to remove the value selected for a characteristic, position the cursor on the
characteristic, select the empty entry at the top of the list of possible values, and choose
Confirm.

5. Repeat step 4 until you have specified all the characteristic values that you require. Then
choose OK.

6. In the tab page, specify the debit/credit sign logic settings for the table.

7. Give the pivot table a name.

8. Decide whether you want the output in the form of a pivot diagram.

9. If you decide in favor of the pivot diagram form, you need to decide on the following display
formats: bar chart, pie chart or a line chart
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Result
•  Display options

In Excel 2000 you can choose between a chart or a diagram as the display format.

•  Matrix layout is inserted
A field button is inserted for each characteristic.

•  Values are imported from the database
When a layout is inserted into a sheet, its data area is automatically filled with data from
the database. This data is temporarily stored in the background.

•  Pivot functions are activated
In pivot tables, the inserted report data is automatically totaled. Other pivot functions
(such as the dynamic report layout) are also available.

You can change the layout of the table by repositioning the field buttons.

The characteristic values that you specify during your definition cannot be
subsequently changed once the table has been generated.

You can your pivot table by choosing Consolidation → Pivot table → Change.
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Additional Settings
Use
Under SAP →  Settings, you can make several formatting settings and general setting for your
work with Interactive Excel.

Features
Formats for Hierarchies
You can change the color of the individual levels and their indent level. Your settings are saved
locally and are therefore computer-specific.

Formats for Matrix Cells
You can define different formats for the following cells:

•  Cells that cannot be used for data entry (for example totals items or invalid
characteristics)

•  Cells that can be used for data entry

•  Report cells into which data is imported

These settings are valid for the entire workbook.

You choose Change for the relevant cells, and a standard Excel dialog box appears. In this box,
you define the formats that you want to use.

The default format template for Interactive Excel is set, and should be sufficient for your needs.
However, you can choose a different template as required.

Settings
Shortcut Key for Possible Entries Function
When you insert a single value or set aggregation into a cell, a possible entries function is
applied to the cell. You can use the button to the right of the cell to display a list of possible
values.

The key combination STRG + h is set as default for this function, should you prefer to use the
keyboard rather than the mouse. However, you can set a different key combination if desired.

Always read values manually
Choose this setting, when you want to prevent data being automatically read from the SAP
System.

Changed matrix data is normally automatically read again from the SAP-System. You can stop
this, for example, when you want to create varied valuations on the basis of data from a key date,
using Interactive Excel.

When you have activated this option – that means only allowing the manual update – every time
you log onto Interactive Excel, you receive a system message informing you that the automatic
update is deactivated.
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Define Font
If desired, you can change the font used for displaying the interface texts (dialogs) in Interactive
Excel. Follow these steps::

7. Choose menu item SAP.

A dropdown menu appears.

8. Choose Settings.

A list of options is displayed.

9. Choose the tab Font.

You can choose either a fixed-width font or a proportional font, for which there are further
choices available. You can display sample texts.

Global Settings
Here your selected global parameters, which you work with in the SAP system, are listed and can
also be changed by you interactively.

Default Settings
You can use the function SAP defaults to restore the predefined settings for Interactive Excel.

Activities
Make your desired settings at menu item SAP → Settings.



Consolidation (EC-CS)  SAP AG

Reporting for Specific Data Categories

464 April 2001

Reporting for Specific Data Categories
Use
You can import financial data for a combination of the following parameters by specifying an
appropriate key figure:

•  Valuation

− Local requirements (reported financial data)

− Group requirements (standardized financial data)

− Consolidated data

•  Currency or quantity

− Local currency

− Group currency

− Transaction currency

− Quantity

•  Input type

− Periodic

− Cumulative

You select the key figure CV GC CD (consolidated data, group currency,
cumulative).

Activities
When you define a data matrix or pivot table, you specify the data category for your report data
by setting the appropriate key figure as a global characteristic value.
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Job
Use
You use a job to report on a workbook by several values of a characteristic. The following values
are possible:

•  single value

•  hierarchies

•  sets

•  attributes

Jobs are defined, changed or deleted in the Job Manager found in Interactive Excel at SAP →
Job Manager → Define/Change.

Structure
To define a job, you can choose from a list of characteristics, such as dimension, consolidation
chart of accounts, fiscal year, consolidation unit, key figure. For each characteristic you choose,
you can choose one of the values listed under Use. For example, these might encompass a key
figure and a single value. Afterwards, you name an Excel macro.
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Refreshing of Report Data
Use
This function enables you to overwrite data in an Interactive Excel matrix report with up-to-the
-minute data from a database. Data can be imported into one or more reports via an interactive
connection to a SAP System or Microsoft Access database.

Prerequisites
•  You have opened an Interactive Excel workbook in which a matrix report is defined.

•  You have logged on to a SAP System or Access database for the offline data entry
program.

Features
Automatic Refresh
Whenever you change characteristics and their values in your report definition, report data is
automatically refreshed You can activate and deactivate the automatic update of data, using the
menu option SAP → Refresh values automatically.

The automatic refresh function cannot be used for a pivot table, since a pivot table
definition cannot be subsequently changed.

Report data is not automatically refreshed when data in the database is modified.
However, each time you log on to a database you are asked whether you want to
refresh report data.

Manual Refresh
You can also import the latest database data into a matrix without having to change the matrix
definition. In this case, you need to trigger the refresh manually. This ensures that no undesired
changes are made to report data.

You can refresh a single matrix, a pivot table, a worksheet, or an entire workbook.

Activities
•  After you have changed a matrix definition, data is refreshed automatically when you

choose ENTER.

•  To refresh report data in a data matrix, choose Consolidation → Import data and select
the relevant report area.

•  To refresh report data in a pivot table, choose Consolidation → Pivot table → Refresh.
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Before you refresh one of several reports on a sheet, you need to make sure that the
relevant report is selected. As the last items in the menu item Consolidation, the
names of all the reports on the sheet are listed for selection with the currently
selected report marked. Only one report can be selected at a time.
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Information About the Origin of Data
Use
This function provides you with important information regarding the current status and the origin
of data in a data matrix, pivot table, or individual cell on a worksheet.

Features
Origin of Data in a Matrix
You can display and, if required, insert the following information into the worksheet at the cursor
position:

•  The characteristics used in the matrix and their values

•  The logon user name with which data was imported

•  The database from which data was imported

•  The date on which report data was last refreshed

•  The scaling factor

•  Further technical information

The following functions are also available in the documentation dialog box:

•  Highlighting of cells blocked for data entry

The blocked cells are marked with a color.

•  Demarcation of the data matrix definition

The various elements in the matrix definition are highlighted on the worksheet.

The relevant cells are marked until you choose another function. However, you can print out a
copy of the sheet with this information displayed before you continue.

Origin of Data in a Cell
You can display and, if required, print information about the parameters for the data in a cell. You
may want to do this, for example, if you cannot establish the origin or data in a cell from the
characteristic values that appear in the sheet.

If data has been calculated using an Excel formula, the formula is displayed.

Data that has been typed directly into the sheet is identified as a constant.

Activities
To display information about the origin of data, choose SAP → Origin of data → Current matrix or
Cell.

Alternatively you can get information about the origin of data by using the context menu SAP →
Origin of Data.
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Report Lock
Use
You can use this security function to protect a report against changes by unauthorized persons.

Features
Workbook Lock
This function locks an entire workbook so that no changes can be made to the row and column
layout. It thereby prevents an automatic refresh of data that could result from such changes.

You can still do the following, even with the lock in place:

•  Import current data from the database

•  Change characteristic values in the header data

Lock with Signature
When you lock a workbook, you can insert a signature box at the cursor position. This box
contains information about the lock and the dates on which report data was refreshed.

Activities
•  To lock a workbook without a signature box, you choose SAP → Security → Lock.  To

lock a workbook without a signature box, you choose SAP → Security → Signature.

 You specify a password and enter it again as confirmation. Interactive Excel logs you out
of the database to lock the book.

•  To unlock a workbook, you choose SAP → Security → Unlock.

You enter the appropriate password.
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Creating a Snapshot of a Worksheet or Workbook
Prerequisites
As a security measure, or for test or presentation purposes, you may want to create a copy of a
worksheet or workbook. The data in this copy cannot be refreshed by importing data from a
database.

Procedure
1. Choose SAP → Snapshot → Workbook or Worksheet.

2. In the following dialog box, enter the name of the workbook in which you want to create a
snapshot, or leave the field empty if you want to create the snapshot in a new workbook.

3. Choose OK.

Result
An identical copy of the workbook or worksheet is created in the specified workbook.

This copy cannot be connected to a database.
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Upgrading Workbooks in Interactive Excel
Prerequisites

•  You have received and installed a new version of Interactive Excel. Now you want to
update the template in your Interactive Excel workbooks to make the workbooks
compatible with the new version.

•  You have opened a workbook or several workbooks, which are in the same directory, in
Microsoft Excel with the Interactive Excel template.

Procedure
1. Choose SAP →  Upgrade.

3. In the following Windows dialog box, select one or several Interactive Excel workbook(s) the
template of which you want to update. A prerequisite for this, is that you execute the upgrade
for several workbooks at the same time, and that these workbooks are in the workbook.

Choose Open.

The selected workbooks are upgraded.

The following rule applies here for the derivation of the file name: Enter the desired
directory for the workbook and provide the original file name with a prefix and a suffix, to
make it easily identifiable.

3. Repeat this procedure until you have updated the templates of all the relevant workbooks.
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Archiving
Purpose
You use archiving to remove mass data you no longer need in SAP Consolidation from the
database, and to store it in an archive file where it can still be evaluated.

Integration
The SAP Data Archiving concept is based on the Archive Development Kit (ADK). The ADK
provides the technical basis for the archiving transaction (SARA). To call the archiving
transaction, choose Tools → Administration → Management → Data Archiving, or enter the
transaction code.

Archiving objects for each application component are predefined in the system.

For more information on archiving objects in SAP Consolidation, see Archiving of Consolidation
Totals Records and Journal Entries [Page 474].

See also
Introduction to Data Archiving (CA-ARC) [Ext.].
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Archiving of Consolidation Total Records and Journal
Entries
Use
You use archiving for consolidation totals records and consolidation journal entries to remove
mass data you no longer need in SAP Consolidation from the database. By storing such data in a
database, you can reduce the data volume.

If your database contains a great number of journal entries, you can archive these data records
on a regular basis. If your system has sufficient storage space, you only need to archive your
data records once every fiscal year.

Features
SAP Consolidation has the following archiving objects:

•  CONS_SUM for archiving and deleting totals records

•  CONS_ITEM for archiving and deleting journal entries

With these two archiving objects, you can archive and delete journal entries and totals records
according to your selections in Variant Maintenance [Page 482].

It is not possible to read from the archive or to restore journal entries and totals records to the
database.

Archiving
You can only archive journal entries if

•  the selected period to be archived is closed and

•  the fiscal year immediately preceding the period to be archived has been completely closed.

The first quarter 2000 and all preceding fiscal years are closed.

time

1998 1999 2000
03

current
time

closed

06

Consequently, with quarterly consolidation, you can archive the journal entries from
the first quarter 2000 as well as those from all preceding fiscal years.

Totals records can only be archived if

•  the corresponding journal entries have been archived

•  all periods of the selected fiscal year are closed
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•  the preceding and next to last fiscal year are closed. This means, you cannot archive totals
records from the current and the preceding fiscal year.

For example, if you archive a totals record in May and create new postings in June, the
system creates a new totals record. This would lead to a second totals record for the
same time period, and thus to inconsistencies.

You should only archive totals records, when you do not need them any more for
reporting purposes.

Delete
You have two options for starting the delete operation:

•  You can perform the archiving and then start the delete operation manually.

•  You can specify that the system automatically starts the delete operation once the archiving
session is completed (option Archive and Delete in the processing options [Page 482]).

In both cases, the system first performs the archiving for safety reasons (this means, it writes the
data to an archive file); the system deletes the data from your database only in the second step.

Further Information
You will find additional information in the hints documentation for each action. In the application
menu, choose the symbol , or choose Goto → Hints.
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Authorization Management
Use
If you want to archive data in SAP Consolidation, you need the general authorizations for
archiving.

Features
The system checks the authorization for the programs of an archiving object using an
authorization object (S_ARCHIVE). The Archive Development Kit (ADK) performs this check
when an archive file is opened for the following actions:

•  Writing and

•  Delete
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Customizing
Use
You adjust the parameters having an effect on data archiving in Archiving Customizing.

Prerequisites
You possess the authorization for Customizing.

Activities
Customizing covers the following areas

•  General Customizing (usually performed during installation of the SAP System)

•  Cross-archiving object Customizing [Ext.]

•  Archiving object-specific Customizing [Page 478]
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Archiving Object-Specific Customizing
Use
Here, you can set parameters, which apply only to the specific archiving object (specifically to
CONS_ITEM or to CONS_SUM).

Activities
You can make the following settings by choosing the pushbutton Customizing:

•  Logical file name [Ext.]

•  Size of the archive file [Page 479]

•  File storage to storage system [Ext.]

•  Delete program settings [Page 480]

•  Server selection [Ext.]
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Size of the Archive File
Use
You can specify the maximum size of the archive file during the write run using this parameter.

Features
You can determine the following settings:

•  Maximum size in MB

•  Maximum number of data objects

The first of the values that is reached triggers the creation of a new archive file. If both fields are
left blank, the system only creates one archive file.

SAP recommends the following settings:

− Maximum size in MB: 50-100

− Maximum number of data objects: 0
With these settings, the file size is the only determining factor.

Note that the maximum size of an archive file is limited by the operating system you
use, and also by the storage system, if such a system is used in Content
Management Service.
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Delete Program Settings
Use
Here, you determine the control parameters for the execution of the delete program.

Features
•  For the Test run variant, enter a variant whose parameters are set to test run. In this case, no

data is deleted in the database.

•  For the Production session variant, enter a variant whose parameters are set to production
session. This variant deletes the archived data in the database.

The variants of the delete programs are client-dependent! You therefore have to
configure the variants for each client in which you wish to perform archiving
sessions.

The first time you archive the selected archiving object, you have to maintain the
corresponding test run and production session variants of the delete program completely.

Check if both variants exist. In particular, if the production session variant does not exist,
no data is deleted from the database when the deletion session was started in the
productive system.

If you choose the option Detail log, you obtain a Detail Log [Page 481].

•  If you wish the production session option Archive and Delete to be activated during Variant
Maintenance [Page 482], set the indicator Start automatic. Only then will the system start the
deletion process automatically with the option Archive and Delete.
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Log
Definition
Analysis that is created for each archiving or deletion session, and for each archive file. The log
file lists the number of archiving objects for each table.

Structure
To display the log, choose the pushbutton Spool list in the screen Archive Management:
Archiving Session Overview. Choose Display in the following screen.

The log consists of the following parts:

•  Header
Contains information on the user, the processing options and the start and end times.

•  General section
Lists the number of archived and/or deleted data records.

•  Detail log
If you set the indicator Detail log in Variant Maintenance, you will find here information on
the version, consolidation units, number of archived and/or deleted data records.

You can obtain an overview of the current jobs by choosing Goto → Job overview in
the screen Archive Administration: Initial Screen.
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Variant Settings for Archiving
Use
If you wish to create an archive file, you have to enter an existing variant, or define a new variant.

The variant contains

•  the selection criteria for the totals records or journal entries you wish to archive

•  the processing options (Test run or production session)

•  if desired, the indicator for the detail log

•  if desired, a note (comment) on the archiving session

Features
Criteria for the selection of data records
The system only archives data which fulfills the selection criteria you specified in the variant. The
following selection criteria are available to you:

Selection Criteria

For journal
entries

Required? For totals
records

Required?

Consolidation Dimension X X X X

Consolidation
chart of
accounts

X X X X

Restrictions Fiscal year X X X X

Period X

Version X X

Document
category

X

In the selection screen, you can only enter the main versions. If delta versions exist, the system
automatically archives these at the same time.

Processing options
Here, you can choose between

•  Test run and

•  Production session options

− Archive and

− Archive and Delete
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•  Choose Test run if you only want to simulate the archiving session for the selection criteria
you entered. The system reads the data, but it does not create an archive file, and it does not
delete any  records from your database. You do, however, obtain a log - as in a production
session - with the records that the production session would archive.

•  Choose Archive if you want to start the write program and create an archive file with the
selection criteria you entered. With this option, the system does not automatically delete
records from your database.

You start the deletion run [Page 486] later separately. To do this, select the desired
archive files.

•  Choose Archive and Delete  if you want to start the write program and create an archive file
with the selection criteria you entered. The system then automatically deletes the data
records from the database. However, this is only done once the archiving session completed
successfully.

The option Archive and Delete only works if you set the indicator Start automatic. in
the Settings for delete program [Page 480].

If you did not set the indicator, the system only performs the archiving.

Detail log
If you set this indicator, the system writes an extended log. It contains the number of archived
and deleted records for each version and consolidation unit.

See also: Log [Page 481]

Comment on archiving run
Here, you can enter a personal note (comment) for the variant. It appears in archive
management in the overview of archiving sessions and helps to identify archiving sessions more
easily.
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Archiving Data Using a Variant
Prerequisites
You have maintained the Customizing Settings [Page 477] for archiving (such as the size of the
archive file and the variants for test and production sessions of the delete program).

The specific conditions for archiving journal entries and totals records are fulfilled (for example,
the corresponding periods are closed).
See Archiving of Consolidation Totals Records and Journal Entries [Page 474].

Procedure
1. Choose Tools → System Administration → Administration → Data Archiving, or start the

transaction using the transaction code SARA.

2. In the screen Archive Management: Initial Screen, enter the object name CONS_ITEM (for
journal entries) or CONS_SUM (for totals records), and choose Archive.

3. In the screen Archive Management: Create Archive Files, enter the name of a variant.

The variant contains the selection criteria for the totals records or journal entries of the
consolidation that you wish to archive.

Here, you can create a new variant, or use an already existing variant.

If you wish to create a new variant, enter the name and choose Maintain.

4. In the screen Variants: Change Screen Assignment, choose Continue.

5. In the variant maintenance screen, you

− determine the selection criteria (View, Consolidation Chart of Accounts, Fiscal Year, and
so on),

− determine the processing options (Test run, Archive or Archive and Delete), and

− if desired, choose the option Detail log and enter a note for the variant.

For more information, see Variant Settings for Archiving [Page 482].

Save the variant by choosing Continue.

6. In the following screen, enter the Variant description, and save the variant again.

7. Return to the screen Archive Management: Create Archive Files, and choose Start Date.

8. Specify the start time and save your entries.

9. In the screen Archive Management: Create Archive Files, choose Spool params.

10. Enter the spool parameter information for the archiving session and save your entries.

11. Once you have maintained the start time and the spool parameters, select Execute in order
to start the write program.

In order to display the status of the job you have created, select Goto → Job overview.

Result
The result depends on the processing options you chose:
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•  If you chose Test run, the system reads the data, but it does not create an archive file and it
does not delete any records from the database.

•  If you chose the processing option Archive, the system writes the data records in one or
more archive files according to your selections, but it does not automatically delete any
records from your database.

•  If you chose the procession option Archive and Delete, the system transfers the totals
records or journal entries to one or more archive files. The system then automatically starts
the delete program for each archive file. The delete program once more reads the data to be
deleted from the archive files, and then deletes the data from the databases.

No matter which option you chose for processing, the system always creates a log file [Page
481].
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Deleting Archived Data from the Database
Use
When you choose the processing option Archive and Delete for an archiving session, the
archived data is automatically deleted from the system. However, sometimes it may be
necessary to start the delete program manually.

You create an archive file and start the write program. The data records are copied
to the archive file(s), but the system interrupts processing when the delete program
is already running. In this case, you have to delete the archived data in a separate
step.

Prerequisites
You have maintained the Customizing settings (in particular the Variants for Test and Production
Sessions [Page 480]).

Procedure
1. Choose Tools → System Administration → Administration → Data Archiving, or start the

transaction using the transaction code SARA.

2. In the screen Archive Management: Initial Screen, enter the object name CONS_ITEM (for
journal entries) or CONS_SUM (for totals records), and choose Delete.

3. In the screen Archive Management: Execute Delete Program, choose Test run if you wish to
start the delete program in test mode. (In test mode, no data records are deleted from the
database.)

Choose Archive Selection.

The system produces a list of files that contain already archived data.

4. Select the archive files which are to be deleted from your database.

Return to the previous screen.

5. Choose Start date.

6. Enter the start time for the delete program and save your entries.

Return to the previous screen.

7. Choose Spool params.

8. Enter the spool parameter information for the delete program and save your entries.

Return to the previous screen.

9. In the screen Archive Management: Execute Delete Program, choose Execute to start the
delete program.

Result
If you started the delete process in the production session, the system deletes the data records
from your database according to the archive files you selected.
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If you started the delete process in a test run, the system does not delete any data records, but
only reads them.

In both cases, you obtain a Log [Page 481].
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Administration
Use
This function provides an overview of the archiving sessions.

Features
The overview of archiving sessions contains the variants with a note (your personal comment).
The archive files are listed per variant.

You can read the status of each archive file:

Status Meaning

Complete (green traffic light) •  Archiving is completed

•  Corresponding data records are deleted

Incomplete (yellow traffic light) •  Archiving is completed

•  Corresponding data records have not yet been deleted

Red traffic light Session was interrupted

You can obtain detailed information on an archive file by double-clicking on the file. You can, for
example, see the path name and whether the file is accessible.

You obtain details on a variant by selecting the variant and choosing User input in the context
menu.
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